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Administration Guide

In this section:

® Qverview
® Who Should Read This Document?

Overview

This document guides EchoSystem administrative staff in using the EchoSystem to automate lecture and
instructional capture.

Who Should Read This Document?

This document is intended for the personnel responsible for administering the EchoSystem on a day-to-day basis. It
may also be useful for other systems administration personnel associated with management of the related system
components. Academic Staff should read the Academic Staff Guide.

EchoSystem Administrators
Personnel responsible for every day functioning of the EchoSystem and lecture capture.

Need to consider

The EchoSystem quickly becomes a critical system in the institutional technology landscape. As
deployments grow more classrooms are captured and more students review instructional materials. It is
important to be competent with EchoSystem operations such as:

EchoSystem configuration

Capture device and Media Processor management
Workflow configuration

Capture schedules

System monitoring

System Administrators

Personnel responsible for other institutional systems with which EchoSystem will integrate. Blackboard or
other CMS/LMS/VLE systems are examples of these types of systems. Authentication and scheduling
systems are another example.

Need to consider

® EchoSystem integration
® EchoSystem APIs

EchoSystem Server Basics

In this section:

Access the User Interface
Server Ul Navigation
Page Types

Download Installers

Start or Stop the ESS
Start or Stop Wowza
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Access the User Interface

The EchoSystem Server user interface (ESS Ul) is a secured web-based interface accessible from any standard
web browser. The EchoSystem administrator configures the web interface address after installation.

The default address for the Ul is:

.....................................................................................................................................................................................

where ess.institution.edu is the host name of the EchoSystem Server (ESS).

The ESS Ul requires authentication. The default user name for the Ul is ess@echo360.com and the default
password is password. See Change the Admin Password for instructions on changing this password.

Server Ul Navigation

The ESS Ul uses a tab and subtab approach to navigation. At the top of the interface there are several tabs. During
some operations you may also see a breadcrumb, identified in the figure below, which simplifies navigation to
screens beyond a subtab. There are three other navigational items displayed at all times: Help, Logout and Userna
me (i.e., ess@echo360.com). The Help link takes you to this documentation. The Logout link ends your Ul session.
The Username link takes you to the change password screen, as identified in the figure below. The image below
shows each of these navigation items.

echo

Echoes Downloads Schedule Monitor Reports Configuration System

Schadules Courses Terms Branding Help

{ Courses = Add Mew Course

Add New Course Breadcrumbs )

Course Details

Mame : |
dentifier : |

Organization : I Choose... hd|

EchoSystem v. 4.0.2011-06-03.1

Page Types

The Ul provides the ability to both view and edit properties for certain items. These pages are referred to as show
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pages and edit pages. Show pages provide a listing of the properties for an item. Edit pages allow the user to set or
modify properties and then save them. For example, the show page for a Blackboard publisher displays the
information entered for the publisher, while the edit page allows you to edit that information.

Show Page Example

The following figure is an example of a Show page.

Echots  Montr  Sctaguie  [JESUSTERES

echo

ahas Diatadn
Publisher Details - BB 9 Pred
Publizher Dwtaily
BB 3 Prod Blackboaed Leaming Systam Enteprise -9
Hiack board § Production Sysiom o

Publisher Configuration

scdmimiy trator hitp\hlackbosed achowtisle edu

stb@echodd com | Lagos

Edit Page Example

The following figure is an example of an Edit page.

Edit Publisher -~ BB 9 Prod
Publishir Details

(e 5 Pros
Hadcboard 9 Produdtion 3

Biac kiboard Loeaming Sysiem Entensiss (53

Publisher Configuration

| stmisisaearse B Dltkbeand £CheaTa

Download Installers

Installers for the EchoSystem components listed below can be downloaded from the Echo360 website:

® Classroom Capture
® Personal Capture
® Processor (media processor)

Follow these steps.

1. Navigate to Downloads > Downloads.
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2. Click on the link for the installer you need.

Echoes  [EIGINIGEGEN  Schedule | Monitor | Reports | Configuration || System

Downleads Send Feedback | Help
Software Installer Downloads
1-5 of b
Description File
Installer for EchoSystem Software Capture (Windows) EchoSystemSoftwareCaptureForWindows_S.4.39024 exe
Installer for EchoSystem Personal Capture (Mac 05 X) EchoSystemPersonalCaptureForMac_5.4.39024. zip
Installer for EchoSystem Processor (Windows) EchoSystemProcessorForWindows_5.4.38024 exe
Installer for EchoSystem Processor (Linux 64) [launch from censele with sudo] EchoSystemProcessorForLinuxS4_5.4.39024 bin
Installer for EchoSystem Processor (Linux 32) [launch from censole with sudo] EchoSystemProcessorForLinux32_5.4.39024 bin
1-5 of b

3. Installer instructions differ by component. Follow the on-screen instructions.

Start or Stop the ESS

The ESS runs as a service or daemon. Managing this service is specific to the platform. Starting, stopping and
restarting this service is referred to throughout this document. The ESS Ul also indicates when service restarts are
required.

© wait Five Minutes

After restarting the ESS, wait five minutes before connecting. This ensures that the ESS is fully
started.

Start ESS on Windows

1. From the Windows taskbar select Start > Programs > Administrative Tools > Services. The Services
dialog opens.

2. Select the EchoSystem Server service.

3. Click Start. The ESS service starts on your local computer.

Stop ESS on Windows
1. From the Windows taskbar select Start > Programs > Administrative Tools > Services. The Services
dialog opens.
2. Select the EchoSystem Server service.
3. Click Stop. The ESS service stops on your local computer.

Restart ESS on Windows

1. From the Windows taskbar select Start > Programs > Administrative Tools > Services. The Services
dialog opens.

2. Select the EchoSystem Server service.

3. Click Restart. The ESS service restarts on your local computer.

Start ESS on Linux

1. Open a terminal prompt.
2. Type in the start command. The command is:
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.........................................................................................................................................................................

© Notice the Space

Note that there is a space between the file name and the start command.

Status messages show you when the service starts.

Stop ESS on Linux

1. Open a terminal prompt.
2. Type the stop command. The command is:

.........................................................................................................................................................................

© Notice the Space

Note that there is a space between the file name and the stop command.

Status messages show when the service stops.

Restart ESS on Linux

1. Open a terminal prompt.
2. Type in the restart command. The command is:

.........................................................................................................................................................................

© Notice the Space

Note that there is a space between the file name and the restart command.

Status messages show when the service stops and then starts.

Start or Stop Wowza

The Wowza Media Server (Wowza) runs as a service or daemon. Managing this service is specific to the platform.
Starting, stopping and restarting this service is referred to throughout this document. The ESS Ul also indicates
when service restarts are required.

Start Wowza on Windows
1. From the Windows taskbar select Start > Programs > Administrative Tools > Services. The Services
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dialog opens.
2. Select the Wowza Media Server service.
3. Click Start. The Wowza service starts on your local computer.

Stop Wowza on Windows
1. From the Windows taskbar, select Start > Programs > Administrative Tools > Services. The Services
dialog opens.
2. Select the Wowza Media Server service.
3. Click Stop. The Wowza service stops on your local computer.

Restart Wowza on Windows
1. From the Windows taskbar, select Start > Programs > Administrative Tools > Services. The Services
dialog opens.

2. Select the Wowza Media Server service.
3. Click Restart. The Wowza service restarts on your local computer.

Start Wowza on Linux

1. Open a terminal prompt.
2. From the terminal prompt, type in the start command. The command is:

sudo /etc/init.d WwzaMedi aServer start

Status messages show when the service starts.

Stop Wowza on Linux

1. Open a terminal prompt.
2. From the terminal prompt, type in the stop command. The command is:

sudo /etc/init.d WwzaMedi aServer stop

Status messages show when the service stops.

Restart Wowza on Linux

1. Open a terminal prompt.
2. From the terminal prompt, type in the restart command. The command is:

sudo /etc/init.d WwzaMedi aServer restart

Status messages show when the service stops and then starts.

System Configuration
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In this section:

® Qverview

Overview

EchoSystem configuration is done when first installing the system or when preparing for a new term. Some
configuration tasks are also done during the normal operation of the system. Common configuration tasks apply to
the EchoSystem Server (ESS) itself, supporting server infrastructure, devices and scheduling. All of these tasks are
driven through the ESS user interface.

You manage most Ul-based system configuration tasks on the System tab and the Configuration tab. The following
pages discuss these configuration settings and provide instructions for these tasks:

® Configure System Settings

® Configure the Flash Media Streaming Server
[ ]

[ ]

Advanced Configuration Options
Server Configuration for Presenters

Apart from System Configuration, there are other system-wide settings you should make before continuing with
setting up the various objects in the system for lecture capture. The following pages discuss these settings and
configuration tasks, and provide a variety of options for the organization of the system:

® | ocalize the EchoSystem
® Defaults and Inheritance
® Delegated Administration and Organizations

Configure System Settings

In this section:

® Qverview
® System Settings
® Save Changes

Overview
The system settings page opens automatically after a fresh installation and first-time login.

If you need to return to this page later, select System > System Settings. Click Edit to make changes.

System Settings
You can set the following system defaults on the System Settings page.

Identification Settings
Application Network Settings
Content Network Settings

Intake Settings
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Active Echo Settings

Inactive Echo Settings
Streaming Settings

Application Security

System Directories

Log Retention Policy

Academic Staff Upload Settings

Room Settings
Server Network Settings

Details on these settings are provided in the sections that follow.

Identification Settings

Identification Settings

Customer and System ldentification

Customer Identifier (Root Organization) : | Sample Customer License

The table below provides a description for the Identification Settings option.

Setting

Customer Identifier (Root Organization)

Application Network Settings

Description

This is the unique licensing identification number
provided to your institution by Echo360 Sales as part of
your system purchase. It is used to assign licenses to
your EchoSystem (ESS).

Application Network Settings

proxy server or ifiptables is being used on Linux to serve on privileged ports.
Protocol : ' All HTTPS s

Host Name | ess1-white.ga.echo360.com

These settings determine the URL used to log in to the EchoSystem Server and the port bindings. Select the protocol with reverse proxy if the application is hosted behind a

| 8443

The table below provides descriptions for the Application Network Settings options.

Setting
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Protocol Specify the protocol to be used for the ESS application
and for content delivered to users. Your choices
include:

* AllHTTPS

® HTTPS for App/HTTP for Content

® HTTPS for App/HTTP for Content with Reverse
Proxy

® HTTPS with Reverse Proxy

Avoid Using Mixed Content if
Possible

Later versions of browsers like
Chrome, Firefox and Internet
Explorer will not serve mixed
content (HTTPS for Application and
HTTP for Content) by default.
Specifically users may not be able
to view embedded EchoCenter and
EchoPlayer content, or be able to
Edit Media on the ESS.

To avoid these problems, select
either All HTTPS or HTTPS with
Reverse Proxy for this setting. Our
internal tests have indicated that the
encryption overhead for serving
HTTPS content does not
significantly impact page load times.
If this is not possible, you must
instruct their users to set their
browser preferences or properties
to "Allow Mixed Content".

Host Name The name of the application server.

Port (HTTPS) Port used for the HTTPS protocol.

Application Network Settings and LTI Integrations

If you are using LTI-Based Publishing to provide EchoSystem content, set your Application
Network Settings prior to configuring the LTI integration. If you change the HTTP/HTTPS
configuration in the Application Network Settings after creating the LTI profile, you will have to
delete and re-create the LTI tool within the LMS. This is because changing the HTTP/HTTPS
settings also changes the ESS launch URL for the LTI tool.

Content Network Settings
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Content Network Settings

These settings determine the URL used for serving content (EchoPlayer and EchoCenter). If applicable, the legacy port allows previously
published non-HTTPS URLs to be redirected to equivalent HTTPS URL.

Host Name : I essd-white.ga.echo360.com Legacy Port (HTTP): I 8080

The table below describes the information that needs to appear in each of the Content Network Settings fields.The

field labels differ in View mode and Edit mode; both are noted in the table.

NOTE that if you are using an internal web server and the Application Network Settings (above) are configured for
ALL HTTPS (with or without Reverse Proxy), the Host Name and Legacy Port (HTTP) settings configured here are
used for RSS feeds. If you are using RSS Feeds and an external web server, see Active Echo Settings below.

Setting Description

Public Content Base URL/Host Name The URL that the ESS will use to serve content.
Public Legacy Content Base URL/Legacy Port Port used for the Legacy content previously published
(HTTP) using the HTTP protocol. This is also the base

Port/URL for RSS feeds, if you are using an internal
web server and serving content over ALL HTTPS (with

or without Reverse Proxy).

Intake Settings

Presentations are transferred by capture devices to an incoming FTP directory. The ESS provides a native SFTP
server application supporting both SFTP with and without encryption. The ESS uses the Internal SFTP server by
default. If you are configuring the system with an external FTP server you can do so with these properties.

Intake Settings

Capture stations will transfer recordings with FTP to a specific folder. You may use the internal SFTP server or an external SFTP/FTP server of your
choice. If the Default Processor path is set, this will allow the EchoSystem Processor(s) to access files directly instead of using SFTE/FTE It must point to
the same folder as the FTF Folder except from the perspective of an EchoSystem Processor (i.e. UNC or NFS path).

FTP: Internal SFTP <sftp:/fec2-50-19-147-36.compute-
1.amazonaws.com:8022/>

FTP Folder : D:\echo360_dirwploadiint

The table below provides descriptions for the Intake Settings options.

Setting Description
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FTP Server

Page 12

Select Internal to use the SFTP server installed with
the ESS or select External to use an external
FTP/SFTP server. If External FTP Server is selected,
then a valid FTP user name and FTP Password are
required. If you use the internal SFTP server these
fields are automatically populated.

Generally, if you are considering an external FTP/SFTP
server, you should have already decided to use a NAS
or SAN storage facility for content, which provides
better system performance.

If you are intending to use an external FTP/SFTP
server, you must:

® Set up an account that the capture devices will use to
log in.

® Give the account read and write access to the
directory that will store the content.

® Appropriately configure the settings below with these
account and directory settings.
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FTP Protocol

FTP User Name

FTP Password

FTP Folder

Page 13

If you selected Internal for the FTP server field, select S
FTP or SFTP w/o Encryption for this field.

If you selected External for the FTP server field, select
FTP, SFTP or SFTP w/o Encryption for this field.

Select FTP if you are using an external FTP server for
file transfers across your network. If you selected the
bundled (internal) intake setting, you must select either
SFTP or SFTP w/o Encryption. FTP does not encrypt
data, so it is the fastest of the three protocol options.
However, it is not as secure as SFTP and does not
ensure data integrity as SFTP w/o Encryption does.

Select SFTP to transmit encrypted files. This option
ensures that files are secure. However, it can
dramatically slow the data transfer rate between the
appliance and the ESS if the appliance captures
consecutive presentations.

The data transfer rate slows because encrypting files
creates additional "work" for the capture appliance.
Say, for example, that the capture appliance is busy
encrypting and transferring one presentation, but must
also capture a second presentation at the same time.
Both presentations will be captured, encrypted, and
transferred, but the transfer rate for the first
presentation could drop by 90 percent, from 1 mbps to
100 kbps. The presentation will become available to
students eventually, but later than it would have been
otherwise.

Select SFTP w/o Encryption when you want to ensure
data integrity but do not require data encryption.
Although SFTP is normally encrypted, this setting
programmatically disables the encryption feature.

Because this option does not encrypt data, the

appliance can transfer a presentation at 1 mbps or
faster, even if it is capturing consecutive presentations.

The user name for the FTP/SFTP server.

The password for the FTP/SFTP server.

The absolute directory path (from the ESS application's
perspective) where the FTP server receives data and
the ESS should look for new capture uploads.
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FTP Host The host name of the FTP server, which by default is
the ESS host. This can be a Fully Qualified Domain
Name (FQDN) or an IP address. FQDN is
recommended. This value will be provided to capture
devices and media processors that are handling
content, and care should be taken that any FQDN that
is provided is one that the media processor or capture
device can resolve to an IP address via DNS.

FTP Port The port number of the FTP server. When configured
for the internal SFTP server, the default port is 8022. If
the server is external, the typical port settings are:

®* FTP: 21. Alternate: 8021
® SFTP: 22. Alternate: 8022

FTP Path If you selected External for the FTP server field, this
field appears. FTP Path is the virtual FTP/SFTP path to
the directory that matches the FTP folder location.

Example: Say that the FTP folder is /echo/upload. If the
SFTP path to get to that folder is:

® sftp://fechoupload.university.edu/echo/upload, then
the FTP Path is /echo/upload

® sftp://fechoupload.university.edu/upload, then the
FTP Path is /upload

Active Echo Settings

These settings define where active Echoes reside and how the HTML files for the presentations are served. Both the
URL and directory must point to the same physical location. All paths (absolute, UNC, or mapped drives) must be
valid, and the base directories must already exist. Be advised that selecting Internal or External web server will show
different fields to complete.

Active Echo Settings

Active Echoes are 'Available’ for users to access. Both the folder location and URL must point to the same physical location. For External Web Server
configuration, HTTP port is needed for RSS feeds to function normally in "ALL HTTPS” and “ALL HTTPS with reverse proxy” modes

j External «
| ess4-white.qa.echo360.com n (H i 449
| 2o

echocontent

l /mnt/content/content

The table below provides descriptions for the Active Echo Settings options. NOTE that if you are using an External
web server and RSS Feeds for publishing content, be sure the Host Name and HTTP port are configured properly.
These are used to generate the base URL for RSS feeds from an External web server..

Setting Description
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Web Server Select Internal or External from the list. By default, the
ESS uses Jetty as the internal web server application,
and the Internal web server is selected.

If you have configured an External web server, be sure
to identify the Host Name of the external web server
along with the proper Ports (both HTTPS and HTTP)
through which content is to be served. If you are using
an external Apache or IIS web server, see also Externa
| Web Server Configuration for Live Chat for information
on possible web server configuration file changes
needed.

Content Folder This directory contains the presentation files, including
Flash SWF, thumbnails, audio, and HTML files. The
Flash FLV files are placed in the Flash folder if the Flas
h Folder setting is configured, or in this folder if it is not.
Presentation content in this location is available.

This is the only configuration field shown for Internal
web servers.

Best Practice: Configure the
Flash Folder Setting

We recommend that you configure
the Flash Folder setting to give
users the best playback experience.

Host Name Identifies the fully qualified host name of the External
web server.
Port (HTTPS) Identifies the Port number that the External web server

will use to deliver active echoes.

NOTE that if your Application Network Settings are set
to serve mixed content (HTTPS for App/HTTP for
Content, with or without Reverse Proxy) this field is
labeled "HTTP Port" and must be the same port
number as the other HTTP Port field in this section.

HTTP Port Identifies the Port number that RSS feeds will use to
deliver content from the External web server. RSS
feeds MUST use an HTTP port for content.

Base URL Path Identifies the base path on the External web server
where active echoes are stored for content delivery.

Inactive Echo Settings

Inactive Echoes are not available for student review. These settings define the location for the three types of inactive
Echoes. All paths (absolute, UNC, or mapped drives) must be valid, and the base directories must already exist.
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Inactive Echo Settings

An Echo may be moved into one of several inactive states. Specifying a folder location will enable the feature.

Folde: c:\echo360 attic Archived Folder c\echo3B0\archive

c:\echo360' deleted

The table below provides descriptions for the Inactive Echo Settings options.

Setting Description

Unavailable Folder ESS moves presentations into this directory when the
user makes them unavailable. Unavailable
presentations are typically ones that are not viewable
by users, but are stored on a locally available media
such as a NAS. They are presentations that can quickly
be made available again, such as presentations that
are taken off-line for editing.

Archived Folder ESS moves presentations into this directory when the
user archives them. It is good practice to archive
content to an external location (possibly tape or other
off-line media) so it does not consume critical and
expensive ESS storage space. However, archived
Echoes are not available. They cannot be viewed by
students until you unarchive them.

© When Choosing the Archive
Location

Make sure the ESS can access the
archive location.

Deleted Folder ESS moves presentations into this directory when the
user deletes them. They remain here until permanently
deleted from the system or reinstated (undeleted)
through the ESS.

Streaming Settings

The audio and video content is streamed during Echo playback. Streaming settings include the base directory where
ESS stores all of the streaming audio and video files for presentations (FLV files) and the URL where the
EchoPlayer accesses the streaming content. Both the directory and URL must point to the same physical location.
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Streaming Settings

Streaming your video files protects the intellectual property of your lecture, and often improves the content viewer's experience. The folder may be
local to the EchoSystem Server or on a network addressable location (NAS, SAN, UNC). Wherever it is located, the associated Streaming URL must
point to the same folder. When using the Internal Wowza server, the URL for both Echoes and Apreso presentations must reference the same host.

Echo Content

Flash Streaming : [ External Flash Server 4
External Flash URL : rtmp:/fess.echostate.edu/echo/_definst_ Flash Folder: D:\echo360\flash
Live Flash URL : rtmp:/fess.echostate.edu/echolive/_definst_ Live Streaming Server Host : rtmp:/ fess.echostate.edu

Apreso Content

Apreso Flash URL : rtmp://ess.echostate.edu/apreso/_definst_
Real Media URL : Real Media Folder :
Windows Media URL : Windows Media Folder:

The table below provides descriptions for the Streaming Settings options.

Setting Description

Flash Streaming Select the streaming server that will be used to stream
presentation playback content. Your choices include:

® External Flash Server (can be either Wowza
or Adobe FMS)

® Internal Wowza Server (only available for
existing customers who upgrade to
EchoSystem 5.4)

Upgrading to 5.4 with an Internal
Wowza Configuration

Existing users upgrading to EchoSystem
5.4, and who are using an Internal
configuration of Wowza can continue to
do so; the ESS will work with the
existing Wowza v3.5, and will update the
necessary items on upgrade. However,
if you want to upgrade to Wowza 4, you
must change to using an External
configuration of Wowza.

Upgrading to Wowza 4 and converting
to an External Wowza media server
configuration are both strongly
recommended. See Configure the
Flash Media Streaming Server and Conf
igure an External Wowza Media Server f
or instructions.
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External Flash URL / Internal Wowza URL

Page 18

This setting defines the Base URL for the Flash
application. The label on this setting varies, depending
on your selection in the Flash Streaming setting.

If you selected External Flash Server as the Flash
Streaming setting, this field is labeled External Flash

® Recent versions of Adobe's Flash Player

require that both the application and the
instance name be specified.

The External Flash URL is comprised of the
following components: the RTMP protocol, the
FQDN (fully-qualified domain name) of the
Wowza or FMS server, the on-demand
application name (echo),and a _definst_ p
ointer. For most External Flash Server
installations, the _defi nst __ parameter is
required at the end of the standard streaming
server URL. The figure below shows an
example External Flash URL.

Echo Content

Flash Streaming I External Flash Ser

External Flash URL remp:f/ess.echost;

If you selected Internal Wowza Server as the Flash
Streaming setting, this field is labeled Internal Wowza
URL and uses the host name of the ESS along with the
on-demand application name (echo).
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Live Flash URL

Flash Folder

Live Streaming Server Host

Real Media URL

Page 19

This setting defines the base URL for the Flash
streaming of live webcasts. You must use a Wowza
Media Server for live webcasting.

When using an External Wowza Server, the Live Flash
URL should consist of the same elements as the
External Flash URL above, but use the live application
name (echolive) instead of the on-demand application
name. For most External Flash Server installations, the
_definst _ parameter is required at the end of the
standard streaming server URL.

Example: rt np: // ess. echost at e. edu/ echo
livel/_definst_

When using an Internal Wowza server, the Live Flash
URL uses the host name of the ESS along with the live
application name (echolive). For example: rt np: // es
s. echost at e. edu/ echol i ve

The path of the directory where the Flash streaming
content is going to be stored.

This may be a Windows UNC path, a Windows mapped
drive, or a Unix-style path. If you use an external
storage such as a SAN for this content, then the ESS
service or daemon needs both read and write access to
this directory. The Flash streaming server requires read
access only.

This setting identifies the host name of the Wowza
Media Server that will be streaming the live webcasts, if
applicable.

When using an External Wowza server, the Live
Streaming Server Host should be the FQDN (without
schema or path components) of your Flash server.

When using an Internal Wowza server, the Live
Streaming Server Host is the same as the host name
of the ESS.

This setting is only used with Apreso Classroom
capture stations configured to capture video using
Real. Required if specifying a Real Media streaming
directory. Enter the Base URL to the Real Media server
mount point.

Example: rtnp://real server.institution. edu
/ echo
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Real Media Folder

Apreso Flash URL

Windows Media URL

Windows Media Folder

This setting is only used with Apreso Classroom
capture stations configured to capture video using
Real. Enter the absolute path of the directory where the
Real Media streaming content is stored.

The ESS supports presentations created by the legacy
Anystream Apreso Classroom 1.3.10 system.

This is the Flash base URL specific to content created
by the Apreso Classroom capture stations. The
Apreso-created content needs slightly differently
settings to produced optimized playback and therefore
uses a separate Flash application.

When using External Flash streaming servers, this may
be unique. For most External Flash server installations,
the _defi nst _ parameter is required at the end of
the standard streaming server URL. Example: rt np: /
/ ess. echost at e. edu/ apreso/ _definst _

When using the Internal Wowza server, the host name
must be the same as that defined for the Internal
Wowza server.

This setting is only used with Apreso Classroom
capture stations configured to capture video using
Windows Media. Required if specifying a Windows
Media streaming directory. Enter the Base URL to the
Windows Media Publish Point. Example: rms: //wi nd
owsnedi a- server.institution. edu/ echo

This setting is only used with Apreso Classroom
capture stations configured to capture video using
Windows Media. Enter the absolute path of the
directory where the Windows Media streaming content
is stored.

Use the table below as a quick guide to the options you can configure based on your capture configuration:

Capture Device and Products Created

EchoSystem SafeCapture HD, EchoSystem Capture
Appliance, Classroom Capture or Personal Capture
creating Podcast/Vodcast content.

EchoSystem SafeCapture HD, EchoSystem Capture
Appliance, Classroom Capture or Personal Capture
creating EchoPlayer content.

Application Security

Page 20

Streaming Settings

Leave these settings as default. Generating a Podcast
does not generate any streaming content.

Specify the Flash Folder and either Internal Wowza
URL or External Flash URL. You may leave the other
settings blank.
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Application Security

The application security settings set the security module used to secure staff and instructor logins fo the ESS
application {U!) and instructor logins via Personal Capture and the capture device Web Ul or REST API. Create and
moaify the settings for application security modules on the Configuration = Secunity tab. Select "Infernal ESS
Database” to manage user authentication in the ESS. Select an application securify module to manage user
authentication extemally using LDAP All users assigned the "System Admin” rale will automatically fall back to the
internal ESS database in the event authentication fails against the configured module. Select the "Enable Fallhack
to Intemal ESS Database™ check box to enable this option for all other user roles {instructor and scheduwler).

Security Module : Internal ESS Database j

Aoy ESS eare to lamin to viaw contant
Allow ESS users to log

Use the options in the following table to manage staff and Instructor logins to the ESS application (Ul) and Instructor
logins to Ad Hoc and Personal Capture.

Setting Definition Inheritance

Security Module The module used to manage user N/A
authentication to the ESS. You can
add and edit security modules on
the System > Security tab. See LD
AP Authentication if you do not
want to use the internal ESS
database.

Enable Fallback to Internal ESS Applies if you are using the LDAP N/A
Database security module. If Yes, the ESS
database will be checked if LDAP
authentication fails.

® Users with the System
Administrator, Parent
Organization Administrator, or
Child Organization Administrator
roles will always be checked
against the ESS database when
LDAP fails.

® By entering Yes, you ensure that
users with other roles (Scheduler,
Instructor) will be checked
against the ESS database when
LDAP fails.
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Allow ESS users to login to view  This setting applies if you have colla N/A
content boration services. If you do, we
recommend that this setting be Yes.
When Yes, the ESS checks the
local database to grant Instructors
and Teaching Assistants
moderation privileges.

Enter Yes when LDAP or seamless
login is used to secure the section.

System Directories

The System Directories entry shows where device software update files are placed. You can leave this at the default

unless you have a need to change the location.

System Directories

The folder for device soffware updates is shown here.

Device Software Update File Goes Here :  C:\Program Files\Echo360\Server\plugins

Log Retention Policy

The Log Retention Policy allows you to determine how many days log files will remain on the system. The default is
30 days, but you can set it for as long as you like. Any changes made to the retention policy are applied during the

next scheduled log deletion process.

Log Retention Policy

This section contrals how many days logs will remain on the system. Any modifications will be used during the next scheduled log deletion process.

Days to Retain Logs: 30

Academic Staff Upload Settings

Academic Staff Upload Settings

These settings control the upload of media files via the External Media tab in the EchoSystem Server and via Echo360 Personal Capture. Change these settings on a presenter’s page to override
the global defaults.

May Upload External Media lg May Configure Products l?]

The table below provides descriptions for the Academic Staff Upload Settings options.

These settings relate to the media import feature. See Import Other Media for Academic Staff for details on this

feature. See Upload Settings for details on a related default.

Setting Definition Inheritance

May Upload External Media The default value (Yes) means that = System > Academic Staff

Academic Staff (if defined as
Instructor for the section) can
upload external media.
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May Configure Products The default value (Yes) means that = System > Academic Staff
Academic Staff (if defined as
Instructor for the section) can
change which products are
produced when uploading external
media.

Room Settings

Room Settings

These settings control default room-refated valies.

me Zone : |[-|:|5:nm US/Eastern ~| Video Standard | NTSC ~|

The table below provides descriptions for the Room Settings options.
Setting Description

Time Zone The time zone where the parent organization is.

Video Standard The standard used by the device in the room when it
captures video. Options include NTSC and PAL, both

of which are standard analog color television encoding
systems.

Server Network Settings

Server Network Settings

These settings define the time servers used by EchoSystem Server to compare dewvice
time signatures in the event system time differs by more than reguired.

g Server: Iﬂ.echn3ﬁﬂ-.pﬁﬂl.ntp.nrg Time Server : I l.echo3&0.pool.ntp.org

g Server: 2.echo360.pool.ntp.org me Server : 3.echo360.pool.ntp.org

The table below provides a description of the Server Network Settings options.

Setting Description

Time Server Enter the NTP server addresses that the ESS should
use to synchronize its time with the time signatures of
connected devices. The EchoSystem requires at least
two distinct time sources. No two Time Server fields
should reference the same NTP server.

Save Changes
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When you have entered your settings, click Save. You will be reminded that you need to restart the EchoSystem
Server and Wowza for the changes to take effect. See Start or Stop the ESS and Start or Stop Wowza for detailed
instructions if necessary.

Configure the Flash Media Streaming Server

In this section:

Overview

Configuration Options

Media Server Recommendations
Adjust the Wowza Media Server

Overview

The Flash media streaming server delivers streaming content to students. This content includes Echoes
(on-demand content) and/or real-time live webcasts. You can use either the Wowza Media Server (Wowza) or the
Adobe Media Server (Adobe).

Besides the configuration information contained on this page, you may also want to review the bandwidth
requirements and example scenarios provided in Bandwidth Requirements for Capture and Media Formats. While
the information provided there is in the context of live webcasting, the specifications shown apply to both live
webcasting and on-demand content delivery.

© Live webcasting requires the Wowza Media Server. EchoSystem 5.5 requires Wowza 3.5, 3.6 or
4. Refer to the Wowza website for more information about their products.

In particular, existing users with an Internal Wowza configuration who are upgrading to 5.5
should refer to the Note in the section below for information regarding upgrading their Wowza
version and configuration.

Configuration Options

The following pages provide the necessary instructions for installing and configuring the flash media server:

® Configure an External Wowza Media Server
® Configure an External Adobe Media Server

While you can install the flash media server on the same server as the ESS, for performance and scalability, we
strongly recommend using a separate server. Both configurations are referred to as "external" because you will
select "External Flash Server" in the Streaming Settings section of the System Settings page on the ESS. "Internal"
configurations are only available for existing customers who are upgrading. See the note below.

You can use a single flash media server for both on-demand and live content, or you can use multiple flash media
servers to deliver streaming content. Note the following points:

® Live webcasting must be streamed from a Wowza Media Server.

® You can have one flash media server (Wowza or Adobe) to deliver on-demand content, and another (Wowza)
media server to deliver live content.

® If you use multiple flash streaming servers, one must be used for live content and one must be used for
on-demand content; you cannot stream one type of content from two different servers (load-balancing).

Page 24


http://www.wowza.com/products/streaming-engine/
http://confluence.echo360.com/display/54/Configure+System+Settings#ConfigureSystemSettings-StreamingSettings

EchoSystem 5.5 Documentation

Be sure you also obtain the proper licensing for the flash media server. For example, the use of Wowza requires a
Wowza Production license, to allow for the number of concurrent connections required to stream ESS content to
users. Refer to your flash media server documentation or sales representative for additional information.

As always, if you have questions or need clarification, contact Echo360 Technical Support for additional assistance.

Upgrading to 5.4 with an Internal Wowza Configuration

Existing users upgrading to EchoSystem 5.5 or any of the 5.5 Service Packs, and who are using
an Internal configuration of Wowza can continue to do so; the ESS will work with the existing
Wowza v3.5, and will update the necessary items on upgrade. However, if you want to upgrade
to Wowza 4, you must change to an External Configuration of Wowza.

Upgrading to Wowza 4 and converting to an External Wowza media server configuration are both
strongly recommended. The instructions linked above provide all the necessary steps for
installing and configuring an external Wowza or Adobe media server.

Media Server Recommendations

Because media server load can vary dramatically from one installation to the next, it is difficult to make general
recommendations. However, these are baseline requirements:

64-bit OS preferred

4 Cores (minimum)

8 GB RAM (minimum)
1 GBNIC

You are strongly encouraged to refer to the product websites for additional information and server requirements:

®* \Wowza: http://www.wowza.com/fag.
® Adobe: http://www.adobe.com/products/adobe-media-server-standard/tech-specs.html

Beyond these minimum requirements, consider the proportions of on-demand versus live content.

®* When serving on-demand content, the server needs to move data from the storage disk to the streaming
server to the student computer. But this data transfer does not have to happen in real time. The audio, video,
and display is reassembled and synchronized when the Echo plays. This means the server should have fast
data transfer (“fast disks") and a generous amount of CPU, but little RAM or network bandwidth.

® Live webcasting occurs in real time. It does not require a fast disk because no data is stored there during
the webcast. It requires, by contrast, a fast network: the data (video, audio, display) must travel to multiple
student computers and appear perfectly synchronized. It requires a high-bandwidth network with large
amounts of RAM.

Consider these questions when determining media server requirements and configuration options.

® Will I use live webcasting at all, or will | use on-demand content delivery only?

® Will | use live webcasting regularly for classes or only for special events or unusual situations?

* Will live webcasts replace current on-demand content or will | be providing regular live webcasts and on-dem
and content?

® |f upgrading to EchoSystem 5.5 and currently using an internal configuration, does my current ESS/media
server device have sufficient power to provide live webcasting in addition to my current on-demand load? Will
| be better off moving to an external media server?

These links can help you estimate system needs:

Page 25


http://echo360.com/customer-portal
http://www.wowza.com/faq
http://www.adobe.com/products/adobe-media-server-standard/tech-specs.html

EchoSystem 5.5 Documentation

Deployment Planning. Provides system planning considerations as well as file transfer and content delivery
information within the context of how network bandwidth is used.

Bandwidth Requirements for Capture and Media Formats. Provides very specific information regarding the
bandwidth used for live (and on-demand) content delivery and how to calculate it accurately.

Wowza FAQs page. Useful if you are using a Wowza Media server. The Performance and Scalability section
of this page provides performance testing information for both on-demand and live content delivery, as well
as the hardware specifications for the machine on which the tests were performed.

Adjust the Wowza Media Server

If you are using a Wowza media server, you should review and, if necessary, adjust the settings applied by the initial
configuration. Refer to these pages on the Wowza website:

Wowza FAQs page: http://www.wowza.com/faq. See the section on performance and scalability.

General performance tuning: http://www.wowzamedia.com/forums/content.php?46.

If you are running Wowza on Linux, information on running Wowza as a named user in Linux: http://www.wow
za.com/forums/content.php?433

Wowza configuration tuning: http://www.wowza.com/forums/content.php?5-general-tuning.

If you are using Wowza with a Java Virtual Machine (JVM) on Windows: http://www.wowza.com/forums/show
thread.php?1029-Windows-tuning-running-the-quot-server-quot-Java-VM-(tuning).

Review the Firewall Port settings for the Wowza Media Server, especially if you do live webcasts.

Wowza licensing

Please note that all licensing for your Wowza server is provided through Wowza. Echo360 no
longer provides licensing for the Wowza server. Please see the following communications:

Customer Communication re Wowza.pdf

Wowza Media Systems Comm Ltr.pdf

Configure an External Wowza Media Server

In this section:

Overview

Preparing for Installation
Co-locating the Flash Content
Installing the On-Demand Bundle
Installing the Live Streaming Bundle
Configuring Wowza

Enabling iOS Live Streaming
Configuring ESS

Overview

This page provides the necessary instructions for installing and configuring a Wowza media server for use with the
EchoSystem.
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You can install Wowza on the same server as the ESS or on a separate server. Both configurations are referred to
as "external" because you will select "External Flash Server" in the Streaming Settings section of the System
Settings page on the ESS. "Internal" configurations are only available for existing customers who are upgrading; the
instructions on this page do not apply to internal configurations.

For performance and scalability, we highly recommend using a dedicated server solely for the purpose of
streaming Flash content that the EchoSystem produces.

© Existing Users Upgrading to Wowza 4 Must Edit Server.xml File

If you already have an existing External Wowza configuration, but are upgrading to Wowza 4,
you will need to make the following change to the server.xml file for Wowza 4 to work properly
with EchoSystem 5.5:

® Change the DefaultStreamPrefix value from "mp4" to “flv"

See the Configuring Wowza section below for additional configuration instructions.

Wowza licensing

Please note that all licensing for your Wowza server is provided through Wowza. Echo360 no
longer provides licensing for the Wowza server. Please see the following communications:

Customer Communication re Wowza.pdf

Wowza Media Systems Comm Ltr.pdf

Preparing for Installation

EchoSystem 5.5 requires the use of Wowza v3.5, v3.6 or v4. Be sure the server you will be using meets Wowza's
specifications. Refer to the Wowza FAQs page for details and installation recommendations.

1.

w

Wowza is a Java application, and requires Java Runtime Environment (JRE) version 6 or 7. Installers for your
platform are available from Oracle.

Download the Wowza Media Server installation bits for your platform from the Wowza installer page.

Make a note of your Wowza license key, which will be required during installation.

Proceed with the installation of Wowza on the server.

Configure Wowza To Run As ESS User

For Linux users: After installation, be sure to configure Wowza to run as a named user. This
user should be same user (or in the same group) as the ESS user (the user that ESS is
configured to run as). For more information, refer to the Wowza forums for Linux at the following
URL.: http://www.wowza.com/forums/content.php?433.

For Windows users: The Wowza service should be run as the same domain user as the ESS
server.

The next section provides instructions on configuring the content storage location that Wowza will use. The flash
content does NOT need not be in the same location as the program files.
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Co-locating the Flash Content

The ESS System Settings allow you to identify the specific location where the ESS is to deposit the Flash content it
generates. This location can be either a local volume or a UNC-addressable path. The location is represented as the
"Flash Folder" field in the Streaming Settings section of the System Settings configuration.

In order for the Wowza server to find and stream the Flash content delivered by the ESS, that content must stored
on a volume that the Wowza application has read and write access to. This can be a local drive (that the ESS writes
to via a network share), a mounted SMB/CIFS file share, or mounted NAS/SAN storage.

Consult your operating system’s documentation for configuring file shares, or contact Echo360 Technical Support for
guidance.

Installing the On-Demand Bundle

For on-demand Echoes and Apreso content, Echo360 has created an archive that contains the proper directory
structure needed inside the Wowza application directory, along with the required files for configuration. For
reference, the directory structure required is shown in the Configuring Wowza section below.

These steps are only necessary if you are configuring an external Wowza server for the first time.

1. Download the latest Wowza On-Demand Bundle available from the Customer Support Portal.

2. Extract the contents of the downloaded zip file to your Wowza Media Server installation root. This will create
the necessary folder structure, and will deposit Application.xml configuration files into each subfolder of the /
conf directory.

Installing the Live Streaming Bundle

For live content and the chat and presence features, Echo360 has created a script that automatically installs the
proper directory structure needed inside the Wowza application directory, and adds the required files for
configuration as well as additional required Java libraries.

The following steps are required if you are configuring an external Wowza server for the first time, OR if you have an
existing external Wowza server that you want to configure for live streaming.

1. Download the latest Wowza Live Streaming Bundle available from the Customer Support Portal.
2. Extract the contents of the downloaded zip file to a temporary location on your Wowza server.
3. Open the included README.html document and follow the instructions appropriate for your platform.

If you are using Live, be advised that features such as live chat require the Collaboration and
Statistics service (also called HEMS). For other live requirements see Specifications for Live

Webcasting.

Configuring Wowza

Wowza Media Server relies on virtual servers, called applications, to serve the correct content based on the
document root given in URL requests. These applications are configured by creating directory structures and XML
documents at specific locations within the Wowza instance’s installation folder.

Both live and on-demand streaming, along with their supporting components, are configured as separate Wowza
applications with distinct parameters. There are four applications in total:

® One for on-demand Echo streaming,
® One for live Echo streaming,
® One for the chat and presence functions of live Echoes,
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® One for legacy Apreso content.

Installing the On-Demand and Live Streaming bundles, covered in the above sections, creates the necessary
application folders and provides the Application.xml files and Java libraries needed for Wowza to deliver ESS
streaming content.

Once those steps are completed, use the below information to verify the proper folder structure and customize the
Application.xml files for your system.

1. Starting at the installation root for the Wowza server instance, verify that the necessary components of the

directory tree (in addition to the program files) appear. By default, the installation root for Wowza is:
® Unix: /usr/local/WowzaMediaServer/
® Windows: C:\Program Files\Wowza Media Server\

2. Within the installation root, the directory structure should appear as follows, noting that if you did not install
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the Live bundle, you will not see the /echolive/ or /echotextchat/ folders:

Wowz aMedi aSer ver
--- applications
--- apreso
--- echo
--- keys
--- _definst_
--- sharedobj ects
--- _definst_
--- echolive
--- sharedobj ects
--- _definst_
--- echot ext chat
--- conf
--- apreso
--- echo
--- echolive
--- echot ext chat

Next, you will need to edit one line in each of the installed Application.xml files (each conf/{application name} f
older contains one) to define the location where Wowza should look for your Flash content.

The /echol/, /echolive/, and /apreso/ Application.xml files all contain a parameter named St or ageDi r in the
first Streams stanza near the top of the file:

<St orageDi r >C. \ Echo360\ Fl ashSt r eam ng</ St or ageDi r >

The default value of this parameter will not be valid for most deployments.

In each file, replace the path between the St or ageDi r tags with the location that corresponds (or will
correspond) to the Flash Folder defined on your ESS System Settings page. As defined above this is the
location where the ESS will deposit the Flash content it generates, and can be either a local volume or a
UNC-addressable path.

The /echotextchat/ Application.xml file is different. Near the bottom of the file, this document contains a set of
property values encoded as follows:
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<Properties>

<Pr operty>
<Nane>obj ect st or agedi r ect or y</ Nane>
<Val ue>
${com wowza. wrs. cont ext . VHost Conf i gHone}/ echot ext chat/rso
</ Val ue>

</ Property>

<Pr operty>
<Name>chat | ogst or agedi r ect or y</ Nane>
<Val ue>
${ com wowza. wrs. cont ext . VHost Conf i gHone}/ echot ext chat/ chat | ogs
</ Val ue>

</ Property>

<Property>
<Nane>echosyst endi r ect or y</ Nanme>
<Val ue>
${ com wowza. wrs. cont ext . VHost Conf i gHone}/
</ Val ue>

</ Property>

</ Properties>

7. Replace the ${com.wowza.wms.context.VHostConfigHome} string with the value entered for St or ageDi r
in the other three Application.xml files BUT leave the appended paths (where this string precedes the path
values) in place.

Changing this last property value identifies the echosyst endi r ect or y as the storage or Flash Folder directory.
This tells Wowza to write its chat and presence logs to a location accessible to the ESS, in a subfolder called
"content" beneath the Flash storage root.

Finally, if you are using Wowza v4, make the following change to the server.xml file located in the /conf/ folder of
the Wowza installation root:

® Change the DefaultStreamPrefix value from "mp4" to "flv"

Further edits to the server.xml file are described below, as
they relate to enabling iOS Live Streaming.

Enabling iOS Live Streaming

Before proceeding, ensure that you have followed the steps above and modified the Application.xml file for each of
the four applications (echo, echolive, echotextchat and apreso).

As of EchoSystem 5.2, iOS streaming is supported for live presentations. However for this to work as expected, you
must edit the Server.xml file located in the /conf/ folder of the Wowza installation root as follows.

1. Open the Server.xml file for editing, and do the following:

a. Insert the following entry in the <Ser ver Li st ener s> section of the Server.xml file:
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<Server Li st ener >
<BaseC ass>com echo360. st reamni ng. | i ve. Medi aCast er </ BaseC ass>
</ ServerLi st ener>

. Insert the following entries at the bottom of the Server.xml file, placing them after the final <Properties>
tag and before the final </Properties> tag (creating properties within the last Properties tag):

<Property>
<l-- the directory that contains the streans.txt file -->
<Nane>St r eanbni t or Di r </ Nane>
<Val ue> ${com wowza. ws. cont ext . VHost Conf i gHone}/ noni t or </ Val ue>
</ Property>

<Property>

<I-- the wowza application that the streans will be activated
on. Default is echolive -->

<Nanme>EchoLi veAppl i cati on</ Narme>

<Val ue>echol i ve</ Val ue>
</ Property>

<Property>

<I-- tinme the thread waits between checks of the streans.txt
file. Default is 5 seconds -->

<Nanme>Wai t | nt er val </ Nane>

<Val ue>5000</ Val ue>
</ Property>

2. Replace the ${com.wowza.wms.context.VHostConfigHome} string with the value you used for the St or ag

eDi r in the Application.xml files.

For your reference, a file named example-Server.xml is included with the Live Bundle files, that shows this change
made to the file. This file contains a basic Wowza server configuration along with all of the necessary changes for
iOS live streaming. It is not automatically installed as a part of the bundle (otherwise it would have overwritten your
existing Server.xml file).

Once all the configuration files have been edited and saved according to these instructions, restart your Wowza

service.

Configuring ESS

There are five especially important fields in the Streaming Settings section of your ESS System Settings that you will
need to validate before the ESS can provision your configured Wowza server to stream content. The information
shown below is also contained in the Streaming Settings section of the System Settings configuration page.

1. Login to the ESS and navigate to the Configuration > System Settings.
2. Click the Edit button.
3. Scroll down to the Streaming Settings section of the page.
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4. For the Flash Streaming parameter, select External Flash Server.

5. For the External Flash URL parameter, compose a URL consisting of the RTMP protocol, the fully-qualified
domain name (FQDN) of the Wowza server, the on-demand application name (echo), and a _definst_ pointe
r. The URL should look similar to the following:
rtnp://fqgdn. of . wowza. server/ echo/ _definst _

6. Forthe Live Flash URL parameter, compose a similar URL consisting of all the same elements, but using
the live application name (echolive), as follows:
rtnp://fqgdn. of . wowza. server/ echol i ve/ _definst _

7. The Flash Folder parameter should already reflect the location where you have chosen to store your Flash
content.

8. The Live Streaming Server Host parameter should represent the FQDN (without schema or path
components) of your Flash server.

9. Once all these parameters are validated, click Save.

The ESS is now configured to direct your viewers’ browsers to call the external Wowza streaming server when
playing live and on-demand Echo content.

Configure an External Adobe Media Server
In this section:

Overview

Preparing for Installation

Co-locating the Flash Content
Configuring the Streaming Application
Configuring the ESS

Overview

The Flash media streaming server delivers streaming content to students. This content includes Echoes
(on-demand content) and/or real-time live webcasts. You can use either the Wowza Media Server (Wowza) or the
Adobe Flash Media Streaming Server (Adobe FMS).

This page provides the necessary instructions for installing and configuring an External Adobe FMS for use with
EchoSystem (5.1 and above).

Preparing for Installation

The first step is to determine whether Adobe FMS will be installed on the same machine as the ESS, as this will
determine if there is a need to co-locate your Flash content (i.e. - to place it in a file system remote to the ESS via a
network share so that the media server can access it locally).

If everything - the ESS, Adobe, and the flash content - will exist on the same physical device, OR the flash content is
to be located or with the content located on a mounted SAN volume, then you can skip the following section. Simply
make a note of the Flash Folder location, which will be configured in the Streaming Settings section of the ESS
System Settings. See Configuring the ESS below as well as the Configure System Settings page.

Co-locating the Flash Content

In order for the Flash server to find and stream Flash content, that content needs to be stored in a drive
letter-addressable location (i.e. - logically local). This location can be physically attached to the Adobe host or on the
network as a SAN volume. The ESS must transfer the Flash content over the network to the location chosen for the
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content storage, meaning this location must be accessible via a network share.

When using a common SAN volume for all content, you can skip this section, and make sure that the Flash Folder
parameter entered in the Streaming Settings section of the ESS System Settings page matches the location where
you want the Flash server to be looking for its content files.

Echo360 recommends NOT storing the content on a location that is logically remote to the Flash server, such as a
NAS or UNC-addressable location, since this will generate unnecessary network traffic that could be detrimental to
the performance of the streaming server.

The following instructions assume that Adobe FMS is installed on a Windows server; if using a Linux distribution,
please refer to the instructions specific to your network file sharing solution (e.g. - Samba) to set up a network share.

1. Using Windows Explorer on the Adobe FMS machine, navigate to the folder where the root of the Flash
content will be stored (e.g. - D:\echo\flash).

2. Right-click the folder, and select Properties.

3. On the Sharing tab of the Properties dialog box, click the radio button labeled Share this folder.

® Enter a unique, recognizable share name. This will be the path element that is later referred to in the
UNC path that defines the share.
® | eave the user limit set to Maximum allowed.

4. Click Permissions and navigate to the Share Permissions tab in order to set the permissions for access to
the folder at the share level.

5. Click Add...

6. If the server is located on an Active Directory-managed domain, add the name of the computer account for
the machine that is running the ESS. Otherwise, it will be necessary to configure the ESS to run as a
separate, privileged user in its Windows service settings, under the "Log On" tab of its properties dialog, and
to add that same user account on this machine.

7. Click Check Names to verify the group and/or accounts that have been entered into the list. This may require
authentication.

8. When satisfied that the account information entered is correct, click OK.

9. Select the account name specified in step 6 from the Group or user names list.

10. Check the box under the Allow column for each of the permissions that should be granted to the selected
account. Echo360 strongly recommends that you allow Full Control to the user and/or computer accounts
representing the ESS; otherwise, the ESS may not be able to place content here.

11. Click OK to commit the changes.

12. Select the Security tab to set the permissions for access to the folder at the file system level.

13. Repeat steps 5 through 10, using the same group and/or accounts that were used for the share-level
permissions.

14. Click Apply and OK to commit the changes and close the Properties.

Optionally, but as a recommended verification, do the following:

1. Log into the machine running the ESS as the user account running ESS, if one was specified in Step 6
above.

2. Attempt to connect to the share you created above using its UNC path.

3. Once connected, confirm that is it possible to view, create, delete, and rename files.

Configuring the Streaming Application

Adobe Meda Server relies on virtual servers, called "applications," to serve the right kind of content based on the
document root given in URL requests. Adobe is installed with a set of default applications that reside in its Program
Files folder. In order for Adobe to work with content from the EchoSystem, it is necessary to create a new
application based on the default Video-on-Demand (called "vod") application. This application will be referred to as
"echo."
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10.
11.
12.

13.
14.

Using Windows Explorer, navigate to the folder where the program files for Adobe FMS are installed.

Open the applications folder.

Create a copy of the vod contained there, and rename it to echo. There should now be both a vod and an ec
ho folder within the applications folder.

Open the echo folder.

Open the Application.xml file in Wordpad for editing.

Line 5 contains a <Streams> directive that is currently set to: /;${VOD_DIR}.

Change this entry to read: /;${ECHO_DIR}.

Save and close the file.

Return to the conf subfolder under the Adobe FMS program files root. It should reside at the same level as
the applications folder.

Open the fms.ini file in Wordpad for editing.

Find the location in the file where the variable VOD_DIR is defined.

Add a new line, defining a new variable, ECHO_DIR, to reflect the path configured as the share in the Co-Loc
ating the Flash Content section above. Use the same format as the VOD_DIR variable. The fms.ini file should
now contain definitions for both the VOD_DIR and ECHO_DIR variables.

When finished, save and close the file.

Start or restart the Adobe FMS service to commit the configuration changes.

Adobe FMS is now configured to serve content from the location set up for holding Flash content.

At this point, the Adobe FMS service should be configured to launch on startup by default.

Configuring the ESS

All of the infrastructure should now be in place for the external FMS. The final step involves configuring three entries
in the ESS system configuration to recognize these changes. The information below is also available in the Configur
e System Settings page.

1.

7.

Log in to the ESS and navigate to Configuration > System Settings.

2. Click Edit (located at the bottom of the page).
3.
4. For the Flash Streaming parameter, select External Flash Server. Do this even if the FMS is located on the

Scroll down to the Streaming Settings section.

same host as the ESS.

For the External Flash URL parameter, compose a URL consisting of the RTMP protocol, the FQDN of the
Adobe server, the application name (echo), and a _definst_ pointer, as follows: rt np://fqdn. of . f ns. se
rver/ echo/ _definst__

© The"echo" in the URL is an application not a folder

The path elements of this URL do not map to path elements on the storage volume; here,
"echo" is the name of an application and not the name of the folder in which the content is
stored, and "_definst_" is a virtual pointer. If the URL contains more elements than the
example shown here, or the ECHO_DIR folder contains additional subfolders above the
content, FMS will not be able to locate the content.

For the Flash Folder parameter, enter the UNC path (or the drive letter path, if using a SAN volume) of the
Flash content folder, which was configured in the Co-Locating the Flash Content section above. This should
point to the same location defined as the variable "ECHO_DIR" in the application configuration.

When finished, click Save.

The ESS is now configured to call the external Adobe FMS when providing content to viewers. If prompted, restart
the ESS in order for the changes to take effect, checking first that no capture or processing tasks are currently
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running.

Updating an External Wowza Media Server
In this section:

Overview

Replacing the Echo360 Libraries

Enabling iOS Live Streaming Functionality
Enabling Closed Captioning for Live Streams
Required Maodification for Wowza 4.0

Overview

These instructions only apply if you are using a Wowza Media Server in an 'external' configuration (not installed or
configured by the ESS). The following scenarios are covered in this document:

® You are upgrading from a prior EchoSystem release to version 5.5 and already have an external Wowza
Media Server instance configured for on-demand and live Echo content.
® You are upgrading an external Wowza 3.x installation to version 4.0.

Use the instructions below to properly upgrade and configure your external Wowza Media Server instance for full
functionality with version 5.5 of the EchoSystem.

Please ensure that the Wowza service is shut down before proceeding with these steps.

Wowza licensing

Please note that all licensing for your Wowza server is provided through Wowza. Echo360 no
longer provides licensing for the Wowza server. Please see the following communications:

Customer Communication re Wowza.pdf

Wowza Media Systems Comm Ltr.pdf

Replacing the Echo360 Libraries

The first step in the upgrade process is to ensure that the latest Echo360 library files are installed. These files
contain the code required for features such as collaboration, iOS live streaming and closed captioning.

1. Navigate to the /lib/ directory under your Wowza installation root and move all existing Echo360-specific JAR
files to a safe location outside this directory. The files present will depend on the version you're currently
using:

Version 5.1 JAR Files

echo360-1ive-app-nmonitor-5.1.0.jar
echo360-text-chat-5.1.0.jar
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Version 5.2 JAR Files

echo360-1ive-app-nonitor-5.2.0.jar
echo360-text-chat-5.2.0.jar
echo360- medi acaster-5.2.0.jar

2. Download the latest External Wowza bundle, available from the Customer Support Portal.

3. Extract the contents of the downloaded ZIP file to a temporary location.

4. Copy the contents of the extracted /lib/ directory to the /lib/ directory under your Wowza installation root. The
Wowza installation /lib/ directory should now contain the following files:

echo360-1ive-app-nmonitor-5.4.1.jar
echo360-text-chat-5.4.1.jar
echo360- medi acaster-5.4.1.jar
echo360-captioning-5.4.1.jar

5. Ensure that the ownership and permissions of these files match the rest of the files in the directory.

Enabling iOS Live Streaming Functionality

The next steps cover required modifications to enable Echo live streaming to iOS devices.

1. In the /conf/ folder under your Wowza installation root, open the Server.xml in a text editor and make the
following changes:

NOTE: If you have previously upgraded your Wowza installation to enable live streaming, then these
attributes may already be present in the Server.xml file. We strongly recommend verifying these changes are
still present to ensure proper functionality, as in some cases the Server.xml file can be overwritten when
upgrading a Wowza instance. If these changes are not present, please add them to the file as directed.

2. Insert the following text between the <Ser ver Li st ener s> and </ Ser ver Li st ener s> tags:

<ServerLi st ener >
<BaseC ass>com echo360. stream ng. | ive. Medi aCast er </ BaseC ass>
</ Server Li st ener >

3. Insert the following text after the final <Pr oper ti es> tag and before the </ Pr operti es> tag:

Page 36


http://echo360.com/customer-portal

EchoSystem 5.5 Documentation

4,

<Property>
<l-- the directory that contains the streans.txt file -->
<Nane>St r eamVoni t or Di r </ Nane>
<Val ue> ${com wowza. wns. cont ext . VHost Conf i gHone}/ noni t or </ Val ue>
</ Property>

<Property>

<I-- the wowza application that the streanms will be activated on.
Default is echolive -->

<Name>EchoLi veAppl i cat i on</ Narme>

<Val ue>echol i ve</ Val ue>
</ Property>

<Property>

<l-- tinme the thread waits between checks of the streans.txt file.
Default is 5 seconds -->

<Nanme>Wai t | nt er val </ Nane>

<Val ue>5000</ Val ue>
</ Property>

Replace the ${com.wowza.wms.context.VHostConfigHome} string with the location of your Echo Flash
folder. If you are not certain what this location is, refer to the St or ageDi r attribute in Application.xml file
located under /conf/echolive in your Wowza installation root.

Enabling Closed Captioning for Live Streams

To enable Live Closed Captioning functionality, the following changes need to be made:

1.
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Copy the entire echocaption directory from the /conf/ subfolder in extracted bundle location (from the Replaci
ng the Echo360 Libraries section above) to the /conf/ directory under your Wowza installation root.

Navigate to the /applications/ subdirectory of your Wowza installation root and create a new empty folder
labeled echocaption

. In the newly copied /conf/echocaption directory of your Wowza installation root, open the Application.xml file

in a text editor.

. Near the bottom of the file, the document contains a set of property values encoded like so:
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<Properties>
<Property>
<Nane>obj ect st or agedi r ect or y</ Nane>

<Val ue>${com wowza. wmrs. cont ext . VHost Conf i gHone}/ cont ent/ echocapti on/ rso</
Val ue>
</ Property>
<Pr operty>
<Name>capt i onl ogst or agedi r ect or y</ Nane>

<Val ue>${com wowza. wns. cont ext . VHost Conf i gHone}/ cont ent/ echocapti on/ capti
onl ogs</ Val ue>
</ Property>
<Property>
<Nane>echosyst endi r ect or y</ Nanme>
<Val ue>${com wowza. wns. cont ext . VHost Conf i gHone} </ Val ue>
</ Property>
</ Properties>

5. Replace the ${com.wowza.wms.context.VHostConfigHome} string with the location of your Echo Flash

directory. If you are not certain what this location is, refer to the St or ageDi r attribute in Application.xml file
located under /conf/echolive in your Wowza installation root.

6. Next, edit the layout.xml in the template directory of the EchoSystem Server

The default location on windows for this is:
C:\echo360\content\templates\1f80f82f-91ba-408a-9a23-c74d701fe3fl\echo_files\layout.xml Edit the file and
update the <enable-live-caption> field to true. If you are using the built-in wowza server, simply uncomment the
<enable-live-caption> option.

Required Modification for Wowza 4.0

The following change is required for Wowza 4.0 to function
properly with the EchoSystem Server. Failure to make this
change will result in all on-demand and live streaming
features ceasing to function.

1. Under the /conf folder in your Wowza installation root, edit the Server.xml file. Find the following line:

<Def aul t St r eanPr ef i x>np4</ Def aul t St reanPr efi x>

2. Modify the value to change nmp4 to f | v, like so:
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Once all the configuration files have been edited and saved according to these instructions, restart the Wowza
service.

Advanced Configuration Options

In this section:

® Qverview

Overview

The modular nature of EchoSystem allows for a great deal of flexibility with respect to system deployment, including
some native services that can be installed and configured to run externally from the EchoSystem Server (ESS)
application and computer. The following pages provide information and instructions for the advanced configuration
options available for a more customized system setup:

Using External FTP for ESS File Transfers

Using UNC Paths for Windows Media Processor Data Transfer
Using an External Web Server for Content Playback
Offloading Media File Downloads to an External Web Server

Refer also to the Deployment Planning pages for information on the configuring the modular aspects of
EchoSystem.

Using External FTP for ESS File Transfers

In this section:

Overview

Configure the FTP Server
A Word on Firewalls
Configure the ESS

Overview

In a default EchoSystem installation, devices exchange capture data with the EchoSystem Server (ESS) via an
internal secure file transfer protocol (SFTP) server that listens on port 8022. While the standard method may be
comfortable for most circumstances, SFTP carries a substantial amount of compression and encryption overhead
that can cause transfer bottlenecks on large-scale installations.

The ESS provides the option to use an external FTP server for handling these file transfers rather than its internal
SFTP facility. This has two advantages:

® The transfer speeds available are much higher
® A dedicated service can be used for back-end content transfers, consolidating back-end file transfer
resources away from the ESS
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SFTP Without Data Encryption

It is possible to use the internal SFTP server without data encryption to achieve substantially
faster transfer speeds from capture devices. This is handled by the FTP protocol option. See Co

nfigure the ESS.

Configure the FTP Server

Although any FTP server can be used, this article will describe the procedure for setting up the FTP server built in to
the Internet Information Services (11S) suite for Windows Server 2003, which is recommended for use alongside the
ESS especially in situations where simple transfer speed is desired.

1.

4,

5.
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If the IIS FTP server is not installed, from the Windows, Control Panel, select Add or Remove Programs >
Windows Components Wizard. You may need a Windows installation CD if these components are not
available. At a minimum, check the following tree of components:

® Application Server

® |Internet Information Services (1IS)

® File Transfer Protocol (FTP) Service; Internet Information Services Manager

. In the Windows Control Panel, select Administrative Tools > Internet Information Services (lIS) Manager.

Using the navigation pane on the left, expand the local computer entry and FTP Sites folder to expose the
list of sites. You may use the default FTP site, or create a new one from scratch.
Right-click your FTP site and click Properties. The following tabs contain configuration options of interest:
® FTP Site: This contains basic connection parameters for the FTP server.
If your server has multiple network interfaces, you can use the "IP address" field to specify which one
the FTP will listen on, allowing you to segregate internal and external network traffic.
As a security measure, you may wish to force the FTP server to use a non-default TCP port as well, or
limit the number of concurrent connections.
® Security Accounts: Anonymous access is enabled or disabled here. By default, it is enabled; we
strongly recommend against this. Clear the option, read the warning that Windows produces, and
select Yes to continue. We will set up security in the next step.
®* Home Directory: Best practice standards recommend that the path given here should be part of the
ESS content upload file system hierarchy. An ideal selection would be something like
D:\echo360\upload\ext (as opposed to "int," which is the default). If the FTP server is remote to the
ESS, you can also specify a shared location on the ESS server where you would like the FTP server to
look for its files. In either case, be sure to enable both read and write permissions.
® Directory Security: At a Network Administrator's discretion, you can restrict access to this FTP
service to specific IP address ranges. Be sure, however, that you do not inadvertently lock out actual
devices on your EchoSystem network from reaching the service to upload their content.
In the Windows Control Panel, select Administrative Tools > Computer Management. Using the navigation
pane on the left, select System Tools\Local Users and Groups\Users to see a list of all users on the local
system.
® You will need to either create or repurpose a user that will control access to the FTP service from your
appliances. Make a note of the user name and password that you choose.
® In the user properties, be sure that "User must change password at next logon" is not enabled, and
enable at least "Password never expires."
In Windows Explorer, navigate to the folder that you specified for the home directory of the FTP server in step
3 (e.g., D:\echo360\upload\ext).
® Right click on the folder itself and click Properties.
Click the Security tab.
Click Add under the name list.
Enter the name of the user you selected in Step 4, and click OK.
In the "Group or user names" list, click the user you just added.
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In the permissions list, give Allow permissions for at least the Modify action. We recommend giving full
control.

Click the Advanced button.

Under the Permissions tab, enable both check-boxes for inheriting and replacing permissions to all
child objects.

Click OK to both dialog boxes to save your changes and close.

6. As an optional test of the new configuration, open a command prompt window.

Execute the following command: ftp localhost (or the IP address you configured).

®* When prompted, enter the user name and password for the account you selected in step 4.

Execute the following commands: | s, nkdir test,andrndir test.
If all of the above succeeded, you have confirmed that the FTP server is online and that the user
account you selected has all the necessary permissions.

A Word on Firewalls

In testing, we have found that when using IIS as an FTP server, a firewall may not always automatically open the
ports necessary for successful active-mode FTP connections; even when manually configuring exceptions for the
FTP control and data ports (21 and 20, respectively), FTP in active mode uses other random ports for its data
connections. However, if you must use a firewall, adding an application-based exception (the software must be able
to support this; Windows Firewall does, for instance) rather than opening port ranges is the most effective method of
allowing access. If you are using IS, the application to clear with the firewall is called inetinfo.exe for Windows
Internet Information Services. It may also be necessary under such circumstances to set a long session timeout
value to prevent the control port from being closed during long file transfers.

Best Practice: Locate the FTP Server Inside the Secure Portion of the Network

If the FTP server is inside the secure portion of your network, no firewall is needed on the
connections between client devices and the FTP server. This avoids connectivity and speed
issues when moving essential files within your EchoSystem installation.

Configure the ESS

&@ Make Sure the Processing Queue is Empty

Do not make changes to these settings if you have any tasks in your processing queue. Ignoring
this warning could cause captures to be lost!

1. Inthe ESS administration interface, select System > System Settings.
2. Click the Edit button at the bottom of the page.
3. Under the Intake Settings heading, update the following configuration items:

FTP Server: External

FTP Protocol: FTP

FTP User Name: As configured on the FTP server. See Configure the FTP Server.

FTP Password: As configured on the FTP server. See Configure the FTP Server.

FTP Folder: The FTP home folder, as configured on the FTP server. See Configure the FTP Server.
FTP Host: The FQDN of the FTP server for the address on which it is listening.

FTP Port: The TCP port, as configured on the FTP server. See Configure the FTP Server.

FTP Path: empty (unless you are using one common FTP server with multiple subdirectories for
multiple applications)

Default Processor Path to FTP Folder: empty (unless you have followed the procedure in the article
"Using UNC Paths for Processor Data Transfer")

4. Click the Save button at the bottom of the page.
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This restarts all of your capture appliances.

5. As an optional test of the new configuration, click the green Test Settings button, which is under the Intake
Settings heading. You should see a success message.

Using UNC Paths for Windows Media Processor Data Transfer
In this section:

® Qverview
® Define the Intake Directory
® Set Up the Intake Directory Share

Overview

In a default EchoSystem installation, devices exchange capture data with the EchoSystem Server (ESS) via an
internal secure file transfer protocol (SFTP) server that listens on port 8022. While the standard method may be
comfortable for most circumstances, SFTP carries a substantial amount of compression and encryption overhead
that can cause transfer bottlenecks on large-scale installations.

Many institutions prefer to implement a centralized, network-based storage solution that relies on universal haming
convention (UNC) paths, thereby eliminating unnecessary file transfer operations. The EchoSystem Media
Processor devices on your network can be configured to access these UNC shares, thereby accessing capture
content directly. The result is a dramatic speedup of processing tasks.

Do Not Refer to Mapped Drives

It is important that you never use mapped drives when configuring storage locations for use with
ESS. If configured incorrectly, these are not persistent across restarts, and the local system
account running the EchoSystem NT services may not have access to the mapped drives in the
first place. If you are using a SAN with system mounted volumes, the use of such a drive letter is
acceptable; otherwise, you are likely to run into errors if you use this feature of Windows. When
in doubt, always use a UNC path for networked storage.

Define the Intake Directory

The intake folder, specified in your ESS system settings as the FTP Directory, is where capture content is
temporarily stored before being copied to, or in the case of network shares, read by the media processor devices on
your network. Regardless of where the directory is located, this folder is the one that you will configure your media
processor devices to access via a network share. Your ESS will receive and store capture content from your capture
appliances and Classroom Capture devices at this location.

Before continuing, define the FTP Directory field under the Intake Settings heading in your ESS System Settings,
then save your changes. For now, it is important that the field labeled "Default Processor Path to FTP Directory"
should be left blank.

Set Up the Intake Directory Share

These instructions assume that all the media processor devices you want to configure are Windows systems
assigned to an Active Directory controlled domain. Since the EchoSystem media processor runs as an NT service,
we will use computer accounts for authentication to the network share and for read-write permissions to the shared
folder itself.
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Before continuing, you may find the share permissions easier to manage if all of the computer accounts for your
media processor devices are added to a group, especially if you have several of them. If you only have one or two
media processors, do not intend to increase your number of media processors, and/or would like to manage the
permissions for each of them directly, skip the following subsection.

Adding Computers to a Security Group

Begin by logging on to your domain controller and accessing the Active Directory Users and Computers console.

1.
2.
3.

8.
9.

In the Active Directory Users and Computers console, expand your domain from the list on the left.
Right-click Groups, then move your mouse to Add and click Group.

Add the information for this group. Remember that this is the group to which your all of your Media Processor
devices should belong. You can call the group anything you like, but it should bear a name that is easy to
recognize. Your network administrator probably has a naming scheme to follow. Review the information and
click Finish when you are satisfied.

Select Computers from the console list under your domain. This will show an index of all the computer
accounts on your domain in the right-hand pane.

Right-click the computer account for one of your media processor devices and select Properties.

Click the Member Of tab, and then click Add.

In the Select Groups dialog box, specify the group that you just created. Click OK to add the specified group
to the list. Your media processor devices may be members of more than one group.

Select OK to finish.

Repeat steps 5 through 8 for all of the media processor devices on your domain.

Sharing and Security

Creating the share itself is usually a simple process but there are two places where your security settings need to be
established: at the share level and at the file system level. You will need to log on to the system in which the folder
you want to share physically resides (typically the machine running ESS itself) to make these changes.

1.
2.
3.

10.
11.
12.
13.
14.

Page 43

Using Windows Explorer, navigate to the folder you defined as the FTP Directory in ESS earlier on.
Right-click the folder, and select Properties

Under the "Sharing" tab, click the radio button labeled "Share this folder." Give it a unique, recognizable share
name. This will be the path element to which you will refer later on in the UNC path that defines the share
(e.g., if you specify "int," it will be something like \\.host\int). Leave the user limit set to "Maximum allowed."
Click the Permissions button. You will see the Share Permissions tab. Here we will set the permissions for
access to the folder at the share level.

Click Add.

Enter the canonical name of the group you created for your media processor devices in the previous
subsection. If you are not using groups for permissions management, search for or enter the names of the
computer accounts of each Media Processor device.

You may click Check Names to verify the group and/or accounts that you have entered into the list. This may
require you to authenticate. When you are satisfied that the information is correct, click OK.

Select the group or one of the user names you specified in step 6 from the "Group or user names:" list.
Check the box under the Allow column for each of the permissions you want to give to the selected account.
We strongly recommend that you allow Full Control to the group and/or computer accounts representing your
Media Processor devices.

Click OK to commit the changes.

Select the Security tab. Here we will set the permissions for access to the folder at the file system level.
Repeat steps 5 through 9, using the same group and/or accounts that you did for the share-level permissions.
Click Apply and OK to commit the changes.

Optionally, but as a recommended step, log in to one of the Media Processor devices and attempt to connect
to the share you just created using its UNC path. You should be able to view, create, delete, and rename
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files.
Define the Default Media Processor Path to FTP Directory

Specify where the share is.

1. Open the ESS System Settings page.

2. Under the Intake Settings heading, specify the full UNC path to the network share you configured in the
previous section.

3. Click Save.

4. Click the green Test Config button to determine whether the settings are successful.

5. Restart the ESS service using the Services console in your Administrative Tools.

Congratulations. If all of the above succeeded, your Media Processor devices will access their files directly from the
network share, reducing transfer overhead to a minimum and greatly speeding up the turnaround time for your
Echoes.

Using an External Web Server for Content Playback
In this section:

Overview

Define and Share the Active Content Directory
On Ports and Protocols

Configuring an IS Web Server

Configuring an Apache Web Server
Configuring an NGINX Web Server

Enabling an External Web Server on the ESS

Overview

The EchoSystemServer software comes bundled with a java-based web server called Jetty. Jetty is responsible for
serving up all web Ul elements and product downloads, processing API calls, and providing EchoPlayer elements
for Rich Media presentation playback. Jetty is enabled by default, and is capable of efficiently handling requests on
small or low-load deployments. However, if you have a large number of users accessing the system simultaneously,
we highly recommend offloading all playback requests to an external web server. Jetty will still be running on the
application host for API requests and the web Ul, but configuring the playback components to be offered by an
external server can greatly reduce the overall load on the system and result in improved performance.

The following web server technology is supported for this use:

® Microsoft IS 6
® Microsoft IS 7
® Apache

The EchoSystemServer will also work with NGINX, and
while this document covers the base configuration of this
product, it is not officially supported at this time. The
following instructions cover how to configure

these software packages for use with ESS content
playback.
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Define and Share the Active Content Directory

The Active Content Directory is defined as the location of all available Echo content that can be viewed by users.
This setting is specified in the EchoSystem Server under System > System Settings > Active Echo Settings > Co
ntent Folder. The content can located on a drive local to the ESS, on a mounted SMB/CIFS file share, or on
mounted NAS/SAN storage. Regardless of where this directory is physically located, this folder must be accessible
by both your external web server and the ESS host.

Additionally, in order for the external web server to find and serve up Echo content delivered by the ESS, your active
content directory network share must be one that the the external web server has read and write access to.

Consult your operating system’s documentation for configuring file shares, or contact Echo360 Technical Support for
guidance.

Do Not Refer to Mapped Drives

It is important that you never use mapped drives when configuring storage locations. If
configured incorrectly, these are not persistent across restarts, and the local system account may
not have access to the mapped drives in the first place. If you are using a SAN with system
mounted volumes, the use of such a drive letter is acceptable; otherwise, you are likely to run
into errors if you use this feature of Windows. When in doubt, always use a UNC path for
networked storage.

On Ports and Protocols

When setting up an external web server, you can configure either HTTP or HTTPS access. The port used is your
choice, though we recommend sticking to standard ports (80, 443, 8080, 8443 etc.). The EchoSystem Server is
typically configured to offer up content over HTTP on port 8080 or HTTPS on port 8443. The application itself always
runs over HTTPS. Reference the documentation for your external web server for configuring ports and protocols.

While not recommended, it is possible to configuring an external web server to run on the same physical host as the
ESS. If this is done, it's important to note that the external web server cannot run on the same protocol and port as
the application. In other words, if the ESS application is configured to run on HTTP/8443, then the external web
server cannot use port 8443. A different port, such as 443, must be used in this case.

Best Practice: Serve Content Over HTTPS

For security reasons, recent versions of major web browsers block "mixed mode" content - in
other words, HTTP content served in an HTTPS wrapper. This will cause certain features of the
EchoSystem, such as editing, to be inaccessible or break entirely. Therefore, we highly
recommend serving content over HTTPS. Not only does it prevent these problems from
occurring, but it's a far more secure way of serving content. The ESS also has a built-in
mechanism to re-direct users who access content over HTTP to HTTPS if the switch is made. To
enable this on the ESS side, set the Protocol option in the Application Network Settings area
of the System tab in the ESS to "All HTTPS".

Note: Mixed mode content is no longer supported as of ESS 5.4 SP3.

© SsSL Certificate Required for HTTPS

If you enable HTTPS on your external web server, you'll need to obtain an SSL certificate for the
host. Refer to your external web server documentation on how to install a certificate.
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The following sections cover individual configuration of the different external web server types.

Configuring an IS Web Server

These instructions assume that you have already installed the Internet Information Services (11S) features on the
Windows host and have the service running with the default configuration.

Begin by opening the Internet Information Services (IIS) Manager, located under Control Panel > Administrative
Tools.

1. On the left panel, expand your domain (or computer name) in the list.

2. Expand the Sites option to reveal your Default Web Site.

3. Right-click on Default Web Site, then select the Add Virtual Directory option.

4. In the Alias box, enter "echocontent” (without quotes).

5. Use the ... button or the Physical Path field to populate the path of the network share for your active content
directory.

6. If your active content directory network share requires a domain account or elevated permissions to access,
click on the Connect As button to enter the credentials of a specific user account that has full permission to
access the share.

7. Once all fields are populated, click on Test Settings to verify your settings are correct.

When finished, click OK.

9. The "echocontent" alias should now appear on the left panel beneath Default Web Site. Expanding this
option should show the sub-folders that exist in your active content directory.

©

Once you have verified the configuration, you'll need to restart the site for the changes to take effect. Click on the De
fault Web Site option in the left panel, and then Restart in the right panel under Manage Web Site. Continue to the
Enabling an External Web Server on the ESS section below to finalize configuration.

Configuring an Apache Web Server

These instructions assume that you have already installed the appropriate Apache web server packages, along with
the mod_alias module, and have the service running with the default configuration.

1. Make a backup copy of the existing httpd.conf file (typically located under /etc/httpd/conf)

2. Add the following to your httpd.conf file:

Alias /echocontent "/var/ww/ echocontent"”
<Directory "/var/ww echocontent">
Options | ndexes MiltiViews
Al |l owOverri de None
Order al |l ow, deny
Al low from all
</Directory>

3. Change both "/ var/ ww/ echocont ent " paths to the path of the mount point you created for your Echo
active content directory (quotations must be left in place).

4. Save the file.

5. Restart the Apache web server service (/etc/init.d/httpd restart).

Once finished, continue to the Enabling an External Web Server on the ESS section below to finalize configuration.

Configuring an NGINX Web Server

Page 46



EchoSystem 5.5 Documentation

These instructions assume that you have already installed the appropriate NGINX packages and have the service
running with the default configuration.

1. Make a backup copy of your configuration file before proceeding. By default, the configuration file is named d
efault.conf and placed in the /etc/nginx/conf.d directory.

2. Add the following to your default.conf file between the server { } block:

| ocation /echocontent {
al i as /usr/share/ ngi nx/ echocont ent;

}

3. Change / usr/ shar e/ ngi nx/ echocont ent to the path of the mount point you created for your Echo active
content directory.

4. Save the file.

5. Restart the NGINX service.

Once finished, continue to the Enabling an External Web
Server on the ESS section below to finalize configuration.

Enabling an External Web Server on the ESS

Once the configuration of your external web server has been completed, the final setup it to enable content playback
to be served through it.

1. Inthe ESS interface, navigate to System > System Settings.
2. Click the Edit button. Scroll down to the Active Echo Settings and make the following modifications

Field Input

Web Server Select External from the drop-down list.

Host Name Enter the FQDN of your external web server host.

Port (HTTPS) Specify the port that HTTPS is using on your
external web server.

HTTP Port Specify the port that HTTP is using on your external
web server (specify 80 if not used).

Base URL Path Enter "echocontent" (without the quotation marks)

Content Folder This field should already be populated with the
location of the active content folder relative to your
ESS.

3. When finished, scroll to the bottom of the page and click Save.
4. You will then be prompted to restart the EchoSystem Server service.

After the ESS service has been restarted, verify that Echo content playback works using your new external web
server configuration.

Offloading Media File Downloads to an External Web Server
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In this section:

Overview

URL Rewrites

Configuring an IS Web Server

Configuring an Apache Web Server

Configuring an NGINX Web Server

Enabling External Media Downloads on the ESS

Overview

When configuring the EchoSystemServer for use with an external web server for content playback (see Using an
External Web Server for Content Playback), downloadable static media, such as .MP3 and .M4YV files, are still
served through the built-in Jetty web server. In deployments that experience regular high load, having these files
served through Jetty can have a serious impact on application performance. The following document covers how to
offload the serving of these files to an external web server that has previously been configured for ESS content
playback.

The following web server technology is supported for this use:

® Microsoft IS 7
® Apache

Microsoft [IS 6 does not support URL rewrites, and
therefore is not supported for this configuration.

This document also covers the configuration of NGINX, but
it is not officially supported at this time.

URL Rewrites

The essence of this change involves the use of URL rewrites. When a request comes to the ESS to download a
static media file, this request is then re-directed to the external web server (which already has access to the
appropriate files in the active content directory defined by your ESS) to be served up for download. Each web server
software package has different means of enabling URL rewrites, and the steps below make the assumption that the
URL rewrite module or feature is already installed for your instance.

Consult your web server software configuration guide for further details on enabling URL rewrite capability, or
contact Echo360 Technical Support for guidance.

Configuring an IIS Web Server

These instructions assume that you have already installed the Internet Information Services (lIS) packages on the
Windows host and have the service configured for use with ESS content playback. Before processing, ensure that
the URL Rewrite Module version 2.0 is installed. You can obtain it here: http://www.microsoft.com/web/gallery/instal
l.aspx?appid=urlrewrite2. Additionally, make sure .NET is installed with [IS and .NET Roles is enabled and running
under ASP.NET in the Features View tab in the IIS manager.

Begin by opening the Internet Information Services (IIS) Manager, located under Control Panel > Administrative
Tools.
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On the left panel, expand your domain (or computer name) in the list.

Expand the Sites option, then click on Default Web Site.

On the Features View tab, double-click on URL Rewrite.

In the Actions panel on the right side of the screen, click on Add Rule(s)...

In the window that appears, under the Outbound Rules section select Blank rule and then the OK button. Yo
u will then be presented with the page to create a new outbound rule.

Set the name of the rule to "Allow Podcast Download" (without the quotations).

Use the drop-down to select <Create New Precondition...> and populate the following values for the new
Precondition:

Field Value

Name Only Match Podcast
Using Regular Expressions
Logical Group Match All

Click the Add.. button to add a new condition, and populate the following values:

Field Value

Condition Input {RESPONSE_CONTENT_TYPE}
Check if input string Matches the Pattern

Pattern Naudio/mpeg

Ignore case Checked

Press OK to complete adding the condition.
Press OK to complete adding the precondition.

Expand the Match section, and populate the following values:

Field Value

Matching Scope Server Variable

Variable Name RESPONSE_Content_Disposition
Variable Value Matches the Pattern

Using Regular Expressions

Pattern (%)

Ignore Case Checked

Expand the Conditions section.

Set the Logical grouping to Match All.
Ensure the Track capture groups across conditions option at the bottom of the pane is checked.
Click on the Add... button. A window will appear to add a new condition. Populate the following values:

Field Value

Condition Input {QUERY_STRING}
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Check if input string

Pattern

Ignore case

16. Press OK to complete adding the condition.

Matches the Pattern

~download

Checked

17. Expand the Actions section and populate the following values:

Field
Action Type

Value

Replace existing server variable value

Stop processing on subsequent rules

Value
Rewrite

attachment;filename=media.mp3

Checked

Unchecked

18. In the Action panel on the right side of the screen, click on Apply. If successful, you'll see the message: "The

changes have been successfully saved."

19. Click the Back to Rules link.

20. Click on Add Rule(s)... again to add another rule.

21. Set the name of the rule to "Allow Vodcast Download" (without the quotations).
22. Use the drop-down to select <Create New Precondition...> and populate the following values for the new

Precondition:

Field
Name

Using

Logical Group

Value
Only Match Vodcast

Regular Expressions

Match All

23. Click the Add.. button to add a new condition, and populate the following values:

Field
Condition Input

Check if input string

Pattern

Ignore case

Note for IIS 8.5

Value
{RESPONSE_CONTENT_TYPE}

Matches the Pattern

video/m4v

Checked

Though not supported at this time, if you are using 1S 8.5 the match pattern should be set

to "video/mp4" rather than "*video/m4v".

24. Press OK to complete adding the condition.
25. Press OK to complete adding the precondition.

26. Expand the Match section, and populate the following values:
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27.

28

29.

30

31.
32.

33.

34.
35.
36.

Field Value

Matching Scope Server Variable

Variable Name RESPONSE_Content_Disposition
Variable Value Matches the Pattern

Using Regular Expressions

Pattern (%

Ignore Case Checked

Expand the Conditions section.

Set the Logical grouping to Match All.
Ensure the Track capture groups across conditions option at the bottom of the pane is checked.
Click on the Add... button. A window will appear to add a new condition. Populate the following values:

Field Value

Condition Input {QUERY_STRING}
Check if input string Matches the Pattern
Pattern ~download

Ignore case Checked

Press OK to complete adding the condition.
Expand the Actions section and populate the following values:

Field Value

Action Type Rewrite

Value attachment;filename=media.m4v
Replace existing server variable value Checked

Stop processing on subsequent rules Unchecked

In the Action panel on the right side of the screen, click on Apply. If successful, you'll see the message: "The
changes have been successfully saved."

Click the Back to Rules link.

The two new outbound rules should be shown in the bottom panel.

Restart the IIS service for these changes to take effect, and proceed to the section below Enabling External
Media Downloads on the ESS .

Configuring an Apache Web Server

These instructions assume that you have already installed the appropriate Apache web server packages, and have

service already configured for use with ESS content playback. You will also need to have the mod_rewrite and mod
_header Apache modules installed. Refer to the Apache or system documentation for instructions on how to do this

for your platform.

1.
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2. Enable the mod_rewrite and mod_header Apache modules. This is typically accomplished by adding lines
like this to the httpd.conf file, but the specifics will depend on your platform:

LoadModul e rewite _nodul e nodul es/nod rewrite. so
LoadModul e headers_nodul e nodul es/ nbd_headers. so

3. Locate the existing echocont ent Alias section of the httpd.conf file and add the following between the <Di r
ect or y> tags:

Rewri t eEngi ne On

Rewri t eCond % QUERY_STRI NG “downl oad

Rewr i t eCond % REQUEST FI LENAME} np3$ [ OR|

Rewr it eCond % REQUEST_FI LENAVE} miAv$

RewiteRule ([A]+)$ - [E=dIfilenane: $1]

Header onsuccess set Content-Di sposition

"attachnent; fil enane=\"%dlfil enane}e\"" env=dlfil enane

This should result in a stanza similar to this:

Al'ias /echocontent "/var/ww/ echocontent™
<Directory "/var/ww echocontent">
Options | ndexes MultiViews
Al Il owOverri de None
Order al |l ow, deny
Allow from all
Rewri t eEngi ne On
Rewr it eCond % QUERY_STRI NG “downl oad
Rewri t eCond % REQUEST_FI LENAMVE} nmp3$ [ OR|
Rewri t eCond % REQUEST_FI LENAVE} miv$
RewriteRule ([*]+)$ - [E=dIfilenane: $1]
Header onsuccess set Content-Di sposition
"attachnent;filename=\"%dlfil ename}e\""
</Directory>

env=dl fil enane

In this example, / var / ww/ echocont ent is the location of the mount point created for the active content
directory. Your configuration will vary.

4. Restart the Apache service for these changes to take effect, and proceed to the section below Enabling
External Media Downloads on the ESS.

Configuring an NGINX Web Server

These instructions assume that you have already installed the appropriate NGINX packages and have the service
running with the default configuration. The nginx application comes bundled with a URL rewrite module by default.
Normally no action will be necessary to enable it.

1. Make a backup copy of your configuration file before proceeding. By default, the configuration file is named d
efault.conf and placed in the directory /etc/nginx/conf.d
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2. Add the following directives to the location block referencing the URL alias for your ESS content (e.g., | ocat
i on /echocontent):

.........................................................................................................................................................................

if ($query_string ~* ~downl oad)
{ set $target $1; add_header Content-Disposition 'attachnent;
filenanme="$target"'; }

.........................................................................................................................................................................

| ocati on / echocont ent

{

al i as /usr/share/ngi nx/ echocontent;

if ($query_string ~* ~downl oad)

{ set $target $1; add_header Content-Di sposition 'attachment;
filename="$target""'; }

In this example, / usr / shar e/ ngi nx/ echocont ent is the location of the mount point created for the active
content directory. Your configuration will vary.

3. Restart the NGINX service for the changes to take effect, and proceed to the section below Enabling
External Media Downloads on the ESS .

Enabling External Media Downloads on the ESS

The final step involves a change to one of the configuration files on the ESS host. You'll need access to the host the
EchoSystem Server application is running on.

1. On the host file system, use a text editor to open the file labeled wrapper.conf, located by default under /usr/lo
cal/echo360/server/etc on Linux and C:\Program Files\Echo360\server\etc on Windows
2. Add the following line within the # Java Addi ti onal Paranet ers section:

.........................................................................................................................................................................
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Ensure that this line is inserted in numeric order relative to the other wr apper . j ava. add
i tional values. The wrapper.conf file cannot have multiple wr apper . j ava. addi ti on
al values with the same number. For example, if the block contained the following
stanzas:

wr apper . j ava. addi ti onal . 401=- Dl ogback. confi gurati onFil e=etc
/jetty.logging.cfg.xm

wr apper . j ava. addi ti onal . 402=- Dor g. apache. t apestry. enabl e-re
set-service=true

wr apper.java. addi ti onal . 1012=- XX: MaxGCPauseM | | i s=1000

wr apper . j ava. addi ti onal . 1021=- Xl oggc: | ogs/ gc. WWRAPPER TI ME_
YYYYMVDD_HHI | SS% | og

This line would be inserted like so:

wr apper . j ava. addi ti onal . 401=- Dl ogback. confi gurati onFi | e=etc
/jetty.logging.cfg.xm

wr apper . j ava. addi ti onal . 402=- Dor g. apache. t apestry. enabl e-re
set-service=true

wr apper . j ava. addi ti onal . 981=- Decho. di rect . ext er nal . downl oad
=true

wr apper . j ava. addi ti onal . 1012=- XX: MaxCGCPauseM | | i s=1000

wr apper.java. addi ti onal . 1021=- Xl oggc: | ogs/ gc. WRAPPER_TI ME_
YYYYMVDD_HHI | SS% | og

3. Save the wrapper.conf file, and restart the ESS service

Server Configuration for Presenters
In this section:

Overview

Add a Presenter

License Presenters

Assign Presenters to Sections
Assign Presenters to Schedules

Overview

You typically assign the Academic Staff role to faculty, then apply one of the section roles to the faculty member
when you add the faculty member's sections. Doing so allows Academic Staff to publish Personal Capture
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recordings and import external media (Media Import) for those sections.

In order to use PCAP and publish those recordings, Academic Staff must be licensed to use Personal Capture.
Personal Capture users are also referred to as "Presenters".

Add a Presenter

Before you can make a person a Presenter, you must add them to EchoSystem as an Academic Staff user. You
then give that Academic Staff user a Presenter role when you add their section. Presenter roles include Instructor,
Student Presenter, Teaching Assistant, and Guest Presenter.

For licensing purposes, users only need to have the Academic Staff role assigned to their user account. They do not
need to be a Presenter for a section or schedule in order to be licensed, however they do need to be associated with
a section in order to publish recordings to a section. The licensing interface, however, refers to licensed users as
"Presenters."

License Presenters

If you are licensing Presenters for Personal Capture, there are two options: site license or license packs. If you
purchased a:

® Site license, no further licensing configuration is required. Presenters are automatically granted the ability to
capture and publish.
® License pack, you must assign licenses to Presenters who will use Personal Capture.

There are four ways to assign licenses to presenters.

® Navigate to System > Licensing where you can:
® License Individual Presenters via Licensing Page
® Bulk License Presenters via CSV Import

* Navigate to Configuration > Userswhere you can:
® | icense Individual Presenters via User Profile
® Bulk License Presenters via Users Page.

Assign Presenters to Sections

To publish Personal Capture recordings or to import external media for a section, the Presenter must be assigned to
the section with a section role, or assigned as a Presenter on a schedule for a section.

1. On the EchoSystem Server (ESS), navigate to Schedule > Courses.
2. Click on the course that contains the section to be assigned.
3. On the Course Details page, click on the edit button for the Presenter's section, as shown in the figure below.
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Echoes Monitor =T LT Configuration Reports

Schedules Courses Terms Branding

Courses > Course Details

Course Details — history of twodotfour

RSS Feed URLs : Podcast: hitp:10.3.10.195:8080/ess/feed ?d=6500e85a-a2b5-4c6-bbdb-ced2 7 d4Scadcltype=MP3
Enhanced Podcast: nttp:/10.3.10.195:8080essfeed ?id=65d0e85a-a2b5-4ci6-bb4b-ced2 7 d49cadebtype=M4)
Vodcast: hittp:/110.3.10.195:8080/ess/feed 7id=65d0a85a-a2b5-4cf6-0b4b-ced27 d4Scadchlype=hidV

Course Details

MName : history of twodotfour Id

Sections
Section Click on edit .
fall 2010
edit delete fall.2010
oldschool

summa2009

4. In the People and Section Roles portion of the Edit Section page, shown in the below figure, select an
Academic Staff member from the Person drop-down list, then select a Role for the user from the Section
Roles drop-down list.

People and Section Roles

Person Section Role
Grodsky_instructor, Susan Instructor Remove

Tillery, David Instructor Remove

I ®| | Choose... * Add ==

5. Click the Add >> link located to the right of your selection.
6. Save the changes. The user is now assigned a role for the section.

Assign Presenters to Schedules

When you create a schedule for a section, you have the ability to assign a Presenter to that particular section
schedule. This simply identifies who is typically presenting that particular instance of the section.

Presenters for schedules are not required to be the same people assigned section soles for the section, though
typically they are. You may, for instance, have a one-time special event for a section where there is a Guest
Presenter who is not necessarily assigned to that section.

The assignment of Presenter for a section schedule allows that user to upload media and Personal Capture
recordings (if the user is licensed to use Personal Capture) to the ESS for that section. Presenters can be added
when you create the schedule, or added later by editing an existing schedule, using the procedure below.

1. On the ESS, navigate to Schedule > Schedules.
2. From the list, find the section schedule to which you want to add a Presenter, and click Edit, as shown in the
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figure below.
Intro to Linguistics (LING 101-Ling-101) Spring 2012 . echo.campus:
m g P
— LING 101-Ling-101 cooy edt ‘éodsky_lrslruclor. B echo.building, echo.appliance

3. In the Presenters section of the Schedule Details screen shown in the below figure, select a Presenter from
the drop-down list, then click Add >>. As is indicated below the text box, you can shorten the selection list by
entering partial First Name, Last Name, and/or Email Address text into the Presenter box.

Presenters

¥ Add>> Grodsky_instructor, Susan (sgrodsky@echo360.com) remove
Search using partial first name, last name and/or email addrass Tillery, David (dtillz@email.com) remove

4. Repeat this step to add more Presenters to the schedule.
5. When finished, click Save.

Localize the EchoSystem

| want to:

® | ocalize the EchoSystem User Interface
® | ocalize EchoSystem Components (ESS Ul, Ad Hoc Ul, EchoPlayer, Editor)

Localize the EchoSystem User Interface

In this section:

® Show the ESS in a Different Language
® Show the ESS in British English

® Change the Language Setting in Your Browser

Show the ESS in a Different Language

Echo360 supports the EchoSystem in six languages:

English (U.S. English and British English)
French

Spanish

German

Arabic

Japanese

This means that you can change the language setting in your browser and the following components will be
displayed in the chosen language. The screenshots show a page of each component in Japanese. Notice that some
items in the interface (such as the Echo names) are not localized.

® The EchoSystem Server (ESS)
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® The EchoCenter

.....

FCAP Soclior - FOAP Course

[yl Lt

@ J=2mEaka LKL

MR AR

If you want to display these components in a language not listed above, you can:

® Contact the reseller for your region. Some resellers have translated the component user interface already.
® Translate the user interface for the component yourself, following the technique described in Localize

EchoSystem Components.

Show the ESS in British English

You can change the language setting in your browser to British English (en-gb). The term "section" will be localized
to "module” the term typically used in Great Britain. For example, buttons labeled section when displayed in U.S.
English will be labeled module when displayed in British English, as shown below.

i Espor Gouses Jf imor ourses Jf csporocves [ impor Mol |
.

See Change the Language Setting in Your Browser for instructions.
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© only the en-us and en-gb Settings Are Supported

Although your browser may support Australian English (en-au), Canadian English (en-ca) and
other dialects of English, the ESS supports only U.S. English (en-us) and British English (en-gb).
If you specify another dialect of English, the ESS displays U.S. English (en-us).

Change the Language Setting in Your Browser

© Browsers are updated frequently. This Echo was accurate as of December 2011.

The Echo below explains how to change the language setting for two commonly used browsers, Firefox and Internet
Explorer.

Rich Media version:
http://training.echo360.com:8080/ess/echo/presentation/6ce93f44-b76a-49a0-90b4-a390b445b134

Video Podcast version:
http://training.echo360.com:8080/ess/echo/presentation/6¢ce93f44-b76a-49a0-90b4-a390b445b134/media.m4v

Defaults and Inheritance

In this section:

Overview

Concepts and Rules

Where Do Defaults Come From?

Inheritance

Inheritance When You Change an Obiject's Organization

Overview

Defaults streamline device management and capture workflow because they:

® Allow you to define settings shared among various objects at a global level
® Pass the setting values down to the related objects, such as devices, sections, and schedules

Passing these settings down is referred to as inheritance. Because objects inherit settings from the defaults, you do
not have to set them manually. This simplifies tasks such adding a new device or creating a new schedule.

Best Practice: Set the Defaults at Installation

Set the defaults during installation or when upgrading to get the full benefit of this efficiency.

Concepts and Rules

As you work with defaults, understand these concepts.

® Defaults. The settings for a particular object before you customize the settings.

® Inheritance. The setting of one object is automatically given to a related object further down the inheritance
chain.
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® Inheritance Chain. The inheritance levels for an object.
® Qverride. Changing a default setting.
® Object. An entity created and managed by EchoSystem, such as a room or section.

These rules also apply:

® Any default setting can be changed on an object's settings page.

® Changes to a setting in the parent organization apply to all existing objects, except that:

® If you override a default setting for an object, changes to that setting up the inheritance chain will not change
the overridden value.

Where Do Defaults Come From?

Defaults are set in different ways, depending on the object.

® Device defaults are set on the Device Defaults page (Configuration > Device Defaults). These are
inherited directly by the devices, not via a parent or child organization. See Manage Device Defaults for
details on each setting. These settings can be changed (see About Devices) and the new defaults will be
passed down to new devices.

® System defaults are set on the System Settings page (System > System Settings).

® Organization defaults are set on the parent organization. These settings can be changed (see Manage
Organizations) and the new defaults will be passed down from the parent to the child organization.

© if you used EchoSystem before EchoSystem 4.0

These defaults replace the global defaults in earlier releases.

Inheritance

If your EchoSystem Server (ESS) has a hierarchy of parent and child organizations, the inheritance chain has four
levels for most objects:

® |evel 1: Parent organization.

® | evel 2: Child organizations. Child organizations inherit properties from the parent organization. Example: the
law school inherits the Product Group settings from the parent organization.

® | evel 3: Objects or sections inherit properties from the child organization. Example: A section inherits the
Product Group settings from the child organization.

® | evel 4: Schedules inherit properties from sections. Example: a schedule inherits the Product Group settings
from the section.

If you do not implement delegated administration (and therefore do not have a parent-child hierarchy), the chain has
three levels: Level 2, the child organization level, is eliminated. Objects or sections inherit settings directly from the
parent organization.

This inheritance chain does not apply to devices, which inherit their settings directly from the device default settings.

For the most part, system settings are not inherited. One exception is the Academic Staff Upload Properties, which
are set at a system level (System > System Settings), then inherited by individual Academic Staff.

Inheritance When You Change an Object's Organization
When you change an object's organization, the object's properties may not inherit as expected.

An object's properties will be handled in these ways:
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® No customization rule. If the object's properties have not been customized, it has the default values of its
parent. When you move the object to a new organization it inherits the default properties of its new parent.

© No Customization Example

Room 667 was owned by Echo360 University. The Administrator of Echo360 University
did not change the Admin User Name for the Ad Hoc Interface (capture appliance) from
the default value. It is Admin. Now you move Room 667, giving ownership to the
engineering school. The engineering school has also preserved the default value of this
setting. After moving, the value remains Admin.

® Customization rule. If the object has a customized property, the customized property is preserved when the
object is moved to a new organization.

© cCustomization Example

Room 667 was owned by the law school, which customized the Admin User Name to Jud
ge. Now you move Room 667, making it part of the engineering school. The Admin User
name remains Judge. If the engineering school has a different Admin User Name (Admin
, Design), you will have to change the Admin User Name for Room 667 in the ESS
interface, by navigating to the room details page for Room 667.

The customization rule does not apply if you specify the value of a property on a spreadsheet and import the
property using the import/export method; the value on the spreadsheet overrides any other value.

Delegated Administration and Organizations
In this section:

Overview

About Hierarchies
Organizational Ownership
User Roles and Rights

Licensing

Overview

This page describes delegated administration and discusses relevant concepts. Review this page carefully before
deciding if you should implement delegated administration. See Implement Delegated Administration for
detailed implementation procedures.

You can create a two-level hierarchy that allows you to create individual organizations such as a school within your
university. You can then delegate some aspects of EchoSystem administration to the school. With delegated
administration, an individual school can create users, schedule rooms, and manage sections. It can also define its
own policies on such subjects as frequency of capture, the need for confidence monitoring, retention policies, and
many other topics. However, an individual school may not have the resources to perform system administration
operations, such as configuring the streaming server, configuring the web server, or configuring the file transfer
server. These can be handled by a university-level IT department that supports each individual school.
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Delegated Administration is Optional

You do not have to delegate administration. Delegating allows individual schools or departments
to customize the EchoSystem for their needs. If this customization is not of interest, do not create
individual organizations. All objects will be owned and managed by the parent organization.

About Hierarchies

A typical hierarchy mirrors the organizations in your institution that use EchoSystem, as demonstrated in the
diagram below:

Your
University
Law Medical Business
Schoal Schoal School

This example hierarchy consists of one parent organization (your university) and three child organizations (the
law school, the medical school, and the business school). You can have only one parent organization but any
number of child organizations.

The parent organization need not be the university. If you want a more granular organization, you could have a
hierarchy like that shown in the following diagram, where the parent organization is the Engineering school, with
three child organizations representing the different disciplines (electrical, mechanical and civil):

Engineering
School

Electrical Mechanical Civil

You can create only one, two-level hierarchy per EchoSystem Server (ESS). You cannot create both of the
hierarchies illustrated above in a single ESS.

To add the organizations that create hierarchy, see Manage Organizations.

When you create a hierarchy, three other concepts become important:

® QOrganizational ownership
® Inheritance
® User roles and rights

Organizational Ownership

Page 62



EchoSystem 5.5 Documentation

Objects are entities within the EchoSystem. With the addition of hierarchy, it is possible for organizations to own
objects. Owning an object means having the ability to schedule it, use it, or share it with another organization. Both
the parent organization and the child organizations can own objects and, in a typical configuration, both do.
However, certain objects can only be owned by the parent organization.

Some objects can have shared ownership:

When an object is shared, organizations other than the owner can schedule or use the object.

Only the owner can modify the properties of the shared object.

Objects owned by the parent organization are automatically shared with all child organizations.

Child organizations can own objects but cannot share them. Only the parent organization can share objects.

Rooms and courses are commonly shared:

® Rooms. You might share a room when two different child organizations (say, the Engineering School and the
School of Arts and Sciences) use a room and want to be able to schedule courses for it. It is good practice for
the parent organization to own the room and share it.

®* Terms. If the term is the same among organizations it is good practice for the parent organization to own the
term and share it.

Courses, by contrast, are commonly owned by a single organization, so that school only can customize the course
and other schools cannot manage it.

The table below gives ownership details for all objects.

Object Can be owned (and Can be owned by Can be batch Comments
shared) by parent child organization? moved to another
organization? Organization?

room Yes Yes No Rooms and capture

devices depend on
each other to
function. A room
and the device
assigned to a room
must be owned by
the same
organization. The
move operation will
check some
dependencies
before completing.

term Yes Yes No A term can be
owned by a child
organization but
cannot be moved to
another child
organization.
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device

content security
module
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Yes

Yes

Yes

Yes

Yes

No

Rooms and capture
devices depend on
each other to
function. A room
and the device
assigned to a room
must be owned by
the same
organization.
Devices can be
assigned to any
organization at
registration time.

The move operation
will check some
dependencies
before completing.
You can move many
devices at once by e
xporting then
importing rooms.

A content security
module can be
owned by a child
organization but
cannot be moved to
another child
organization.
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media processor

publisher

course
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Yes

Yes

Yes

Yes

Yes

Yes

No

No

Yes

Initially, all media
processors are
owned by the parent
organization.

Media processors
owned by the parent
organization share
the load for all child
organizations.

A media processor
owned by the child
organization
handles jobs only for
that child
organization.

A child organization
Administrator can
change job priorities
only for media
processors owned
by the child
organization.

A publisher can be
owned by a child
organization but
cannot be moved to
another child
organization.

Courses own
sections. If you
move a course from
one organization to
another, all related
sections move with
the course. When a
section moves,
certain other objects
move with it. See
the description of se
ction in this table for
details.
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branding asset

section

schedule

Echo
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Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

No

Yes

Yes

Yes

A branding asset
can be owned by a
child organization
but cannot be
moved to another
child organization.

Sections own
certain other
objects: schedules,
capture records, and
Echoes. When a
section moved to a
new organization, all
of these objects
move with it.

A capture record is
the unique record
for the specific
capture. It appears
in the Monitor tab
when the capture is
running and in the
logs after the
capture completes.

You can move many
sections to a new
organization at once

by exporting or
importing sections.

Schedules are
owned by a section
and move with the
section. If you move
a section from one
organization to
another (from child
to child, from parent
to child, from child to
parent), the
schedule for the
section moves with
the section.
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Echoes are owned
by a section. If you
move the section to
a different
organization,
Echoes move with
the section.
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campus Yes

building Yes

application security ~ Yes

module
license Yes
trusted system Yes
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No

No

No

No

No

No

No

No

No

No

A campus cannot be
owned by a child
organization but the
child organization
Administrator can
add or edit a
campus when
adding a room.

A building cannot be
owned by a child
organization but the
child organization
Administrator can
add or edit a
building when
adding a room.

The application
security module
supports querying
multiple LDAP
servers and trees.
See LDAP
Authentication.

All licenses are
owned by the parent
organization. Both
parent and child
organization
Administrators can
assign licenses to
venues and users.

We recommend that
Administrators
coordinate their
efforts to ensure
proper license
assignment.
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user Yes No Yes All user objects are
owned by the parent
organization and
assigned access
rights to both parent
and child
organizations
through roles.

You can assign
many roles at once
by exporting or
importing users.

User Roles and Rights

When you create a hierarchy with a parent organization and child organizations, certain roles are associated with an
organization. Others are associated with a section. This distinction is important because organization roles are
defined on the User page in the ESS (Configuration > Users) but section roles are defined on the Section page (S
chedules > Courses).

Rights "flow down". This means that the Admin at the parent organization level can make configuration choices for
any child organization. Say, for example, that the Admin at the parent organization has specified that the Days to
Keep Originals setting is 120 days. However, the business school is running short on storage space and the Admin
for the business school is on vacation. The parent organization Admin can change this setting for the business
school. The business school is lower in the hierarchy, so the parent organization Admin has access rights.

For details on the different roles and instructions on adding users, see Manage Users.

Licensing

A license is an object and, like all objects, a license owned by the parent organization is automatically shared with
child organizations. This means that any existing course, venue, or user can be assigned a license because it can
use the parent organization license.

On upgrade, all licenses are owned by the parent organization.

A license can be purchased by a child organization and used only for that child organization, but the license will
always be owned by the parent organization. Parent organization licenses are still shared and can still be used by a
child organization that has purchased its own license.

See Manage Licenses for details.

Implement Delegated Administration
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In this section:

® Qverview

® Plan the Organizational Hierarchy
® Plan Organizational Ownership

® Plan User Roles
[ )

[ )

[ )

Add Child Organizations
Reassign Ownership of Objects
Reassign User Roles

Overview

©® Who can do this?
® System Administrator
¢ Administrator of Parent Organization

You can follow this process to implement delegated administration in either of these circumstances:

®* New install. You are installing the EchoSystem Server (ESS) for the first time. You will be able to skip some
steps.

® Upgrade. You have an existing ESS and are upgrading to a release that supports delegated administration.
Delegated administration is supported in EchoSystem 4.0 and later.

The implementation process described here assumed you have already:

1. Reviewed the relevant documentation.

2. Gained a thorough understanding of the concepts underlying delegated administration: organizations,

hierarchy, inheritance, object ownership.

Decided that you want to implement delegated administration.

Set up a test system.

5. Installed a release that supports delegated administration on that test system. Delegated administration is
supported in EchoSystem 4.0 and later.

6. Attended any training classes available or held discussions with Echo360 engineers.

how

Implementing delegated administration consists of these steps:

1. Plan the organizational hierarchy.

Plan organizational ownership.

Plan user roles.

Add child organizations.

Reassign ownership of objects. New installs can skip this step.
Reassign user roles New installs can skip this step.

o0k wnN

Best Practices
1. Complete all of the planning steps before you begin implementation.
2. Create delegated administration on a test system and verify it before moving to a
production system.

Plan the Organizational Hierarchy

Delegated administration allows you to create a two-level hierarchy consisting of a parent organization and as many
child organizations as you like.
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List the child organizations you intend to create, such as:

® |Law School
®* Medical School
® Business School

See About Hierarchies for discussion and examples.

Plan Organizational Ownership

The advantage of delegated administration is that child organizations can own objects (such as rooms, devices,
publishers, courses, or sections), configuring them and managing them as they like.

If you implemented delegated administration already, any existing organizational hierarchy is respected when you
install an upgrade.

If you have not implemented delegated organization, all objects are owned by the parent organization. In this step,
you list specific objects and decide which should be owned by child organizations. See Organizational Ownership for
details. Consider these guidelines:

® Some objects can only be owned by the parent organization
® Some objects can be owned by either the parent organization or a child organization
® Some objects can be shared

See Organizational Ownership for discussion and examples.

Plan User Roles

If you implemented delegated administration already, any existing user roles are respected when you install an
upgrade. You can probably skip this step.

If you are implementing delegated administration for the first time, do this step.

® Add Organization Administrators. You may want to reassign some System Administrators to either the
parent organization Administrator or child organization Administrator role.

® Reassign some Instructors to an auxiliary role. You may want to reassign some Instructors to the
Teaching Assistant or Guest Presenter roles.

® Assign Instructors to a section. You must assign Instructors to sections.

® Appoint a License Manager. You may want to assign a staff member the new role of License Manager. It is
typical for an organization Administrator to also have the role of License Manager.

See Manage Users for discussion and examples.

Add Child Organizations

See Add a Child Organization.

Reassign Ownership of Objects

New installs can skip this step.If you have an existing installation but are implementing delegated administration for
the first time, do this step.

Follow this order to ensure a smooth process.

1. Reassign courses. You can reassign many courses to a child organization efficiently by using the export and
import feature. See Import Courses. You do not need to reassign sections, schedules, and Echoes. These
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reassignments occur automatically when you reassign the course.

2. Reassign rooms. If you have only a few rooms to reassign to new organizations, you can edit the room
details. If you have many rooms to reassign, use the export and import feature. The devices associated with a
room are automatically reassigned when you reassign the room.

3. Reassign devices. You can reassign devices in two ways. First, when you reassign a room, the device
associated with the room is also reassigned. Second, if a device is not associated with a room, you can
associate it by editing the Current Room Assignment setting.

4. Reassign security modules. A security module is typically shared, but you can reassign it by editing the
security module details. Navigate to System > Security and edit the security module.

5. Reassign media processors. Edit the media processor details. Navigate to Configuration > Devices and
edit the media processor.

6. Reassign publishers. Edit the publisher details. Navigate to Configuration > Publishers and edit the
publisher.

Reassign User Roles

New installs can skip this step. If you have an existing installation but are implementing delegated administration for
the first time, do this step.

Organizational user roles can be reassigned efficiently by using the export and import features with a spreadsheet
program such as Excel. See Import Users. You can use this feature to assign the Academic Staff role.

After you assign the Academic Staff role to a user, you will probably want to assign a section role (Instructor, Guest
Presenter, Student Presenter, Teaching Assistant). These roles must be assigned role by role. See People and
Section Roles.

Manage Organizations
In this section:

Overview

Edit the Parent Organization
Add a Child Organization
Edit a Child Organization
Delete a Child Organization

Overview

Since EchoSystem 4.0, you have had the ability to implement a hierarchy of parent and child organizations
("delegated administration"). The parent organization, typically the university, is established automatically when you
install EchoSystem 4.0 or higher. If you are upgrading to the current release from EchoSystem 4.0 or later, you
should have already adjusted your configuration to work with delegated administration.

You can also establish child organizations, which are often component schools such as the School of Nursing. Once
you have child organizations, they can own rooms, devices, and other objects.

Child organizations initially inherit all of the settings of the parent but you can customize those settings.
Customization allows an individual school to define its own policies on such subjects as frequency of capture, the
need for confidence monitoring, retention policies, and many other topics.

You can have two hierarchical levels: parent and child. You can have only one parent but any nhumber of child
organizations.
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© You Cannot Delete the Parent Organization.

If you are the System Administrator or the Administrator of the parent organization, you can edit
the parent organization's details or add a child organization to it. You cannot delete it.

Edit the Parent Organization

@ Who can do this?
® System Administrator
® Administrator of Parent Organization

The parent organization's settings are specified automatically when it is created, but they can be edited. These
customized settings become the default settings for child organizations.

1. Navigate to Configuration > Organizations. The Organizations page appears.
2. Select the parent organization. Buttons appear in the highlighted row. The parent organization is selected in
the example below.

Organizations

1-3 of 3
Mame a Full Name

Echo3E0

add  edit Echo360 University

Echo360 / CLP
Echo360 CLP Department

Echa3E0 / Engineering
Martin School of Engineering

Wiew: | 20 j Organizations per Page 1-3 b3

EchoSystam v. 3.1.2011-02-21.1* ess@echod60.com | Logout

3. Click edit. The Edit Organization — Parent Name page appears.
4. Modify settings. See Organization Settings for details.

Add a Child Organization

©® Who can do this?
® System Administrator
® Administrator of Parent Organization

1. Navigate to Configuration > Organizations. The Organizations page appears as shown in the figure below.

Page 77



EchoSystem 5.5 Documentation

Organizations
1-3 of 3
Name a Full Name
Echol&0
Echo360 University
Echo360 / CLP
Echo360 CLP Department
Echa360 / Engineering
Martin School of Engineering
Wiew:| 20 ﬂ Organizations per Page 1-30f 5
EchoSystem v. 3.1.2011-02-21.1*

assi@echodB0.com | Logout

2. Click Add. The Add Organization page appears.
Review the settings, which are inherited from the parent organization.
Change the inherited settings as needed. For example, if you want to display the child organization's logo in

the EchoPlayer, you would change the Player Logo Image setting. You might also customize the Player Logo

Hover Text and Player Logo Click URL settings. See Organization Settings for details.
5. Click Save.

Edit a Child Organization

©® Who can do this?
® System Administrator
¢ Admin of Parent Organization
¢ Admin of Child Organization (that is being edited)

1. Navigate to Configuration > Organizations. The Organizations page appears.
2. Hover over an organization to edit. Buttons appear in the highlighted row, as shown in the figure below.

Organizations
1-3 of 3
MName &« Full Name
Echo3gl
Echo3B60 University
Echo360/ CLP
Echo360 CLP Department
Echo3&0 / Engineering ) . i
adit dalsts Martin School of Engineering
View:| 20 j Organizations per Page 1-3af 3
EchoSystem v. 3.1.2011-02-21.1*

ess@echod6l.com | Logout
3. Click edit. The Edit Organization — Parent Name / Child Name page appears.
4. Review and change the current settings as needed. See Organization Settings for details on the available

fields and settings.
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5. When finished, click Save.

Delete a Child Organization

©® Wwho can do this?
® System Administrator
¢ Administrator of Parent Organization
® Administrator of Child Organization (that is being deleted)

Navigate to Configuration > Organizations. The Organizations page appears.

Select an organization to delete. Edit and delete buttons appear in the highlighted row. You can only delete
organizations that are not associated with rooms, courses, and other entities. To delete an organization, you
must delete those entities first.

Click delete. A confirmation dialog box appears.

Confirm that you want to delete the child organization by clicking Yes. The child organization is removed from
your EchoSystem Server (ESS).

Organization Settings

In this section:

Overview
Organization Details
Schedule Settings
Media Settings
Echo Deletion Settings
Echo Defaults
Branding
EchoCenter
EchoPlayer

Product Groups
Security Settings
Support

Upload Settings

Overview

The parent organization is automatically created with particular default settings. You can change those settings and
child organizations will inherit the new default settings. See Manage Organizations.

The individual settings are:
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Schedule Settings

Media Settings
Echo Defaults

Branding
EchoCenter
EchoPlayer
Product Groups

Security Settings
Support
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® Upload Settings

Details on these settings are provided in the sections that follow.

Organization Details

Organization Details

Short Name : I Westman

hoSystem Identifier:  e1cB621e-8f2a-4f10-b7d8-09e6393203b3

Full Name : MWorthwestern NY University - Westman School of Music

The table below provides definitions for the Organization Details options.

Setting Definition Inheritance

Short Name Name of the organization as it N/A
appears in the user interface

EchoSystem Identifier The globally unique identifier N/A
(GUID) used by the EchoSystem
Server (ESS) to identify the object.
The ESS automatically assigns this
ID to each object in the system. You
may use this identifier when making
API or other system calls. See API
Documentation for further
explanation.

Alternate Identifier The globally unique identifier N/A
(GUID) used by an external system,
such as an LMS or LDAP, to
identify the object. Entering an
Alternate ID is optional, but allows
you to use the external system's
GUID (not the EchoSystem
Identifier) when making API or other
system calls.

The Alternate Identifier must be
unique for each ESS object type.
See APl Documentation for further
explanation.

Full Name Use this field to include a full N/A
description of the organization
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Schedule Settings

Schedule Settings

These seftings control default schedule values. Change these settings on a section’s or schedule’s page to override the global defaults.

Term : Choose... ¥ Duration (minutes) : 10
Default Publishers : Available Selected

BB Links Seamless Echo360 Search Indexing

Blackboard Links RSS Feed Section

The table below provides definitions and inheritance information for the Schedule Settings options.

Setting Definition Inheritance
Term The default term used when Parent Organization > Child
creating new schedules and the Organization > Schedule

term in which to copy schedules

Time Zone The default time zone used when Parent Organization > Child
creating captures within new Organization > Schedule
schedules

Duration The default duration used when Parent Organization > Child
creating captures within new Organization > Schedule
schedules

Default Publishers The default publishers used for Parent Organization > Child
sections (new and existing) and Organization > Schedule

schedules (new and existing)

Media Settings

Media Settings

These seltings control the automated deletion of raw media files and media file copyright insertion. Change these settings on a section's page to
override the global defauits.

The table below provides definitions and inheritance information for the Media Settings options.

Setting Definition Inheritance

Delete Original Media? A check box value enabling or N/A
disabling the feature and the Days
to Keep Originals field.
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Days to Keep Originals

Display Media Links on Playback

Echo Deletion Settings

How long original (raw media) files
are kept before being automatically
deleted. The number of days is
defined from the capture date of the
echo.

If checked, links appear in the
EchoPlayer that allow a student to
download Podcasts or Vodcasts.
Downloaded files can be distributed
by the student. If unchecked, a
student must stream the files.

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section

Echo Deletion Settings

Automatically delete Echoes? : lg

Days to Keep Echoes : | 120

These settings control the automated deletion of echoes. Change these seftings on a section’s page to override the global defaults.

The table below provides definitions and inheritance information for the Echo Deletion Settings options.

Setting

Automatically Delete Echoes?

Days to Keep Echoes

Echo Defaults

Definition

A check box value enabling or
disabling the feature and the Days
to Keep Echoes field.

How long original Echoes are kept

before being automatically deleted.
The number of days is defined from
the capture date of the echo.

Inheritance

N/A

Parent Organization > Child
Organization > Section

Echo Defaults

Echoes Initially Unavailable? :

This setting controls the default presentation state. Presentations can either be made Available or Unavailable by default. Change these
seltings on a section’s or schedule’s page to override the global defaults.

The table below provides definitions and inheritance information for the Echo Defaults options.

Setting
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Echoes Initially Unavailable?

Branding
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A check box value defining if the Parent Organization > Child
default state of a new Echo Organization > Schedule
(presentation) should be

"Unavailable". This is typically used

for workflows requiring approval or

editing of presentations before

student review or for workflows

favoring presentation release at

specified times, such as a week

before exams.

Live Streaming
Not Available if
Checked

If a schedule is
configured for a
Live Webcast
section and this
box remains
checked on the
Section
scheduling page
, Live Webcast
streaming of the
section will not b
e available. You
can still check
this box as the
default for
Section
schedules,
however if any
Live Webcasting
schedules are
created or
edited, the Echo
es Initially
Unavailable che
ck box must be
unchecked.
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Branding

These settings control the optional colors, images and copyright text used to brand the Echo player for your institution. There are also seftings to
add a short video clip at the beginning and end of media files. Change these seltings on a section’s page to override the global defaults.

Copyright Text :

A
Enforce Copyright Acknowledgement :

Player Metadata Font Color : | #999999 Player Title Font Color : | #FFFFFT

Player Banner Background Image : Choose. .. . Player Logo Image : Mone Available *
Player Logo Hover Text : Player Logo Click URL :

Intro Clip : None Available % Outro Clip : None Available %
Watermark Image : Choose... =

Students viewing Echoes in the EchoPlayer will see your institution's logo or other branding assets, as shown in the
figure below:

A 2 Player Banner
Echo340_101 (2340_101-Using the Echosysteriy fall. Background
Image

Player Logo Image.

[ v tomize th Change the color
ou can customize e of this taxt with

logo with Player Logo the Player Title
Hover Text and a Font Color
Player Logo Click

Change the color
of this text with
the Player
Metadata Font

In some cases, you will need to upload an image or video clip file to the branding repository before selecting it from
a drop-down list. See Manage the Branding Files Repository.

Note the following details about application or changes to Branding settings:

® After you establish the branding items described below, they are automatically applied to new Echoes.

® Existing Echoes displayed in the EchoPlayer product will have the Player Banner Background Image and
copyright text applied after you establish these branding items.

® Existing Echoes displayed in the Podcast product must be reprocessed (presentation by presentation) to
apply any brand item.

® [f a brand item does not appear in an existing Echo, reprocess the Echo. Press the Reprocess Media button
at the bottom of the Echo Details page.

The table below provides definitions and inheritance information for the Branding options.
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Setting

Copyright Text

Enforce Copyright
Acknowledgment

Page 85

Description Inheritance

Copyright text appears on the Parent Organization > Child
loading screen in the EchoPlayer Organization > Section

and Podcast products. Enter the

copyright text.

® Formatting (such as capital letters
and spaces) is respected.

® The color of the copyright text
changes to coordinate with the
EchoPlayer theme chosen. The
text is white if the dark theme is
chosen, black if the light theme is
chosen.

® The character limit depends on
the exact release installed.

® You can enter about 400 words in
English. The word count will be
different in other languages.

If you check this box, users must Parent Organization > Child
acknowledge that the material is Organization > Section
copyrighted before viewing.

Enforcing
copyright
acknowledgment
prevents Echo
playback from
embedded
EchoPlayers. If
you or your
users plan to
embed
EchoPlayers, do
not check this
box, or plan to
uncheck it on a
per-section
basis as
needed.
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Player Metadata Font Color

Player Title Font Color
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Metadata appears in the upper left
corner of the EchoPlayer, next to
the logo. It includes the date, time,
room, and Presenter.

The Player Banner Background
Image is layered below this text.
Choose a color that contrasts well
with the background image.

Metadata is in smaller and lighter
weight type above the class title.

Type the HTML number for the
metadata font color. To find the
HTML number, we recommend the
site http://kuler.adobe.com/. You
could specify one of your
institution's characteristic colors.

The class title appears in the upper
left corner of the EchoPlayer
window, next to the logo. Itis in
larger and heavier weight type
under the metadata.

The Player Banner Background
Image is layered below this text.
Choose a color that contrasts well
with the background image.

Type the HTML number for the
color.To find the HTML number, we
recommend the site http://kuler.ado
be.com/. You could specify one of
your institution's characteristic
colors.

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section


http://kuler.adobe.com/
http://kuler.adobe.com/
http://kuler.adobe.com/
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Player Banner Background Image The banner background appears in

Player Logo Image

Player Logo Hover Text

Player Logo Click URL
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the upper portion of the EchoPlayer
window.

Select the desired image from the
drop-down list. To see details about
available branding files, navigate to
Schedule > Branding.

If the file you want to use is not
available, upload the image to the
branding repository so you can
select it. See Manage the Branding

Files Repository.

You could upload an image of your
institution or department.

The logo appears in the upper-left
corner of the EchoPlayer window.

Select the desired image from the
drop-down list. To see details about
available branding files, navigate to
Schedule > Branding.

If the file you want to use is not
available, upload the image to the
branding repository so you can
select it. See Manage the Branding

Files Repository.

Enter the text to display when the
student hovers a cursor on the
EchoPlayer logo image. If the logo
links to your institution's home
page, your hover text might be "Go
to <my_institution's> home page."

You can make the EchoPlayer logo
image a hyperlink by entering a
URL in this field. When the student
clicks on the logo a new browser
window opens with this URL. You
might, for example, link to your
institution's homepage.

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section
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Intro Clip

Outro Clip
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An intro (also called "bumper") is a Parent Organization > Child
movie or clip that plays before the Organization > Section
captured content. You can use this

to promote your institution or

department.

The intro appears in the Podcast,
Vodcast, and EchoPlayer products.

Select the desired file from the
drop-down list. To see details about
available branding files, navigate to
Schedule > Branding.

If the file you want to use is not
available, upload the image to the
branding repository so you can
select it. See Manage the Branding

Files Repository.

An outro is a movie or clip that Parent Organization > Child
plays after the captured content. Organization > Section

The outro appears ONLY in the
Podcast and Vodcast products; it
does not appear in the EchoPlayer.

Select the desired file from the
drop-down list. To see details about
available branding files, navigate to
Schedule > Branding.

If the file you want to use is not
available, upload the image to the
branding repository so you can
select it. See Manage the Branding

Files Repository.
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Watermark Image A watermark is an image file (such
as a logo) that appears in the lower
right corner of both the video pane

and the content (VGA) pane.

Parent Organization > Child
Organization > Section

Select the desired file from the
drop-down list. To see details about
available branding files, navigate to
Schedule > Branding.

If the file you want to use is not
available, upload the image to the
branding repository so you can
select it. See Manage the Branding
Files Repository.

EchoCenter

EchoCenter

These seftings control the behavior of the EchoCenter.
Disable atend of Term? :

Enable Audio File downloads : ™ Enable Video File downloads :
Enable EchoPlayer downloads :

EchoCenter Logo Image : Echol60 EC *

Use these settings to control the behavior of certain aspects of the EchoCenter.

The Enable downloads options let you determine whether or not users can download processed echoes for offline
access, and in what format. When enabled, the available downloads appear as links for the Echo in the EchoCenter,
as identified in the below figure.

O % &

Information

DATE January 08 8:46 AM
PRESENTERS Uday Rajaput
pavan kumar
TYPE Lecture
DURATION 00:00:25
DOWNLOADS _b Audio File
Video File
EchoPlayer File

STATUS

@ Available

The table below provides definitions and inheritance information for the EchoCenter options.

Setting
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Definition

Inheritance
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Disable at end of Term?

Enable Audio File downloads

Enable Audio File downloads

Enable EchoPlayer downloads

EchoCenter Logo Image

EchoPlayer

The EchoCenter page for the
course will be disabled when the
term ends.

If checked, the EchoCenter page
provides an Audio file (Podcast)
download link. It appears on the
Info tab for an Echo. This allows
users to download the audio
recording of the Echo for offline
listening.

If checked, the EchoCenter page
provides an Audio file (Vodcast)
download link. It appears on the
Info tab for an Echo. This allows
users to download the video of the
Echo recording for offline viewing.

If checked, the EchoCenter page
provides an EchoPlayer download
link. It appears on the Info tab for an
Echo. This allows users to
download the EchoPlayer
browser-based playback media
experience. This is useful for
instances where available internet
speeds for students are not fast
enough to allow streamed viewing
over the internet.

Be advised that you must have the
proper licensing for your
EchoSystem in order for this option
to appear.

Allows you to select an image that
will appear on EchoCenter pages.
You must first add the image to the
branding repository. See Manage
the Branding Files Repository.

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section

Parent Organization > Child

Organization > Section

EchoPlayer

These seftings control which applications are available in the EchoPlayer.
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The table below provides definitions and inheritance information for the EchoPlayer options.

Setting

Discussions

Feedback

Sharing

Product Groups

Definition

Check to enable the Discussions
application in the EchoPlayer. You
must subscribe to the Collaboration
and Statistics Service to enable this
application.

Check to enable the Feedback
application in the EchoPlayer.

Check to enable the Sharing
application and Embed code for the
EchoPlayer. The Share button in
the EchoPlayer allows users to
share a link to the Echo, or to
embed the Echo on a 3rd party
website, such as an LMS, or staff
member's website/course page, or
a social media site.

Inheritance

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section

Parent Organization > Child
Organization > Section

Product Groups

the global defaults.

Product Group :

These settings control the default product groups created for each capture, Change these settings on a section’s or schedule'’s page to override

Display Only (Podcast/Vodcast/EchoPlayer). Balanced between file size & guality

A

The table below provides definitions and inheritance information for the Product Group options.

Setting

Product Group

Security Settings

Definition

The product group specified here is
inherited by sections. You can
change the value either here in the
organization or on the section.

Inheritance

Parent Organization > Child
Organization > Section

Security Settings

These seftings contral the security.

Allow All

L L

This setting allows you to implement either the standard or Collaboration Service versions of the EchoCenter pages.
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The Standard version of EchoCenter does not require user authentication and therefore does not provide the same
level of functionality as the Collaboration Service version of the EchoCenter does.

Collaboration features require the system to know who is logged in. This means that in order to use Collaboration
and present the appropriate information and features, you must use a security module that requires authentication.
Conversely, sections configured with a Security Module that requires user authentication are presented with the
Collaboration Service version of EchoCenter.

The table below provides definitions and inheritance information for the Security Settings options. The options you
can select from this list depends on what Security Modules have already been configured for your system.

Setting Definition Inheritance
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Security Module

Page 93

Specify the security module to use,
by default, for all configured
sections in the Organization.
Security settings determine how (or
whether) the ESS should verify a
user's credentials when accessing
EchoCenter, EchoPlayer, or other
content. Security modules may
have custom names.

Allow All does not authenticate
users for access, and therefore
implements the Standard version of
the EchoCenter.

Authentication Required uses
either the ESS user information or
an external Trusted System such as
CAS or Shibboleth to authenticate
users. You can also configure the
LMS (like Blackboard or Moodle) as
as trusted system to authenticate
users. This configuration requires
users to access EchoCenter
through the LMS.

LDAP allows you to use an external
LDAP system for user
authentication. See LDAP
Authentication for more information.

® If you are using LTI-Based
Publishing, you MUST use either
LDAP or Authentication Required
as the security module for
sections to be presented through
an LTI integrated system.

Seamless Only requires the use of
an LMS (such as Blackboard or
Moodle) or other third party system
to pass through user credentials
and allow user access.

® With Seamless Only, users can
only access Echoes through the
third party system and only if the
appropriate building blocks or
plug-ins have been installed.
Echo360 provide downloads for
supported systems via the Custo
mer Portal.

Parent Organization > Child
Organization > Section


http://echo360.com/customer-portal
http://echo360.com/customer-portal
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Support

We recommend that you provide instructions on the specifics of your playback products, directing students to your
institution's website and help desk. The help link is visible on the student's EchoPlayer during playback (in the

browser).

Support

Support URL Text:

Help information can optionally be provided. If this information is entered, it will be provided to users in the Echo player when presentations are
viewed. Change these seftings on a section's page to override the global defauits.

w
1)

The table below provides definitions and inheritance information for the Support options.

Section

Support URL Text

Support Phone

Support URL

Upload Settings

Description

Defines text to be displayed when
the student rests their cursor on the
help link displayed in the
EchoPlayer. Example: "Online
help."

Defines a phone number for
technical support that students can
call with questions or problems on
the EchoPlayer. This number
appears in the Help tab of the
EchoPlayer.

Defines a URL to your help page or
help system URL in this field. A link
to this help page will be displayed in
the Help tab of the EchoPlayer.

Inheritance

Parent Organization > Child Orga
nization > Section

Parent Organization > Child Orga
nization > Section

Parent Organization > Child Orga
nization > Section

The Upload Settings allow you to configure and enforce file size quotas for each section. The quota applies to
instructor-uploaded files like external media files and Personal Capture recordings. Section upload quotas let you
limit the amount of total storage that can be used for these files.

Upload Settings

m

nforce section upload quotas :

These settings control the upload of media files via the External Media tab in the EchoSystem Server and via Echo360 Personal Capture.
Change these seftings on a section’s page to override the global defaults.

Section upload quota (MB) :

20,480

Note the following about quotas:

1. Quota size includes the total of the processed AND completed media files (the /content AND the /flash folder
on the file system), not just uploaded files. Take this into consideration when calculating quota allotments per
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section. Avoid a situation where the processed file storage requirement is significantly greater than the
section quota. For example:
® Section Quota - 10 MB
® Unprocessed uploaded file - 8 MB
® Processed file storage file - 41 MB
2. Quotas can only be enforced on upload. Once uploaded, media is made available. If the processed file size
causes the quota to be reached or exceeded, future uploads will fail unless the quota is increased.
3. Once a quota is reached, and if section upload quotas are enforced, users will not be able to upload
additional files.

The table below provides definitions and inheritance information for the Upload Settings options.

These settings relate to the Media Import feature. See Import Other Media for Academic Staff for details on this
feature.

Setting

Enforce section upload quotas

Section upload quota (MB)

Definition

If set to the default value (No),
Presenters may import as many
other media files as they wish and
those files can be of any size.

This setting is enforced only if the E
nforce section upload quotas sett

Inheritance

Parent Organization > Child Orga
nization > Section

Parent Organization > Child Orga
nization > Section

ing is Yes.

If set to the default value (0),
Presenters cannot import external
media files.

When setting this value, consider
the amount of storage you have
available and the needs of
Presenters. This value is the total a
mount of file space used for both
processed and completed media
files, as noted above.

System Management and Reporting

In this section:

® Qverview

Overview

EchoSystem provides a variety of ways to manage and monitor the system. The topics in this section provide
information and instructions on using the available tools to keep apprised of system usage, issues, set alerts and if
necessary, upload server information to the Echo360 support team. The pages in this section include:

® Monitor the System and Set Alerts
® Manage System Indexes
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Student Usage Reports

Track ESS Usage with Google Analytics

Support Uploads

Audit Reports
EchoCenter Cache Behavior and Troubleshooting

Monitor

the System and Set Alerts

In this section:

User Roles and Monitoring

Monitor Overall Processing Status

Monitor Capture Processing Status
Monitor Capture Status

Monitor Processing Tasks

Monitor Personal Capture Devices
Receive Alerts

Receive Email Notifiers

View and Set Alerts

Receive Technical Support
View Log Files

User Roles and Monitoring

If you implemented delegated administration , you created child organizations and user roles that are specific to the
child organizations. You might have an Administrator or Scheduler for the child organizations. You might also have
Academic Staff for the child organizations.

The tabs visible to you and the information in the tabs depends on your role and on your organization, as detailed in
the table below.

If you are:

The System Administrator

An Administrator for the parent organization

An Administrator for a child organization
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You:

See every tab and all information on the tabs. As the
System Administrator you are, by definition, associated
with the parent organization

See every tab and, in each tab, information on tasks
related to all organizations

See every tab and, in each tab, information on tasks
related to your organization
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A Scheduler (for either the parent or a child See only the Summary and Processing Tasks tabs
organization)
See only events from your organization. You can see
all events for your organization, even if you did not
schedule them yourself.

See the capture and section details links

Cannot change priorities or delete jobs on the
Processing tab

Academic Staff Cannot see the Monitor tab

Monitor Overall Processing Status

© Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U
ser Roles and Monitoring.

You can find statistics about the overall health of the EchoSystem Server (ESS) on the Summary page. Statistics
include the number of system alerts, the status of each active device and media processor, and the system status.
All monitoring activities on this tab are done at the system level, meaning you can monitor all capture operations on
a given day.

You can also monitor the status of the audio, display, and video signals associated with each capture. A legend is
listed next to the Source header of the page explains the meaning of each color for the signal status.

© Monitor a Single Capture

You can also monitor a single device-specific configuration or device-specific configuration or
capture in the Ad Hoc interface. You may want to do this, for example, if you noticed a problem
with a capture on the Summary page but could not resolve the problem without more detail. The
Ad Hoc interface provides a way for you to get more information about the problem from the
capture device itself. To reach the Ad Hoc interface, navigate to Configuration > Devices, then
click the link in the device listing to reach the Device Details page. Click the IP address of the
device. The Ad Hoc interface appears. Click the Monitor tab to watch a visual representation of
the capture.

1. Navigate to Monitor > Summary. The Summary tab appears, as shown in the figure below.

Echoes Downloads Schedule Monitor Reports Configuration System

Summary Captures Processing Tasks Personal Capture Alerts Notfiers Alert Setings Support Help

Summary

System Alerts Capture Stations Processors System Status

1 inlast hour 4 registered 1 registered 7 active license(s) [expiration in 1 year, 11 months]
2 1to4 hours ago 0 outofcontact 0 outofcontact 2 storage volume(s) with disk space OK

7 41to 12 hours ago 3 assigned to @ room 0 jobsin queue 0 storage volume(s) with disk space LOW

0 12to 24 hours ago 26 jobs completed today 0 jobsin process 0 storage volume(s) with disk space CRITICAL

0 1to 5 days ago 25 jobs completed today

2. Review the System Alerts, Capture Stations, Media Processors, and System Status information at the top of
the page.
3. Click any number in the summary statistics to link to detailed information about it. For example, clicking the
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number of registered capture stations opens the Devices page within the Configuration tab, where you can
view, edit, upgrade, or retire those capture stations.
4. Review the System Status column to see the status of storage volumes.
® Disk space is CRITICAL when a volume has 10 GB (10240 MB) or less of unused storage space
® Disk space is LOW when a volume has 30 GB (30720 MB) or less of unused storage space

Monitor Capture Processing Status

©® Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U
ser Roles and Monitoring.

1. Navigate to Monitor > Summary. The Summary tab appears.
2. View the Recent Captures area below the summary statistics, shown in the below figure.

Recent Captures
Filter By : Organization % Organization Choose... s Keyword Search m

Scheduled: 1 Capturing: 1 Processing: 1 Completed: 25

Time ~ Course Room Capture Status Source [legend] Streaming Processing Status Progress Elapsed Publishing Alerts

9:30 AM - 8:35 AM ASLPL-Aptus section  echo.building-SCHD [d¢ Capturing I N/A NiA nia [i}

All recent captures appear on one of four tabs: Scheduled, Capturing, Processing, or Completed, as defined
in the table below.

Capture State Definition

Scheduled A capture that has been scheduled for later today.
Capturing A lecture that is currently being captured.
Processing A capture or media import that is being processed

and packaged for use.

Completed A capture that has completed processing and has
been published to the selected publisher(s).

3. Find the capture you want to monitor. You can do that in either of the following ways.
® Search for a capture that meets the search criteria you enter.
® Browse the captures by state by clicking the relevant tab as described in the table above.
4. Review the status of the capture. The following table explains each element of the capture's status.

Status Element Definition

Time Start and end time of the capture

Course The Course ldentifier associated with a course in
the system
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Room

Capture Status

Source

Streaming

Physical location where the capture occurs

Displays the status of the capture of the lecture or
external media import. Options are Waiting, Uploadi
ng Files, Capturing, Succeeded, Failed, and Missed

A capture that is Failed or Missed will be listed for
seven days, then deleted.

© WMissed Captures

A missed capture is a scheduled
capture that did not start
capturing. A capture might be
missed if there is not a device in
the room, if the scheduled
capture was not transmitted to
the device in time for the capture
to actually start, or a power
outage occurred. The System
Administrator can troubleshoot a
missed capture by monitoring
the device and confirming that it
is licensed.

Shows the status of the video, display, and audio
signals associated with the capture. The following
image explains the color coding of the signal status.

© The source signal graph only
shows the status of the latest
60-minute block of the capture,
in one-minute intervals.

If a currently capturing item is a live webcast, the
Streaming column provides an icon to indicate
whether the expected input is streaming properly,
and provides a Monitor link that allows you to open
the student view of the webcast to see what is being
broadcast in real-time.
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Processing Status Displays the status of the processing of the capture,
which involves packaging the capture into a form
that a student, for example, can experience.
Options are Succeeded, Failed, License Expired, or
Cancelled.

© About the Succeeded Status

It is possible for a capture's
processing status to display Suc
ceeded even when the source
signal graph shows areas of
problems with a source signal.
The processing status
complements the source signal
graph. Succeeded indicates that
some signal was successfully
captured. Problems in the
source signal highlight portions
of the captured media that may
not have captured the desired
content. For example, if the
Audio Signal shows as Not
Present, perhaps because the
microphone was unplugged, the
capture's processing status
would show as Succeeded but
the captured media may have an
audio dropout.

Progress Displays the percent complete of the processing
step.
Elapsed Time in hours, seconds, and minutes since

processing began.

Publishing If the capture is scheduled to be published, this field
shows the name of each publisher (such as RSS or

Email) and its status: Success ( e ), Pending (
), Retry (= ), and Failure ( * ).

Alerts Number of times this capture has raised a
publishing alert.

@ Sort the list of captures

You can sort the list of captures for a selected capture state tab by clicking the column
name.
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Monitor Capture Status

© Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U
ser Roles and Monitoring.

View the status of all captures, including Echoes (lecture captures) and external media imports, on the Captures tab.
Click any capture name to view its details.

1. Navigate to Monitor > Captures.
Echoes [UGLUGIE | Schedule = Configuration Reports Test

Summary Captures Processing Tasks Personal Capture Alerts Motifiers Alert Settings Support
Captures
Search
Filter By :  Date | From : D To: D Keyword Search :
All: 15 Scheduled: 0 Current: 0 Processing: 5 Published: 10
Title / Room Capture Status Course Section
How to do scheduling
Succeeded ECHO100-100-002
temp
Succeeded 3.0-sanity-video-only
Echo360 training-Scheduling
Succeeded ECHO100-100-001
3.0-sanity-testing (3.0-sanity-appliance) fall.2010
echo.revG Succeeded 3.0-sanity-appliance

2. Find the Echo or media import. You have several choices for finding a capture. Options include the following.
® Click the All tab and search for a capture by entering a term in the Keyword Search box and then
clicking Search.
® Click the All tab and filter the list of all captures by Date, Course, Presenter, or Room. Select one of
these options from the Filter list, optionally enter a date, and then click Search.
® Filter the list of all captures by clicking the Scheduled, Capturing, Processing, or Completed tab.
Each tab corresponds to a capture state. A list of only those captures in the selected state appear.

@ sSort the List of Captures

You can sort the list of captures for a selected capture state tab by clicking the
column name.

3. Check the status of the capture by viewing the summary in the capture list. Click the capture name to view
the detailed status about the capture, including its history as reported in the system log and full log.

View Capture Details

You can click the name of a capture in the list of captures on the Captures page and the Processing Tasks page to
get details about that capture, as well as access to a full log of the capture's processing activity.

1. Navigate to Monitor > Captures.

2. Click the name of the capture in the Title column. The Capture Details page appears, as shown in the figure
below.
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Captures > Capiure Details

Capture Details — 5 Min Captures (5min-111) Winter 2011

Capture Description

ID: 2e30eeb8-1d4e-452f-8990-88c669d 74688

Room : Echo360: Dulles, Poland-1

Presenter : Darone, Ken

Related Tasks

Title : 5 Min Captures (5min-111) Winter 2011 Section

Start Time : 2/16/11 10:21 AM Duration

5 Min Captures (5min-111) Winter 2011
Mot Started

50 minutes

Task ID Task Created

There are no processing tasks fo display here.

The following table explains the information on this page.

Field

ID

Title

Room

Start Time

Presenter

Presentation ID(s)

Section

Status

Duration

Task ID

Task Created

Description

The unique identifier for the capture. Click this link
to view the processing log in a new browser
window.

The capture title that the system or the user
provided

Complete location of capture including campus,
building and room

The time when the capture began

The name(s) of the Presenter(s) that the user
provided

The unique identifier of the processed echo. Click
this link to view details about this echo.

Term, Course and Section IDs

This capture status

The length in time of the capture

The unique identifier for the processing task

The time when the processing task began
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3. For additional details about this capture, view one of the logs. Click the System Log button to view the details
about the processing of this specific capture. Click the Full Log button to view the complete history of the
capture from the time it was scheduled to the time publishing is complete. Both logs open in a new browser

Monitor Processing Tasks

window.

@ Sort the List of Captures

You can sort the list of captures for a selected capture state tab by clicking the column

name.

© Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U

ser Roles and Monitoring.

On the Processing page you can see the captures currently being processed and in the queue for processing. In
addition to viewing the details of the task in either list, you can prioritize (raise or lower the priority in the list) or

cancel the tasks for the ESS in the Queued to be Processed list.

Click any task to view its details, including its history as captured in the system log and full log.

® Navigate to Monitor > Processing Tasks. The Processing Tasks page appears. You can do the following on
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this page.

® View information about each capture that is being processed or in the queue for processing. The

following table explains this information.

Field

Title

Processor

Pri.

Description

Name of the capture being processed or in the
queue for processing

The MAC of the media processor assigned the
processing task

Priority of the capture that is determined by the
user. The default, which you may change, is Nor
mal. Options are Low, Normal, and High. Note
that you can raise or lower the priority of a
capture by hovering your mouse over a capture
to highlight it, then clicking raise or lower, as
shown in the following figure.

Title

existingiextended captures (existing-existing_0011 summaz20

raize lower cancel

Click cancel to cancel the processing of this
task.
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Task Created The date and time when the recording of the
capture ended and processing began.

Next Retry If the media processors are busy or the media
files are uploading, the system enters a time in
this field. The default is ASAP.

Capture Start The date and time when the recording of the
capture began.

Duration The length of time of the capture that is in the
queue to be processed.

Room The room where the capture was recorded

® Click the capture title to view details about that capture.

® Change the priority or cancel the processing task. To do so, hover your mouse over a capture to
highlight it. Click the raise button to increase the priority of the processing task, the lower button to
decrease its priority. Click the cancel button to remove it from the list and either stop all processing
tasks in progress or remove those tasks from the processing queue.

@ Sort the List of Processing Tasks

You can sort the list of processing tasks by clicking the column name.

Monitor Personal Capture Devices

© Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U
ser Roles and Monitoring.

This tab lists computers with Personal Capture that have connected to the ESS.

Navigate to Monitor > Personal Capture. The Personal Capture Devices page appears as shown in the below
figure.

Monitor Schedule Configuration Reports

Summary Captures Precessing Tasks Personal Capture Alerts Notifiers Alert Settings Support Help

Personal Capture Devices

1-2 0of 2

Last IP Address Platform 0I5 Details Software Version Last Publish Request Time Last Publish Request By
10.3.10.208
Windows 32-bit (x88) Micresoft Windows 7 (bui 3.0.21431 /1910 4:04 PM wu, lam
10.3.10.164
Mac (Universal) Wersion 10.6.4 (Build 10F! 3.0.21403 111810 12:01 PM wu, lam
view: | 20 [3#] Devices per Page tererz

EchoSystem v. 3.0.2010-11-17.1* ess{@echo360.com | Logout

The following table explains the fields.
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Field Description

Last IP Address The IP address of the computer that connected to the
ESS. The Last Publish Request By field shows that
the last request was made by Lam Vu, so this is
probably the IP address of Lam Vu's personal
computer.

Platform The computing platform of the personal computer when
it last connected to the ESS. This is probably the
computing platform of Lam Vu's personal computer.

O/S Details The operating system of the personal computer when it
last connected to the ESS. This is probably the
computing platform of Lam Vu's personal computer.

Software Version The version of Personal Capture installed on the
personal computer when it last connected to the ESS.
This is probably the version of Personal Capture
installed on Lam Vu's personal computer.

Last Publish Request Time The date and time of the last publishing request
received by the ESS from this personal computer.

Last Publish Request By The person who made the most recent publish request
from this personal computer.

© sSort the List of Devices

You can sort the list of personal capture devices by clicking the column name.

Receive Alerts

© Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U
ser Roles and Monitoring.

You can receive alerts that apply to ESS as a whole or to a specific capture. They show if something out of the
ordinary has happened on your EchoSystem. For example, if the capture was not licensed or your ESS is out of disk
space, you can receive an alert.

You can view a record of all of the alerts that your capture and processing tasks have triggered. This information
helps you decide when you might need to reprocess an Echo.

® Navigate to Monitor > Alerts. The Alerts page appears. You can do the following on this page.
® View the alerts that have been triggered by capture and processing tasks. The following table explains
the available status information.
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Field

Alert Time

Triggering Event

Time Relative to Trigger

Relates To

No. of Notifications Sent

Receive Email Notifiers

© Wwhat You See Depends on Who You Are

Description
The time the alert was triggered
The event that caused the alert to be sent

How soon after the triggering event that the ESS
sent the alert

Name of the ESS capture or processing task
that triggered the alert

Number of emails sent to the ESS administrator
about this alert

Your user role and organizational affiliation affect the information shown to you, as explained in U

ser Roles and Monitoring.

You can set up EchoSystem to send a notifier e-mail if a system alert occurs. Receiving these notifications helps
you address potential problems quickly, thereby maintaining system up time. You can view these emails as well as

add, edit, and delete them.

These notifier emails are sent through a SMTP server to all registered addresses for certain user roles (Scheduler,
Academic Staff, Admin, A/V Technician, and Server Administrator).

View Email Notifiers

1. Navigate to Monitor > Notifiers. The Notifiers page appears.
2. View all email notifications that ESS has sent. The following table explains the information provided about

these emails.

Field

Name

Description

Notifier Type

Add Email Notifiers

Description
Name of the email notifier
Additional information about the email notifier

How the notifier was sent. Email is currently the only
option.

1. Navigate to Monitor > Notifiers. The Notifiers page appears.
2. Click Add. The Add Notifier page appears, as shown in the following figure.
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Echoes Monitor Schedule Configuration Reports

Summary Captures Processing Tasks Perzonal Capture Alerts Notifiers Alert Settir:gi

Motifiers = Add Notifier

Add Notifier

Notifier Details

Mame I
Description :
Natifier Type : | Choose._ [w]

_-_d"""—-‘_ v/-'_
Enter a name for the notifier.
Optionally, enter additional information about the notifier.

Select a natifier type from the list. Email is currently the only option.
Click Save.

L

Edit Email Notifiers

You may need to edit your email notifiers if you modify your email system; for example, by adding security to the
system or changing your email server.

1. Navigate to Monitor > Notifiers. The Notifiers page appears.
2. Highlight a notifier. Two buttons appear.

3. Click edit.

4. Make changes to the notifier as desired.

5. Click Save.

Delete Email Notifiers
If the email notifier has sent an alert (even just once) it cannot be deleted.

Otherwise, follow these steps.

1. Navigate to Monitor > Notifiers.
2. Hover over the notifier to be deleted.

5JG's email notifier

odit delete Email natifier that can be deleted

w

Click delete.
Confirm that you want to delete the notifier.
5. Notice the message confirming deletion at the top of the page.

E

View and Set Alerts
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© Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U
ser Roles and Monitoring.

You can view all alerts configured and specify which alerts selected users should receive. When the administrator
configures an alert, he or she subscribes to it on behalf of a selected user role. For example, when triggering events
occur, an alert about them is sent only to people with selected roles such as A/V Technician, Server Administrator,
and Academic Staff.

The notifier email simply contains the outgoing SMTP server information.

View Alert Settings

Navigate to Monitor > Alert Settings. The Alert Settings page appears, showing all alert settings for all user roles.
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Monitor Schedule Configuration

Summary Captures Processing Ta

Reports

Perzonal Capture

Alerts MNotifiers

Alert Settings Support

Alert Settings

Role Subscriptions

Role [Naotifier] All

Alert Type
Capture - Device everdue [1 hour before]
Capture - Device overdue [1 day before]
Capture - Ne device in room [1 hour before]
Capture - Mo device in room [1 day before]
Capture - No device in room [1 week before]
Capture - Mo device in room [1 menth before]
Capture - Product not supperted [1 hour before]
Capture - Product not supperted [1 day before]
Capture - Product not supperted [1 week before]
Capture - Product not supperted [1 month before]
Capture - Room not licensed [1 hour before]

Capture - Room not licensed [1 day before]

Capture — Bad File Upload

Capture — Error

Capture — Input Mizzing [S minutes after]
Capture — Input Restored

Capture — Missed

Capture — New Ad Hoc Available For Processing
Capture - Stopped

Device Clock — Out of Sync

Device Clock — Sync Restored
Device Failure — Reboot Required
Device Failure — Reboot Successful
Device — Overdug [10 minutes after]
Device — Overdug [1 hour after]
Device — Overdue [8 hours after]
Device — Overdue [1 day after]

Dizk Space Status Changed

ESS Emergency Restart

ESS Emergency Shutdewn

License update - Restart Wowza
License — Expires [1 day before]
License — Expires [1 week before]
License — Expires [2 weeks before]
License — Expires [1 month before]
Presentation - Publizh Failed

Processor — Bad File Upload
Processor — Job Failed

Syetem Clock — Qut of Sync

System Clock — Sync Restored

Set Alerts to Receive

1. Navigate to Monitor > Alert Settings. The Alert Settings page appears, showing all alert settings for all user

roles.

Subscribing Reles

Server Adminiztrator [Email Motifier]
Server Adminiztrator [Email Motifier]
Server Adminiztrator [Email Motifier]
Server Administrator [Email Motifier]
Server Administrator [Email Motifier]
Server Administrator [Email Motifier]
Server Administrator [Email Motifier]
Server Administrator [Email Motifier]
Server Administrator [Email Motifier]
Server Administrator [Email Motifier]
Server Administrator [Email Notifier]
Server Administrator [Email Motifier]

Admin [Email Notifier]; Presenter [Email Notifier]
Server Administrator [Email Motifier]

Admin [Email Notifier]; Presenter [Email Motifier]
Server Administrator [Email Motifier]

AN/ Technician [Email Notifier]; Presenter [Email Notifier]
AN/ Technician [Email Notifier]; Admin [Email Notifier]
Server Administrator [Email Motifier]

Admin [Email Notifier]

Presenter [Email Motifier]

Server Administrator [Email Motifier]

Presenter [Email Notifier]; Server Administrator [Email Motifier]
Presenter [Email Notifier], Server Administrator [Email Notifier]
Server Administrator [Email Notifier]

A Technician [Email Notifier]

A Technician [Email Notifier]

A Technician [Email Netifier]; Admin [Email Notifier]

A Technician [Emall Notifier]

Server Administrator [Email Notifier]

Admin [Email Notifier]; Server Administrator [Email Motifier]
Server Administrator [Email Motifier]

Server Administrator [Email Motifier]

AN Technician [Email Metifier]

AN/ Technician [Email Notifier]

AN/ Technician [Email Notifier]; Presenter [Email Motifier]
AN Technician [Email Netifier]; Admin [Email Notifier]
Server Administrator [Email Motifier]

Server Administrator [Email Motifier]

Admin [Email Notifier]; Presenter [Email Notifier]
Server Administrator [Email Motifier]

Presenter [Email Motifier]; Server Administrater [Email Motifier]

Server Administrator [Email Motifier]

2. From the Role list, select the user role to which you want to send a new alert.
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Alert Settings /

Role Subscriptions

Role [Notifier] All (]

3. Select one or more triggering events for which you want to generate an alert to people with this user role.
4. Click Save.

Receive Technical Support

©® Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U
ser Roles and Monitoring.

When you need support, havigate to Monitor > Support and share the details there about your ESS to support
personnel. You can even upload this information directly to support personnel by clicking the Upload button at the
top of the page. Click the logs at the bottom of the page to get details about all recent capture and processing tasks.
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Monitor Schadule

Configuiration Reporis

SuMmmary Caplures Proceasing Tasks Persanal Capglure Alerns Nedifiers: Alert Seflings Suppen Help

Support

Upload to Support

Recent Upload Events

You can upload troubleshooting information for this server to Echo360 suppart by clicking the upload button below
Information was last uploaded to support 11/20M0 11:23 PM

1120010 11:23 PM

TI20M0 11:23PW

System Technical Information

Software Versions

19021710 12-13:03 AM

1171910 2:03:11 PM {1 day. 10 hours)

ate 1117710 4:17-47 PM (3.0.7.21551)

ArmencaMew_York (-0500)

English {United Statas)

Email

Angel Learning System; Blackboard Learning System (Vista 4 and CE E)

Elackboard Leaming System Enterprise (B-3). Closed Captioning and Transcript

Echa3B0 Search Indexing: Email Publisher; Moodle Leaming System: RSS Feeds; TWERN: iTunes U
Allow All, LDAP Securty. Seamlass Only

fes

Installer Versions

3.02010-11-17 1%

30721551

3021451

Linux, 2 6 18-194 17 1 25, amdBd

Java(TM) SE Runtirme Emironment, 1.6.0_16-b01
Java HotSpot{TM) 64-Bit Server VI, 14 2-b01

Apache Derby v.10.5 [10.5.3.0 - (BO2917)]

Log Files

3.0.21403
302143
3.0 21545°
3.0.21545

3.0 21545
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255 20101117 log
ess-installer log
equest 201071121 Jog
egquest 20101120 log
equest 201071119 Jog
equest. 20101118 log
equest 20101117 log
wrapper 20101119 1o
wrapper 20101117
jetty 20101117 log
jetty 20101118

jetty 20101119

jetty 20101120 ]

EchoSysiem v. 30.20MM0-1117.1* essffiechodB0 com | Logout

View Log Files

© Wwhat You See Depends on Who You Are

Your user role and organizational affiliation affect the information shown to you, as explained in U
ser Roles and Monitoring.

Overview

Log files (except for the ess-installer.log) show detailed daily operations by component. You might be asked to
send a log file to Technical Support or to look at one while talking with a Technical Support engineer.

® The ess log files (such as ess.20111020.log) show all server-side activity required to make a capture
available. Current ESS tasks are shown as active. This file is often used when diagnosing publisher issues.
® If you are diagnosing issues with a Blackboard integration, consult this KB (Knowledge Base) article (D
iagnosing Blackboard Learn 9 publisher failures) for a discussion of log file messages and what they
mean.

Accessing the Knowledge Base
You will need a customer portal login to access the Knowledge Base. Contact Tech

nical Support if you need a login.

® The request log files (such as request.20111020.log) show every http request being made to the web
server. These are typically called "web server access logs". You might view these files with Echo360
Technical Support to discover spurious requests from the server.

® The wrapper log files (such as wrapper.20111020.log) show interaction between the ESS and operating
system (Windows, Linux, Mac OS). You might view these files with Echo360 Technical Support when the
Java virtual machine (JVS) fails to start.

® The jetty log files (such as jetty.20111016.log) show errors specific to the web server (the Jetty server) as
opposed to those that relate to the ESS. You might view these files with Echo360 Technical Support when
either the ESS or EchoCenter fails to start.

Procedure

1. Navigate to Monitor > Support.
2. Scroll down to the Log Files section of the page.
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Log Files

Log Files : ess.20111020.log
ess.20111019.log
ess.20111018.log
ess.20111017.log
ess.20111016.log
ess-installer.log
request.20111020.1og
request.20111019.1og
request.20111018.1og
request.20111017 log
request.20111016.1og
wrapper.20111020.1og
wrapper.20111018.log
wrapper.20111018.log
wrapper.20111017.log
wrapper.20111016.log
jetty.20111016.log
jetty. 20111017 .log
jetty.20111018.log
jetty.20111018.log
jetty.20111020.log

Click on the desired log file. The file opens in a new tab. The example below shows an ESS log file.

00:00:00.062 INFO [eduler Worker-3] com.echo360.ess.util.impl.ApplicationInfoUtilImpl (line 247 ) EchoSystem v4.0.2011
00:00:00.063 INFO [eduler Worker-3] com.echo360.ess.util.impl.ApplicationInfoUtilImpl (line 250 ) EchoSystem Server v
00:00:00.063 INFO [eduler_Worker-3] com.echo360.ess.util.impl.ApplicationInfoUtilImpl (line 253 ) current time: 2011-1
00:00:00.063 INFO [eduler_Worker-3] com.echo360.ess.util.impl.ApplicationInfoUtilImpl (line 260 ) default time zone: N
00:00:00.064 INFO [eduler_Worker-3] com.echo360.ess.util.impl.ApplicationInfoUtilImpl (line 273 ) Java HotSpot(TM) 64
00:00:00.064 INFO [eduler Worker-3] com.echo360.ess.tx.impl.AbstractDatabaseUtil (line 107 ) database: Microsoft
00:16:26.949 INFO [cutor-default-2] com.echo360.es8. job.ExpiredMediaFileDelete (line 29 ) beginning evaluation
00:16:27.032 INFO [cutor-default-2] c.echo360.ess.service.impl.PresentationServiceImpl (line 275 ) evaluating random bal
00:16:27.076 INFO [cutor=-default=2] c.echo360.ess.service.impl.PresentationServiceImpl (line 284 ) none of the presenta
00:16:27.076 INFO [cutor-default=2] com.echo360.ess.job.ExpiredMediaFileDelete (line 33 ) finished evaluation
00:17:21.758 INFO [cutor-default-2] com.echo360.ess. job.CleanupLogUploadOrphans (line 74 ) starting cleanup of
00:17:21.764 INFO [cutor-default-2] com.echo360.ess. job.CleanupLogUploadOrphans (line 76 ) completed cleanup off
00:17:22.564 INFO [cutor-default-5) com.echo360.ess.job.ExpiredExternalMediaDelete (line 30 ) beginning evaluationf
00:17:22.565 INFQ [cutor-default-5) com.echo360.ess.job.ExpiredExternalMediabDelete (line 38 ) finished evaluation
00:17:32.037 INFO [cutor-default=5] com.echo360.ess. job.UpdateCaptureStatusJob (line &0 ) found 16 capture(s)
01:10:07.563 INFO [cutor-default-2] com.echo360.ess.job.Section¥mlResync (line 43 ) beginning resync of
01:10:08.894 INFO [cutor-default-2] com.echo360.ess.job.Section¥mlResync (line 77 ) finished resyne of 1
01:10:14.919 INFO [cutor-default-6] com.echod6l0.ess.job.SectionXmlResync (line 43 ) beginning resync of
01:10:15.965 INFOQ [cutor-default-6) com.echod6l0.ess.job.SectionXmlResync (line 77 ) finished resync of 1
01:14:31.288 INFO [cutor=-default=5] com.echo360.ess.job.Section¥mlResync (line 43 ) beginning resync of
01:14:32.393 INFO [cutor-default-5] com.echo360.ess.job.Section¥mlResync (line 77 ) finished resyne of 1
01:14:3B.694 INFO [cutor-default-3) com.echo360.ess.job.Section¥mlResync (line 43 ) beginning resync of
01:14:39.827 INFO [cutor-default-3) com.echod60.ess.job.SectionXmlResyne (line 77 ) finished resync of 1
01:16:27.116 INFOQ [cutor-default-1) com.echo360.ess. job.ExpiredMediaFileDelete (line 29 ) beginning evaluation
01:16:27.178 INFO [cutor=-default=1] c.echo360.ess.service.impl.PresentationServiceImpl (line 275 ) evaluating random baj
01:16:27.227 INFO [cutor-default-1] c.echo360.ess.service.impl.PresentationServiceImpl (line 284 ) none of the presental
01:16:27.228 INFO [cutor-default-1] com.echo360.es3.job.ExpiredMediaFileDelete (line 33 ) finished evaluation
01:17:22.594 INFO [cutor-default-3] com.echo360.ess.job.ExpiredExternalMediaDelete (line 30 ) beginning evaluationf
01:17:22.595 INFO [cutor-default-3) com.echo360.ess.job.ExpiredExternalMediaDelete (line 38 ) finished evaluation
01:17:32.254 INFO [cutor=-default=2] com.echo360.ess. job.UpdateCaptureStatusJob (line &0 ) found 16 capture(s)
01:47:21.794 INFO [cutor-default-1] com.echo360.ess. job.CleanuplogUploadOrphans (line 74 ) starting cleanup of
01:47:21.799 INFO [cutor-default-1] com.echo360.ess. job.CleanupLogUploadOrphans (line 76 ) completed cleanup off
01:53:22.076 WARN [76B-plugin-test] com.echo36l.ess.publish.EmailPlugin (line 100 ) MessagingException w
javax.mail .MessagingException: Unknown SMTP host: https://localhost

at com.sun.mail.smip.SMTPTransport.openServer (SMIPTransport.java:1280) ~[mail-1.4.jar:1.4]

at com.sun.mail.smip.SMTPTransport.protocolConnect (SMTPTransport.java:370) ~[mail-1.4.jar:1.4]

at javax.mail.Service.connect(Service.java:275) ~[mail-1.4.jar:1.4]

at com.echold60.ess.publish.EmailPlugin.getConnectedTransport (EmailPlugin.java:149%) ~[classes/:4.0.1B-SNAPSHOT]

Manage System Indexes

In this section:

® Qverview
® Procedure

Overview

The system indexes are used when you search or filter lists of items on an ESS page, such as the Courses page
shown below:
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Courses

Search

Organization : | cheose... | Term: choose... | Person: choose... |

You might be asked to regenerate a system index while talking with a Technical Support engineer.

The table below shows the index to regenerate for particular types of content.

Regenerate this index To re-index this content and keyword search for the
page

AdHocCapture Ad hoc captures listed on the Echoes > Ad Hoc
Captures page.

Capture Captures listed on the Monitor > Captures page.

Course Courses listed on the Schedule > Courses page. The

Course search parameter appears on the Schedules >
Schedule page.

Person Users listed on the Configuration > Users page. The
Person search parameter appears on the Schedules >
Courses page.

Presentation Echoes listed on the Echoes > Echoes page.

Room Rooms listed on the Configuration > Rooms page.
The Room search parameter appears on the Configur
ation > Devices page.

Schedule Rule Schedules listed on the Schedule > Schedules page.
Procedure
1. Navigate to System > System Indexes.

System Indexes

Index Name Location

AdHocGapture G:\Program Files\Echo360\Serveridblindex\adhoc
Capture C:\Program Files\Echo360\Serveridblindex\capture
Course C:\Program Files\Echo360\Server\dblindex\course
Person C:\Program Files\Echo360\Serverdblindex\person
Presentation C:\Program Files\Echo360\Server\db\index\presentation
Room C:\Program Files\Echo360\Server\db\index\room
Schedule Rule C:\Program Files\Echo360\Server\dblindexischedulerule

Re-Index All on Next ESS Restart

2. Do one of the following:
® Click on the button next to the specific index you want to regenerate. The table in the Overview shows
which index to regenerate for specific search parameters.
® Click on the Reindex All on Next ESS Restart button at the bottom of the page to regenerate every
index.
3. Restart the ESS at a time that minimizes disruption and delay.
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Student Usage Reports

In this section:

® Qverview
® Summary Report
® Detailed Reports

Overview

©® Who can do this?
® System Administrator
¢ Admin of Parent Organization
® Scheduler of Parent Organization

The summary report and detailed reports show student usage of EchoSystem content.

® Summary reports are automatically generated. As the example shown below illustrates, they show:
® A chart of week-by-week usage for the year ("This Year By Week") or day-by-day usage for the current
month ("This Month By Day")
® A list of frequently accessed courses and presentations

Summary
This Year By Week This Month By Day
314
154 = Captures
[ e e e HSLINE e S s s e e
10 15 35 40 45 50
Most Viewed Courses (9) Most Viewed Presentations (10)

security 34 41.0%  security (sec101-Idap) spring - Mon May 6 9:30 AM 10 12.0%

eccourse 24 28.9%  Dog Grooming (DOG101-Denice LDAP) spring - Wed May 15 8 6%

Dog Grooming 8 9.6% 3:00 PM .

Object Deletion Course Name for a Sub org 7 8.4% Karnataka is a state in South West India. It was created on 1

Object Deletion Course Name for a root org 3 3.6% November 1956, with the passage of the States Reorganisation

01. Human genome 3 3.6% Act. Originally known as the State of Mysore, it was renamed 6 7.2%

LMI LTI Test 2 2.4% Karnataka in 1973. The capital and largest city is Bangalore.

Adhoc instructor 1 1.2% Wikipedia - Mon Apr 29 10:52 AM

Course A: pcap test 1 1.2% name changed - Wed May 15 1:02 PM 6 7.2%
eccourse (ec-ECSeamless Only)
ecterm.2013.05.09.03.22.35. AM{recurring capture) - Fri May 106 7.2%
3:30 AM
Object Deletion Course Name for a root org (Object Deletion
Course Name for a root org - ident-With Publishers) Object 5 6.0%

® Detailed reports are generated on request. Usage data is exported to a .pdf file.
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© whatis a"view"?

The reports show "most viewed courses”, "most viewed presentations" and other statistics. But
what user action constitutes a "view"?

A view is recorded whenever a user visits a URL to view a product. If you authenticate or
authorize users before allowing access to the URL, the user must be authenticated or authorized
before the view is recorded.

Summary Report
To navigate to the summary report, select Reports > Summary.

The first tab, This Year By Week, plots captures and views for each week of the year on a histogram. At the bottom
of the page, the Most Viewed Courses and Most Viewed Presentations are ranked according to the most frequently
accessed content for the year. Percentages are figured against total views.

The second tab, This Month By Day, plots the day-by-day usage for the current month. At the bottom of the page,
the Most Viewed Courses and Most Viewed Presentations are ranked according to the most frequently accessed
content for the month. Percentages are figured against total views.

Detailed Reports
To navigate to the summary report, select Reports > Details Reports.

The detailed reports are created when you specify these parameters:

® Report type:

* Views by Presentation, showing the presentations ranked from most frequently viewed to least, and
including number of hits and percentage of total viewing traffic

® Views by Product, showing the types of recordings (that is, Podcast vs. Vodcast vs. EchoPlayer) that
are being viewed, and including number of hits and percentage of total viewing traffic

®* Quota by Section, showing the storage (in MB) used by the section and the section limit

* Views by Time of Day, showing 24 one-hour segments and the number of views within that segment,
both as an aggregate number of views and as percentage of total views

* Views by Week of Year, showing the number of views occurring within each week of the calendar
year, both as an aggregate number and as a percentage of total views.
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Detailed Reports

Report Type

Report Type : | Views by Presentation ; v|

Views by Presentation

Report Selel:iiu| Wiews by Product
Quota by Section

) ) | Wiews by Time of Day
Filter By : Da“. Views by Week of Year D To: D

Report Output Format

Report Qutput Format : | PDF |

® Date range.
® OQutput format. The report is a .pdf file.

A sample report is shown below.

Viwrs by Product ECh{E‘}

from 2008-08-27 1o 2008-D4

Track ESS Usage with Google Analytics

In this section:

® Qverview

® Get Started with Google Analytics
® Turn Off Google Analytics

Overview

With EchoSystem 5.1, Echo360 began using Google Analytics (GA) to identify browser composition and usage
across deployed EchoSystems. You, as the System Administrator, can also use a GA Tracking ID to generate

reports about your school's ESS usage.

What is Google Analytics?

Google Analytics (GA) is a service that allows you to track views of web pages through embedded JavaScript calls.
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As each page is rendered in a browser, a call is made to GA. The system correlates the views and inspects the
browser user agent string to determine browser characteristics (see http://www.useragentstring.com for details on
the user agent string contents).

GA also provides analytic tools for aggregating and inspecting the data. The current GA dashboard, which gives an
overview of the data collected, is shown below.

& Audience

Overview
* Demographics
' Behavior
* Technology *
* Mobile
* Custom

Visitors Flow

® Advertising
= Trafic Sources
i Content

K conversions

The Visitors Ovenview Report
Comparing Mefrics

Using the Interactive Table
Common Report Controls
Video: Add Advanced Segments
Find Your Old Reports in the New
Interface

Help center

Search help center

Help ]

Visitors Overview

Advanced Segments | Email 5574 Export -

@ 100.00% of total visits
Overview
Visits -

VS. Seledta metic

® Visits
400

N Apr 29, 2012 -May 29, 2012

Add to Dashboard

Hourly ' Day = Week = Month

/

May 6

739 people visited this site

ArmrA\ Visits: 2,562

AL Unique Visitors: 739
MMM, Pageviews: 64,433
Pt PagesiVisit: 25.15

Jirerminyt Avg. Visit Duration: 00:19:09
~msvM. Bounce Rate: 17.49%
Mot % New Visits: 26.74%

Demographics

May 13 WMay 20 May 27

u 71.08% Returning Visitor
1,821 Visits

m 28.92% New Visitor
741 Visits

Language Visits % Visits

Language . 1. enus

2003 I =169%

4 B 43040

CountrTaritnr o

Example - GA at Echo360

At Echo360 we need to know the specific browsers that customers prefer. We drilled into the Technology
parameter (marked with a red arrow in the figure above) and got the analysis shown below. We saw that Firefox had
the greatest penetration and were able to drill down further to see which versions of Firefox were used.

© Example For lllustration Purposes Only

Please do not draw any conclusions from this example.
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Browser & 0S Apr 29, 2012-May 29, 2012

Advanced Segments | Customize Email 5574 Export .  Add to Dashboard
€ 100.00% of fotal visits

Explorer

Site Usage Ecommerce

Visits . | V5. Selecta metric Day Week Month |24 «%

@ Visits
400

'

May & May 13 May 20 May 27
Visits Pages/Visit Avg. Visit Duration % Mew Visits Bounce Rate
2,562 25.15 00:19:09 26.74% 17.49%

f Total: 100.00% (2,562 Site Avg: 23.15 (0.00% Sitz Avg: 00:19:09 (0.00% Sitz Avg: 26.74% (0.00% Site Avg: 17.49% (0.00%;

Primary Dimension: Browser Operating System  Soeen Resolution  Soreen Colors  Flash Version  Other

Secondary dimension - | Sort Type. | Default - E advanced | B | @ | = | % |iiii
Browser Visits =] + Visits Contribution to total: | Visits [=]

1. W Firefox 1,232 48.09%

2. m Chrome 785 30.64%

3. W Safari 3or 11.98%

4 Internet Explorer 225 8.78%

5. m Android Browser T 0.27%

6. m Rockllelt 4 0.16% o

7 |E with Chrome Frame 2 0.08% B 30.64%

For further details on GA, see http://www.google.com/analytics or follow the blog at http://analytics.blogspot.com/.

Get Started with Google Analytics

Using GA to track ESS page usage requires these phases:

1. Getthe GA Tracking ID
2. Tell the EchoSystem Server (ESS) to include the Tracking ID on each ESS page

Phase 1 - Get the Tracking ID

If you already have a GA account and a Tracking ID, skip this phase.

1. Create a Google account. Visit http://www.google.com and https://accounts.google.com.
2. Visit http://www.google.com/analytics and log in.

3. Click Admin.

4. Click + New Account.

5. Complete the Account Administration page.

a. Under “What would you like to track?” select Web Site. This means that all your pages will be tracked,
even if your content is hosted separately.

b. Complete the rest of the fields.

c. Disable both sharing settings.
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Account Administration
Bccounts

VWhat would you like to track?

Web Site f App

Setting up your web property
Website Name
Iy Niew el She

Web Site URL

hittpedf III

ripila: RECWA WS R oom

Industry Category 7

Select One -

Reporting Time Zone
United States w  (GMT-08:00) Pacific Time -

Setting up your account

Account Mame

Wiy New ACCOUNE IName

Data Sharing Settings (7
With other Google products onhy cosone
Erusinle i s Al A

6. Click Get Tracking ID.
7. Look for the Tracking ID in the format UA-######HHE-# at the top of the page.

Profiles | Tracking Info | Property

Tracking IO Stat
e
Lea

8. Make a note of the Tracking ID. You will use it soon.
9. Navigate back to your account home page. Notice that the new account is listed.

Phase 2 - Include the Tracking ID on Each ESS Page

Follow these steps.

1. In{ESS_HOME}/etc/analytics/, create a file called push-customer.js.
2. Include this exact call. This is the code that will be called to the GA service.
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_gag. push(
['b. _setAccount', 'UA- ######i#-#' ],
['b._set Donai nNane', 'none'],

['b. _setAll owli nker', true],
['b._trackPagevi ew ]

)

3. Replace UA-#######HE-# with your GA Tracking ID.
4. Restart the ESS.

5. Visit http://www.google.com/analytics to see the results.

® Results are not immediately posted.

® Allow some time.

Turn Off Google Analytics

The ESS uses a series of script files to control GA . If you do not want GA to collect data, you can prevent that script
from running.

Follow these steps:

1. Create an empty file: {ESS_HOME}/etc/analytics/declare-queue.js.

2.

Restart the ESS.

Support Uploads

In this section:

® Upload Process
® | oggin

® Cached Files
® Other

Upload Process

1.
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Immediately after the user presses the button, an empty “transfer.started" file is uploaded. If this file cannot
be successfully uploaded, no support upload will be performed, but the files that would be uploaded are still
created in the staging area. If the user presses the button and the folder and file are not created within a few
seconds you know the upload will not work.
The upload is now broken into several files instead of just one big one. Each file is created in a staging area
and regardless of whether they can actually be uploaded, the files are created and remain in the staging area
until the next support upload is performed.
The staging area is under <ESS_HOME>/.tmp/.supportUpload. Whenever a new support upload is initiated,
the staging area is cleaned out prior to new staged support upload files being created there.
A directory is created in the staging area that is named the same as the directory where files are uploaded on
sftpupload.echo360.com.
The upload files are created one by one and are uploaded as they are created:

® config.zip contains the contents of the <ESS HOME>/etc dir and the wowza configuration dir (if

applicable).
® gsysinfo.zip contains various system information, such as Java system properties, environment
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©

variables, a summary of the relevant file systems, and a file that shows the number of records in each
of the database tables.
® Zip files are created that contain log files covering three day periods. The first,
logs_00-03_daysAgo.zip, contains the log files with a last modified time from now until three days ago.
The second, logs_03-06_daysAgo.zip, contains the log files with a last modified time from three to six
days ago. Zip files are created and named following this pattern. The oldest file,
logs-27-30_daysAgo.zip, contains the log files with a last modified time from 27 to 30 days ago.
® database.zip contains the Derby database (if applicable).
The log file archives will only be produced if there are logs from those days. Also, there is a 200 MB limit, so
as soon as the cumulative size of the log archives exceeds that limit, no more will be produced.
Files (like log files, files in etc, database files) now retain their last modified date when extracted from the zip.
If all of the files upload successfully, an empty "transfer.complete" file is uploaded as before.
No longer allow multiple overlapping simultaneous uploads at the same time. Give user a message that one
is already in progress if they keep hitting the button before the first one is finished.

Logging

1.

There is a new "jetty.log" file that logs some jetty-specific stuff, especially during startup. This will be very
useful troubleshooting cases where the EchoSystem Server (ESS) will not start up correctly. It should no
longer be necessary to start the ESS from the command prompt in these cases. In fact, most logging is no
longer directed to stdout/stderr so will not appear in the console when starting from a command prompt.
wrapper.log is now capturing stdout/stderr from the java virtual machine. This will allow it to capture thread
dumps and other debugging information that can be provided by the JVM.

The logging configuration file (<ESS_HOME>/etc/logging.cfg.xml) can now be changed on a running system
and the changes will be picked up without restarting the ESS

Logging should now resume soon after correcting a problem that prevents logging, such as interruption of an
NFS share or a permissions issue. Until now, when logging stopped due to such an issue, an ESS restarted
was required to get it going again.

. The request.log file entries are now in the local time zone of the ESS machine like all of the other logs,

instead of GMT. The naming pattern of the request log files is how consistent with the other logs.

The active log files are now named using the same pattern as the rolled-over log files, so the name will no
longer change when it gets rolled over. This was previously the case with the wrapper log file and now
applies to all of the log files.

Cached Files

1.

Other
1.

2.
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The <ESS_HOME>/cache dir, where the device software files are cached, has been moved to
<ESS_HOME>/.tmp/.deviceFileCache.

The place where the device software jar file is unzipped (staged) was previously in a temporary folder under
the system temp dir, but has now been moved to <ESS_HOME>/.tmp/.deviceFileStaging.

. The place where plugins are staged during run time was previously in a temporary folder under the system

temp dir, but has now been moved to <ESS_HOME>/.tmp/.deviceFileStaging

The name of the executable jar for command line utilities has changed from "ess-lib-util.jar" to
"ess-command.jar”. For example, to run a database script, you will now do this:
<ESS_HOME>/etc/wrapper.conf no longer is required to have numbered entries be in strict numerical order
without gaps. In the past, when adding Java Additional Parameters, for instance, you had to number them
consecutively. This is no longer needed and the default wrapper.conf now has these parameters organized
into logical groups.

JConsole is now included with the Java Runtime Environment installed with the ESS and the MBean support
for monitoring Jetty is configured by default. New installations as of 2.6 include the lines needed to enable
monitoring with JConsole commented out in the Java Additional Parameters section of jre/bin/java
-Xmx1024m -jar lib/ess-command.jar ExecuteScript --script somescript.sql <ESS_HOME> /etc/wrapper.conf.
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For new installations, monitoring with JConsole merely requires uncommenting three lines from wrapper.conf,
restarting the ESS, and starting JConsole (<ESS_HOME>/bin/jconsole).

Audit Reports

In this section:

® Qverview

Overview
Audit Reports are automatically generated and list items that are added to or deleted from the system.
To view the audit report, select Reports > Audit Report.

For a detailed review of the audit report information, click Export to export the Audit Report to a CSV file. This
allows you to open the report in a spreadsheet program, and perform sorting and filtering of the reported data.

A sample Audit Report is shown in the below figure.

Audit Report
Time Username Action Type Description
TH8M3 246 PM essadmin@institution.edu Added Schedule dz-garoomCS101 (dz-garcomCS101-section001) dan ga DeptA summer - dan zhang instructor - DZ_QA_LAB_CCAP
THEM3 245PM essadmin@institution.edu Added Section section001 - dz-garoomCS101 - dan qa DeptA summer
71613 2:44 PM essadmin@instiution.edu Added Course dz-qaroomCS101 (dz-garoomCS101)
THEM3 211 PM essadmin@institution.edu Added Schedule fpga EP_Display very_low.SC.low_14.53.00 [10m_11.24] - DVI-D 1440x300 - ns.instructor - QA_LAB_SCHD_3
TMBM3 211 PM essadmin@institution. edu Added Schedule fpga. EP_Display. medium SC.medium_14.20.00 [10m_11,24] - DVI-D 1440x800 - ns.instructer - QA_LAB_SCHD_3
7H6M3 210 PM essadming@institution.adu Added Schedule fpga EP_Display low.SC low_15.04.00 [10m_11.24] - DVI-D 1440x800 - ns.instructor - QA_LAB_SCHD_3
TH8M3 210 PM essadmin@institution.edu Added Schedule fpga EP_Display.high.SC.medium_14.31.00 [10m_11.24] - DVI-D 1440x300 - ns.instructor - QA_LAB_SCHD_3
7MBM3 210 PM essadmin@institution edu Added Schedule fpga. EP_Display extreme.SC.medium_14.42.00 [10m_11,24] - DVI-D 1440x800 - ns.instructor - QA_LAB_SCHD_3
7MBM3 2:08 PM essadmin@institution. edu Added Section 5297 - SCHO_FPGA - newton
71613 2:08 PM essadmin@institution.edu Added Course SCHD_FPGA (SCALER)
71613 1116 PM essadmin@institution.edu Deleted Presentation SCHD_Regression [SCHDR-GB36664R) newton [Podeast Audio.Low]
THMBM3 12:56 PM essadmin@institution. edu Added Schedule SCHO_Regression (SCHDR-GB36664R) newton [Podcast Audio.Low] - ns.instructor - QA_LAB_SCHD_3
716/13 12:50 PM essadmin@institution.edu Added Schedule dz CS 101 (dz CS101-8AM section by instructor) dan ga DeptA summer - dan zhang instructor - DZ_QA_lecal
THEM3 1248 PM essadmin@institution.edu Added Section BAM section by instructor - dz CS 101 - dan ga DeptA summer
7HM6M3 12:48 PM essadmin@institution. edu Added Course dz CS 101 (dz CS101)
THEN3 12:48 PM essadmin@institution adu Added Term dan ga DeplA summer
71613 12:47 PM essadmin@institution.edu Added Person dan zhang instructor <dzhanglnstructor@acho360.com> [dzin]
THBM3 12:41 PM essadmin@institution. edu Added Device Configuration  custom: 28e4ad8b-7d94-402-ba‘e-b51f02adbB0c
7116113 12:38 PM essadmin@institution.edu Added Device device-ty pe-software-capture e0-08-g6-45-15-57
716M3 12:34 PM essadmin@institution.adu Added Device Configuration  custom: 241481f6-e00a-4ff8-610a-2fe2871b06as

View: [ 20 |2 521- 540 of 598 4 4 b M
[ Export |

The information provided by an audit report is detailed in the below table.

Column Name Description

Time Provides and time/date stamp for when the listed action
occurred.

Username Lists the email address of the logged in user who

performed the action.

Action Shows whether the item was Added or Deleted from
the ESS.
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Type Lists the type of item that was either added or deleted
from the ESS, and can include the following items:

Schedule

Section

Course

Term

User (Type=Person)

Device

Device Configuration

Security Module

Organization

Echo (Type=Presentation) NOTE: Only
Deleted Echoes are listed, since creation is
not done through direct interaction with the
ESS interface.

Description Provides detailed information about the item, and
includes the following information for the noted item

type:

® Schedule: <schedule name> <room name>
<presenter name> <summary from schedule
list>

® Section: <section name> - <course name> -
<term name>

® Course: <course name>

® Term: <term name>

® User (Type=Person): <display name> <email
address> <username>

® Device: <device type> <MAC Address>

® Device Configuration: <device configuration
name>

® Security Module: <security module name>

® QOrganization: <organization name> - <org full
name>

® Echo (Type = Presentation): <echo name>
<device name> <product group>

EchoCenter Cache Behavior and Troubleshooting
In this section:

® EchoCenter Cache Behavior

EchoCenter Cache Behavior

When the EchoCenter is loaded, page information is retrieved either from a cache or the application database. The
first time the page is loaded, all information is retrieved from the database. On subsequent page loads, information
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is retrieved from the cache, as retrieving information from the cache is faster than from the database. After a
predefined amount of time, called Cache Time, has elapsed, page information is again retrieved from the database

(instead of the cache) to guarantee accuracy of the data.

At any time, a user can force the page to load all information from the database by appending "?skipCache=true" to

the EchoCenter URL.

For example: htt ps: // ess12-white. ga. echo360. com 8443/ ess/ portal /section/7dcb18a9-d0c7-43

99- bd9c- e37b4de16b89?ski pCache=true

The table below lists the caching setup for each page/module in EchoCenter, and describes the amount of time
before cached information expires.

Module

Course and section
names

Course statistics

Recent Activity Stream

Presentations

Scheduled Lectures

Presentation Activity

Presentation Meta data
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Cache Time

1 hour

5 minutes

3 minutes

3 minutes

3 minutes

15 minutes

3 minutes

15 minutes

15 minutes

Cache Name

essSectionCache

hemsPresentationsinSecti
onCache

hemsDiscussionActivityln
SectionCache

essPresentationsinSectio
nCache

essCapturesinSectionCac
he

hemsPresentationActivity
Cache

essPresentationsinSectio
nCache

hemsDiscussionsInPrese
ntationCache

hemsPeoplelnSectionCac
he

Screenshot/Usage

B Craerms Sttiesion

P Courss Stmtissce

ULICRE WIEWESE AMD CLsULY

1]

% Recent Activity

Imi.student2 posted a comment in: Brewing
Ales 30

Imi.student3 posted a comment in: Brewing
Ales 30
sad

Imi.student1 posted a comment in: Brewing
Ales 30

Imi.student2 posted a commant in: Brewing
Ales 30

@ Crana Lo Frpar

Feraing dies ¥
P o e

Frerming s 36

g i 71

Ry diew

Contains cached chat
discussions for an echo

Contains cached users
from a section
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Hosted Services

In this section:

® Qverview
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15 minutes

15 minutes

15 minutes

3 minutes

3 minutes

1 minute

1 minute

3 minutes

60 minutes

15 minutes

15 minutes

15 minutes

30 minutes

hemsPresentationPerson
ActivityCache

hemsPresentationPerson
DetailActivityCache

hemsPersonPresentation
ActivitiesCache

hemsSectionWeeklyView
sCache

essPresentationldsinSecti
onCache

essPresentationsCache

essCurrentlyLiveAndFutur
eCapturesCache

essCaptureRoomCache

essPersonCache

essPresentationMediaDo
wnloadReportByPresentat
ionAndPersonCache

essPresentationMediaDo
wnloadReportByPersonC
ache

hemsPersonActivitiesCac
he

ecTokenCache

Contains cached detailed
echo activity for an user

Contains cached detailed
echo statistics for an user

Contains cached detailed
echo activities for an user
in a section

Contains cached weekly
views for a section

Contains cached echo

Contains cached live and
futures captures of a
section

Contains cached room
that has capture device
provisioned

Contains cached user

Contains cached
downloadable report of
echo with userin a
section

Contains cached
downloadable report of an
user in a section

Contains cached user
activities for a section, by
given pagesize, sortorder
and sortfield

Holds tokens that hash to
hems sessions. Tokens
expire after 30 minutes of
inactivity
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Overview

The Hosted Services area of the ESS System is where a System Administrator can configure and view the
externally hosted systems that interact with the ESS and provide interactive services for instructors and students
through the EchoCenter. The following Hosted Services are available for configuration:

® Collaboration and Statistics Service
® | ecture Tools Integration

The pages linked above provide details and instructions for configuring those services.

Collaboration and Statistics Service

In this section:

® Qverview

® licensing

® Configuration

® Disable or Enable the Discussions Feature

Overview

What is the Collaboration and Statistics Service?
The Collaboration and Statistics Service (also called the "Collaboration Service") offers these features:

Discussions. A student (or an instructor) viewing an Echo can click the Discussions button, shown below, and
begin a discussion with the instructor and other students. Discussions can also be launched from the EchoCenter.
Discussions can be enabled or disabled for a section using the Discussions check box in the EchoPlayer portion of
the Section configuration page.

“~ Discussions

Bookmarks. A student (or an instructor) viewing an Echo can click the Bookmarks button, shown below, to mark
certain points in an Echo, allowing him to quickly navigate to a particular point.

E1 Bookmarks

Student Usage statistics. These appear as charts and reports on the number of students who have viewed a
particular Echo or participated in a discussion. Instructors (but not students) see usage statistics on the EchoCenter
page, as shown in the figure below. See Student Usage Reports - Are Students Engaged?.
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Server Hosted by Echo360

The Collaboration and Statistics Service relies on the EchoSystem Server (ESS) or the EchoPlayer sending and
receiving data from a server hosted by Echo360. Data is sent with SSL encryption. Only course information and
statistical data required to support these features are stored on the server. No Echoes, raw media files, or identifying
information about the student are stored there. For further details on Echo 360's privacy policy, see http://echo360.c
om/echo360-online-privacy-policy/.

Licensing

If you purchased any of the following licenses, the Collaboration and Statistics Service is automatically registered
and enabled during ESS installation:

® The Collaboration and Statistics Service license (sometimes called the "HEMS" license).
® At least five recurring EchoSelect licenses. The Collaboration and Statistics Service license is included in this
purchase.

Configuration

Once the ESS is installed:

® You must modify the firewall to allow port 443 (TCP outbound)
®* You may want to follow the instructions in the Disable or Enable the Discussions Feature section below.

Disable or Enable the Discussions Feature

©® Who can do this?
® System Administrator
® Parent organization Administrator
® Child organization Administrator (for the child organization)
® Scheduler (for the section)

When the Collaboration and Statistics Service was set up, the following features were enabled:

® Bookmarks
® Student Usage statistics
® Discussions
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The Bookmarks and Student Usage statistics features are automatically enabled. You cannot disable either except
by disabling all collaboration features. The Discussions feature (which is enabled by default), is different. It can be
enabled or disabled for an organization, for a course, or for a section.

The following procedure shows how to configure Discussions for a section.

1. Navigate to the section details page.
a. Navigate to Schedule > Courses.
b. Click on the course link.
c. Click on the section link. The section details page appears.
2. Click Edit.
3. Find the EchoPlayer settings group, shown in the figure below.
4. Check or uncheck the box for Discussions.

EchoPlayer

These settings control which applications are available in the EchoPlayer.

e v

W

5. Click Save.

Lecture Tools Integration
In this section:

Qverview

Add Lecture Tools as a Hosted Service

Configure User Authentication on Course Sections
Provide Guidance to Academic Staff

Overview

Echo360 integration with Lecture Tools allows instructors and students to utilize the presentation and polling
capabilities of the Lecture Tools product directly through EchoCenter.

Instructors can access Lecture Tools through their course EchoCenters and prepare lecture materials, such as polls,
quizzes or other interactive instructional items, and have those items be linked to each course or section. Once
prepared and published, Students can access these materials, allowing them to become more integrated with the
classroom even if they are not physically present.

Integration of Lecture Tools into EchoSystem requires the following configurations:

® Addition of Lecture Tools as a Hosted Service on the EchoSystem Server (ESS)
Use of the Collaboration and Statistics Service (also referred to as HEMS)
® Sections must require user authentication for EchoCenter access, in order to identify instructors and students.

Furthermore, Instructors should be instructed to access LectureTools through the course EchoCenter (and not
independently through a direct LectureTools link). The informational flow, seamless authorization, and connection
between courses in EchoSystem and LectureTools is currently "one way". The only way EchoCenter knows that an
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Echo is linked with a LectureTools Lecture is to create the LectureTools lecture from the EchoCenter link.
The below sections of this page cover administrative configuration for use of Lecture Tools with EchoCenter.

Additional user-directed information for instructors is located in Using Lecture Tools with EchoCenter, and for
students on the Seeing Lecture Tools Materials in EchoPlayer section of the Guided Tour of an EchoCenter Page.

Add Lecture Tools as a Hosted Service

To add Lecture Tools integration to EchoSystem, you must add Lecture Tools as a Hosted Service, which
configures authentication between the ESS and the Lecture Tools service.

If you have a Lecture Tools license, you should have received an email containing some configuration properties
related to your Lecture Tools service. If you have NOT received this email, contact your Lecture Tools support
representative. You cannot continue without this information.

Once you have the Lecture Tools configuration information use the following steps to add Lecture Tools as a Hosted
Service.

1. On the ESS, navigate to System > Hosted Services. You should already see a Collaboration and Statistics
service listed there. If you do not, contact Echo360 Customer Support.
2. Click Add. The Hosted Service Information page appears, as shown in the below figure.

Hosted Service Information

| save |} Cancel |

3. Enter a Label that clearly identifies this as the Lecture Tools service. This is the text you will see in the list of
Hosted Systems.

4. Complete the Consumer Key, API Secret, and API Host URL fields using the email you received, discussed
above, with these configuration properties.

5. When finished, click Save.

Configure User Authentication on Course Sections

Lecture Tools needs to know who is attempting to access its information, and the EchoCenter needs to know how to
present links and information to the user (depending on whether it is a student or instructor). In order to do this, each
section to be integrated with Lecture Tools needs to have the Security Settings configured to require user
authentication to access the EchoCenter.

Use the Security Settings section of the Edit Section page to make this selection. It may be easier for you to set the
default Security Settings for the Organization to one that requires authorization. This allows each section configured
for the Organization to inherit that security setting, eliminating the need to manually configure each.

You may also need to configure additional Security Modules, or change the settings for existing modules as needed.
This is because the Security Settings available for selection are determined by what security modules are configured
for the ESS.
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Users Accounts Must Have an Email Address

Access to Lecture Tools must occur through the EchoCenter. When a Lecture Tools button is
clicked, the EchoCenter passes through the user's first and last name and email address. If it
does not receive an email address, Lecture Tools will not allow the user to connect. The user
receives a notification and is provided with a instructions to update or enter the account email
address to be used. This applies to both instructors and students.

Provide Guidance to Academic Staff

You will want to provide course instructors and other presenters with the basic information they will need to use
Lecture Tools with their courses. There is information provided in the Academic Staff Guide, in particular on the
page devoted to Using Lecture Tools with EchoCenter.

Specifically, you want to be sure that the course instructors are told (and advise their students) to always access the
EchoPlayer through the course EchoCenter. The integration and pass-through of information from Lecture Tools is
provided through the EchoCenter. Anyone accessing the lecture (including both Echoes and Live webcasts) through
a direct link to the EchoPlayer will NOT see the Lecture Tools materials provided.

Furthermore, you will want to advise your staff that EchoCenter does not, at this time, support the use of an Image
Quiz from Lecture Tools. All other question formats provided by Lecture Tools can be used through EchoCenter.

Security

Security Modules

Trusted Systems

LDAP Authentication

CAS and Shibboleth Authentication

Security Modules
In this section:

Overview

Seamless Only vs Authentication Required

If You Are Creating an LDAP Security Module

If You Are Creating a Seamless Only Security Module
Create the Security Module

Delete the Security Module

Overview
You can implement any of four different types of security:

Allow All, the default security module, requires no authentication.

Authentication Required allows you to authenticate users against the user profile information on the ESS, or
a against a configured Trusted System such as CAS or Shibboleth or other third-party system.

LDAP integrates the ESS with an existing LDAP security system. See LDAP Authentication for additional
information and instructions. If necessary, you may want to refer to this KB (Knowledge Base) article (LDAP
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security module configuration) for details on configuring the ESS for LDAP.

Seamless Only provides the ability for a trusted system, such as an LMS, to perform authentication and
authorization for ESS content links. This allows a user to seamlessly log in to content hosted by ESS from
publishers such as Blackboard and Moodle. See:

® Blackboard Learning Management System Enterprise 7.3-9.1 - Individual Link Publishing Moodle -
EchoCenter Publishing

® Moodle - EchoCenter Publishing. A trusted system must be implemented for the Moodle 2.x
integration. It is optional for Moodle 1.9.x.

If you are using LTI-Based Publishing, you MUST use either LDAP or Authentication Required as the security
module for user authorization.

If you are using Seamless Only to provide access through an LMS or other third-party system, users can only
access Echoes through that system, and only if you have installed the building block or plug-in that provides
seamless authentication into an EchoSystem. Echo360 provides downloads for supported systems via the Customer
Portal.

Accessing the Knowledge Base
You will need a customer portal login to access the Knowledge Base. Contact Technical Support
if you need a login.

Seamless Only vs Authentication Required

If Seamless Only is used on a section, then students must be authorized via an LTI or Seamless link for the specific
section in the LMS in order to view content for that section.

If Authentication Required is used on a section, then any authenticated student can access the content for that
section.

If You Are Creating an LDAP Security Module

Invite the LDAP Administrator to work with you or consult with the Administrator before you begin.

1. Ask the LDAP Administrator how to configure these fields:
® | DAP URL.
Manager DN. Some LDAP Administrators set up a special user name and password for LDAP testing.
Manager Password.
Base Group DN.
User Name Attribute
Base User DN.
2. Discuss adding extra security to certain sections with the LDAP Administrator. If you decide to do so, ask the
LDAP Administrator how to configure these fields:
® Required Extra User Attribute Value
® Extra User Attribute Name
3. You may want to print the screenshot below and have the LDAP Administrator annotate it with the correct
input data for each field.
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Security Settings — Tree 1
This is the primary LDAF tree that will be evaluafod.
|dap:ffess1-blue. echo380.com:389 Yas

cn=admin, de=university, dc=edu

ou=groups, do=wniversity, do=edu Yas

membes uid
ou=users, de=university, de=edu Yes
givenName &N

rail displayMame

If You Are Creating a Seamless Only Security Module

In certain specific circumstances, the Seamless Only security module can prevent users from logging in to an
EchoCenter page. This happens when the section associated with the EchoCenter page has the Seamless Only
security module specified and one of the following is true:

® System Missing. You have not configured a trusted system.
® User Not Authenticated. The user logs in to the EchoCenter page without first logging in to a trusted
system, such as an LMS like Blackboard or Moodle.

Because the user has not been authenticated, the EchoCenter does not allow access. The user is told that the user
name or password is incorrect, as shown below.

Pleose enter your user rome and possword
Your user rarne ond/or passwornd is incomech, Please Iry agoin,

Usar Mame

Posswiond;

To prevent the System Missing case from occurring, make sure you configure a trusted system if you configure a
Seamless Only security module. See Trusted Systems.

To address the User Not Authenticated case, follow these practices:

® |f your security system is configured in a way that makes this case likely to occur, use a different security
method, such as LDAP, CAS, or Shibboleth. All of these methods support seamless login. This means that
once the user has logged in, he can access the EchoCenter without being challenged for credentials.
* |f you want to use the Seamless Only security method, prepare your school's Help Desk to aid users:
® Explain how the User Not Authenticated case occurs.
® Explain this quick fix: If a user is unable to log in to an EchoCenter page, have the user log in to a
trusted system, such as a learning management system (LMS) first. Logging in to the LMS
authenticates the user, who can then log in to the EchoCenter page.

Create the Security Module

Follow these steps to create the security module.
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1. Log in as an Administrator.
2. Navigate to the System > Security page of the ESS.
3. Click the Add button. The Add Security Module page appears as shown in the figure below.

Security > Add New Security Module

Add Security Module

General Information

ar

Choose...

Choose... E

4. Enter a Name for the module, preferably using one that indicates its function, such as
"ldap_content_module”.

o

Enter a Description of the module. This appears in the Seurity Modules list on the ESS.

(o2}

. Select the parent or child organization from the Organization list.
. Select the module type from the drop-down list. Depending on your selection, the page expands to show
additional fields.

8. If you want this security module to be inherited by all new sections by default, select the Default Module? bo
X. There can be only one Default Module. If you have already configured a Default security module, this field
shows "No" as the value with no checkbox.

9. If you are configuring an LDAP security module, complete the Security Settings - Tree 1 fields, using the input
data from the LDAP Administrator. See If You Are Creating an LDAP Security Module.

10. Click Save.

~

Delete the Security Module

You can only delete custom security modules. You cannot delete the Allow All, Authentication Required, LDAP,
or Seamless Only security modules.

When you delete a custom security module, you must specify the alternate security module to use. If the custom
security module is specific to a certain child organization, the alternate security module must be:

® Associated with the same child organization, or
® Associated with the parent organization

Upon deletion, when a replacement security module is chosen, any applicable properties of the deleted security
module should be copied over to the replacement security module.

If you do not specify an alternate module, the Allow All security module will be applied to sections that were
associated with the deleted security module.

Best Practice: Know the Alternate Security Module You Will Apply

Before deleting a custom security module, review the sections that will be affected and determine
which security module you want to apply to those sections.
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Procedure

1. Navigate to System > Security.
2. Click on the security module you want to delete.

SJG security md&g

3. On the Security Module Details page, scroll to the bottom.
4. Click Delete.

5. Specify the alternate security module to use.

[ Are you sure you want to delete
- Security module "SJG security
module"?

This will permanently move 1 section(s) of SJG security
module to : Allow All Ad

loaP

| Authentication Reguired
6. Confirm the deletion.

7. Notice that the security module has been removed from the security module list.
8. Check that the new security module was assigned.

a. Navigate to a section that had the deleted security module assigned

b. Notice that the section now has the alternate security module assigned.

Security Settings

These seffings control the securnty.

Security Module Allow All

Trusted Systems

In this section:

® Add the Trusted System in the ESS

Add the Trusted System in the ESS

1. Log in to the ESS as an Administrator.
2. Navigate to System > Trusted Systems.

Page 135



EchoSystem 5.5 Documentation

Trusted Systems

System Name a

ecp

Description

EchoCenter

View: | 20 j Systems per Page

1-1 of 1

1-1 of 1

3. Click Add. The Add Trusted System page appears.
Add Trusted System

Trusted System Information

Save

4. Complete the required fields:
® System Name. We recommend the name of the system being integrated, such as "Blackboard" or
"Moodle".
® Description. We recommend the URL of the system being integrated.
® Consumer Key. We recommend a simple string, such as your initials, for the Consumer Key.
5. Click Save to commit your edits and reveal your Consumer Secret.

Record the Consumer Key and Consumer Secret.

Make a note of the Consumer Key and copy the Consumer Secret value from the Trusted
Systems page into a text editor. Make sure you copy the equals signs (==) at the end of
the Consumer Secret. Do not copy the extra character of white space that follows the
equals signs (==).

6. Click Done.

LDAP Authentication

In this section:

Qverview
Directory Systems Supported
Network Requirements
Enable | DAP Authentication
® Consult With the LDAP Administrator
Create the Security Module
Test the Security Module
Deploy the Security Module
Modify the User Account

Deploy Additional Security
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Overview

LDAP (Lightweight Directory Access Protocol) allows you to use a single central source to authenticate user
credentials. You can integrate the EchoSystem with LDAP so all users are authenticated. These users might be:

® System users who access the EchoSystem Server (ESS)
® Content creators who access Ad Hoc capture or upload recordings created in Personal Capture
® Students who review content already created

The distinction between system users and content users is important because, though you create a single security
module, it exists as two instances:

® As the system instance (the application security module), it authenticates users logging in to the ESS
administrative interface. These might be:
® A System Administrator logging into the ESS
® An Instructor using Ad Hoc capture in the classroom
® An Instructor or Teaching Assistant uploading a personal capture recording

® As the content instance (the content security module), it authorizes Academic Staff and students logging in to
view content. These might be:

® Students playing an Echo.

® Students or Academic Staff accessing EchoCenter pages. When users are authorized with the content
instance, you can present different EchoCenter pages for students and Instructors. If you do not
authorize users with the content instance, students and Instructors both see the standard EchoCenter
page.

The security module supports:

® Automatic searches of sub-trees. One part of creating the security module is configuring the tree definition
fields. These fields determine how the ESS connects to the LDAP directory and what criteria are considered
when a user provides credentials. The ESS searches up to three different trees and any number of sub-trees
within each tree. The trees can reside on the same or different LDAP servers.

® Multiple tree failover up to three trees. If the EchoSystem does not find the user's credentials in the first
tree searched, it searches two more trees.
®* Fallback to the ESS database. If the user's credentials are not found in any of the LDAP trees, the

EchoSystem searches its internal database. If the user's credentials are still not found, the EchoSystem
refuses access.

® Security over SSL. SSL, the Secure Sockets Layer protocol, provides transport security that prevents an
interloper from reading traffic.

Directory Systems Supported

The EchoSystem LDAP feature is compatible with the following directory systems:

® OpenLDAP 2.3
® Microsoft Active Directory & AD Lightweight Directory Service
® MacOS X Open Directory

LDAP and Ad Hoc Interface

Disabling HTTPS for either the appliance or Classroom Capture Ad Hoc interface passes LDAP
credentials in clear text.

Network Requirements
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LDAP communications use port 389 for insecure transport and port 636 for secure transport over SSL/TLS.

Enable LDAP Authentication

Enabling LDAP authentication consists of these phases.

Consult With the LDAP_Administrator

Create the security module

Test the security module

Deploy the security module

If you are deploying an application security module: Maodify the user account
Optional: Deploy additional security

o r~wWNPRE

Consult With the LDAP Administrator

Invite the LDAP Administrator to work with you or consult with the Administrator before you begin.

1. Ask the LDAP Administrator how to configure these fields:
® | DAP URL.
Manager DN. Some LDAP Administrators set up a special user name and password for LDAP testing.
Manager Password.
Base Group DN.
User Name Attribute
Base User DN.
2. Discuss adding extra security to certain sections with the LDAP Administrator. If you decide to do so, ask the
LDAP Administrator how to configure these fields:
® Required Extra User Attribute Value
® Extra User Attribute Name
3. You may want to print the screenshot below and have the LDAP Administrator annotate it with the correct
input data for each field.

Security Settings — Tree 1

This is the primary LDAF tree that will be evaluafod.
|dap:!ess-blus. scho3&0.com: 389 Yas

cn=admin, de=university, dc=edu

ocu=groups, de=wniversity, dec=edu Yas

membes uid
ou=users, de=university, dc=edu Yes
givenName &N

rmail displayMName

Create the Security Module
1. Log in as an Administrator.
2. Navigate to the System > Security page of the ESS.
3. Click the Add button. The Add Security Module page appears, the top section of which is shown in the below
figure.
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© N o v

10.

11.

12.

Add Security Module

General Information

Name : | LoaP Module
Description : LDAP Security Module

Organization : [ echo3so

Ak

ype : [ LDAP Security %

Security Settings

These settings control the security.

T

Authentication Mode : + Try all trees independently |
Try all trees together as one

Enter a Name for the security module, preferably one that indicates its function, such as "LDAP_Content".
This name appears in the Security Modules list and the Security Settings drop-down list for Organizations and
Sections.

Enter a Description for the security module. This description appears in the Security Modules list.
Select the Organization to which this security module applies.
Select LDAP Security from from the Module Type drop-down list.

Use the Default Module checkbox to indicate whether this is the default security module inherited by all new
sections. There can be only one Default security module.

For Authentication Mode, select one of the following options from the drop-down list, shown in the above
figure:

® Try all trees independently: Select this option if you are using only one Tree for your LDAP
authentication, or you are using a Master and Slave LDAP configuration, where the Tree
configurations are identical and the Slave LDAP should only be used if the Master LDAP is unavailable
or cannot authenticate the user for some reason.
®* Try all trees together as one: Select this option if your Tree configurations are using different
identifiers for authentication. For example, different types of users may use different User Name
identifiers for login. Configuring multiple Trees to accommodate these different user identification types
allows for seamless authentication of the different user types through a single security module.
Complete the fields in the Tree 1 section, as well as the Tree 2 and Tree 3 sections if appropriate. See Consu
It with the LDAP Administrator section above for obtaining input for these fields.
If appropriate at this time, enter a User Name and Password to test the LDAP configuration. See Test the
Security Module below for more information.
When finished, click Save.

Test the Security Module

Each security module contains a section to test your configuration based on a specific user's credentials. Follow
these steps.

1.
2.
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3.

Repeat the following steps for each user to be tested:
a. Enter a user name in the User Name field.
b. Enter that user's password in the Password field.
c. Click Test LDAP Configuration.
d. Look for a success message.

Deploy the Security Module

After you create and test a security module, deploy it.

When deployed as a content security module, a student must log in against the LDAP criteria before viewing
a presentation (an Echo).

When deployed as an application security module, users must log in against the LDAP criteria before
accessing the ESS administration interface (the web user interface).

Content and application security modules are deployed differently because they affect different parts of the system.

© If You Use EchoCenter Pages

If you use EchoCenter pages and subscribe to the Collaboration Service you can enable differen
t EchoCenter pages for students and Instructors. Users with the role of student see a student
page; users with the roles of Instructor, Administrator, or Teaching Assistant see the Instructor
EchoCenter page.

To allow for these different pages, LDAP must authenticate a user as either a student or
Instructor. You must:

1. Configure both a content security module and an application security module with at least
one common LDAP authentication tree
2. Deploy both the content security module and the application security module

If you do not deploy both security modules, everyone sees the standard EchoCenter page.

Deploy a Content Security Module

Follow these steps.

1.

ok wN

~

9.

Log in as an Administrator.

Navigate to the Schedule > Courses page.

Click on the name of a course containing a section where the content security module should be deployed.
Point to the section.

Click the edit button that appears.

In the Application Security section, select the content security module from the Security Module drop-dow
n list.

Notice that additional fields appear with names similar to those on the module configuration page.
Complete these optional section-level overrides to allow or disallow access based on the section an Echo
belongs to.

Save the section.

Deploy an Application Security Module

When you deploy an application security module, you can enable fallback to the ESS database and also allow ESS
users to log in to view content.

Follow these steps.
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1. Log in as an Administrator.

Navigate to System > System Settings.

3. Inthe Application Security section, select the application security module from the Security Module drop-
down list.

4. Optionally, select Enable Fallback to Internal ESS Database and Allow ESS users to login to view
content. See Application Security.

5. Click Save.

n

Modify the User Account

If you are deploying an application security module, change the ESS user name so it matches the user name for
other university accounts. This is often <initial><lasthame>, though it could be the full email address. The ESS and
LDAP servers use this key field to unambiguously relate an account in the ESS directory to an account in the
(unrelated) LDAP directory.

If you are modifying the user name of the System Administrator, you must include a password. See Add a User .

Deploy Additional Security

If you and the LDAP Administrator decided that certain sections should have additional security (see Consult With
the LDAP Administrator), add the security now.

Follow these steps for each section that requires additional security.

1. Navigate to the section details page.

a. Navigate to Schedule > Courses.

b. Click on the link for the course you want to edit.

c. Click on the link for the section you want to edit.
2. On the section details page, find the Security Settings - Tree 1 settings group.
3. Populate the following fields as instructed by the LDAP Administrator:

® Required Extra User Attribute Value

® Extra User Attribute Name

CAS and Shibboleth Authentication

® Qverview
® SSO for Classroom Capture or Personal Capture

Overview

EchoSystem provides support for external single sign on (SSO) through either Jasig's CAS or Shibboleth federated
authentication systems. These systems allow your users to sign in once, then provide seamless, secure access to
the other integrated products in your enterprise.

® For more information on Jasig's CAS project, see http://www.jasig.org/cas.
® For more information on Shibboleth's federated identity solutions, see http://shibboleth.net

The configuration and setup of these external authentication systems within EchoSystem requires coordination with
Echo360 professional services personnel to implement.

If you are interested in implementing SSO for your institution, please contact Echo360 professional services via

Page 141


http://www.jasig.org/cas
http://shibboleth.net

EchoSystem 5.5 Documentation

email at services@echo360.com.

SSO for Classroom Capture or Personal Capture

CAS and Shibboleth are not compatible with Classroom Capture or Personal Capture. This means that the
credentials you use for CAS and Shibboleth will not automatically work with Classroom Capture or Personal
Capture.

It is possible to ensure single sign on for users if you use LDAP as the security method for your ESS: Have the
ESS LDAP application module be the same LDAP module that your CAS/Shibboleth uses.

A user will be able to log in to different components (Classroom Capture, Personal Capture, EchoCenter, ESS) with
the same credentials although the technologies behind their authentications are different.

®* When a user logs in to Classroom Capture or Personal Capture, s/he is authenticated via LDAP.
® When a user logs in to other components of the EchoSystem (the EchoCenter, for example), s/he is
authenticated via CAS or Shibboleth.

Import and Export Objects

In this section:

Overview

General Procedure - Export Objects

General Procedure - Edit the Spreadsheet
General Procedure - Import Objects

Example - Move Courses to a New Organization
Example - Add New Rooms

Example - Edit Existing Users

Example - Post EchoCenter Page URLSs to an LMS

Overview

The export/import feature lets you export the properties for certain objects to a spreadsheet, edit those properties,
and import them. This is an efficient way to:

* Add many objects all at once
® Change properties of many objects all at once
® Extract the properties of many objects to a spreadsheet for further manipulation

You might use this feature when:

® Your institution has built a new, fully equipped lecture hall. You need to add many new rooms. This is an ad
d many operation.

®* You have added organizations to allow delegated administration. Many objects (courses, sections, rooms,
users) that had been owned by the parent organization (the university) should now be owned by a particular
child organization, such as the law school. This is an edit many operation.

® You want to post the EchoCenter URL of many sections to your learning management system (LMS), but use
an LMS that is not integrated with the EchoSystem Server (ESS). You can extract the URLSs to a spreadsheet
then copy-paste them to your LMS. This is an extract operation.

You can do these operations efficiently by using the import and export features with a spreadsheet program such as
Excel.
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EchoSystem allows for import and export of the following objects:

Courses

Sections

Rooms

Users

Schedules

Personal Capture Licenses

You must logged in as a System Administrator or the Administrator of the parent organization to use this feature.
When you export or import objects, all objects of that type (all courses, all sections, all rooms) are exported. Export
cannot be limited by organization. That is why only System Administrators or parent organization Administrators (but
not child organization Administrators) can use this feature.

The basic steps are the same for all operations.

1. Export existing objects. Do this even if you are doing an add many operation because it gives you a
properly formatted spreadsheet.

2. Edit the spreadsheet.

3. Import the spreadsheet.

General Procedure - Export Objects

This procedure shows how to export users. Adapt this process to export other objects: courses, sections, schedules,
rooms, or Personal Capture licenses.

1. Navigate to Configuration > Users.

2. Scroll to the bottom of the page.

3. Click Export.

4. The user records are exported to CSV file. You can open this file in a spreadsheet program such as Excel.

General Procedure - Edit the Spreadsheet

1. Follow these best practices to reduce the possibility of errors:
® Adjust the cell margins so you can easily see the content of each cell.
® Sort the spreadsheet so the relevant cells display at the top of the page.
® For add many operations: clear the existing data cells, but preserve row 1, the heading cells.
2. Enter and edit data.
® |f you change an object's organization, see Inheritance When You Change an Object's Organization.
® In the example shown below, David Goodwin, who had been Academic Staff for the university,
becomes Academic Staff for the engineering school and a Scheduler for CLP. Gilda Good, who had
been a Scheduler for the university, becomes a Scheduler for the engineering school.

dgoodwin@echo360.com dgoodwin Echo360 / engineering; role-name-academic-staff  Echo360 / CLP;role-name-scheduler
ggood@echo3s0.com ggood J Echo360 / engineering; role-name-scheduler

3. Save the edited spreadsheet as a CSV file.

General Procedure - Import Objects
This procedure shows how to import users. Adapt this process to import courses, sections, or rooms.

This procedure assumes you have already exported objects and edited the spreadsheet. You must have a properly
configured spreadsheet to import.
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1. Navigate to Configuration > Users.

2. Scroll to the bottom of the page.

3. Click Import. The Import Users screen appears.

4. Review the help text. Make sure your import file is properly configured.

5. Click Browse.

6. Select the import file.

7. Click Import. The file is imported and processed. Results of the import appear in the field at the bottom of the
screen.

8. Review the results.

9. Notice in the example below that two users were not updated because the import file was not properly

configured.

Import Users

Use this page to add or make mass changes to multiple users (such as adding an organization role) using a properly formatted .csv file. Use Users
> Export to create this file (named person.csv) then edit as needed ensuring every field is populated before submitting. Passwords are only
required for new administrative users, users who require an updated password, or for schools not using LDAP for Application Security; otherwise
leave the field blank. See the documentation for more details about importing users. Results display in the text below and may be copied to your
clipboard for further review by pasting into your program of choice.

Use the Browse button below to select the CSV file to import. Results are displayed in the text box below the Import button. The results will
indicate the line number in the CSV for reference in the event an error occurs during import.

- fa ~
I.n’Usersfsgrodsk'.r,fDocumenls,fM'.rStuffM.D (Aristotle) | Browse... )

Person: "User, Default" Could not be updated. Password cannot be blank for a System Ac

Person: "Grodsky, Susan" Could not be updated. Password cannot be blank for a System I

Person: "Shrestha, Nabin" updated.
Person: "Scheduler, Root" updated.
Person: "Staff, Root" updated.
Person: "Instructor, Root" updated.
Person: "Assistant, Root" updated.
Person: "Presenter, Root" updated.
Person: "Student, Root" updated.
Person: "Admin, CLP" updated.

Person: "Scheduler. CTIP" undated.
L4 b alr

10. Scroll to the bottom of the results field to review the summary. In the figure below, notice that the two users
edited in the procedure above, David Goodwin and Gilda Good, were updated.
Person: "Student, CLP" updated.

Person: "GCoodwin, David" updated.

Person: "Good, Gilda" updated.
Import Complete! 0 Perscons created, 21 Perscons updated, 2 failed

Review the results. Two users were
not updated because the import file
was not properly configured.

11. Decide if you need to edit the import file and re-import. You may want to copy the results to an editor
(Notepad, TextEdit) or make notes about edits required.

12. Click Done.

13. If you like, check one or two user profiles to see the effect of the imports. The below example shows the user
profiles for David Goodwin and Gilda Good.

Name » Email Address System Role(s)
Goodwin, David

dgoodwin@echo360.com Echo360 / CLP->Scheduler; Echo360 / Engineering—>Academic Staff
Good, Gilda <

‘ggood@echo360.com Echo360 / Engineering-->Scheduler

Example - Move Courses to a New Organization

In this example, you move a course to another organization. Sections, schedules, and Echoes associated with the
course move to the other organization.

This example follows the general procedures outlined above.

1. Export the courses.
a. Navigate to Schedule > Courses.
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b. Scroll to the bottom of the page.

Click Export Courses.

d. The course records are exported to a spreadsheet named course-<num>.csv, as shown in the
example below. If you have a spreadsheet program installed, it opens automatically.

o

B C
| Course Name Identifier Organization
nabin's adhoc test AHTL101 Echo3al f NS
LMI - Test Course One Imi-tco Echo3al f LMI
tg: safeCapture Test TGS100 Echo36l f Tade University
nabin's emi test MWEMZ00 Echo3al f NS
Blended Learning ECH101 Echo3a
Collab Course 1 CCT101 Echo360 / Collaboration
MNew aptus identifier Echo3el / Aptusnew
LMI - Sectian Testing Imi-st Echo3ol f LMI

2. Edit the spreadsheet. See General Procedure-Edit the Spreadsheet for details and best practices.
® You can change the course name, Identifier, and Organization.
® In the example shown below, Blended Learning is moved from Echo360, the parent organization, to
the School of Arts and Sciences. The Identifier changes from ECH101 to EDU201.

nabin's Er'rii test MNEM200 Echo3sl f NS
Blended Learning W EDUZ201 Echo360/A5
Collab Course 1 CCT101 Echo360 / Collaboration

3. Import the edited spreadsheet, adapting the general procedure on importing.

Example - Add New Rooms

When you move a room to another organization:

® Devices associated with the room move to the other organization

® |f a schedule is associated with the room, the schedule is no longer accessible to the originating organization
after the change. The import fails for that room. To avoid this failure, remove the room from the schedule
before moving the room.

This example shows how to add new rooms. For each room, you specify:

® Campus

® Building

® Room

® QOrganization

This example follows the general procedures outlined above.

1. Export the rooms.
a. Navigate to Configuration > Rooms.
b. Scroll to the bottom of the page.
c. Click Export.
d. The room records are exported to a spreadsheet named room-<num>.csv. If you have a spreadsheet
program installed, it opens automatically.
2. Edit the spreadsheet. See General Procedure-Edit the Spreadsheet for details and best practices. The
example below shows an edited spreadsheet ready to be imported.

Campus-Name |Building-Name Room-Mame Organization

South Mew Hal Room 101 Echo3al f AS
South MNew Hal Room 102 Echo36l f AS
South Mew Hal Room 103 Echo3al f AS
South Mew Hal Roam 104 Echo3al f AS

3. Import the edited spreadsheet, adapting the general procedure on importing.__

Example - Edit Existing Users
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This example shows how to edit existing users. When you export and import users you can edit:

Last name.

First name.

E-mail address.

User name.

Password. Passwords are only required for new administrative users, users who require an updated
password, or for organizations not using LDAP. In most cases, you can leave the field blank.

Organization.

® Role. If a user is assigned two roles, you can change either or both roles. If a user is not assigned a role, you
can add up to two roles.

© Student Users must NOT have Organization or Role assigned

If you are importing Student users via the spreadsheet import, be sure there is no Organization
or Role associated with any of the students. The ESS automatically identifies any user with no
role or organization as a Student user.

You can add or change organization roles via import/export, but not section roles. You can, for example, add an
individual to the organization in the Academic Staff role, but you cannot make her an Instructor for a particular
section. To make someone an Instructor, you edit the People and Section Roles setting for the section.

To export and import users, follow the general procedures above.

1. Export users.
2. Edit the spreadsheet. See General Procedure-Edit the Spreadsheet for details and best practices.

3. Import users.

Example - Post EchoCenter Page URLs to an LMS

You do not need to export section properties in order to move a section to a new organization. The section moves
with the course when you move the course.

You might, however, want to use export and import to post EchoCenter URLSs to your LMS.

You do not have to use this method if your LMS is Blackboard Learn or Moodle. You can configure either of these
learning management systems so EchoCenter URLs post automatically. However, if you are using another LMS,
you must copy the URL from the section details page, shown in the below figure, and paste it to the LMS course

page.

Sections

Section
Spring 2011 {

httpeiec2-50-17-99-228.compute-1.amazonaws.com:B080ess/portal/section/Section %201

This can be tedious if you have many URLSs to post. You may prefer the method described here: exporting the URLs
to a spreadsheet and then copy-pasting to the LMS course page from the spreadsheet.

1. Export the sections.
a. Navigate to Schedule > Courses.
b. Scroll to the bottom of the page.
c. Click Export Sections.
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d. All sections for all courses are exported to a spreadsheet named section-<num>.csv. If you have a
spreadsheet program installed, it opens automatically.
2. Copy-paste the URLs from the spreadsheet to the LMS.

Import Courses

In this section:

® Format
® Special Field Descriptions

® CSV Example

Format

Importing courses into the EchoSystem Server (ESS) requires that you create a CSV or "comma-separated-value
file. The file can have any name you want, as long as it contains a .csv extension. The file format must be as
follows:

® There is one course record per line of the file

® The first line of the file should have the column names, as shown in the example below

® Each record value is contained in its own column (if the CSV file is generated by a spreadsheet program,
such as Excel) or is separated by a comma in the flat (text) file.

You may want to generate an export of existing courses (Schedule > Courses > Export Courses) to provide a
formatted CSV file to use as a base.

You can also update course information in the exported file, then reimport the file to apply the changes to the
system.

The column headers and field values are as follows; use UTF-8 ascii characters only:

Field Name Description

Course Name The name of the course, such as Introduction to
Economics.

Identifier An abbreviated identifier for the course, such as

ECON101 or ENG330. This also appears in the ESS
and the EchoCenter.

Organization See Special Field Descriptions below.

Special Field Descriptions

Organization names are comprised of two components:

® Organization name
® Suborganization name (if applicable)

They are separated by a sequence of "<space><forward slash><space>" like this: " /"

A valid organization would look like these examples:
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Organization / suborganization
University

University / math-department
University / nursing-school

CSV Example

Following is an example of the format for this file:

ta L =~ e
Course-Name Identifier Organization
aptus course ASLPL echo3al [ Aptus
Cat Grooming CAT101 echa3el
Course A: pcap test CRS101.F echo3al
Course For Everyone's Use Ceu echo3ed
Denice's course {do not delete) DoD echo3al
ECCourse ec echo3del [ Aptus
Intro o Linguistics LING 101 echa3el
Introduction to Cat Bathing Cat Bathing 101 echo3el
Ldap Course Idapl02 echo3ed
LMI American History: Revolution Imi-his222 echa3el
LMI Deutsch Course vibersetzung Imi-gc echo3al
LMI First Course Imi_fc echo3al
LMI Intro to American History: Colonolization  |Imi_his111 echo3al
Dog Grooming DOGGroom10l echo3el [ rest
test course rest echo3eld [ rest
Test Course 2 testcourse echo3ed
test secl? test secl? echo3al
testlcourse asd echoied

Import Sections

In this section:

Required Configuration
Format

Import Considerations
CSV Example

Required Configuration

Before you can import sections into the EchoSystem Server (ESS), you must have already defined the courses. The
first required field of the sections import is the unique course identifier. This field must match to a pre-existing
course.

The "email" fields in the CSV file must match one of the pre-existing users in the ESS. Users specified in the email
fields of the CSV file but do not have the Academic Staff role in the section's organization will be assigned the role.
You may consider performing a User export (Configuration > Users > Export) to provide you with a list of user
email addresses to use.

Format

Importing sections into the ESS requires that you create a CSV or "comma-separated-value" file. The file can have
any name you want, as long as it contains a .csv extension. The file format must be as follows:

® There is one course record per line of the file.
® The first line of the file must have the column names, as shown in the example below.
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® Each record value is contained in its own column (if the CSV file is generated by a spreadsheet program,
such as Excel) or is separated by a comma in the flat (text) file.

You may want to generate an export of existing sections (Schedule > Courses > Export Sections) to provide a

formatted CSV file to use as a base.

You can also update section information in the exported file, then reimport the file to apply the changes to the

system.

The column headers and field values are as follows; use UTF-8 ascii characters only:

Field Name

Course-ID

Section-Name

Term-Name

Section-URL

External-System-ID1

External-System-ID2

External-System-ID3

External-System-1D4

External-System-ID5

External-System-ID6
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Description

The unique IDs defined in the ESS for the Courses
(which must pre-exist). The easiest way to get this data
is to export the courses (Schedule > Courses > Expor
t Courses) or to create your Course CSV import file,
then import that file immediate before importing the
Section CSV file.

The plain-text name that you want to show to users in
the ESS and in recordings.

Must match a pre-existing term name.
Must be blank. Will be ignored if not blank.

The unique identifier for this section in your LMS.
EchoSystem will use this to publish presentation links
to the correct section.

A second unique identifier for this section in your LMS.
EchoSystem will use this to publish presentation links
to the correct section.

A third unique identifier for this section in your LMS.
EchoSystem will use this to publish presentation links
to the correct section.

A fourth unique identifier for this section in your LMS.
EchoSystem will use this to publish presentation links
to the correct section.

A fifth unique identifier for this section in your LMS.
EchoSystem will use this to publish presentation links
to the correct section.

A sixth unique identifier for this section in your LMS.
EchoSystem will use this to publish presentation links
to the correct section.
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Email-Instructorl

Email-Instructor2

Email-Teaching-Assistantl

Email-Teaching-Assistant2

Email-Guest-Presenterl

Email-Guest-Presenter2

Email-Student-Presenterl

Email-Student-Presenter2

Import Considerations

A pre-existing User that will be associated with this
section as an instructor.

A pre-existing User that will be associated with this
section as an instructor.

A pre-existing User that will be associated with this
section as a Teaching Assistant.

A pre-existing User that will be associated with this
section as a Teaching Assistant.

A pre-existing User that will be associated with this
section as a Guest Presenter.

A pre-existing User that will be associated with this
section as a Guest Presenter.

A pre-existing User that will be associated with this
section as a Student Presenter.

A pre-existing User that will be associated with this
section as a Student Presenter.

If you are importing more than 1,000 sections, divide the sections into multiple independent CSV files where each
has 1,000 or fewer sections. Then import the files separately. For example, if you are importing 2,345 sections, you
could divide them into three separate files with 800, 800, and 745 entries. You would then import the three files.

CSV Example

Following is an example of the format for this file:

Course-1D Section-Name _ Term-Name External-Sy DI External-Sy D2 External-Syste External-Systc External-Sy. External-Gys Emall-Instructorl Emall-Instructor2 | Email-Teaching-Assistant] E
ec Seamless Only  ecterm edinstructor@institut
ASLPL section aptus term aefaultpresenter! lon.edu uday @institution.ecu babu@institution.cdu
ec Ldap aptus term edinstructor@institution edu
Imrac allowal Rest of 2013 dul-tc e Iingle@institution.edu
ec Authentication Rec aptus term ecinstructor@ institution. edu
test test Summer 2013 defaultpresenter @institution.edu
ASLPL section echo,Summer 20111 ucay@institution.edu babu@institution.edu
Ss101 Allow All echo Summer 2011.1 sn.instructor@sn.com
$s5101 Seamless Summer 2013
ASLPL nithya echo.Summer 2011.1 babu@institution.edu
ec Allow All ecterm
ss101 Allow All Summer 2013
ec Seamless Only  aptus term ecinstructor@ nstitution.edu
rest rest_section restterml restinstry ri@rest.in
Im-ac seamless Rest of 2013 sot lingle@institution.edu
t restSection echo Summer 2011.1 restinstructor@rest.in restta@rest.in
test comma Nithya, section;adc Device Deletion test@test.org
t restSection restrerm1 restinstructor@rest.in restta@rest.in
$s101 Idap Summer 2013 sn.instructor@sn.com
ec Allow All aptus term ecinstructor@institution.edu
ASLPL sysAptus section  aptus term uday@institution.edu babu@institution.edu
ASLPL Aptus section aptus term uday @institution.edu babu@institution.edu
Im-ac ldap Rest of 2013 dess2 dess act11itest dul lingle@institution.edu spanish@ingle.org
55101 Auth regd Summer 2013 sn.assistant@sn.com
Im-ac authonly Rest of 2013 act1il german@ingle.arg lingle@institution.edu
ec Auth Only aptus term ecin: @nstitution. edu
ec Authentication Rec ecterm du
ec aptus LDAP ecterm i B ion.edu
CRS101.F CRS10L.EO0L  echo,Summer 20111 CRS102.E.001 CRS102.E.001.1 rinstructor @institution.edu uday@institution.edu rta@institution.edu
Cat Bathing 101 Introduction to Ca Summer 2013 bronwyngagne@gmail.com

Import Rooms
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In this section:

® Format
® Special Field Descriptions

® CSV Example

Format

Importing rooms into the EchoSystem Server (ESS) requires that you create a CSV or "comma-separated-value"
file. The file can have any name you want, as long as it contains a .csv extension. The file format must be as
follows:

® There is one room record per line of the file

® The first line of the file should have the column names, as shown in the table below

® Each record value is contained in its own column (if the CSV file is generated by a spreadsheet program,
such as Excel) or is separated by a comma in the flat (text) file.

You may want to generate an export of existing rooms (Configuration > Rooms > Export) to provide a formatted
CSV file to use as a base.

You can also update room information in the exported file, then reimport the file to apply the changes to the system.

BE ADVISED:

* A new campus will be created if there is no pre-existing campus identified by "Campus-Name".
* A new building will be created if there is no pre-existing building identified by "Building-Name".

The column headers and field values are as follows; use UTF-8 ascii characters only, and the fields, except
Organization, are limited to 50 characters:

Field Name Description

Campus-Name The name of the Campus on which the room resides. If
the Campus-Name entered does not already exist, it
will be created on import.

Building-Name The name of the building in which the room exists. if
the Building-Name entered does not already exist, it will
be created on import.

Room-Name The name to be given to the room. This appears in the
ESS interface and is the room selected for device and
schedule assignment.

Organization See Special Field Descriptions below.

Special Field Descriptions

Organization names are comprised of two components:

® Organization name
® Suborganization name (if applicable)

They are separated by a sequence of "<space><forward slash><space>" like this: " /"
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A valid organization would look like these examples:

Organization / suborganization
University

University / math-department
University / nursing-school

CSV Example

Following is an example of the format for this file:

A B ___________c | D E
Campus-Name Building-Name |Room-Name Organization
BethesdaCampus aptus building  Room G-2 echo3e0 f rest
BethesdaCampus aptus building Room G-1 echo360 f Aptus
BethesdaCampus aptus building Room B-1 echo360 f shruthi
BethesdaCampus aptus building Room A-L echo3el
BethesdaCampus aptus building Room B-2 echio3e0
BethesdaCampus aptus building  Room A-2 echo3e0 f rest
DullesCampus echo.Building Dulles Auditorium echo3el
DullesCampus echo.Building Dulles Auditorium echo3e0
DullesCampus echo.Building Dulles Auditorium echo3e0
DullesCampus echo.Building Dulles Auditorium echo3al
DullesCampus echo.Building Dulles Auditorium echo3e0
DullesCampus echo.Building Dulles Auditorium echo3el
NOVACampus Cap2 Bullding |Room 4 echio3e0
NOVACampus Cap?2 Building |Room 1 echo3e0 f rest
NOVACampus Cap2 Bullding |Room 2 echo3el
NOVACampus Cap2 Building |Room 3 echo3e0
NOVACampus Capd Buillding Room & echo3e0 f rest
NOVACampus Cap2 Bullding |Room Ba echo360 f Aptus

Import Users

In this section:

® Format
® Special Field Descriptions

® CSV Example

Format

Importing users into the EchoSystem Server (ESS) requires that you create a CSV or "comma-separated-value" file.
The file can have any name you want, as long as it contains a .csv extension. The file format must be as follows:

® There is one user record per line of the file

® The first line of the file should have the column names, as shown in the table below

® Each record value is contained in its own column (if the CSV file is generated by a spreadsheet program,
such as Excel) or is separated by a comma in the flat (text) file.

You may want to generate an export of existing users (Configuration > Users > Export) to provide a formatted
CSV file to use as a base, and to show you how the CSV fields correspond with the fields in the ESS user interface.

You can also update user information in the exported file, then reimport the file to apply the changes to the system.
NOTE: You cannot set or update the Password for existing users. The password field is only usable for new users
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you are creating via the import.

The column headers and field values are as follows; use UTF-8 ascii characters only:

Field Name Description

Last-Name The last name of the user. Limit 50 chars

First-Name The first name of the user. Limit 50 chars

Display-Name The user's name as it appears in the interface, typically
First Name Last Name. Limit 50 chars

Email The user's email address. Limit 128 chars

User-Name The username to be used for logging into the system.
Limit 50 chars

Password The password to be used for logging into the system.
No Char limit. Can only be used for new users being
created by the import. You cannot use the import to set
or update passwords for existing users.

Organization-Role-Namel Do not populate for Student Users. Required for all
other user types. See Special Field Descriptions.

Organization-Role-Name2 See Special Field Descriptions.

Organization-Role-Name3 See Special Field Descriptions.

Organization-Role-Name4 See Special Field Descriptions.

Organization-Role-Name5 See Special Field Descriptions.

Special Field Descriptions

The Password field is applicable only for a new users. You cannot use a CSV import to set or update the password
for existing users.

Organization role names are comprised of two components, separated by a semicolon:

® Organization name and sub organization name (if applicable), separated by a sequence of "<space><forward
slash><space>" like this: " /"
® The role value, selected from the following list:

role-name-system-admin (or system-admin)
role-name-academic-staff (or academic-staff)
role-name-admin (or admin)
role-name-av-technician (or av-technician)
role-name-license-manager (or license-manager)
role-name-scheduler (or scheduler)

A valid Organization-Role-Name would look like these examples:

® Organization / suborganization;role-name-system-admin
® University/department;role-name-academic-staff
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Except for Student user imports, you must have one organization role name assigned to each user. Additional
organization role names may be provided, but are not required. If a user has only one organization role, then you do
not need to include the additional commas to "space out" the blank columns.

Student users must NOT have an organization or a role associated with them. Any user without an organization or
role is automatically recognized by the ESS as a Student.

CSV Example

Following is an example of a user import CSV file open in Excel:

A B c D E F i G i H 1
Last-Name  First-Name Emall User-Name Password  Organization-Role-Name1 Organization-Role-Name2 | Organizatian-Role-Name3
Dennis :: Dennis.Abbett@institution.edu dennis.abbatt echa360 / Presenters; role-name-academic-staff
Glen Glen.Abbott@institutien. edu glen.abbat echa360 / Presenters; role-name-academic-staff
Julle Julle. Abbor@institution.edu julie.abborc echo360 / Presenters; role-name-academic-staff
Marion Marlon.Abbett@instiution.edu marian.abbott echo360 / Presenters; role-name-academic-staff
Martha Abbott Martha Martha. Abbokt® nstitution.edu martha.aboatt echo360 / Presenters; role-name-academic-staff
Monica Abbott Monica Monica.Abbott@institution.edu manica.abbott echo360 / Presenters; role-name-academic-staff
Phyllis Phyllis.Abbatt@institution.edu phyllis.abbott echo360 / Presenters; role-name-academic-staff
Susan Susan.Abbott@institution.edu susan.abbott echo360 / Prese s, role-name-academic-staff
oy Troy.Abbort@institution.edu troy.abbott echa360 / Presenters; role-name-academic-staff
Vicki Vicki.ABbott@institution.edu vicki absatt echa360 / Presenters; role-name-academic-staff
wWanda Wanda.Abbatt@ins edu wanda.abbott echo360 / Presenters; role-name-academic-staff
Christine Abrams Christine  Christine.Abrams@institution.edu christine.abrams echa360 / Presenters; role-name-academic-staff
Gary Abrams Gary Gary.Abrams@instiwtion.edu gary.abrams echo360 / Presenters; role-name-academic-staff
Heid Abrams Heid Heidl.Abrams@institution.edu heldl.abrams echo360 / Presenters; role-name-academic-staff
Howard Abrams Howard Howard.Abrams@institution.edu howard.abrams echo360 / Presenters; role-name-academic-staff
Kathryn Abrams Kathryn Kathryn.Abrams@institution.edu kathryn.abrams echo360 / Presenters, role-name-academic-staff
Lisa Abrams Lisa Lisa.Abrams@institution.edu lisa.abrams echo360 / Presenters; role-name-academic-staff
Max Abrams Max Max.Abrams@institution.edu max.abrams echo360 / Prese rs; role-name-academic-staff
Patricia Abrams Patricia Patricia.Abrams@institution.edu patricia.abrams echo360 / Pres: s, role-name-academic-staff
Terr Abrams Terr Terri. Abrams @insticution.edu terri.abrams echa360 / Presenters; role-name-academic-staff
Tina Abrams Tina Tinz.Abrams@instizution.edu tina.abrams echo360 / Presenters; role-name-academic-staff
Veronica  Abrams Abrams Veranica  Veronica.Abrams@institution.edu veronica.abrams echa360 / Presenters; role-name-academic-staff
Alexandra  Adams Adams Alexandra  Alexandra.Adams@instiwtion.edu alexandra.acams echo360 / Presenters; role-name-academic-staff
Allison Adams Adams Allison Allison. Adams@institution.edu allison.adams echo360 / Presenters; role-name-academic-staff
Elisabeth  Adams Adams Elisabeth  Elisabeth. Acams@ nstitution.edu elisabeth.adams echo360 / Presenters; role-name-academic-staff
Tony Adams Adams Tany Tony.Adams@institution.edu tony.adams echo360 / Presenters, role-name-academic-staff
Dwight Adcock Adcock Dwight Dwight. Adcock@institution.edu dwight.adcock echo360 / Presenters; role-name-academic-staff
Erica Adcock Adcock Erica Erica. Adcock@ nstitutio: erica.adcock echo360 / Prese rs; role-name-academic-staff
Evan Adcock Adcock Evan Evan.Adcock@institu evan.adcock echo360 / Prese s, role-name-academic-staff
Pam Adeock Adcock Pam Pam.Adcock@inst pam.adcock echa360 / Presenters; role-name-academic-staff
ehillia Adcack Adcock hillip Phillip. Adcock@ins: . phillip.adcock echa360 / Presenters; role-name-academic-staff
Sherry Adcack Adcock Sherry Sherry. Accock @ nstitution.edu sherry.adcack echa360 / Presenters; role-name-academic-staff

Import Schedules

In this section:

Required Configuration

Format

Import Considerations

Updating Schedules via Export then Import

CSV Example

Required Configuration

Before you can import schedules into the EchoSystem Server (ESS), you must have already defined the dependent
configuration items, including rooms, terms, courses, and sections, among others. For example, the Presenter field
in the CSV file must contain either the name or email address of users who already exist in the ESS.
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Best Practice: Use Other Exports for Schedule Import Field Data

Because many items in the CSV file must already be defined in the system, you can generate
exports from the ESS to provide you with fields to copy and paste into the CSV import file. The
advantage of this method is that the copied fields are accurate and already have the proper
formatting, reducing errors caused by manual input. If you are generating a list of new schedules
to add to the system, you can:

Perform an export of your existing schedules (Schedule > Schedules > Export). This will
provide a template to work with and show you how the final imported CSV should look.

Use a Room Export (Configuration > Rooms > Export) to provide the following fields for
copy:

® Campus Name
® Building Name
® Room Name

Use a Section Export (Schedule > Courses > Export Sections) to provide the following
fields for copy:

Term Name

Course Name

Section Name

Presenter Email (if needed) - Can be copied from the Instructor Email, Teaching
Assistant Email, Guest Presenter Email, and/or Student Presenter Email fields.

Product Group and Properties field data can be obtained by performing an export of your current
schedules (Schedule > Schedules > Export) and copying the appropriate Product
Group/Properties fields to the new schedule import file.

Alternately, if many of the above-listed fields will not differ from your current schedule data, you
can run a schedule export, update the necessary fields, and save the file for importing. Be sure
to remove the Schedule-ID field for new schedules. See also Updating Schedules via Export then

Import.

Format

Importing schedules into the ESS requires that you create a CSV file that contains the following attributes:

There is one schedule record per row/line of the file;

The first row/line of the file must have the column names (a header row);

If you are using a comma-delimited-text file, each field (record value) must separated by a comma,;

If you are using a spreadsheet program such as Microsoft Excel to generate the CSV file, each field must

reside in a different column;

® Multiple values within a single field must be separated by a bar. For example, Mon|Wed|Fri to indicate
multiple days of the week;

® All fields must contain only UTF-8 ascii characters.

The column headers and field values are as follows; use UTF-8 ascii characters only:

Field Name Description
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Schedule-ID

Term-Name

Course-Name

Section-Name

Title

Description

Campus-Name

Building-Name

Room-Name

Recurring

Start-Date

Start-Time
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System Identifier for the schedule. This cell must be
empty for new schedules and is only required if you are
updating an existing schedule.

Name of the existing term associated with the
schedule. Maximum 50 characters.

Name or Course ID of the existing course associated
with the schedule.

Name of the existing section associated with the
schedule.

Title to be given to the schedule being created (or
updated). Maximum 200 characters.

Description to be given to the schedule being created
(or updated). Maximum 1000 characters.

Name of the existing campus associated with the
schedule.

Name of the existing building associated with the
schedule.

Name of the existing room where the scheduled
capture is to take place.

Indicates whether the schedule is recurring or not. Valid
values: TRUE and FALSE (not case sensitive).

Date the schedule is to begin. Valid formats include
yyyy-mm-dd and mm/ddlyy.

Start time for the scheduled capture. Enter in 24-hour
format: hh:mm:ss
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End-Time Can either be the time the scheduled capture must end
OR the duration of the capture. Enter only one as

OR follows:

Duration ® Enter End-Time in 24 hour format: hh:mm:ss.

For example 13:00:00 for 1pm.

® Enter Duration (length of time) for the capture.
To use Duration instead of End-Time be
advised of the following:

1. You MUST change the column header
to Duration.

2. You must enter an h to indicate hours,
or an m to indicate minutes. Any
number entered without an indicator is
recognized as "seconds" by default.

3. You can only enter a single unit of
measure for each schedule, using
either minutes OR hours OR seconds.

For example:

® To indicate a schedule lasting 50
minutes, enter 50m into the field.

® For a schedule lasting an hour and a
half, enter 90m in the field. Do NOT
enter "1h 30m". Mixing units will cause
the import to fail.

® For a schedule lasting two hours, you
could enter either 2h or 120m into the
field.

NOTE: You cannot create a schedule longer than four
hours. Any schedules longer than four hours will not be
imported.

End-Date Required only for recurring schedules. Date of the last
day for the schedule. Valid format: yyyy-mm-dd or
mm/dd/yy.
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Days-of-Week

Excluded-Dates
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Required only for recurring schedules. Days that the
scheduled capture must run.

Valid values are three-letter day abbreviations: sun,
mon, tue, wed, thu, fri, sat, sun. Separate multiple
values with a bar. For example, a Monday,
Wednesday, Friday schedule is entered as mon|wed|fr
i

Use English Values for Days of
the Week

You MUST use the English values
for days as listed above. Using
localized language versions for
days of the week will cause the
import to fail.

Used for recurring schedules only but not required if not
applicable. Specific dates or date range(s) when the
schedule should not run. These might include exam
dates for a course, school holidays, or spring break.
Valid format: yyyymmdd for a single day;
yyyymmdd-yyyymmdd for a range. Separate multiple
entries with a bar.

For example, the entry:
20130218|20130324-20130331|20130506-20130510
would exclude February 18 (for President's Day),
March 24-31 (for Spring Break), and May 6-10 (for final
exams).
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Status Indicates the desired status for the schedule being
created. Valid values (not case sensitive):

® Draft - Schedule exists but will not run until
activated.

® Active - Schedule exists and will run
according to configured parameters.

® Complete - Schedule end-date has passed or
is non-recurring and has already happened.

® Trashed - Deletes the schedule from the
system. Allows for bulk deletions of
schedules.

This field is required. For any record where Status is
blank, that schedule will not be imported to the system.

Use English Values for Status

You MUST use the English values
for Status as listed above. Using
localized language versions for the
Status field will cause the import to
fail.

Presenters Identifies the presenters for the schedule. Typically this
includes the Academic Staff member teaching the
course, and possibly one or more Teaching Assistants.
Separate multiple values with a bar. Valid formats
include:

® Email address - Email address is
recommended as it is less prone to variation
and error.

® |astname:firstname

® Username

Product-Group Product Group Name for the schedule. To reduce the
possibility of entry error, use one of the following two
methods to enter this information:

* Navigate to Configuration > Product
Groups, select the name of the group you
want to use, then copy the title of the group
from the top of the page.

® Perform an export of your existing schedules,
and copy the desired Product Group
information from the export.

Properties
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Not required, but can be used to specify additional
capture properties that are not indicated or are different
from those provided through the Product Group
defaults. Separate multiple properties/values with a bar.
For example:
Live=true|echo-initally-unavailable=false|Aspect-ratio-o
verride-channel-1=widescreen

It does not matter what order the values are entered
into this field.

Property values and formats are as follows:
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® live: Indicates if the schedule is set for live
streaming. Valid values are True or False (not case
sensitive). Sample entry: live=true. Setting to "true"
means schedule will be streamed live if otherwise
supported by the assigned room and product group.

® Echoes-initially-unavailable: Use to mark the
echoes captured by this schedule as initially
unavailable. Valid values are True or False (not case
sensitive). Sample entry:
echoes-initially-unavailable=true. NOTE: If you are
using Live streaming, do NOT mark this as "true".

® aspect-ratio-override-channel-1: Specifies the
aspect ratio to use for channel 1 (Primary
Display/Secondary Video). Applicable for SCHD
captures only. Sample entry:
aspect-ratio-override-channel-1=widescreen. Valid
values are Standard or Widescreen (not case
sensitive).
Standard aspect ratio for display and video = 4:3.
Widescreen aspect ratio for video = 16:9.
Widescreen aspect ratio for display = 16:10.

® Aspect-ratio-override-channel-2: Specifies the
aspect ratio to use for channel 2, (Primary
Video/Secondary Display). Applicable for SCHD
captures only. Sample entry:
aspect-ratio-override-channel-2=widescreen. Valid
values are Standard or Widescreen (not case
sensitive).

® Display-input-resolution-override: Specifies the
resolution to be used for non-SCHD captures that
capture Display input (not applicable for
audio/video-based captures). Sample
entry: display-input-resolution-override=1280x720.
Valid values are:

® 800x600

1024x768

1280x720

1280x768

1280x800

1280x1024

1366x800

1440x900

1600x1200

1680x1050

Import Considerations

If you are importing more than 1,000 schedules, divide the schedules into multiple independent CSV files where
each has 1,000 or fewer schedules. Then import the files separately. For example, if you are importing 2,345
schedules, you could divide them into three separate files with 800, 800, and 745 entries. You would then import the
three files.
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You may also want to consider using separate CSV files for different categorizations of schedules, especially if you
have a large number of schedules to import. For example, create one CSV file for all schedules planned for a certain
room. In this case, the Campus-Name, Building-Name, and Room-Name fields would be the same for all entries on
the spreadsheet. In addition, if the other settings generally remain static for the room across terms (such as Product
Groups or Course Names used for the room), you could reuse the spreadsheet for importing subsequent terms'
schedules, requiring changes to fewer fields.

Updating Schedules via Export then Import

The Schedules page allows you to export a list of all existing schedules. The generated CSV file contains the same i
nformation and format as the schedule import CSV must contain. This allows you to:

® Create new schedules using existing schedule data:

a. Generate an export.

b. Remove the Schedule-ID field data
c. Update other fields as needed.

d. Reimport the file.

® Update existing schedules (for example, set all Draft schedules to Active):

a. Generate an export.
b. Update necessary fields.
c. Reimport the CSV file.

® Delete existing schedules (for example, set all Active schedules to Trashed):

a. Generate an export.
b. Update the Status field for appropriate schedules to Trashed.
c. Reimport the CSV file.

Keep in mind that if you do use a schedule export CSV file as the base from which to work, the Schedule-ID field
specifically identifies existing schedules. This means:

® Any field changes made to a row where the Schedule-ID field exists will apply those changes to the existing
schedule.

® To create a NEW schedule, be sure the Schedule-ID field is blank. The ESS will create a schedule ID when it
creates the schedule.

CSV Example

The figure below shows a portion of a sample CSV file that creates new schedules ready for import. The figure
shown is the CSV file open in Microsoft Excel.
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A B C D E F G H 1 J K L M N
Schedule-I0 | Term-Name  Course-Name Section-Name Title Description  Campus-Name Bullding-Name Room-Name  Recurring Start-Date Start-Time Duration End-Date Days-Of-Wee!
2013 Dog Grooming 2000 Dog Grooming (DOG101-200 Echo360 EchoBullding Echo SCHD[D TRUE 1/7/13 9:00: 50m 5/10/13 mon|wed|fri
‘term test test course  test Section12 test course (test course-test Echo360 EchoBuilding  Eche SCHDI| FALSE 1/7/13 1 50m 5/10/13 mon|wed|fri
term test test course  test Section12 test course (test course-test Echo360 EchcBullding Eche SCHI FALSE 1/7/13 1 50m §/10/13 mon|wed|fri
echo.Summer Course A: pca CRS101.R.001 Course A: pcap test (CRS101 Echo360 EchoBullding Echo SCHI FALSE 1/7/13 1 50m 5/10/13 mon|wed|fri
2013 Dog Groaming 2000 Dag Greaming (DOG101-200 Echo360 EchoBullding Echo SCHI TRUE 1/7/13 1 50m 5/10/13 mon|wed|fri
2013 Dog Grooming 2000 Dog Grooming (DOG101-200 Echo360 EchoBullding Echo SCHI TRUE 1/7/13 1 5/10/13 mon|wed|fri
2013 Dog Groaming 2000 Dag Grooming (DOG101-200 Echo360 EchoBuilding  Echo SCHD[ TRUE 17/13 1 5/10/13 mon|wed|fri
2013 Intro to Lingul UrsuMWF sect Intre to Linguistics (LING 10 echo.campus echo.building Echo Device 1 TRUE 1/7/13 1 5/10/13 mon|wed|fri
aptus term EC-course ECAllow All EC-course {ec-ECAllow All) a| Echo360 EchoBullding Eche SCHD[D TRUE 1/7/13 5/10/13 mon|wed|fri
2013 Curso tradiciol ldap Cursa tradicional en espa_(c echo.campus echa.building Echo Device 1 TRUE 1/7/13 5/10/13 mon|wed|fri
2013 Nithya Course Section Name Nithya Course (Media Identifi echo.campus echo.building Echo Device 1 FALSE 1/7/13 5/10/13 mon|wed|fri
2013 Nithya Course Section Name Nithya Course (Media Identifiecho.campus echo.building Echo Device 1 FALSE 1/7/13 5/10/13 mon|wed|fri
2013 Nithya Course Section Name Nithya Course (Media Identifi echo.campus echo.building Echo Device 1 FALSE 1/7/13 5/10/13 mon|wed|fri
2013 Nithya Course Monitor and ¢z Monitor and capture tab echo.campus echo.building Echo Device 1 FALSE 1/7/13 5/10/13 tue|thu
2013 Nithya Course Section Name Nithya Course (Medla Identifi echo.campus echa.building Echo Device 1 FALSE 1/7/13 5/10/13 tue|thu
2013 Org media del org delete exp Org media delete Nithya (dsf Echo360 EchoBuilding FEcho Device = FALSE 1/7/13 5/10/13 tue|thu
2013 Nithya Course section test us test users default Echo360 EchoBullding  Echo FALSE 1/7/13 5/10/13 tue|thu
aptus term EC-course ECSeamless  EC-course (ec-ECSeamless) ¢ Echo360 EchoBuilding  Echo FALSE 17j13 5/10/13 tue|thu
2013 security Seamless security (sec101-Seamless) i Echo360 EchoBullding  Echo FALSE 1/7/13 5/10/13 tue|thu
2013 security Auth regd security (sec101-Auth reqd) Echo360 EchoBullding Echo FALSE 1/7/13 5/10/13 tue|thu
2013 security Seamless security (sec101-Seamless) : Echo350 EchoBuilding  Echo FALSE 1/7/13 5/10/13 tue|thu
2013 security Allow all security (sec101-Allow all) 2( Eche360 EchcBullding  Eche FALSE 1/7/13 §/10/13 tue|thu
2013 security Allow all security (sec101-Allow all) 2( Echo360 EchoBullding Echo FALSE 1/7/13 5/10/13 tue|thu
2013 security Seamless  serurlty (secl01-Seamless) : Echo360 EcheBullding  Echo FALSE 1/7/13 5/10/13 tue|thu
2013 security Allow all security (sec101-Allow all) 2( Echo360 EchoBullding  Echo FALSE 1/7/13 5/10/13 tue|thu
2013 security Seamiess security (sec101-Seamless) : Echo360 EchoBuilding  Echo FALSE 1/7/13 5/10/13 tue|thu
2013 security Allow all security (sec101-Allow all) 2 Echo360 EchoBullding  Echo [ FALSE 1/7/13 5/10/13 tue|thu
2013 security Auth regd security (sec101-Auth reqd) echo.campus echo.building Echo Device I TRUE 1/7/13 5/10/13 tue|thu
2013 security Auth reqd  security {sec101-Auth recd) echo.campus echa.building Echo Device 1 TRUE 17/13 5/10/13 tue|thu
2013 security Auth regd security (sec101-Auth regd) echo.campus echo.building Echo Device 1 TRUE 1/7/13 5/10/13 tue|thu
2013 security Idap security (sec101-1dap) 2013 Echo360 EchoBullding Echo SCHD[D FALSE 1/7/13 5/10/13 mon|wed|fri
2013 security Idap security (sec101-ldap) 2013 Echo3s0 EchoBuilding  Echo SCHD[D  FALSE 1/7/13 5/10/13 mon|wed|fri
2013 security Idap security (sec101-1dap) 2013 Eche360 EchcBullding Eche SCHD[D FALSE 1/7/13 §/10/13 mon|wed|fri
2013 security Idap security (sec101-ldap) 2013 echo.campus echo.building Echo Device 1 FALSE 1/7/13 5/10/13 mon|wed|fri
2013 security idap security (sec101-Idap) 2013 Echo360 EchoBuilding Echo SCHD[D  FALSE 1/7/13 5/10/13 mon|wed|fri
2013 security Idap security (sec101-1dap) 2013 Echo360 EchoBullding Eche SCHD[D FALSE 1/7/13 5/10/13 mon|wed|fri
2013 security Idap security (sec101-ldap) 2013 Echo360 EchoBuilding Echo Device 2 FALSE 17/13 5/10/13 mon|wed|fri

There are also two sample schedule import files attached to this page; a sample using End-Time and a sample
using Duration for the schedules listed.

Viewing CSV Exports in Other Languages

In this section:

® Qverview
® Setting Encoding for Excel and Open Office

Overview

EchoCenter supports viewing the system and its components in the following languages: Arabic, English, French,
German, Japanese and Spanish.

The CSV export functions are configured for UTF-8 character encoding. If you plan to view an exported CSV file in
Arabic or Japanese, there are specific choices you must make in order to import the CSV file into the spreadsheet
program properly.

While we did not test all operating system and software combinations, the information provided here should provide
sufficient guidelines to apply to other configurations as needed.

The instructions provided below apply to all CSV exports from the ESS, including object exports such as user or
course export, as well as Personal Capture licensing exports and all report exports to CSV.

© Encoding Configuration is NOT supported for Excel on Mac OS X

The language encoding selection process noted here is not supported on Excel for Mac OS X.

Setting Encoding for Excel and Open Office

Use the below instructions to set language encoding for Excel on Windows 7, or Open Office on either Windows 7 or
Mac OS X. The steps provided here were generated for Open Office 3.4.1.
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Language

Arabic

Arabic

Arabic

Japanese
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Operating System

Windows 7 SP1

Windows 7 SP1, Mac OS
X 10.6.8

Mac OS X 10.6.8

Windows 7 SP1

Software

Excel 2007, 2013

Open Office 3.4.1

Excel 2011

Excel 2007, 2013

Steps

Choose language
encoding during CSV
import

1.

Create a new
worksheet. This
activates the buttons
in the tabs.

Click the Data tab.
Click the From Text b
utton.

Navigate to the CSV
file you exported from
the ESS, and
double-click it, or
highlight it and click |
mport. The Text
Import Wizard
appears.

. Select Delimited for

the data type.

In the File Origin drop
-down list, select Unic
ode (UTF-8).

Click Next

From the list of
Delimiters, select Co
mma and de-select T
ab (selected by
default).

Click Finish.

Create a new
spreadsheet.

Click the Open icon.
From the Character
Set drop-down list in
the Import section,
select Unicode UTF-8

From the list of
Separated By options,
select Comma.

Click OK

Unsupported

Option 1: Choose
language encoding during
CSV import
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9.

. Create a new

worksheet. This
activates the buttons
in the tabs.

Click the Data tab.
Click the From Text b
utton.

Navigate to the CSV
file you exported from
the ESS, and
double-click it, or
highlight it and click |
mport. The Text
Import Wizard
appears.

Select Delimited for
the data type.

In the File Origin drop
-down list, select Japa
nese (Shift-JIS).
Click Next

From the list of
Delimiters, select Co
mma and de-select T
ab (selected by
default).

Click Finish.

Option 2: Set language
encoding for Excel
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Japanese Windows 7 SP1, Mac OS
X 10.6.8
Japanese Mac OS X 10.6.8

Manage Licenses

In this section:

® Qverview

® License Types

® Download and Update Licenses

® |nterpreting the Licensing Interface
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Open Office 3.4.1

Excel 2011

. Open Excel Options,

either by clicking the
Office logo in the
upper left corner, or
using the File tab.

. Open the Language

Settings (select Popul
ar > Language
Settings or select La
nguage in the left
sidebar, depending on
the Excel version you
are using).

. In the Editing

Languages section,
select Japanese from
the drop-down list,
and click Add.

. If appropriate,

highlight Japanese
from the Editing
Language list and
click Set as Default.

. Click OK.

. Create a new

spreadsheet.

. Click the Open icon.
. From the Character

Set drop-down list in
the Import section,
select Unicode UTF-8

. From the list of

Separated By options,
select Comma.

. Click OK

Unsupported



EchoSystem 5.5 Documentation

Overview

Licensing your EchoSystem installation involves the following phases:

1. Purchasing the appropriate types of licenses for your configuration.

2. Downloading the licenses to your EchoSystem Server (ESS). Even if you have an existing licensed ESS
system, you may need to update your license configuration to accommodate any system upgrades, such as
to a new ESS version with associated updated components.

3. Assigning licenses to rooms or individuals as necessary. If your capture licenses are all Site licenses, you do
not need to configure these further. If you purchased Personal Capture licenses, you should plan to review
and, if necessary, adjust those individual license assignments.

License Types

Some of the licenses you can purchase are service-type licenses, meaning they apply to a single server or service.
Those licenses are listed below.

® Echo360 Feature Licenses - Feature licenses provide access to specific Echo360 features including:

® Media Import (EMI) License - Allows users to import external media files to the ESS for distribution
along with the section's Echoes.

® Collaboration and Statistics Server (sometimes also called HEMS) - Allows for the use of collaborati
on services such as discussions for Echoes and chat for live webcasting.

® Download Presentation License - Allows users to download the EchoPlayer browser-based playback
of echoes (rather than just a podcast or vodcast download). The option to provide EchoPlayer
downloads is configurable at the Organization and Section level.

Once these licenses are purchased and downloaded to the
ESS, no more configuration is required.

The other licenses required for your system are capture-type licenses and apply to the devices used to capture
classroom activity. These licenses can be either "Site" or "Room" licenses. Site licenses apply to all installations of
the licensed capture device and require no further configuration. Room licenses are purchased in bundles and must
be assigned to each room where the capture device is located.

Capture licenses include the following:

® Capture Appliance Licenses - Allows for use of the EchoSystem Capture Appliance (the "1G appliance").

¢ SafeCapture HD Licenses - Allow for use of the EchoSystem SafeCapture HD (the "2G appliance").

® Classroom Capture Licenses (formerly called Software Capture) - Allows for the installation and use of Clas
sroom Capture Software on the podium PC in a lecture venue.

The remaining type of license available is a Personal Capture license. These are used to license individuals to
use Personal Capture to prepare and publish presentations for their courses using their personal PC or laptop.
These are available only as license bundles that are then assigned to individual staff members.

Download and Update Licenses

After you purchase new licenses or update your existing licenses, your account information is updated on the
Echo360 license control server (LCS). Your account license information is recognized using the Customer Identifier
you receive from Echo360.

Licensing EchoSystem is required to begin capturing lectures. Before downloading and updating your license
information, you must:
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® Purchase the appropriate licenses from Echo360. Contact Echo360 Technical Support for more information.

® Enter your Customer Identifier into the System Settings.

® Have outbound Internet access for the ESS, to allow the ESS to contact the LCS to update your license
information.

To download and update your licenses:

1. Login to the ESS using the default Administrator account: ess@echo0360.com

2. Navigate to System > Licensing.

3. Click Update. If licensing is successful, a message appears above the license list indicating that the licensing
information was updated successfully.

Interpreting the Licensing Interface

The Licensing page lists all of your available licenses, both server-type and capture-type licenses as well as any
Personal Capture (formerly called EchoCapture Personal or PCAP) licenses you may have purchased. The
Limitations field on the Licensing page identifies the Device Type of the license, and whether the license is a Site
License or a Room License. Room Licenses are indicated in the Limitations list by identifying a Target of "ROOM"
and showing a Quantity of total licenses in the license bundle. All Personal Capture licenses have a Target of
"PRESENTER".

Because the license names are not always intuitive, the following figure shows a sample License page, and includes
highlighting to help you identify which licenses apply to what features.

Licenses
Mame Products Limitations
Features License, |D 2013-11-01-002032, HEMS N/A - Site License

Podcast Audio, Enhanced Podcast Audio, Screen Podcast, Video Podcast,
EchoPlayer Display, EchoPlayer Display and Video, EchoPlayer Video,
EchoPlayer Dual Video, EchoPlayer Dual Display, Live Display, Live Dual Display,
Live Video, Live Display and Video, Live Dual Video

Wowza FULL 3.0 License, D 2013-12-06-001887 1 Pro Unlimited edition

Podcast Audio, Enhanced Podcast Audio, Screen Podcast, Video Podcast,
EchoPlayer Video, EchoPlayer Display, EchoPlayer Display and Video

Podcast Audio, Enhanced Podcast Audio, Screen Podcast, Video Podcast,
EchoPlayer Video, EchoPlayer Display, EchoPlayer Display and Video

Podcast Audio, Enhanced Podcast Audio, Screen Podcast, EchoPlayer Display,
EchoPlayer Display and Video, EchoPlayer Dual Video

Features License, |D: 2013-12-12-000021, Download Presentation NiA - Site License

Podcast Audio, Enhanced Podcast Audio, Screen Podcast, EchoPlayer Display, . . .
Product License Classroom Capture, 1D 2014-01-08-001844, Producti EchoPlayer Display and Video, EchoPlayer Dual Video Target: ROOM, Quantity: 10; Device Type: Classroom Capture

Product License, |D 2013-04-22-001877, Preduct(s): 2 channel PRO Target: ROOM, Quantity: 20; Device Type: SafeCapture HD

Product License EMI, ID 2011-08-04-001138, External Media Ingest , | Device Type: Media Import
Target: ROOM, Quantity: 20; Device Type: Capture Appliance

Product License Capture Appliance, |D 2011-08-04-001838, Product(s

Product License - PCAP, ID 2011-08-04-001826, Product(s): Podcast Target: PRESENTER, Quantity: 25; Device Type: Personal Capture

The following table lists the terms in each of the license names that identifies the kind of license it is.

If This Term Appears in the License Name... It is a license for this device or service

Product(s): 2 channel PRO SafeCapture HD

EMI and External Medial Ingest External Media Import or EMI

HEMS Collaboration and Statistics Service

PCAP Personal Capture

Download Presentation Provides an EchoPlayer checkbox in the EchoCenter

section of the Organization Settings and Section
Settings pages. Allows users to download the full
EchoPlayer for an echo.

Capture Appliance EchoSystem Capture Appliance

Software Capture Classroom Capture
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Understanding the identifier in the License Name is important, because when you assign room licenses, you are
presented with a drop-down list containing only the license name. You will need to know which license to select for
assignment to each room.

The below figure shows a sample drop-down list from the Room Assignments licensing page, with highlights of the
License Name text that identifies the license type, as defined above. The same drop-down list appears when you as
sign a capture appliance or classroom capture installation to a room.

License : » ail
License [Product License Software Capture, 1D 2011-02-10-001844, Product(s): Podcast, Enhanced Podeast, Vodcast, Rich Media Audio , Expires 2015-07-08T00:00:00.000Z |
Available License [Product License, ID 2011-04-13-001877, Product(s): 2 channel PRO , Expires 2014-06-03T00:00:00.0002 |
Room License [Product License Capture Appliance, ID 2011-02-10-001838, Product(s): Podcast, Enhanced P...n Vodcast, Video Vodcast, Rich Media Audio, Rich Media Video , Expires 2015-06-25T00:00:00.0002 ]

The interface for assigning PCAP licenses to multiple users from the Users list also uses a drop-down list to select a
Personal Capture licenses, but only Personal Capture license bundles appear in that list, so there is no confusion as
to which license type to select.

License Presenters for Personal Capture
In this section:

® Qverview

® Methods for Personal Capture Licensing
® |icense Presenters via the Licensing Page
® |icense Presenters via the Users Page

Overview

In order to use Personal Capture (formerly called Personal Capture or EchoCapture Personal) to record and publish
presentations, Academic Staff members must have a Personal Capture license assigned to them. There are multiple
methods for assigning (and revoking) Personal Capture licenses, as outlined below.

Personal Capture licenses are available as site licenses, or by purchasing a license pack. Site licenses apply across
all Academic Staff and no further configuration is required. If you purchase a license pack, you must:

* Download and update your licenses on the ESS.
® Assign the licenses to the Academic Staff who are using Personal Capture.
® If necessary, revoke licenses from Academic Staff who no longer need to be licensed for Personal Capture.

The ESS licensing interface keeps track of and displays the total number of licenses in the license pack along with
the number of licenses still available for assignment.

Licensed Personal Capture users are referred to as "Presenters". These users may or may not be assigned a
Presenter role in other parts of the interface (such as for the Section or the Schedule), but all licensed Personal
Capture Presenters must have the Academic Staff role assigned to their user account. Keep in mind, however, that
in order to publish Personal Capture recordings, Presenters must be associated with a Section or Schedule. See
also Server Configuration for Presenters.

For more information about user roles, see Manage Users. For detailed information about license options, contact E
cho360 Technical Support.
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©® Wwho Can Do This?
® System Administrator
® User with both Admin & License Manager roles

If a user has only the License Manager role assigned, they can view Personal Capture license
assignments but cannot assign or revoke licenses.

Users must possess both Admin & License Manager roles to assign and revoke Personal
Capture licenses. Furthermore, the user can only assign licenses to staff belonging to the same
organization for which their roles apply. If the Admin & License Manager roles are assigned at
the root organization, the user can assign/revoke licenses for staff belonging to both the root and
sub-organizations. For information on assigning organizations and roles for a user, as well as the
privileges associated with each role, see Manage Users.

Methods for Personal Capture Licensing

There are four methods for assigning Personal Capture licenses to Academic Staff, two through the Licenses page a
nd two through the Users page. Brief instructions for each are provided below with links to more detailed instructions
if needed.

License Presenters via the Licensing Page

The Licensing page lets you assign and revoke Personal Capture license for individual users, or use a CSV file
import to bulk assign/revoke Personal Capture licenses.

Assign or Revoke Licenses for Individual Users

1. Navigate to System > Licensing.
2. Click Presenter Assignments.
3. To assign a license, in the Assign Licenses section of the page:

a. Use the Presenter drop-down list to search for and select an Academic Staff user.
b. Click Assign next to the Personal Capture license bundle you want to assign to the user.

4. Torevoke a license, in the Revoke Licenses section of the page;

a. Find the Presenter whose license you want to revoke. If necessary, use the drop-down lists to narrow
the list of currently licensed presenters.
b. Click Revoke next to the user to revoke their license.

For more detailed instructions, see License Individual Presenters via Licensing Page.

Assign or Revoke Licenses for Multiple Users via CSV Import

1.

ogAWDN

Prepare and save a CSV file for import using the format described below.
Navigate to System > Licensing.

Click Presenter Assignments.

Click Import.

Click Choose File to select the CSV file for import.

Click Import.

See Bulk License Presenters via CSV Import for more detailed instructions.

The CSV file must include the fields shown in the below example table. Formatting and data information for each
field appears below the table.
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Username Action License ID
userl@example.com assign ID 2013-07-05-012345
user2@example.com assign ID 2013-07-05-012345
User Name 1 revoke ID 2013-07-05-012346
User Name 2 revokeall

user3@example.com autoassign

Username can be either the presenter's email address or the User Name string identifier that appears in the User
Account section of the user profile. We recommend using email address as it tends to vary less and is less prone to
entry error.

Action can include the following:

® assign - Assigns the specified license ID to the user. The License ID field must be populated with a valid
Personal Capture license ID.

® autoassign - Assigns the first available Personal Capture license to the user. License ID field should be
blank, but will be ignored if populated. The system will show an error if/when all Personal Capture licenses
are currently assigned or if the username is invalid.

®* revoke - Removes the specified license ID from the user. The License ID field must be populated with
Personal Capture license ID being revoked.

® revokeall - Removes all associated Personal Capture licenses from the user. License ID field should be
blank, but will be ignored if populated.

License ID must use the following format: | D yyyy- nm dd- xxxxxXx. The License ID is visible on the Licensing
page of the ESS, listed as the PCAP Product License.

If you already have licensed Personal Capture users in the system, we recommend you generate an Export from
the Presenter Assignments page in order to have a template of a properly formatted file.

License Presenters via the Users Page

The Users page lets you access user profiles and edit them to license each Academic Staff member, or to select
multiple users at once and assign or revoke Personal Capture licenses.

Assign or Revoke Licenses on Individual User Profiles

1. Navigate to Configuration > Users.

2. In the Staff tab, find the user you want to license and click edit.

3. In the Personal Capture Licenses section of the page, check or uncheck listed Personal Capture licenses to
assign or revoke licensing respectively.

4. When finished, click Save.

See License Individual Presenters via User Profile for more details.

If you do not see a Personal Capture Licenses section on the Edit User page, be sure the user is assigned the
Academic Staff role. Only Academic Staff can be assigned Personal Capture licenses.

Assign Licenses for Multiple Users via Users Page

1. Navigate to Configuration > Users.
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2. In the Staff tab, click the checkbox for the Academic Staff users you want to license.

3. Select Assign Personal Capture Presenter License from the Actions drop-down list at the bottom of the
page.

4. An Assign License dialog box appears. From the License drop-down list, select a license then click Continue

When the Users page refreshes, the selected users now show assigned Personal Capture licenses in the Assigned
Licenses column.

Revoke Licenses for Multiple Users via Users Page

1. Navigate to Configuration > Users.

2. In the Staff tab, click the checkbox for the Academic Staff users whose licenses you want to revoke.

3. Select Revoke All Personal Capture Presenter Licenses from the Actions drop-down list at the bottom of
the page.

When the Users page refreshes, the Assigned Licenses column should be blank for the selected users, indicating all
Personal Capture licenses were revoked.

See Bulk License Presenters via Users Page for more details.

License Individual Presenters via Licensing Page
In this section:

® Qverview
® Assign Personal Capture Licenses
® Revoke Personal Capture Licenses

Overview

In order to use Personal Software Capture to record and publish presentations for students, Academic Staff
members must have a Personal Capture license assigned to them.

The Licensing page provides two methods

® Find and select each Presenter listed and assign or revoke a license
® Use a CSV file import to bulk assign and revoke licenses.

The instructions on this page cover using the Licensing page to assign or revoke Personal Capture licenses to
Academic Staff members.

Assign Personal Capture Licenses

The procedure below identifies the steps used in assigning Personal Capture licenses through the ESS Licensing
interface.

Before beginning, you may want to navigate to Configuration > Users to verify that the users to whom you want to
assign Personal Capture licenses have been added to EchoSystem as Academic Staff.

1. Login to the ESS.
2. Navigate to System > Licensing as shown in the figure below.
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3. Click Presenter Assignments. The Manage Presenter Licenses page appears, shown in the below figure.

Licenses

Name Products
Podcast Audio, Enhanced Podcast Audio, Screen Podcast,
Product License - PCAP S5, ID 2013-02-27-001414, Pro EchoPlayer Display, EchoPlayer Display and Video,
EchoPlayer Dual Video

Podcast Audio, Enhanced Podcast Audio, Screen Podcast,
Video Podcast, EchoPlayer Display,

EchoPlayer Display and Video, EchoPlayer Video,

EchoPlayer Dual Display, EchoPlayer Dual Video, Live Display,
Live Dual Display, Live Video, Live Display and Video,

Live Dual Video

Podcast Audio, Enhanced Podeast Audic, Screen Podcast,

Product License - PCAP 82, ID 2013-02-27-001410, Pro EchoPlayer Display, EchoPlayer Display and Video,
EchoPlayer Dual Video

Product License, 1D 2013-02-27-001020, Product(s): SC

Features License, ID 2013-02-27-001021, HEMS
‘Wowza 3.0 License, ID 2013-02-27-001017

Podcast Audio, Enhanced Podcast Audio, Screen Podcast,
Product License - PCAP 51, ID 2013-02-27-001019, Pro EchoPlayer Display, EchoPlayer Display and Video,
EchoPlayer Dual Video

Podcast Audio, Enhanced Podcast Audio, Screen Podcast,
Product License Capture Appliance, 1D 2013-02-27-001 Video Podcast, EchoPlayer Video, EchoPlayer Display,
EchoPlayer Display and Video

Podcast Audio, Enhanced Podeast Audic, Screen Podcast,
Product License - PCAP 53, D 2013-02-27-001412, Pro EchoPlayer Display, EchoPlayer Display and Video,
EchoPlayer Dual Video

Podcast Audio, Enhanced Podcast Audio, Screen Podcast,
Product License - PCAP 54, 1D 2013-02-27-001413, Pro EchoPlayer Display, EchoPlayer Display and Video,
EchoPlayer Dual Video

Podcast Audic, Enhanced Podcast Audic, Screen Podcast,
Product License - PCAP S6, ID 2013-02-27-001415, Pro EchoPlayer Display, EchoPlayer Display and Video,
EchoPlayer Dual Video

Podcast Audio, Enhanced Podcast Audic, Screen Podcast,
EchoPlayer Display, EchoPlayer Display and Video

Podcast Audio, Enhanced Podeast Audic, Screen Podcast,
Product License Media Import, |0 2013-02-27-001018, b Video Podcast, EchoPlayer Video, EchoPlayer Display,
EchoPlayer Display and Video

Product License Classroom Capture, |D 2013-02-27-001

er Assignmen

Limitations

Target: PRESENTER, Quantity: 1000;

Device Type: Personal Capture

Target: ROOM, Quantity: 10;
Device Type: SafeCapture HD

Target: PRESENTER, Quantity: 2;
Device Type: Personal Capture

NIA = Site License
1 Pro Unlimited edition

Target: PRESENTER, Quantity: 1000;

Device Type: Personal Capture

Target: ROOM, Quantity: 10;
Device Type: Capture Appliance

Target: PRESENTER, Quantity: 1000;

Device Type: Personal Capture

Target: PRESENTER, Quantity: 1000;

Device Type: Personal Capture

Target: PRESENTER, Quantity: 1000;

Device Type: Personal Capture

Target: ROOM, Quantity: 10;
Device Type: Classroom Capture

Device Type: Media Import

View: | 20 | ¥ | Licenses per Page

1-12 of 12
Expiration Time

3/26/13 8:00 PM (2 months, 10 days ago)

6/2/14 8:00 PM (in 11 months, 27 days)

12/31/14 7:00 PM (in 1 year, 6 months)

4/28/15 8:00 PM (in 1 year, 10 months)
6/2/15 8:00 PM (in 1 year, 11 months)

6/24/15 8:00 PM (in 2 years, 0 months)

(24115 B:00 PM (in 2 years, 0 months)

824115 B:00 PM (in 2 years, 0 months)

6/24/15 8:00 PM (in 2 years, 0 months)

6/24/15 8:00 PM (in 2 years, 0 months)

7ITHS 8:00 PM (in 2 years, 1 month)

111118 7:00 PM {in 5 years, 7 months)

1-12 of 12

Licensing > Manage Presenter Licenses

Manage Presenter Licenses

Assign Licenses

Select presenter then assign license from list. Search for presenter using partial first name, last name and/or email address.

Presenter : | v
License Expiration Time Total Avallable
Product License - PCAP, ID 2012-04-18-001826 5/5/15 8:00 PM 200 197
Product License - PCAP, ID 2012-04-30-001826 4130115 8:00 PM 20 18
Revoke Licenses
Presenter: [ ®  Organization : | choose... B License :  choose... B

=1

Presenter «
Bobby, Hill (Bobby Hill@Bogusdelight.com)
Nagaraj, Shruthi (snagaraj@echo360.com)

Organizations

echo360 / Presenters
echo360 / Shruthi
echo360; echo360 / Aptus
echo360; echo360 / Aptus
echo360; echo360 / denice

Rajaput, Uday (uday@aptus.in)
Rajaput, Uday (uday@aptus.in)
thornton, denice (dthornton@echo360.com)

[ Dore |

License Name

Product License - PCAP, ID 2012-04-18-001826
Product License - PCAP, 1D 2012-04-30-001826
Product License - PCAP, 1D 2012-04-30-001826
Product License - PCAP, 1D 2012-04-18-001826
Product License - PCAP, ID 2012-04-18-001826

Expiration Time

5/5/15 8:00 PM Revoke
4/30/15 8:00 PM Revoke
4/30/15 8:00 PM Revoke
5/5/15 8.00 PM Revoke
5/5/15 8:00 PM Revoke

1-54f 5

4. In the Assign Licenses section of the page, select the Presenter whom you want to license from the Presente
r drop-down list. Search for Presenters by typing first or last name or email address information. The
drop-down list narrows to fit the criteria you enter, as shown in the below figure.

Licensing > Manage Presenter Licenses

Manage Presenter Licenses

Assign Licenses

Select presenter then assign license from list. Search for presenter using partial first name, last name and/or email address.

Presenter : [echo [

License guest, echo360 (guest@echo360.com) »n Time Total Avallable

Product Licens, instructor, echo360 (instructor@echo360.com) — 200 197
student, echo360 (student@echo360.com)

Proguct Licens 00 PM 20 18

ta, echo360 (ta@echo360.com)

5. Once the Presenter you want to license appears in the Presenter field, click the Assign button that
corresponds to the license you are assigning that Presenter, as shown in the below figure.
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Licensing > Manage Presenter Licenses

Manage Presenter Licenses

Assign Licenses

Select presenter then assign license from list. Search for presenter using partial first name, last name andfor emall address.

Presenter : [instructor, echo360 (instructor@echo360.com) 2

License Expiration Time Total
Product License - PCAP, 1D 2012-04-18-001826 5/5M5 B:00 PM 200
Product License - PCAP, 1D 2012-04-30-001826 4/30/15 8:00 PM 20

Available
187 =
8

6. The selected Presenter is now licensed. Notice that the selected Presenter now appears in the Presenter list
in the Revoke Licenses section of the page, and that the number of available licenses has been
decremented. You should also see a success message at the top of the page, as shown in the below figure.

Manage Presenter Licenses

The license has been assigned.
Assign Licenses

Select presenter then assign license from list. Search for presenter using partial first name, last name and/or email address,

Presenter : | £l
License Expiration Time Total Available
Product License - PCAP, ID 2012-04-18-001626 5/5015 8:00 PM 200 196
Product License - PCAP, ID 2012-04-30-001626 413015 8:00 PM 20 18
Revoke Licenses
Presenter : [ ¥ Organization : | choose... &+ License: | Choose.. s

[ clear |

Presenter Organizations License Name Expiration Time

Bobby, Hil (Bobby. Hil@Bogusdelight.com) echods0 / Presenters Proguct License - PCAP, ID 2012-04-18-001826 5/5(15 8:00 PM Revoke
instructor, echo360 (instructor@echo3e0.com) echo3sn Proguct License - PCAP, ID 2012-04-18-001826 5/5(15 8:00 PM Revoke
Nagaraj, Shruthi (snagaraj@echo360.com) echo360 / Shruthi Proguct License - PCAP, |D 2012-04-30-001826 4130115 B:00 PM Revoke
Rajaput, Uday (uday@aptus.in} Echo360; echodsl / Aptus Proguct License - PCAP, ID 2012-04-30-001826 4130115 B:00 PM Revoke
Rajaput, Uday (uday@aptus.in) echo36D; echo360 / Aptus Product License - PCAP, |D 2012-04-18-001826 5/5015 8:00 PM Revoke
thornton, denice (dthornton@echo360.com) echo36D; echo360 / denice Product License - PCAP, ID 2012-04-18-001826 5/5/15 8:00 PM Revoke

Ex

7. Repeat the above steps to assign a license to another Presenter. You can assign licenses to one Presenter
at a time. When you are finished, click Done to return to the Licenses page.

Revoke Personal Capture Licenses

The procedure below identifies the steps used in revoking Presenter licenses through the ESS Licensing interface.

Log in to the ESS.
Navigate to System > Licensing.
Click Presenter Assignments. The Manage Presenter Licenses page appears.
In the Revoke Licenses section of the page, select the Presenter whose license you want to revoke. If the
Presenter list is very long, you can sort the list, or you can narrow the list in the following ways:
® Use the Organization and/or License drop-down lists to identify specific sets of Presenters to choose
from, then click Search.
® Search for Presenters by typing first or last name or email address information in the Presenter
drop-down list. The drop-down list narrows to fit the criteria you enter, as shown in the below figure.
Selecting a Presenter from the drop-down list, then clicking Search narrows the list to only that
Presenter.

rPowbdPR
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Licensing > Manage Presenter Licenses

Manage Presenter Licenses

Assign Licenses

Select presenter then assign license from list. Search for presenter using partial first name, last name and/or email address.

Presenter : [ v
License Expiration Time Total Avallable
Product License - PCAP, ID 2012-04-18-001826 5/5/15 8:00 PM 200 198
Product License - PCAP, ID 2012-04-30-001826 4/30/15 8:00 PM 20 18
Revoke Licenses
Presenter : [echo x| Organization : | choose... + License : | choose... :

guest, echo360 (guest@echo360.com)

“linstructor, echo360 (instructor@echo360.com)
student, echo360 (student@echo360.com) 1-6of &
ta, echo360 (ta@echo360.com) License Name Expiration Time

Presenter -

Bobby, Hill (Bobby Hil@Bogusdelight.com) acho360 / Presenters Product License - PCAP, | 2012-04-18-001826 51515 8:00 PM Revoke
instructor, @cho360 (instructor@echo360.com) acho360 Product License - PCAP, D 2012-04-18-001826 5/5/15 8:00 PM Revoke
Nagaraj, Shruthi (snagaraj@echo360.com) echo360 / Shruthi Product License - PCAP, D 2012-04-30-001826 4/30/15 8:00 PM Revoke
Rajaput, Uday (uday@aptus.in) echo360; echo36D / Aptus Product License - PCAP, ID 2012-04-30-001826 430115 8:00 PM Revoke
Rajaput, Uday (udey@aptus.in) echo360; echo360 / Aptus Product License - PCAP, | 2012-04-18-001826 5I5/15 8:00 PM Revoke
thornton, denice (dthornton@echo360.com) acho360; echods0 / denice Product License - PCAP, I 2012-04-18-001826 51515 8:00 PM Revoke

1-6of &

[ Done |

5. Click the Revoke link associated with each Presenter whose license you want to revoke, as shown in the
below figure.

Revoke Licenses

Presenter : [ v

| soarcn JiGlean]

Organization : | choose... s+ License:  cnoose.. +

1-6 of 6
Presenter « Organizations License Name Expiration Time
Bobby, Hill (Babby. Hil@Bogusdelight.com) echo380  Presenters Product License - PCAP, ID 2012-04-18-001826 5/515 8:00 PM Revoke
instructor, echo360 (instructor@echo360.com) echodb Product License - PCAP, D 2012-04-18-001826 5/515 8:00 PM Revoke
Nagaraj, Shruthi (snagaraj@echo3s0.com) echo360 / Shruthi Product License - PCAP, ID 2012-04-30-001626 4/30/15 8:00 PM / Revoke
Rajaput, Uday (uday @aptus.in) echo3B0; echo38D / Aptus Product License - PCAP, ID 2012-04-30-001826 4130/15 8:00 PM Revoke
Rajaput, Uday (uday@aptus.in) echo3B0; echod80 / Aptus Product License - PCAP, ID 2012-04-18-001826 5/515 8:00 PM Revoke
thorntan, denice (dthorntan@echa360.com) echad60; echod60 / denice Product License - PCAP, ID 2012-04-18-001826 5/5115 8:00 PM Revoke
1-6of 6

| Done |

6. The selected Presenter's license is revoked. Notice that the selected Presenter no longer appears in the
Presenter list in the Revoke Licenses section of the page, and that the number of available licenses has been
incremented to reflect the newly available license. You should also see a success message at the top of the
page, as shown in the below figure.

7.
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Licensing > Manage Presenter Licenses

Manage Presenter Licenses

Assign Licenses

License assigned to instructor, echo360 has been revoked

Select presenter then assign license from list. Search for presenter using partial first name, last name and/or email address.

Presenter : | v
License Expiration Time Total Avallable
Product License - PCAP, ID 2012-04-18-001826 5/5/15 8:00 PM 200 187
Product License - PGAP, ID 2012-04-30-001826 413015 B:00 PM 20 18
Revoke Licenses
Presenter: [ ®  Organization : | choose... B License :  choose... B

=1

1505
Presenter « Organizations License Name Expiration Time
Bobby, Hill (Bobby Hill@Bogusdelight.com) echo360 / Presenters Product License - PCAP, ID 2012-04-18-001826 §/5/15 8:00 PM Revoke
Nagaraj, Shruthi (snagaraj@echo360.com) echo360 / Shruthi Product License - PCAP, 1D 2012-04-30-001826 4/30/15 8:00 PM Revoke
Rajaput, Uday (uday@aptus.in) echo360; echo360 / Aptus Product License - PCAP, 1D 2012-04-30-001826 4/30/15 8:00 PM Revoke
Rajaput, Uday (uday@aptus.in) echo360; echo360 / Aptus Product License - PCAP, 1D 2012-04-18-001826 §/5/15 8:00 PM Revoke
thernton, denice (dthornton@echo360.com) echo360; echo360 / denice Product License - PCAP, ID 2012-04-18-001826 §/5/15 8:00 PM Revoke
1505

[ Dore |

If you are finished, click Done to return to the Licensing page. You can also continue to revoke other licenses,
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or you can assign (or re-assign) licenses as necessary.

Bulk License Presenters via CSV Import
In this section:

® Qverview

® Format

® Perform a Personal Capture Licensing Import

® Tips for Creating a Properly Formatted CSV File

Overview

In order to use Personal Software Capture to record and publish presentations for students, Academic Staff
members must have a Personal Capture license assigned to them.

The Licensing page of the EchoSystem Server (ESS) provides two methods for licensing presenters for Personal
Capture:

® Find and select each Presenter listed and assign or revoke a license
® Use a CSV file import to bulk assign and revoke licenses.

The instructions on this page cover running a CSV import from the Manage Presenter Licenses page to assign or
revoke Personal Capture licenses.

To open the Manage Presenter Licenses page, navigate to System > Licensing and click Presenter Assignments

The Import button resides at the bottom of the page.

There is also an Export button that allows you to export a list of currently licensed Personal Capture users. You may
want to export a list of currently licensed Personal Capture users to generate a properly formatted CSV file. You can
then edit this file for import.

Format

Using a CSV import to bulk assign and revoke licenses for users requires the use of a properly formatted CSV file.
The CSV file must include the fields described in the following table. As noted above, it might be easier for you run
an export of currently licensed users, then edit this file for import.

Field Name Description

Username Can be the user email address or the User Name string
identifier that appears in the User Account section of
the user profile. Example entry:
instructorl@example.com or Instructor Name. We
recommend using email address because there is less
variance and chance for erroneous entry.
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Action Indicates the action to be taken for the user. Valid
actions include:

® assign - Assigns the specified License ID to
the user. License ID field must be populated.

® autoassign - Assigns the first available
license to the user. License ID field should not
be populated but will be ignored if it is.

®* revoke - Revokes the specified License ID
from the user. License ID field must be
populated.

® revokeall - Revokes ALL assigned licenses
from the user. License ID field should not be
populated but will be ignored if it is.

License ID Identifies the Personal Capture license to be assigned
or revoked. The License ID must use the following
format: | D yyyy- nm dd- xxxxxx. Example entry: ID
2013-07-05-012345

The CSV file should appear similar to the table shown below.

Username Action License ID
instructorl@example.com assign ID 2013-07-05-012345
instructor@example.com assign ID 2013-07-05-012345
User Name 1 revoke ID 2013-07-05-012346
User Name 2 revoke ID 2013-07-05-012346
instructor3@example.com autoassign

User Name 4 revokeall

There are ways to use existing system information to generate a Personal Capture license import file. See Bulk
License Presenters via CSV Import#Tips for Creating a Properly Formatted CSV File for some suggestions.

Perform a Personal Capture Licensing Import

Once you have generated the *.csv file(s) to assign and/or revoke Personal Capture licenses as necessary, use the
following procedure to import the file.

1. Navigate to System > Licensing.
2. Click Presenter Assignments.
3. Click Import. The Import Presenter Licenses page appears as shown in the below figure.
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Import Presenter Licenses

Quickly assign or revoke Personal Capture presenter licenses for a large number of users by importing a CSV file with license information.
b See Detailed Instructions

Use the Browse button below to select the CSV file to import. Results are displayed in the text box below the Import button. The results will indicate the line
number in the CSV for reference in the event an error occurs during import.

Choose File | no file selected

 Done |

4. Click Choose File, then navigate to and select the CSV file for import.

Click Import.

6. The status of the import appears in the progress window on the page, including any rows that are not
processed and the error generated. Make note of these so that you can either fix the file for re-import, or licen
se those presenters individually.

7. When the import is complete, click Done.

o

The Manage Presenter Licenses page reappears, showing the following:

® The presenters who were licensed during the import now appear in the Revoke Licenses list, indicating they
have licenses assigned to them.

® |n addition the licenses listed at the top of the page should have updated Total and Available license counts,
indicating that licenses were assigned and/or revoked during the import process.

Tips for Creating a Properly Formatted CSV File

There are a number of different ways to create a CSV file that is properly formatted to use for bulk assigning or
revoking Personal Capture licenses. Besides doing so manually, you can use some of the Export functionality in the
ESS to assist you in creating the file. The tips provided here assume you are using Microsoft Excel or other
spreadsheet program to generate the file, then saving it as a *.csv file.

Export Existing Personal Capture Users
As stated in the Overview, the Manage Presenter Licenses page contains an Export button that generates a list of

currently licensed Personal Capture users in CSV format. Opened in Excel, this CSV file appears as shown in the
below figure:
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= A B C D E
1 |Username Actian License [D

2 |admin reot and sub asslgn 1D 2013-02-27-001019
3 |anup asslgn 1D 2013-02-27-001019
4  |aptus.instructar asslgn 1D 2013-02-27-001019
5 |crnarrelll asslgn 1D 2013-02-27-001019
6 |dAS asslgn 1D 2013-02-27-001019
7 |dASnGP assign 1D 2013-02-27-001019
8 |dASnGProot asslgn 1D 2013-02-27-001019
9 |dASnINroot assign 1D 2013-02-27-001019
10 |dASnSP asslgn 1D 2013-02-27-001019
11 |dASnSProot assign 1D 2013-02-27-001019
12 | dASnTA asslgn 1D 2013-02-27-001019
13 |dASnTAroot asslgn 1D 2013-02-27-001019
14 |dASroot asslgn 1D 2013-02-27-001019
15 |dmitchell asslgn 1D 2013-02-27-001019
16 |drogers asslgn 1D 2013-02-27-001019
17 |dsortme asslgn 1D 2013-02-27-001019
18 |dt.instructor assign 1D 2013-02-27-001019
19 |dtillery asslgn 1D 2013-02-27-001019
20 |dvader assign 1D 2013-02-27-001019
21 |dyoung asslgn 1D 2013-02-27-001019
22 |ebanker assign 1D 2013-02-27-001019
23 |Grodsky_instructor asslgn 1D 2013-02-27-001019
24 |jsmith asslgn 1D 2013-02-27-001019
25 |kbergir Assign ID 2013-02-27-0010n19

Notice how the formatting is the same as that required for a Personal Capture licensing import. Also notice how the
action column shows assign as the only action. This indicates that the License ID listed is assigned to that user.

Depending on the tasks you need to perform, using the Personal Capture user export might be the most efficient
way to generate a proper CSV file for import. For example, you may have users currently assigned a Personal
Capture license that must be replaced by a new or updated license. In this case you should revoke the old licenses
then assign the new ones to the same users, possibly adding new users to the assignment list if necessary.

To generate a CSV file that revokes old licenses and assigns new ones to existing staff:

1.
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Generate the Personal Capture export file by navigating to System > Licensing > Presenter Assignments,
then click Export.
Open the automatically downloaded file titled licenses.csv.
If desired, sort the file by Username or License ID, depending on how you want to view the list.
* |f you only want to revoke particular Licenses IDs to reassign new, sort by License ID and apply the
below instructions to only those rows.
* |f you want to revoke license for only certain Users, sort by Username and apply the below instructions
to only those users.
Replace "assign" in the Action column with revoke or revokeall.
® Revoke will revoke only the listed License ID from that user.
® Revokeall removes ALL licenses from that user and does not require a License ID, though if one
appears the system ignores it.
For all users to whom you will be re-assigning new licenses, copy the Username column entries, then paste
the list starting with the first row below the last current entry. This means you will have two sets of the same
users in the file, one set below the other. Alternately you can paste this list to a new file to generate two
imports: one that revokes licenses and one that assigns them.
Pass through the second (pasted) users list and:
® Remove any users who should no longer be assigned a license.
® Add any new users who must have a Personal Capture license assigned.
In the Action column for the pasted list of users, enter assign or autoassign as appropriate. You can enter
the action into the first row, then copy and paste it to subsequent rows.
If you entered "assign" in the Action column, enter the new License ID to be assigned to the users. You can
enter the ID in the first row, then copy and paste it to susbsequent rows. Autoassign does not require entry of
a License ID.
Save the file as a *.csv file.
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After you have generated the CSV file, use the instructions below to import the file to the ESS.

As indicated in the procedure, you can perform this task using two different CSV files, one that revokes licenses
from the username list, and one that assigns new licenses to the username list. This method may be easier if you
have a particularly large list of users. Generating two files keeps the list from becoming cumbersome and hard to
navigate.

Export the User List

If you need to license a large number of Academic Staff members who do not currently have Personal Capture
licenses assigned to them, the easiest way to create the file may be to generate an export of your users list, then
copy the User-Name or Email column from that export into a Personal Capture license export file.

The figure below shows a sample User export, the person.csv file, open in Excel and sorted by
Organization-Role-Name-1 column.

A B c D E F G H
Last-Name First-Name  Display-Name Email User-Name Password Organization-Role-Name1 Organization-Role-Name2
coinstructor denice denice co Instructor dthorninstructor3@college.edu aptus.instructor echo360;rale-name-academic-staff echo360 / denice;role-name-academic-staff
thornASnGFroot denice Genice thornASnGProot GASNGProot@college.edu GASNGFroot echo360;rale-name-academic-staff echo360 / denice;role-name-academic-staff
thornASnSProot denice denice thormASnSProat dASnSProat@college.edu cASnSPraot echo360;rale-name-acadenmic-staff echo360 / denice;role-name-academic-staff
thornASnTArcot denice denice thornASnTAroot GASnTAroot@coallege. edu dASnTAroot echo360; rale-name-academic-staff echo360 / denice;role-name-academic-staff
Rajaraman Nithya guest F Nithya guest Presenter 1nr.guest@callege.eou Nithya guest Presenter echo360;rale-name-acagemic-staff echo360;rale-name-acacenic-staff
Rajaraman Nithya Instruci Nithya instructor inrinstructor@college.edu Nithya Instructor echo360;rale-name-acadenmic-staff echo360;rale-name-acadernic-staff
Rajaraman Nithya studeni Nithya student Presenter  Inrstudent@college.edu Nithya student Presenter echo360; rale-name-academic-staff echo360; rale-name-academic-staff
Rajaraman NithyaTA  Nithya TA inrassistant@college.edu Nithya TA -name-academic-staff -name-academic-staff

Young Dirk Dirk Young dyoung Ecollege.edu dyoung -name-academic-staff -name-admin
Rajaraman Nithya root an Test@college.edu nithyad44@college.edu admin root and sub -name-academic-staff -name-admin
Marrell Carl Carl Marrelll cmarrelli@college.edu cmarrelli 60; role-name-academic-staff 60; role-name-admin
Academic Staff Nithya Root sc Nithya Root scheduler + Instri test@college. edu Nithya scheduler Instructar echo360; rale-name-academic-staff echo360; rale-name-scheduler
rsehrins rsehring rschtins rschrins@college. edu rsehrins echo360; rale-name-academic-staff echo360; rale-name-scheduler
Brathwaite Shireen shireen sbrathwaite@college.edu shireen echo360;role-name-academic-staff echo360;role-name-scheduler
Vader Darth Darth Vader dvader@college.edu dvader echo360; rale-name-academic-staff

Mitchell Debbie Debbie Mitchell dmitchell@college.edu dmitchell echo360; role-name-academic-staff

thornASnINroot denice denice thornASnINroot dASnINroot@coliege.edu dASnINroot echo360; role-name-academic-staff

thornASroot denice denice thornASroat dASrootEcollege.edu dASront echa360; rale-name-academic-staff

thornsortme denice denice thornsortme dSortme@college.edu dsortme echo360; role-name-academic-staff

Ragers Doug Doug Rogers drogers@college.edu drogers echo360; rale-name-academic-staff

Rajaraman Nithya test ins Instructar nithya@college.edu nithya ins echo360; rale-name-academic-staff

Smith John John Smith Jsmith@college.edu Jjsmith echo360; role-name-academic-staff

Depending on whether you have multiple organizations configured for your system, you may be able to use this
method to easily identify and select academic staff from the list, and copy and paste their Email or User-Name fields
into the Personal Capture licensing CSV import file.

After you have generated the CSV file, use the instructions above to import the file to the ESS.

© PCAP Licenses are Only Assigned to Academic Staff

If you have multiple organizations and sub-organizations, you may find it difficult to sort the Users
export to find only academic staff and copy/paste their User-Name or Email for licensing.
However Personal Capture licenses can ONLY be assigned to users with the Academic Staff role
assigned to them. So if you accidentally include an Admin or other type of user in the import file,
do not worry. If the import process finds other types of users on the list, it will note an error on the
processing log and skip that user.

License Individual Presenters via User Profile
In this section:

® Qverview
® Assign Personal Capture License via User Profile

® Revoke Personal Capture License via User Profile

Overview

In order to use Personal Software Capture to record and publish presentations for students, Academic Staff
members must have a Personal Capture license assigned to them.

The Users page of the EchoSystem Server (ESS) provides two methods for licensing presenters for Personal
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Capture:

¢ Edit an individual presenter's user profile and assign or revoke the Personal Capture license.
® Select multiple presenters from the Active Staff tab and choose to assign or revoke Personal Capture
licenses for all selections.

The instructions on this page cover using the individual presenter's user profile to assign or revoke Personal Capture
licenses.

Assign Personal Capture License via User Profile

Use the procedure below to assign a Personal Capture license to a presenter through the Edit User page of the
ESS.

Navigate to Configuration > Users.

In the Active Staff tab, find the presenter you want to license and click edit.

In the Personal Capture Licenses section of the Edit User page, shown in the below figure, check the
Personal Capture (PCAP Product) license you want to assign.

Edit User - Instructor

wn P

User Details
First Name | class
Last Name | Instructer

| instructor

| instructor@institution.edu

Local Time Zone | t-05:00) US/Eastern 3

fcd415bd1-8718-49c9-a929-84d292183d66

Organization Roles

Organization Role
echod0 Academic Staff Remove
Choose... : Choose... : Add >>

Personal Capture Licenses

Name Products Available Expiration Time
Product License - PCAP §1, ID 2013-02-27-001018, Podcast Audio, Enhanced Pedcast Audio,
Product(s): Podcast, Enhanced Podcast, Vodcast, Rich  Screen Podcast, EchoPlayer Display, 1,000 6/24/15 B:00 PM (in 2 years, 0 manths)
Media (A/D, AV, AVID, AVIV) EchePlayer Display and Video, EchoPlayer Dual Video
Product License - PCAP 82, ID 2013-02-27-001410, Podcast Audio, Enhanced Pedcast Audio,

&  Product(s): Podcast, Enhanced Podcast, Vodeast, Rich  Screen Podcast, EchoPlayer Display, 2 12/31/14 7:00 PM (in 1 year, 6 manths)
Media (A/D, AV, AVID, AVIV) EchePlayer Display and Video, EchoPlayer Dual Video
Product License - PCAP 83, ID 2013-02-27-001412, Podcast Audio, Enhanced Pedcast Audio,
Product(s): Podcast, Enhanced Podcast, Vodcast, Rich ~ Screen Podcast, EchoPlayer Display, 1,000 6/24/15 B:00 PM (in 2 years, D months)
Media (A/D, AV, ANID, AVIV) EchoPlayer Display and Video, EchoPlayer Dual Video
Product License - PCAP 54, ID 2013-02-27-001413, Podcast Audio, Enhanced Podcast Audio,
Product(s): Podcast, Enhanced Podcast, Vodcast, Rich  Screen Podcast, EchoPlayer Display, 1,000 6/24/15 B:00 PM (in 2 years, 0 months)
Media (A/D, AV, ANID, AVIV) EchoPlayer Display and Video, EchoPlayer Dual Video
Product License - PCAP S6, ID 2013-02-27-001415, Podcast Audio, Enhanced Podcast Audio,
Product(s): Podcast, Enhanced Podcast, Vodcast, Rich  Screen Podcast, EchoPlayer Display, 1,000 6/24/15 B:00 PM (in 2 years, 0 months)
Media (A/D, AV, AVID, AVIV) EchePlayer Display and Video, EchoPlayer Dual Video

4. When finished, click Save.

If you do not see a Personal Capture Licenses section on the Edit User page, be sure the user is assigned the
Academic Staff role. Only Academic Staff can be assigned Personal Capture licenses. See Manage Users for
additional information on user roles.

Revoke Personal Capture License via User Profile

Use the procedure below to revoke any assigned Personal Capture licenses from a user through the Edit User page
of the ESS.

1. Navigate to Configuration > Users.

2. In the Active Staff tab, find the presenter whose license you want to revoke and click edit.

3. In the Personal Capture Licenses section of the Edit User page, shown in the below figure, uncheck the
assigned Personal Capture (PCAP Product) license you want to revoke.
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Edit User - Instructor

User Details

First Name | class

Last Name | instructor

Display Name | Instructor

Email Address | instructor@institution.edu

Block Alerts?

Local Time Zone | (-05:00) US/Eastern

EchoSystem Identifier:  fc415bd1-8718-49c9-2929-84d292183d66

Alternate Identifier

Organization Roles

Organization Role
echo3s0 Academic Staff Remove
Choose... 2 Choose... 2 Add >>

Personal Capture Licenses

Name Products Available Expiration Time

Product License - PCAP 1, ID 2013-02-27-001018, Podcast Audio, Enhanced Podcast Audio,

Product(s): Podcast, Enhanced Podcast, Vodcast, Rich  Screen Podcast, EchoPlayer Display, 1,000 6/24/15 B:00 PM (in 2 years, 0 months)
Media (A/D, AV, ANID, ANIV) EchoPlayer Display and Video, EchoPlayer Dual Video

Product License - PCAP 82, |D 2013-02-27-001410, Podcast Audio, Enhanced Podcast Audio,

Product(s): Podcast, Enhanced Podcast, Vodcast, Rich  Screen Podcast, EchoPlayer Display, 2 12/31/14 7:00 PM (in 1 year, & months)
Media (A/D, AV, ANID, AVIV) EchoPlayer Display and Video, EchoPlayer Dual Video

Product License - PCAP 83, |D 2013-02-27-001412, Podcast Audio, Enhanced Podcast Audio,

Product(s): Podcast, Enhanced Podcast, Vodcast, Rich  Screen Podcast, EchoPlayer Display, 1,000 6/24/15 B:00 PM (in 2 years, 0 months)
Media (A/D, AV, ANID, AVIV) EchoPlayer Display and Video, EchoPlayer Dual Video

Product License - PCAP 4, |D 2013-02-27-001413, Podcast Audio, Enhanced Podcast Audio,

Product(s): Podcast, Enhanced Podcast, Vodcast, Rich  Screen Podcast, EchoPlayer Display, 1,000 6/24/15 B:00 PM (in 2 years, 0 months)
Media (A/D, AV, ANID, AVIV) EchoPlayer Display and Video, EchoPlayer Dual Video

Product License - PCAP S6, ID 2013-02-27-001415, Podcast Audio, Enhanced Podcast Audio,

Product(s): Podcast, Enhanced Podcast, Vodcast, Rich  Screen Podcast, EchoPlayar Displa 1,000 6/24/15 B:00 PM (in 2 years, 0 months)

Meadia (D, AV, AVID, ANVV)

y,
EchoPlayer Display and Video, EchoPlayer Dual Vidao

4. When finished, click Save.

Bulk License Presenters via Users Page

In this section:

® Qverview
® Assign Personal Capture Licenses to Multiple Users
® Revoke Personal Capture Licenses from Multiple Users

Overview

In order to use Personal Software Capture to record and publish presentations for students, Academic Staff
members must have a Personal Capture license assigned to them.

The Users page of the EchoSystem Server (ESS) provides two methods for licensing presenters for Personal
Capture:

® Edit the presenter's user profile and assign or revoke the Personal Capture license.
® Select multiple presenters on the Active Staff tab in the ESS and choose to assign or revoke Personal
Capture licenses for all selections.

The instructions on this page cover assigning or revoking Personal Capture licenses for multiple presenters at once
through the Users page.

Assign Personal Capture Licenses to Multiple Users

The procedure below identifies the steps used in assigning Personal Capture licenses to multiple presenters at once
through the Active Staff tab of the Users page on the ESS.

1. Navigate to Configuration > Users.
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2. In the Active Staff tab, click the checkbox for the Academic Staff users you want to license.
3. Select Assign PCAP Presenter License from the Actions drop-down list at the bottom of the page, as
shown in the below figure.

Active Staff: 10 Active Student: 1 Retired: 0 1-10 of 10
Name & Email Address System Role{s) Assigned Licenses LastLogIn
denice co instructor . echo360 / denice-->Academic Staff; echo360-- .
lg dthorninstructor3@gmail.com >Academic Staff 6/4/13 10:16 AM
o LEhTEss nithya@.org echo3B0->Academic Staff
Nithy tructor f del
'y &3 Inafrucion for aec cel nithya@test.org echo360-->Academic Staff
Nithya DB
¥a see nit@test.org echo360-->Academic Staff
I} Nithya instructor Tnrinstructor@echo.com echo380. i Staff; echo380 ic: Staff
Nithya instructor Adh
'y insiruoion Achoc NithyaAdhoc@test.org echo360-->Academic Staff
Nithya org instructor N echo360 / Nithya-->Academic Staff, echo360--
lg Tnrorg.instructor@echo.com >Academic Staff, echo3B0-->License Manager
Nithya O hedul Instructs s i = i -
iya Org scheduler + Instructor nithya@testt.org ecsch?ijop’mhya >Mcademic Staff, echo360 / Nithya-
= uler
Nithya Root schedul Instruct
ya oot scheduer + iratruclor test@test org echo3B0-->Academic Staff, echoas0-->Seheduler
R instruct
nstructor rinstructor@aptus.in echo360-->Academic Staff
Select: All 10 (of 10) Displayed Above, All 10 in Fitter, None Action ¥ Choose.. View: | 20 |4 Users per Page 1-10 of 10
[ Add || Export | impor | e
Assign PCAP Presenter License
Revoke All PCAP Presenter Licenses

4. An Assign License dialog box appears, as shown below. From the License drop-down list, select a license
then click Continue.

Assign License

License Choose... ¥

When the Users page refreshes, the selected presenters now show the Personal Capture license in the Assigned
Licenses column. The figure in the section below shows an Active Staff list with assigned licenses.

Revoke Personal Capture Licenses from Multiple Users

Follow these steps to revoke Personal Capture licenses from multiple presenters at once through the Active Staff
tab of the Users page on the ESS.

1. Navigate to Configuration > Users.

2. In the Active Staff tab, click the checkbox for the Academic Staff whose licenses you want to revoke.

3. Select Revoke All PCAP Presenter Licenses from the Actions drop-down list at the bottom of the page, as
shown in the below figure.
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Active Staff: 10 Active Student: 1 Retired: 0 1-10 of 10
Name & Email Address System Role(s) Assigned Licenses LastLogIn

Product License - PCAP
&1, ID 2013-02-27-001019,

denice co instructor echo360 / denice-->Academic Staff; echo360-- Product(s): Podcast,
) dihorninstructor3@gmail.com e St Ennanons podoaat 814113 10:18 AM
Vodcast, Rich Media (AD,
AN, AVID, ANIV)

Product License - PCAP
&1, ID 2013-02-27-001019,

Instructor
54 nithya@rr.crg echo360-->Academic Staff Eroduci(a): Podcast,
Vodcast, Rich Media (A/D,
AN, ANID, ANV
Nith tructor for sec del
va s instruclar far ec de nithya@test.org echo380-->Academic Staff
Nithya DB
walhs aec nit@test.org echo380-->Academic Staff
Protuct Licsnss - PCAP
R S, 1D 2013-02-27-001018,
wa instructor N ) N ; Product(s): Poroast,
) 1w instructor@echo.com 60ho360-->Academis Siaf, cchodeD-->Academic Staff  Lroouck ) Podeas
Vodcast, Rich Media (AD,
AN, ANID, AN
Nithya nstructor Adh
wa inafructor Ashoc NithyaAdhoc@test org 6cho360-->Academic Staff
Product License - PCAP
i - S1, ID 2013-02-27-001019,
wa org instructor echo3g0 / Nilhya-Academic Staf, echo3g0-- Product(s): Podcast,
& 1nrorg.instructor@echo.com >Academic Staff; echo360-->License Manager Enhanced Podcast,
Vodcast, Rich Media (A/D,
AN, ANID, AN
Nithya Org scheduler + Instructor D 5cho360 / Nithya-->Academic Staff; scho350 / Nithya—
>Scheduler
Nithya Rool scheduler + Instructor \si@iestong o = Siafs achaEo.
R instruct
nstructor rinstructor@aptus.in 6cho360-->Academic Staff
Select All 10 (of 10) Displayed Abave, All 10 in Fier, Nane A T View: [FZ07TZ) Usans por Fage 1-10 of 10

[ acd || Export | import | Nesan pCAr e
Assign PCAP Presenter License
Revoke All PCAP Presenter Licenses

When the Users page refreshes, the Assigned Licenses column should be blank for the selected presenters,
indicating those Personal Capture licenses were revoked. The figure in the section above shows an Active Staff list
without assigned licenses.

License Rooms

In this section:

® Qverview
® Understanding License Names
® Assigning and Removing Room Licenses

Overview

Room licenses allow for capturing lectures or other activities in a room such as a classroom, auditorium or lecture
hall, and apply to the following capture methods:

® EchoSystem Capture Appliance
® EchoSystem SafeCapture HD

® Classroom Capture Software installed on the podium PC

Room licenses differ from site licenses in that a site license covers all instances of the licensed capture method in all
locations. No further licensing configuration steps are required beyond downloading and updating your license
information on the ESS. Room licenses are sold in bundles of individual licenses that are then assigned to each
room where the capture method is used.

You can, if necessary, assign multiple different room licenses to a single room. For example, there may be a capture
appliance installed in a room along with Classroom Capture installed on the podium PC. In order to use both
recording methods, or to have both available in case one method fails, the room must have both a capture appliance
license and a Classroom Capture license assigned to the room. In this case, you would perform the licensing
procedure shown below twice, selecting each different license type and checking the room to which the situation
applies. Once assigned, both licenses will appear in the Licensed column for the room.
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The Assign Room Licenses page also allows you to "un-assign” or remove a license from a room as needed. This is
done by unchecking the room for the particular license selected.

©® wWho Can Do This?
® System Administrator
® User with both Admin & License Manager roles

If a user has only the License Manager role assigned, they can view room license assignments
but cannot assign or revoke licenses.

Users must possess both Admin & License Manager roles to assign and revoke room licenses.
Furthermore, the user can only assign licenses to rooms belonging to the same organization for
which their roles apply. If the Admin & License Manager roles are assigned at the root
organization, the user can assign/revoke licenses for both the root and sub-organizations. For
information on assigning organizations and roles for a user, as well as the privileges associated
with each role, see Manage Users.

Understanding License Names

When you assign room licenses, you are presented with a drop-down list that contains only the license names. You
will need understand the information presented in the license name in order to know which license to select for
assignment to each room.

The below figure shows a sample drop-down list from the Room Assignments licensing page, with highlights of the
License Name text that identifies the license type.

License : , Al
License [Product License Software Capture, 1D 2011-02-10-001844, Preduct(s): Pedcast, Enhanced Pedcast, Vodcast, Rich Media Audic , Expires 2015-07-08T00:00:00.000Z |
Available License [Product License, ID 2011-04-13-001877, Product(s): 2 channel PRO , Expires 2014-06-03T00:00:00.000Z |

Room License [Product License Capture Appliance, ID 2011-02-10-001838, Product(s): Podcast, Enhanced P...n Vodcast, Video Vodcast, Rich Media Audio, Rich Media Video , Expires 2015-06-25T00:00:00.0002 |

The following table lists the terms in the license name that identifies each of the three types of licenses you available
for room assignment.

If This Term Appears in the License Name... It is alicense for this device
Software Capture Classroom Capture

2 channel PRO SafeCapture HD

Capture Appliance EchoSystem Capture Appliance

In addition to identifying the device type to which the license applies, the license information may also contain an ID
number, a truncated list of supported products and outputs, and the expiration date for the license. While this
additional information is important, it is more clearly displayed on the main Licenses page of the ESS.

The License drop-down list also contains an "All" selection, which is the selection shown by default when you open
the Room Assignments page. This selection simply allows you to see the total number of purchased, available, and
assigned licenses combined across all room license types. It is not used for assigning licenses to rooms.

Assigning and Removing Room Licenses
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You can also assign room licenses when you assign a device

You can also assign a room license when you assign and configure a device for a Room. See As

sign the Capture Appliance to the Room or Assign Classroom Capture to the Room as
appropriate

The Assign Room Licenses page contains the following items:

® A License drop-down list that allows you to select a license to assign to a room.

® Areal-time calculation of total, assigned, and available licenses. These numbers change depending on which
license is selected from the list, and whether you have assigned more licenses to rooms.

® A list of rooms configured for the system, the organization to which each belongs, and the licenses, if any,
currently assigned to the room.

The figure below shows a sample Assign Room Licenses page, with the "All" option selected. "All" simply allows you
to see the combined total of available licenses, the number assigned and the number still available. The "All" option
is not used for assigning licenses.

eché
Echoes Downloads Schedule | Monitor | Reports Configuration System
System Settings Security Device Defaults Trusted Systems Hosted Services System Indexes Licensing Help
Licensing > Assign Room Licenses
Assign Room Licenses
License : = g + Total : 31 Assigned: 7 Available : 24
Room Organization Licensed
aptus campus: aptus building, Room with Appliance echo3s0 / Aptus gg‘j;“;;';i“;ggfgggt“‘“"‘ Capture, ID 2012-04-18-002844; 2 channel PRO
BIET: BIET, Classroom cap echo360 Product License Software Capture, 1D 2012-04-18-002644
BIET: schd device, Do Not Move echode0 2 channel PRO 2012-04-18-001826
echo.campus: aptus.Building, aptus.Appliance echo360 / Aptus
echo.campus: echo.building, echo.appliance echo360 Product License Capture Appliance, 1D 2012-04-18-0016368
UofDe: build1, roomQrg echo360 / denice Preduct License Capture Appliance, 1D 2012-04-18-001838
UofDe: build1, roomRoot echo360 Product License Capture Appliance, ID 2012-04-18-001838
| Cancel |

If you select a specific license from the drop-down list, the available license information changes to be specific to the
selected license. In addition, the Room list also changes to show a check box for each room. If the box is checked,
the selected license is assigned to that room. If the box is not checked, the room does not have the selected license
assigned to it.

When assigning licenses, one or more of the following scenarios likely fits your situation:

®* You have new appliances or Classroom Capture installations that you need to license.

®* You have moved one or more appliances or Classroom Capture installations to different rooms, so you need
to remove a license from one room and assign it to another.

® You have replaced an old capture appliance with a new SafeCapture HD appliance.

® You have removed a capture appliance or Classroom Capture installation from a room where you are no
longer recording captures.

The simple design of the Assign Room Licenses page allows you to use check boxes to do all of the
assignment/removal for each type of license at once, rather than having to remove, save, then re-assign licenses via
separate steps. In addition, it allows you to quickly see what licenses are already assigned to each room.
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©® Know Which Rooms Require Which Licenses

what capture methods and require appropriate licensing.

Before you assign room licenses, be prepared with a list, if necessary, of which rooms contain

To assign and remove room licenses:

1. Inthe ESS, navigate to System > Licensing.
2. Click Room Assignments. The Assign Room Licenses page appears.

3. Select a license from the drop-down list, shown in the figure below. If necessary, use the information in the

table above to identify which license applies to which capture method.

License [2 channel PRO 2012-04-18-001926 , Expires 2015-03-04T00:00:00.000Z ]
License [Product License Software Capture, ID 2012-04-18-002844 , Expires 2015-07-08T00:00:00.000Z |
Room License [Product License Capture Appliance, ID 2012-04-18-001838 , Expires 2015-03-06T00:00:00.000Z | Licensed

License : Total : 31 Assigned: 7 Available :

24

4. After selecting a license, notice that:

® The Total, Assigned, and Available quantities change to show the applicable quantities for the selected

license.

® A check box appears for each of the rooms. If the box is checked, this license is already assigned to

the room.

The below figure shows a Classroom Capture license selected, and two rooms checked, meaning the

license is assigned to those rooms.

echoé
Echoes Downloads Schedule | Monitor Reports Configuration = EEFEEL
System Settings Security Device Defautts Trusted Systems Hosted Services System Indexes Licensing Help
Licensing > Assign Room Licenses
Assign Room Licenses
License :  License [Product License Software Capture, ID 2012-04- 18-002844 , Expires 2015-07-08T00:00:00.000Z | % Total: 12 Assigned: 2 Available: 10
Room Organization Licensed
- » N , Product License Software Capture, ID 2012-04-18-002844; 2 channel PRO
®  aptus campus: aptus building, Room with Appliance echo360 / Aptus 1o 0e e botene
E BIET: BIET, Classroom cap echo360 Product License Software Capture, 1D 2012-04-18-002844
[ BIET: schd device, Do Not Move echo360 2 channel PRO 2012-04-18-001826
[ echo.campus: aptus.Bullding, aptus.Appliance echo360 / Aptus
[ echo.campus: echo buiding, echo.applance echo360 Product License Capture Appliance, |0 2012-04-18-001838
[J  UofDe: build1, roomOrg echo380 / denice Product License Capture Appliance, ID 2012-04-18-001838
[ UofDe: build1, roomRoot echo360 Product License Capture Appliance, ID 2012-04-18-001838
Seiect: Al Non

5. Click a checkmark in the check box to assign the license to the corresponding room.

o

Remove the checkmark from the check box to un-assign or remove the license from the room.

7. Review your selections, including which license appears in the License field, and which rooms have

checkmarks to indicate licensing for that room.

8. If the selections are correct click Save. A message appears at the top of the page to indicate success.

9. Repeat these steps for each license type you need to assign or un-assign for each room.

10. When you are finished, click Cancel or click the Licensing link in the breadcrumbs to return to the Licensing

page.

Manage Schedules

In this section:

® Qverview
® \Who Does Scheduling?

® Schedule Terminology
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Overview

Scheduling automates lecture capture. When you (a Scheduler or System Administrator) schedule a course, you tell
the EchoSystem to capture every lecture given in a particular classroom (such as "Room 729") at a particular time
(such as "8-9:15 am, Monday, Wednesday, Friday"), for a particular term (such as "Autumn 2010").

When a course is scheduled in the EchoSystem Server (ESS), the Academic Staff member serving as the Presenter
(Instructor, Teaching Assistant, Student Presenter, or Guest Presenter) need only arrive at the classroom and begin
teaching. The lecture is automatically captured, processed, and posted for student review without any further
administration.

Besides the information on this page, see also:

® Create a New Schedule
® Activate a Draft Schedule
® Manage Existing Schedules

In addition, if you are already familiar with scheduling and the information required, see Import Schedules for
instructions on using a CSV import to create or edit schedules.

Who Does Scheduling?

The EchoSystem includes two different user roles, either of which can schedule captures:

® The Admin role has unrestricted rights. An Admin can perform any function in the EchoSystem, including
scheduling.
® The Scheduler role has more authority than one of the Academic Staff roles, but less authority than the
Admin role. This role may be assigned to junior staff. In general, the Scheduler can:
® Create and modify schedules
® Edit presentation metadata (such as the Description)

More specifically, the Scheduler can:

® |ogintothe ESS UI.
® Configure Scheduler Alerts settings.
® View all presentations in the Echoes tab.
® Edit presentation metadata (such as the Description).
® Change presentation states. However, the Scheduler cannot permanently delete an Echo.
* View and modify any schedules.
® View the Monitor tab and see the following sub-tabs:
® Summary
® Captures
® Processing Tasks
® Alerts
® Support

The Scheduler cannot:

® Log in to the capture device user interface or Personal Capture. The Scheduler is not assigned to sections as
Academic Staff are.

® View or modify the Configuration tab.

® View or modify Notifier settings or non-Scheduler Alert settings.

® Change course content.

Roles are additive. This means that a Scheduler who is also a Academic Staff member may perform both roles.
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Schedule Terminology
The terms listed in the table below are commonly used when discussing scheduling.

Term Description

Recurring Event Schedule A recurring event schedule enables captures on
several different dates and times over the course of a
term. Say, for example, that during the autumn term,
section 001 of ECON101 meets on Mondays,
Wednesdays and Fridays in room 600 at 10 am. You
could create a recurring schedule that would capture all
class meetings without further administration from you.

Single Event Schedule A single event schedule enables a single capture at a
specified date and time. For example, if a guest lecturer
is presenting in a large lecture hall, you can schedule a
single event to capture the lecture.

Draft Schedule Draft schedules are saved but not activated. You can
begin work on creating a schedule, save it as a dratft,
and return later to complete it. All schedules (including
copied schedules) are draft until activated.

Active Schedule An active schedule is applied to the room for capture.
All required information must be set before a schedule
can be activated.

Completed Schedule A completed schedule is one where the last scheduled
capture time is in the past. If you create a schedule to
capture all classes from August 1 to December 15, that
schedule becomes a completed schedule on December
16. This is so even if the last capture did not occur.

Create a New Schedule
In this section:

® Qverview
® Before You Begin
® Create a New Schedule

Overview

You can create two different types of schedules:

® Section schedule. You might create a schedule for section 001 of ECON101, which meets on Mondays,
Wednesdays and Fridays in room 600 at 10 am during the autumn term.

® Special event schedule. This schedule enables a single capture at a specified date and time with an
assigned capture device (a capture appliance or Classroom Capture Software). You might create such a
schedule for a guest lecturer, keynote speaker, or commencement address.
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This section explains how to create both types of schedules. If you have a large number of schedules to create, you
can create them using a CSV import. See Import Schedules for detailed instructions.

Remember to Activate the Schedule

When you first create a schedule, it is in draft status. It does not become active until you press
the Activate button.

Before You Begin

Before you create a schedule, make sure you have defined the entities you will specify when you create the
schedule. These are:

Terms (Schedule > Terms)

Sections (Schedule > Courses > Course Details)
Date and Time

Rooms (Configuration > Rooms)

Presenter (inherited from section)

Product Groups (inherited from product groups)

When you create the schedule, you can set or modify these entities:

Schedule- or course-specific exclusions dates
Display input resolution (inherited from room)
Echo defaults (inherited from the parent or child organization)

Create a New Schedule

1.

10.
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In the EchoSystem Server (ESS) interface, navigate to Schedule > Schedules.

2. Select the term from the list.

3. Select the course from the list.

4,

5. Click Add New. This opens the Add New Schedule page, as shown in the figure below.

Select the section from the list.

Schedules

Add New Schedule

Term : Spring 2012 3 Course ENGC205 & Section Introduction to Linguistics - ENG205 :

Review and complete the Course/Description, Room, Date and Time, Exclusions, Presenters, Product
Groups, and Echo Defaults options.

Click Save.

Saving the schedule opens the Schedule Details page, as shown in the figure below.

Remember to Activate the Schedule

Although you have saved the schedule, it is still in draft status. It does not become active
until you press the Activate button.

Verify that you have entered all the information required. You should see a series of green check marks at the
top of the page.
Press Activate to move the schedule from draft to active status.
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Course / Description

The following figure shows the Course/Description scheduling options. Below the figure is a table that describes the
settings available.

Course [ Description

Course : Choreographic Blocking (Chor-Block 101-Choreographic Blocking 1) 2013
Title : I Choreographic Blecking (Cheor-Block 101-Choreographic Blocking 1) 2013
Description :

EchoSystem ldentifier:  5d28f135-8bc6-4a88-b551-484232eeceSb

Alternate ldentifier :

Option Description Inherited From

Course The full course name according to Course
the ESS. The ESS constructs a
course name from the defined
course name, the course identifier,
the section, and the term.

Title The course title, set to the ESS Course
course name by default. It is
displayed in the EchoPlayer during
student review.

Description An optional description for the Course
course that can be displayed in the
EchoPlayer during student review.

EchoSystem Identifier The globally unique identifier N/A
(GUID) used by the EchoSystem
Server (ESS) to identify the object.
The ESS automatically assigns this
ID to each object in the system. You
may use this identifier when making
API or other system calls. See API
Documentation for further
explanation.
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Alternate Identifier The globally unique identifier N/A
(GUID) used by an external system,
such as an LMS or LDAP, to
identify the object. Entering an
Alternate ID is optional, but allows
you to use the external system's
GUID (not the EchoSystem
Identifier) when making API or other
system calls.

The Alternate Identifier must be
unique for each ESS object type.
See APl Documentation for further
explanation.

Room

The following figure shows the Room settings. Below the figure is a table that describes the settings available.

Room
Campus (filter) Device 1 Campus *
Building (filter) Device 1 Building %
Room Device 1 Room | * Room Status:  Room is ready to capture.
Option Description
Campus (filter) Select the appropriate campus. Only buildings on that
campus are listed in the Building list.
Building (filter) Select the appropriate building. Only rooms in that
building are listed in the Room list.
Room Select the appropriate room. Room Status area
indicates whether or not the selected room is ready to
capture.

Date and Time - Recurring Event

The following figure shows the Date and Time scheduling options for a Recurring Event. Below the figure is a table
that describes the settings available.
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Date and Time
Single Event (=) Recurring
6/26/13 = End Date : 8/9/13 i
a Monday Tuesday Wednesday Thursday Friday Saturday Sunday
Start Time : I 9:00 AM Duration (minutes) : 10 (End Time : £:10 AM)
Option Description Inherited From
Start Date The start date for the recurring N/A
capture. Typically, the first day of
the term.
End Date The end date for the recurring N/A
capture. Typically, the last day of
the term.
Days Days of week to capture. Select all N/A
relevant days.
Start Time The start time of the capture. N/A
Typically, the class start time.
Duration The duration of the capture. Parent Organization > Child

Date and Time - Single Event

The following figure shows the Date and Time scheduling options for a Single Event. Below the figure is a table that

describes the settings available.

Typically, the class duration.

Organization > Schedule

Date and Time

® Single Event

O

() Recurring
9/1/09

10:00 AM

50 (End Time : 10:50 AM)

Option

Start Date

Start Time

Duration
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Description

The date of the capture.

The start time of the capture.
Typically, the class start time.

The duration of the capture.
Typically, the class duration.

Inherited From

N/A

N/A

Parent Organization > Child
Organization > Schedule
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Exclusions

The following figure shows the scheduling Exclusions options. Below the figure is a table that describes the settings

available.

Exclusions, e.g. mid-term break / holidays

from

M to

e Add=>

714713 - TITM3 remove

Option

Excluded Dates (from and to)

Presenters

Description

Specific dates or a date range that
should not be captured. These
might be the exam dates for the
course. These dates, with the term
exclusion dates, determine which
class sessions are not captured.

Inherited From

N/A

The following figure shows the Presenters section of the scheduling page. Below the figure is a table describing the

information.
Presenters
resenter ¥ Add>> Presenter, Default (defaultpresenter@echo360.com) remove
Search using partial first name, last name and/or smai address Allen, Deborah (dallen@Westman.edu) remove
Option Description Inherited From

Selected Presenter(s)

Echo Defaults

Presenters for the capture.
Typically, the Academic Staff
member presenting the course,
and, possibly, teaching assistants.

Presenters already appearing here
are the users assigned to the
section and are inherited from the
section. You can add additional
presenters or remove any
presenters from this schedule as
appropriate.

Section

The following figure shows the information displayed in the Echo Defaults section of the Schedule Details page.
Below the figure is a table describing the information.
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Echo Defaults

This setting controls the default presentation state. Presentations can either be made Available or Unavailable by default. Change
these seftings on a section’s or schedule's page to override the global defaults.

Echoes Initially Unavailable? :

Option Definition Inherited From

Echoes Initially Unavailable? If checked, Echoes are not availabl ~ Section
e as soon as processed. You might
check this box:

® |f Echoes must be approved or
edited before student review

® To ensure that Echoes are
released at specific times, such
as a week before exams

Live Streaming
Unavailable if
Checked

If you are
configuring this
schedule as a
Live Webcast of
the section, this
box must be
unchecked .

Product Groups

The following figure shows the scheduling Product Groups options. Below the figure is a table that describes the
settings available.

Product Groups

These settings control the default product groups created for each capture. Change these settings on a section’s or schedule’s page
o override the global defaults.

Product Group : Display Only (Podcast/Vodcast/EchoPlayer). Balanced between file size & quality % Stream Live :

The table below describes the options configured in the Product Groups section of the Schedule Details page.

Option Definition Inherited From
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Product Group The products and output qualities Section
that are captured. The selections
available are determined by the
capabilities of the capture
equipment resident in the room
selected for this schedule.The
specific choices you make for each
product (Podcast, Vodcast, and
EchoPlayer) must coordinate with
each other. See Manage Product
Groups for details.

Stream Live This check box may be enabled or N/A
disabled, depending on how the
product group was configured. See
Add a Custom Product Group.

® To enable live webcasting for the
section, check this box if it is not
already checked.

® To disable live webcasting for the
section, uncheck this box if you
can. If you cannot uncheck the
box, assign a different product
group to the schedule.

Source Configuration

The Source Configuration section of the Schedule Details page, shown in the below figure, allows you to change the
Display input resolution if the one configured for the selected room is inappropriate. The default is to use the
resolution configured for the selected room.

Source Configuration

Display Input Resolution Use room default (L024x768) »

Activate a Draft Schedule
In this section:

® Qverview
® Activate a Schedule

Overview

Saving a draft lets you keep a schedule without activating it. Say, for example, that you know the dates and times for
the course but not the room. You can enter the parameters you know, save the schedule as a draft, then enter just
the room later.
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The draft schedule (on both the listing page and detail page) shows the status of each required field. In the
screenshot shown in the figure below, you see that the room parameter has not been completed.

Dratt: 1

Tithe = Course Info Presenter Date & Time Reom Products Publishirg

- - [ Q S ]

ECON101-00; o ha L~ L L

Activate a Schedule

You can activate a draft schedule any time if all required schedule data has been entered. If all data has been
entered, you see a series of green check marks next to the schedule title.

1. Navigate to Schedule > Schedules.

2. At the bottom of the page, click the Draft tab.

3. Click the schedule you want to activate. The Schedule Details page appears.
4. Review the settings. Make sure you have entered all required data.

5. Click Activate.

Best Practice: Confirm the Assigned Product Group

If the product group assigned to a schedule specifies that a particular capture device be
used, and the device is not installed in the specified room, you will see a warning
message. Before activating the schedule, we recommend that you confirm that the device
in the room can support the assigned product group. See Manage Product Groups.

Manage Existing Schedules

In this section:

Overview

Sort Schedules

Filter and Search Schedules

Copy a Schedule

Delete Schedules

Manage Schedules with Default Presenter as Instructor

Overview

After you have created a few schedules you may want to:

Sort schedules by title, presenter, room or status
Filter and search schedules

Copy a schedule

Delete draft or completed schedules

All of these tasks are done from the Schedules tab. Select Schedule > Schedules.

Sort Schedules
The Schedules List view organizes schedules into active, draft, and completed groups by tabs. Within each tab,

schedules are listed in a table with sortable columns. You can sort schedules by various parameters, such as title or
presenter. The figure below shows the Active tab of the Schedules List view.
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Schedules (Active)

Add New Schedule

Term : echo.Summer 2011.1 3  Course : Choose... ¢ Section : [ Choose... +
Search
Filter By : | Date B From : o Te: [ Keyword Search:

All: 713 Active: 15 Draft: 4 Completed: 694 1-15 of 15
Title Presenter Room Next Capture Summary Status Capturing Device
Auth reqd 1 echo. Campus THB4 - 711814 Active 00-13-95-06-58-18
Ss101-Auth regd orgassistant sn fg{’;a‘,‘(‘:f"'g' SCHDforall[Do 71814 @ 1230 AM 45 55 apy - 1:25 AM (1 captures)  (since 7/17/13 6:06 AM)
Course A: pcap test (CRS101.P-CRS101.P.001) echo.Summer R instructor; - A "

011.1 Uday Rajaput;  SoriD Campus T2eM3 @G5 AN [22A3-8A0M3 L Aclive :
CRS101.P-CRE101 P.001 R guest SCHD Building, SCHD Room Mon/Tue 6:25 AM - 6:30 AM (6 captures)
c A test (CRS101.P-CRS101.P.001) echo.S
Coursa A: poap test ( } CENO-SUMIET b efaut Presenter Cap1 Campus: s @szoam T3 81 Active 00-50-c2-Be-a8-c0
Uday Rajaput Cap1 Building, Cap1 Room {

Wed/Thu 5:20 AM - 5:25 AM 6 captures) (since TH0/13 4:11 PM)

CRS101.P-CRE101.P.O01

Some schedules have additional management options. Hover your cursor on the schedule row to make the hover
menu appear.

Filter and Search Schedules

Use the Filter By and Keyword Search controls to display only the schedules of interest. The filter or search is
specific to the selected tab. This means that if, for example, you are viewing the Active schedules and search for the
course "ECON101", only schedules in the Active tab with that keyword will be displayed. To apply a filter to all
schedules with a particular keyword or parameter value, select the All tab.

This is particularly useful for applying a batch action, such as deleting schedules, to a set of schedules. Use the filter
to narrow the list, then sort the filtered list to show the schedules you want. You can then use the selection links,
shown in the below figure, to select all or some subset of the listed schedules for deletion.

o Aptus section-aptus term.2013.07.03.03.28.45.AM Uday Rajaput; SCHD Campus: 7313 - 733 Complateg  00-16-08-00-02-2d
ASLPL-Aptus section pavan kumar SCHD Building, SCHD Room 5:30 AM - 5:35 AM P (since 7/213 4:30 PM

@] Aptus section-aptus term.2013.07.03.06.27.12.AM Uday Rajaput; ~ SCHD Campus: 713113 - 71313 Completeg  00-1¢-08-00-02-9d
ASLPL-Aptus section pavan kumar SCHD Building, SCHD Room 6:30 AM - 6:35 AM P (since 7/2/13 4:30 PM

o section-echo.Summer 2011.1.2013.07.03.03.01 .16.AM Uday Rajaput; SCHD Campus: 703113 - 71313 Complateg  °0-1¢-08-00-02-0d
ASLPL-section pavan kumar SCHD Building, SCHD Room 3:15 AM - 3:20 AM Pl (since 7/2/13 4:30 PM

& section-echo.Summer 2011.1.2013.07.03.03.19.36.AM Uday Rajaput; SCHD Campus: 713113 - 713113 BT 0-02-9d
ASLPL-section pavan kumar SCHD Building, SCHD Room 4:15 AM - 4:20 AM P 12113 4:30 PM

Select: All 10 (of 16) Displayed Above, All 16 in Fiter, None

Emlm\

1-10 of 16 M
View: | 10 ¥ Schedules per Page

Actions:| Choose... ¥

Copy a Schedule
Copying a schedule is a convenient time-saver when a section's schedule is the same for two terms.

You can copy active schedules only. When you copy a schedule, the section and schedule data are copied into a
new term.

1. Create a new term (Schedule > Terms). You will copy the section and schedule into this new term.

2. Set this term to be the default Term (Configuration > Organizations).

3. Navigate to Schedule > Schedules. Find the schedule you want to copy, using a filter or keyword search as
necessary.

4. Hover your mouse over the schedule you want to copy. Notice that a copy button appears below the schedule
name, as shown in the figure below.
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All: 713 Active: 15 Draft: 4 Completed: 694 1-15 of 15
Title « Presenter Room Next Capture Summary Status Capturing Device
Auth regd 1 ) echo Campus: ey 718/14 - 711814 Active 00-13-95-06-56-18
Ss101-Auth regd orgassistant sn ﬁgrﬁ\g‘}‘if”- SCHDforall[Do 784 @ 12:30 AM 15 a0 ary' 1.29 AM (1captures)  (since 7/17/13 6:06 AM)
C: A test (CRS101.P-CRS101.P.001 ho.St .
P ) echa Summer D oot SCHD Campus: e @ezs Ay T2213- BA0/3 Active 00-1c-08-00-02-8d
- 0 . : foniTue B:25 AM - 6:30 AM since 7/8/13 6:12 AM
CRE101.P-CRS101.P.001 copy edit R guest SCHD Building, SCHD Room Mon/Tue 6:25 AM - 6:30 AM (6 captures) (since 7/8/13 6:12 AM)
g&“ﬁg A:peap test (CRS101.P-CRS101.P.001) echo -Copv this entire schedule to the default term 713113 @ 5:20 AM 7MTH3 - BIAM3 Active 00-50-c2-Ba-ad-c0
) Uday Rajaput CapT Building, Capl Room @S Wed/Thu 5:20 AM - 5:25 AM (6 captures) (since 7/10/13 4:11 PM)

CRS101.P-CRS101.P.001

Click Copy.

The edit schedule page displays. Edit the schedule data if necessary.

Scroll to the bottom of the page and click Save.

The schedule is saved as a dratft.

Notice that the new term ("Spring" for example) appears next to the course name and title.
10. Click Activate.

© 0N

Delete Schedules

You can delete draft, completed and active schedules. You can delete an active schedule even if the end date of the
schedule is later than the current day's date. Say, for example, that today is Friday, June 7, 2013 and you want to
delete a schedule with an end date of July 7, 2013. You can delete that schedule. You do not need to change the
end date in order to delete it.

When you delete a schedule, no other objects are deleted with it.

1. Navigate to Schedule > Schedules.
2. Select the tab containing the schedule(s) you want to delete.
3. Do one of the following:
® To delete a single schedule, click the name of the schedule to open the Schedule Details page, then
click Delete.
®* To permanently delete one or multiple schedules, select the box to the left of each schedule and select
Delete selected from the Actions drop-down list at the bottom of the page.
4. Confirm that you want to delete the schedule (s).
Notice the confirmation message at the top of the page.
6. Refresh the page. Notice that:
® The schedule is deleted from the list
® The number of schedules listed for the tab is smaller

o

Manage Schedules with Default Presenter as Instructor

In certain cases, you will see the Default Presenter assigned to a schedule:

Course A: pcap test (CR5101.P-CRS101.R.001) echo.Summer 2011.1 Device2 campus: g B8M7M3 -6/2813
CRS101,P-CRS101.P.001 Defauit Presenter o yice 2 Building, Deviee2 Room 6124113 @ 6:30 AM 6:35 AM

Mon/Tue 6:30 AM

This occurs when you have retired the only Presenter assigned to the schedule (typically an instructor assigned to
the associated section). When this happens, the Default Presenter (not a real person) is automatically to the
schedule, because the schedule requires a Presenter be assigned.

When an Instructor takes responsibility for teaching a section assigned to the Default Presenter, change the
presenter assigned to the section and schedule. You can update schedules in either of two ways:

® By importing from a spreadsheet . If you have many schedules to modify, use this method. See Import and
Export Objects and Import Schedules.
®* Viathe user interface. If you have only a few schedules to modify, this is the easiest way.
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The steps below provide guidance on how to identify and edit schedules associated with a Default Presenter. You
should also identify and edit any sections associated with a Default Presenter as soon as you can assign Academic
Staff to the section. See the People and Roles section of the Manage Sections page for additional information.

1. Navigate to Schedules > Schedules.

2. In the Keyword Search field, enter default presenter.

3. Review the list of schedules assigned to the Default Presenter and decide how you will edit the schedules.
a. Hover over the schedule and click edit.
b. Remove the Default Presenter

Search
Filter By : | Date B From : ] To: 3 Keyword Search : | Default Presenter
All: 45 Active: 1 Draft: 0 Completed: 44 21-40 of 45 4 4P M
Title Presenter Room Summary Status Capturing Device
= f:[-td;lfﬁm BRI E?Eﬁ gﬂﬁﬁ"; Capz Room ToT P 308 P EorEont (e 7213 10444 PM - 773
gzﬁ'f;; du(::jsfj jlxjaljica deletion-Section used for Device Deletion 0121 Presenter 53.'35 Eﬁ?ﬂﬁ"; Cap2 Room BaT P 252 oM Completed {Siee 7o 158 PM - T4
= E;\:T;? pleten i g D 53.'35 Eﬁ?ﬂﬁ"; Cap2 Room e A 1347 A Eont (e 715 10044 PM - 772
[d:tc(:jclcwa Default Presenter 53.'35 Eﬁ?ﬂﬁ"; Cap2 Room oA Completed (Siee 73 1,14 PA - 773
= E;:IIC;F serent D E§S§ Sﬁ?ﬂﬁ"; Cap2 Room AL Eont e T 147 oA - 7
gzilr:sce i‘: ‘:‘;‘?;r;\\jsa\?:ciu\il-eis;‘rrsi;g:: :::éule;%evice Deletion Default Presenter g:gé gi‘\r\gﬁ'ugs Cap2 Room ?‘3"21 E’r;ﬂ 7#:;1:? PM Completed Fsuwrs:oecTZ"?"J 11f-§C-SPI~‘. T4
= (dico‘:.:rc:ed:sk;t‘liofruraz:\:::‘daelelion—Seclion used for Device Deletion D g:gl gi‘mﬁ'u; Cap1 Room :ng’; /J‘J:J 74‘2;:132 AM Compieted Fsuwrs:oec.‘zzefil ig‘]‘éOPM TMa
E;:\:If:sf pleten durhg ezp procesan Default Presenter 5335 3352?”; Cap2 Room oA, Completed e 73 1,14 PA - 773

If you have a lot of schedules to modify, prepare and import a spreadsheet. See Import Schedules. If you
have only a few schedules to modify, edit each schedule.

a. Hover over the schedule and click edit.

b. Remove the Default Presenter

c. Add the new Instructor or Presenter.

Presenters y ]

Presenter

[= Add>> Presenter, Default (defaultpresenter@echo360.com) remove

Search using partial first name, last name andior email address

Be sure you also to maodify the sections to reflect the change in Instructors from Default Presenter.

Publishing

In this section:

® Add a Publisher
® Edit a Publisher
® Remove a Publisher

Add a Publisher

The process for adding a publisher is specific to each publisher. See the following pages for information about each
publisher.

® Blackboard Learning Management Systems
® Moodle Learning System

® | TI-Based Publishing
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Email Publisher

Closed Captioning and Transcript Publisher
iTunes U

RSS Feeds

ANGEL Learning Management Suite
Echo360 Search Indexing

3Play Media
TWEN

Edit a Publisher

1. Log in as an Administrator.

2. Navigate to Configuration > Publishers.

3. Hover over the publisher you want to edit.

4. Select edit.

5. Modify the fields as needed. The fields differ by publisher. See the following pages for information about each
publisher.

® Blackboard Learning Management Systems
Moodle Learning System

LTI-Based Publishing

Email Publisher

Closed Captioning and Transcript Publisher
iTunes U

RSS Feeds

ANGEL | earning Management Suite
Echo360 Search Indexing

3Play Media
TWEN

Remove a Publisher

A publisher is usually applied to a specific section or Echo. See the links above for instructions on applying a
publisher to a section.

You can delete a publisher that has failed. If the publisher has never failed, and it is still applied to a section or Echo,
you cannot delete it.

Blackboard Learning Management Systems

In this section:

® Qverview
® Traditional Publishing Methods
® Recommended Publishing Method - L TI-Based Publishing

Overview

You can publish to Blackboard, the learning management system. Publishing means that when an Echo is available,
Blackboard does the following.

® Creates a new announcement for the course with capture name, date and time information.
® Creates a detailed link (including capture name, date, and time) to the Echo in a content area for the course.
If a Class Capture content area is available, the link is posted there. If a Class Capture content area is not
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available, the link is posted to Course Documents.
® Adds the Echo360 icon to all announcements and links, so students can easily identify Echoes.

EchoSystem supports the following Blackboard versions.

® Blackboard Learning Management System Enterprise, versions 7.3 through 9.1. For any of these versions:
® |nstall and configure the Blackboard Building Block.
® Enable seamless login.
® See Blackboard Learning Management System Enterprise 7.3-9.1 - Individual Link Publishing for
instructions on both processes.
® Blackboard Learning System Vista 4 and CE. Add the publisher and enroll trusted users. See Blackboard
Learning System, Vista 4 and CE 6 - Individual Link Publishing.

Traditional Publishing Methods
If you have BlackBoard 9.1, two traditional publishing methods are supported:
Individual Link Publishing means that users see just Echoes and additional materials on the BlackBoard page.

This publishing method has been supported since EchoSystem 2.3. See Blackboard Learning Management System
Enterprise 7.3-9.1 - Individual Link Publishing for details.

EchoCenter Publishing means that users see the EchoCenter page. This newer publishing method has been
supported since EchoSystem 4.0. We recommend that you implement EchoCenter publishing. With this method,
users see a course list page, called an EchoCenter page, not just individual Echoes and additional materials. The
EchoCenter page offers:

® A convenient, intuitive dashboard that groups all materials (Echoes, Media Imports, and Personal Capture
recordings) together by date and lecture.
® An organization that matches the syllabus and the mental model of students and Academic Staff. If your
license includes the Collaboration and Statistics Service and you implement EchoCenter publishing, you can
also offer:
® Different pages for students and Instructors.
® For students: Access to discussions and course notes (bookmarks).
® For students and Instructors: Access to live webcasts (if offered by the section).
® For instructors: Most student features plus access to course statistics, engagement analytics, and
Echo-specific heat maps.

See Blackboard Learning Management System Enterprise 9.1 - EchoCenter Publishing for details.

Recommended Publishing Method - LTI-Based Publishing

You can use LTI-Based publishing if you have:

® Blackboard, version 9.1 Service Pack 9 or higher, and
® EchoSystem 5.2 with Service Pack 2 or higher

We recommend that you use LTI-Based publishing instead of the traditional publishing methods for these reasons:

® | TI-Based publishing supports EchoCenter publishing, which is recommended instead of individual link
publishing.

® |Tlis apublished standard. The information passed between the systems is secured and authorized, and
can ultimately provide for viewing analytics through the ESS.

® | TI-Based publishing is dynamic, but traditional publishing is static. Static publishing means that if you
change security settings or if you configure a publisher incorrectly, you must repost links to the learning
management system (LMS). In dynamic publishing, by contrast, any changes made to the courses or
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sections are passed through automatically.
® LTI configuration on the ESS is simple. It requires only an LTI profile and an association between the ESS
section and the LMS course via the Course IDs.

See LTI-Based Publishing and Blackboard LTI for details.

Blackboard Learning Management System Enterprise 7.3-9.1 - Individual Link Publishing

In this section:

Qverview
Install the Building Block
Configure the Blackboard Building Block
Enable Seamless Login
® Before You Begin
Add the Trusted System in the ESS
Add the Blackboard Publisher in the ESS
Configure the Blackboard Building Block for Seamless Login

Troubleshooting Seamless Login

® Add Blackboard to Each Section
® Troubleshooting Individual Link Publishing

e o o o

Overview
EchoSystem supports Blackboard Learning System Enterprise, versions 7.3 through 9.1.

If you have been using the building block for some time and have run into issues after upgrading to Blackboard 9.1,
use these instructions to delete the old building block and install the new one.

Enabling Blackboard as an EchoSystem publisher consists of these phases:

Install the Blackboard building block.

Configure the Blackboard building block.

Add Blackboard as a publisher.

Enable seamless login.

Add Blackboard to each section. After you enable Blackboard as a publisher, specify it as the publisher for
each section. This ensures that Echoes for each section publish to Blackboard.

aprwdPRE

Automated posting of Echo links into Blackboard is accomplished by the HTTP POST mechanism and the
Blackboard Building Block. The Blackboard Building Block is installed on the Blackboard server.

Install the Building Block

The screen shots in this section are from version 9.1.

1. If you have an older version of the Building Block installed, delete it.
2. Download the Blackboard Building Block from the Echo360 downloads page. Store the downloaded file in an
easy-to-access location.

Remember this location.

You will need to know this location later.
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3. Log in to Blackboard as a user with system administration privileges.
4. Navigate to the System Admin tab as shown in the figure below.
5. Click the Building Blocks link.

» Administrator Guide » 88L Choice
» Behind the Blackboard ™ » Privileges

» Session Fingerprint Settings
» Gateway Options

» Local Support Contact
» On Demand

» gdugarage ™

Building Blecks

Content Management » Authentication

» Manage Content Click the % Learning Environment Integrations
> Paorffolios Building Blocks ontext Encryption Key
» Learning Objects Catalog Link Integration Password

» Building Blocks
» Web Services

» Display Options

» Content Management Settings
» Technical Seftings

- » Administrator Search

» Feature and Tool Management

» Content Area Management

Tools and Utilities

» Announcements

» Messages
» Calendar

= m

6. Select Installed Tools.
Building Blocks

# Installed Tools

Configure or Delete Building Blocks that were included with the system.

7. Click the Upload Building Blocks button.

8. Browse for the Building Block. The file name is standard-4.0.x.war where x indicates the last element of the
release number.

9. Click Submit.

1. Install Building Block

Browse to select a Building Block package to install. Building Blocks can be downloaded from the Blackboard Building
Blocks Catalog.

Building Block Package Browse...

N swome ]
Cancel m

10. Click OK.

11. Notice that the building block ("EchoSystem Content Creator") is listed, as shown in the figure below, but
when first installed, is shown as Inactive.

12. Select the Available option from the list.

[ = [ ||
EchoSystem Content Creator Echo360, Inc. 4.0.2 Available j| ’ | Available ﬂ|
el I Concle 110 [acsioin 1 [o1 ilatl 1

Configure the Blackboard Building Block
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1. On the Building Blocks page, find the EchoSystem Content Creator item.
2. Click the Settings button. The Configure Echo Content Creator page appears.
3. Configure the first two setting groups, as shown in the figure below.

2 Configure Echo Content Creator

the individual Echo and EchoCenter publishing options

Shared Secret:

™ Allow Pre Version 4.0 Authentication Mechanism?
[ Check user for course membership?

Consumer Key:

Consumer Secret:

Realm: default

8 EchoSystem Basic Connection Properties (red fields required)

Basic connection properties allow the EchoSystem Server to connect to Blackboard and post data. The Shared Secret is defined in both the
EchoSystem Server Blackboard Publisher and Blackboard Building Block (here). The username needs to be a valid Blackboard user but the
password for this user is not required. Typically a dedicated Blackboard user is defined for this purpose. These properties are required for both

Fll EchoSystem Seamless Connection Properties

Seamless connection properties allow the EchoSystem Server to trust Blackboard's authentication and authorization of users for viewing
content. Set these properties to secure content by course without a duplicate login. These values are generated by the EchoSystem Server by
creating a Trusted System. Seamless connections are supported by both individual Echo and EchoCenter publishing options

Field Name

Shared Secret

Allow Pre Version 4.0 Authentication
Mechanism?

Check User for Course Membership

Consumer Key
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Description

The integration uses a dedicated shared secret
configured in the building block instead of the
administrator user password. The shared secret, set
by the Blackboard administrator, allows Blackboard
and the EchoSystem Server (ESS) to establish a
handshake. The shared secret values on the ESS
and the Blackboard Building Block must match. In
the ESS, navigate to Configuration > Publishers a
nd edit the Blackboard publisher.

Check this box only if:

® You are running different EchoSystem Servers
that point to the same instance of BlackBoard

® At least one of the EchoSystem Servers has
release 3.0, update 5 or earlier installed

Checking this box allows variant EchoSystem

Servers to send updates to a single BlackBoard
instance.

When this box is checked, you cannot use the
seamless security module or trusted systems.

If checked, Blackboard will verify that the student is
enrolled in the course before allowing access.
Enabling this option offers additional access control.

Enter the Consumer Key you established when you
added the trusted system.
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Consumer Secret

Realm

Enter the Consumer Secret you established when
you added the trusted system.

In most cases, you can leave this field at the default
value. Change it only if you are in the particular
circumstances described in Create the Security

Module.

4. Configure the next two settings groups, as shown below.
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Ef Individual Echo Recording Publishing Properties (red fields required)

These properties control how individual Echoes appear in Blackboard upon publishing. Blackboard can post an announcement, can set available
times for the Echoes, etc.

Default Content Area: Content

Alternate Content Area: Course Documents

(] Place content in a subfolder within content area?

If so, enter subfolder name: |ngne

# Add announcement each time a class capture is posted?
# Make newly p d c ilable by default?
# Allow Blackboard to track views of new custom content?

Content Available Until: [01/30/2022 |

L3 EchoCenter Publishing Options (requires EchoSystem 4.0 or greater)

EchoCenter publishing provides the viewers with the more functional course/section specific EchoCenter portal interface. The EchoCenter
portal page can be embedded in Blackboard or opened in a new window. It will appear in the course table of contents as "EchoCenter”. Include
the section identifier when posting multiple EchoSystem sections to a single course in Blackboard. Please note that due to a new feature in Bb

Learn 9.1 SP3 or later, the EchoCenter link will not appear in Blackboard for 30 minutes after the data is published to Blackboard

™ Include Echo System Section Identifier
Display:| In Parent Blackboard Page ~|

b

Field Name

Default Content Area

Alternate Content Area

Place content in a subfolder within content
area?

If so, enter subfolder name

Add announcement each time a class capture is
posted?

Description

The content area for posting EchoSystem links. If a
default content area does not exist, the building
block uses the Alternate Content Area value.

The content area for posting EchoSystem links. This
content area is used if a default content area does
not exist.

You can place content in a subfolder within the
content area. Subfolders are only supported when
posting content to the default content area.

Subfolder name.

If checked, an announcement is posted when an
Echo is posted.
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Make newly posted content available by default?

Allow Blackboard to track views of new custom

content?

Content Available Limit

Include Echo System Section Identifier

Display

5. Click Submit.
6. Look for a message indicating success.

Enable Seamless Login

If checked, the EchoSystem content link is available
in the UI. Links can be made available later through
the course control panel.

If checked, view statistics are enabled for the Echo
classroom content link. Links can be tracked later
through the course control panel.

If checked, the EchoSystem content link is available
in the UI. Links can be made available later through
the course control panel.

We recommend checking this box. Doing so
displays the section identifier on the Blackboard
course page.

Select from the drop-down list. The course list page
can open in the Blackboard course page or in a new
tab in the browser.

You can authenticate students seamlessly before allowing them to view content published in Blackboard.
"Seamlessly" means that once a student has authenticated against Blackboard, that authentication is transparently
("seamlessly") passed to the ESS. The ESS validates that the student has been authenticated by Blackboard and
does not ask the student for credentials a second time.

To enable seamless login, follow these phases:

1. Enable the trusted system in the ESS.
2. Enable the publisher in the ESS.
3. Configure the Blackboard Building Block.

Seamless Login is Optional

Echoes are published to Blackboard whether or not you enable seamless login.

Before You Begin

Ensure that:

® You are using a supported version of Blackboard. Seamless login is supported for Blackboard Learning

System Enterprise, versions 7.3 through 9.1.

® You have installed the latest EchoSystem Building Block on your Blackboard server.
® You have enabled the Blackboard publisher in the EchoSystem.

Add the Trusted System in the ESS

Be sure to record the Consumer Key and Consumer Secret. You will need both of these items when you configure
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the Blackboard Building Block.

1. Log in to the ESS as an Administrator.
2. Navigate to System > Trusted Systems.

Trusted Systems

System Mame & Description

BCp
EchoCenter

View: | 20 j Systems per Page 1-1 et

3. Click Add. The Add Trusted System page appears.
Add Trusted System

Trusted System Information

4. Complete the required fields:

® System Name. We recommend the name of the system being integrated, such as "Blackboard" or
"Moodle".
® Description. We recommend the URL of the system being integrated.
® Consumer Key. We recommend a simple string, such as your initials, for the Consumer Key.
5. Click Save to commit your edits and reveal your Consumer Secret.

Record the Consumer Key and Consumer Secret.

Make a note of the Consumer Key and copy the Consumer Secret value from the Trusted
Systems page into a text editor. Make sure you copy the equals signs (==) at the end of
the Consumer Secret. Do not copy the extra character of white space that follows the
equals signs (==).

6. Click Done.

Add the Blackboard Publisher in the ESS

1. Login to the ESS as an administrator.
2. Navigate to Configuration > Publishers.
3. Click Add. The Add Publisher page appears.
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Add Publisher

Publisher Details

Description :

Organization : I Echo3ad j
Publisher Type : I Choose... j
Use by Default: O

4. Enter a name and description for the publisher.
5. Select the parent or child organization to which this publisher belongs.
6. From the Publisher Type list, select Blackboard Learning Management System Enterprise 7.3-9.1. The

page expands to include a section on Publisher Configuration that is specific to this version of Blackboard.
Connection Properties

O

Publish Individual Links Options

Only applies to the "Publish individual Links" option below
Post Podcast ¢ @ Post Vodcast E
Post EchoFlayer : ™

Publishing Mode

The "Publish EchoCenter” option is the preferred option providing a richer experience for both students and

instructors. This option is supported for Blackboard versions 8, 8.0, and 9.1. Echo360 maintains support for
Blackboard's latest service packs for each version.

Publizhing Mode : I Publish EchoCenter B

7. If you want Blackboard Learning Management System Enterprise 7.3-9.1 to be your default publisher, select
the Use by Default box.

8. In the Connection Properties group, select the Use Seamless Login check box to enable the module.
9. Populate the other fields in the Connection Properties group, as described in the following table:

Field Name Description Example
User Name Enter the Echo360 Blackboard Echo360user
user name
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.............................................

The URL of the Blackboard
Learning Management System
Enterprise server

URL

https://ess. ech
ost at e. edu/ Bl ac
kboard

Enter the shared secret you (or
the Blackboard administrator)
created in the building block.

Shared Secret

If you are publishing individual links, check or clear check boxes as desired in the Publish Individual Links
Options group. Post EchoPlayer means that you will post a rich media version viewable in the EchoPlayer
(student player). If you are publishing to the EchoCenter (EchoCenter publishing), ignore this settings group.
In the Publishing Mode group, select either Publish EchoCenter or Publish Individual Links.

®* Publish EchoCenter means that Blackboard will display Echoes on the EchoCenter page. See Manag

® Publish Individual Links means that Blackboard will display Echoes in the default Blackboard format.

10.
11.
e the EchoCenter for details on this feature.
12. Click Save to commit your edits.
13.

Publish a course to Blackboard to verify that the building block is correctly configured.

Configure the Blackboard Building Block for Seamless Login

1. Log in to Blackboard as an Administrator.

2. Navigate to System Admin > Building Blocks.

3. Select Installed Tools.

4. In the list, find the Echo360 Building Block named EchoSystem Content Creator.

5. Click the Settings button.

6. In section 2, edit the Consumer Secret field, entering the same value you entered in the ESS by pasting the
Consumer Secret value from the text editor. Make sure you do not copy the extra blank character you may
have at the end of the Consumer Secret string.

Maks newty postad content svaliabis by default?

Alow Biackboard to track views of new custop.s
Faste the

ril Seamless Login Support. (onsumer Secrat e only required if

value here '

Consumsr Key: |Das$mrd1 |

CONSUMST 38075t [aannnanansnssnnnana|”

7. Click Submit.

Troubleshooting Seamless Login

See this KB (Knowledge Base) article to diagnose seamless login failures: Troubleshooting seamless content

authentication for Blackboard

Accessing the Knowledge Base

You will need a customer portal
if you need a login.

Add Blackboard to Each Section
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login to access the Knowledge Base. Contact Technical Support
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After you enable Blackboard as a publisher, specify it as the publisher for each section. This ensures that Echoes for
each section publish to Blackboard.

1. Get the Blackboard Course ID.
a. In Blackboard, navigate to System Admin > Courses.

b. Note the Course ID.

} Categorize | Availability: Delete
[] | Status \ Course |D < Course Name
Dirk Dirk's Test Course

In the ESS, navigate to the Section Details page.

2.
3. Scroll to the bottom of the page.
4, Click Add Publisher.
5. On the Add Publisher page:
a. Select Blackboard as the publisher
b. Enter the Course ID in the CMS ID field.
Echoes Monitor Schedule Configuration Reports
Schedules Courses Terms
Courzes = Course Detaile = Add Publisher
Add Publis Select Blackboard as ion Course (Echo360-001) 2010
the publisher
General Info P
I Blackboard |E|
Publisher Configuration Emer the GDMS? ID
in the CMS 1D field
ystem v. 2.6.2010-07-02.2
6. Click Save.

Troubleshooting Individual Link Publishing

See these KB (Knowledge Base) articles:

® To diagnose and correct general publishing failures: https://na6.salesforce.com/50180000000XTUS
® To diagnose seamless login failures: https://na6.salesforce.com/50180000000ikik

Accessing the Knowledge Base
You will need a customer portal login to access the Knowledge Base. Contact Technical Support

if you need a login.
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Blackboard Learning Management System Enterprise 9.1 - EchoCenter Publishing

In this section:

OQverview

Verify that the ecp Trusted System EXxists

Add the Blackboard Publisher in the ESS

Review the EchoCenter Settings on the Section
Add Blackboard to Each Section

Test the EchoCenter Link on the Blackboard Page

Overview

You may already publish individual links and supplemental materials to Blackboard (“individual link publishing"). You
can publish EchoCenter pages to Blackboard also ("EchoCenter publishing"). In EchoCenter publishing, the
EchoCenter page appears on the Blackboard page for the section.

You can support both publishing methods. Some sections can publish via individual link publishing, others can use
EchoCenter publishing. To do this, you will need to create two publishing instances, one for individual link publishing
and one for EchoCenter publishing.

If you decide to enable EchoCenter publishing in Blackboard, you must decide if you want to enable standard
EchoCenter publishing or Collaboration Service EchoCenter publishing. Standard EchoCenter publishing requires
only that you have Blackboard Learning System Enterprise version 9.1 installed. To enable Collaboration Service
EchoCenter publishing in Blackboard, you must:

® Have Blackboard Learning System Enterprise version 9.1 installed
® Have enabled seamless login with LDAP or have enabled the seamless security module
® Have subscribed to the Collaboration and Statistics Service

Enabling EchoCenter publishing consists of these required phases. Some of these phases are also required for
individual link publishing.

1. Install the Building Block .

Configure the Blackboard Building Block.

Verify that the ecp trusted system exists in the ESS.
Add the Blackboard publisher in the ESS.

Review the EchoCenter settings on the section.
Add Blackboard to each section.

Test the EchoCenter link on the Blackboard page.

Nookwd

©® Wwho can do this?
® System Administrator
® Admin of Parent Organization

Verify that the ecp Trusted System Exists

You must have the ecp trusted system installed.

1. Navigate to System > Trusted Systems.
2. Look for a trusted system called ecp.
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Trusted Systems

System Name Description

\ EchoCenter

ecp

Add the Blackboard Publisher in the ESS

1. Log in to the ESS as an administrator.
2. Navigate to Configuration > Publishers.
3. Click Add. The Add Publisher page appears.

Add Publisher

Publisher Details

Irganization : I Echo3ad j

Publisher Type : I Choose... j

1

4. Enter a name and description for the publisher.

Select the parent or child organization to which this publisher belongs.

6. From the Publisher Type list, select Blackboard Learning Management System Enterprise 7.3-9.1. The
page expands to include a section on Publisher Configuration that is specific to this version of Blackboard.

o
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10.

11.

12.
13.
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Connection Properties

Publish Individual Links Options

Qnly applies to the "Publish individual Links" option below
Post Podcast @ @ Post Vodecast : E
FPost EchoPlayer : E

Publishing Mode

The "Publish EchoCenter” option is the preferred option providing a richer experience for both students and

instructors. This option is supported for Blackboard versions 8, 8.0, and 9.1. Echo360 maintains support for
Blackboard's latest service packs for each version.

Publishing Mode I Publish EchoCenter Bl

Save

. If you want Blackboard Learning Management System Enterprise 7.3-9.1 to be your default publisher, select

the Use by Default box.
In the Connection Properties group, select the Use Seamless Login check box to enable the module.
Populate the other fields in the Connection Properties group, as described in the following table:

Field Name Description Example
User Name Enter the Echo360 Blackboard Echo360user
user name
URL The URL of the Blackboard | |

Learning Management System

; https://ess. ech
Enterprise server

ost at e. edu/ Bl ac
kboar d

Shared Secret Enter the shared secret you (or -
the Blackboard administrator)
created in the building block.

If you are publishing individual links, check or clear check boxes as desired in the Publish Individual Links
Options group. Post EchoPlayer means that you will post a rich media version viewable in the EchoPlayer
(student player). If you are publishing to the EchoCenter (EchoCenter publishing), ignore this settings group.
In the Publishing Mode group, select either Publish EchoCenter or Publish Individual Links.

®* Publish EchoCenter means that Blackboard will display Echoes on the EchoCenter page. See Manag

e the EchoCenter for details on this feature.

® Publish Individual Links means that Blackboard will display Echoes in the default Blackboard format.
Click Save to commit your edits.
Publish a course to Blackboard to verify that the building block is correctly configured.
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Review the EchoCenter Settings on the Section

You may wish to modify some EchoCenter settings in the Section configuration details.

Add Blackboard to Each Section

After you enable Blackboard as a publisher, specify it as the publisher for each section. This ensures that Echoes for
each section publish to Blackboard.

1. Get the Blackboard Course ID.
a. In Blackboard, navigate to System Admin > Courses.
b. Note the Course ID.

-~ Categorize | Availability: Delete
[ | status \ Course ID ™ Course Name
= Dirk Dirk's Test Course
2. In the ESS, navigate to the Section Details page.
3. Scroll to the bottom of the page.
4. Click Add Publisher.
5. On the Add Publisher page:
a. Select Blackboard as the publisher
b. Enter the Course ID in the CMS ID field.
Echoes Monitor Schedule Configuration Reports
Schedules Courses Terms
Courzes = Course Detaile > Add Publisher
Add Publis Select Blackboard as ion Course (Echo360-001) 2010
the publisher
General Info P
I Blackboard |E|
Publisher Configuration Enter the Goursg ID
in the CMS 1D field
ystem v. 2.6.2010-07-022
6. Click Save.

Test the EchoCenter Link on the Blackboard Page

1. In Blackboard, navigate to the course page for the section.
2. Verify that you see the EchoCenter link, as shown in the figure below.

Page 215



EchoSystem 5.5 Documentation

ElODC g N

Home Page

Information E:

Content £

Discussions

Groups

Toaols

Help

EchoCenter (5)C sectior

3. Click on the link. You should see the EchoCenter page, as shown below. Depending on how you configured
the Display setting on the Blackboard Building Block, you will see the EchoCenter page either:
¢ Embedded in the Blackboard interface, or
® In anew browser tab

Loura Test || 1 MyPiaces |4 Home | [ Hel |+ Logout

\dap2 - BIET ech® @

B Course Statistics View Trends By Echo  ~ & Recent Activity

Unique Viewers & Cumulative Views by Echo Unique m Use the discussion feature to engage other viewers by adding dialog.
Cumuiatve @ comm hile watching an Echo. Click here to leam

25 -

20 -

15 -

00 -
622 622

@ Course Echoes @ Available (O Other

Most Recent o 2 Echoes.

| - BIET (biet-Idap2) Summer BIET (biet-Idap2) Summer S
Ju

ine 22 10:25 AM June 22 10:25 AM. Friday. Week 4
Presenters: instructor sn, orginstructor sn

BIET (biet-ldap2) Summer
June 22 9:45 AM B 0 2 &

Statistics

VIEWING

Blackboard Learning System, Vista 4 and CE 6 - Individual Link Publishing

In this section:

® Qverview

® Add the Blackboard Learning System (Vista 4 and CE 6) Publisher
® Create and Enroll the Trusted User

® Add Blackboard CE/Vista to Each Section

Overview

Enabling Blackboard as an EchoSystem publisher for the Learning System CE and Vista versions consists of these
phases:

1. Add the publisher in the ESS.

2. Create and enroll the trusted user in the Learning System CE or Vista server.

3. Add Blackboard to each section. After you enable Blackboard as a publisher, specify it as the publisher for
each section. This ensures that Echoes for each section publish to Blackboard.
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No Powerlink is needed for this integration.

Add the Blackboard Learning System (Vista 4 and CE 6) Publisher

1. Log in to the ESS as a System Administrator.
2. Select Configuration > Publishers.
3. Click Add. The Add Publisher page appears as shown in the figure below.

Add Publisher

Publisher Details

k] oo
wolle . I|

Organization : I Echo3&d j
Publisher Type I Choose... j
Use by Default: [

4. Enter a name and description for the publisher.

Select the parent or child organization to which this publisher belongs.

6. From the Publisher Type list, select Blackboard Learning System (Vista 4 and CE 6). The page expands to
include a section on Publisher Configuration that is specific to Blackboard Learning System (Vista 4 and CE
6), as shown in the figure below.

Publisher Configuration

URL : | ST |
Trusted User : I Password I
Post Podcast ™ Post Vodcast - M
Post EchoPlayer : ™

7. If you want Blackboard Learning System (Vista 4 and CE 6) to be your default publisher, select the Use by
Default box.
8. Complete the fields as described in the following table:

o

Field Name Description

URL Enter the base URL for the CE/Vista server, such as
http://vista.university.edu
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INST Enter the name of the CE/Vista institution where
you will publish Echoes. The name must be entered
exactly as it is in CE/Vista, including capitalization
and spacing.

Trusted User Create a user account that will be used for the
integration with CE/Vista.

Password Enter a password for the trusted user account.

9. By default you will post Podcast, Vodcast, and EchoPlayer versions of your Echo to Blackboard Learning
System Vista 4 and CE 6. Post EchoPlayer means that you will post a rich media version viewable in the
EchoPlayer (student player). Change these if necessary by clearing the check boxes.

10. Click Connect to Blackboard to verify that a connection can be established. If it cannot be established, you
receive a detailed error message.
11. Click Save.

Create and Enroll the Trusted User

1. Log in to the CE/Vista server as an administrator.
2. Create a new user account for the trusted user created in the ESS.

User Name and Password Must Match

The user account must have the same user name and password as specified in the ESS.

3. For every CE/Vista section to be integrated with the EchoSystem, enroll the trusted user as a section level
designer.

4. Links to the Echoes appear in the calendar in the section for the day the lecture was recorded. Only links are
placed in CE/Vista. No files are placed in the calendar.

Learning Context ID (LCID)

For every CE/Vista section to be integrated with the EchoSystem, you need the LCID.
CE/Vista automatically generates the LCID.

Add Blackboard CE/Vista to Each Section

After you enable Blackboard CE/Vista as a publisher, you have to specify it as the publisher for each section. This
ensures that Echoes for each section publish to Blackboard CE/Vista.

Follow these steps.

1. Enter the LCID from Blackboard CE/Vista in the CMS ID field.
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Edit Publishei : Vista/CE Publisher

Harmi I

Conliguie Pulblisher

CHSID: |

2. Click Save.

Moodle Learning System

In this section:

¢ Overview

® Traditional Publishing Methods
® Recommended Publishing Method - LTI-Based Publishing

Overview

You can publish to Moodle, the open source learning management system, allowing students and Instructors to view
materials via the Moodle calendar.

Traditional Publishing Methods
Two traditional publishing methods are supported:

Individual Link Publishing means that users see just Echoes and additional materials on the Moodle calendar.
This publishing method has been supported since EchoSystem 2.3. See Moaodle - Individual Link Publishing for
details.

EchoCenter Publishing means that users see the EchoCenter page. This newer publishing method has been
supported since EchoSystem 4.0. We recommend that you implement EchoCenter publishing. With this method,
users see a course list page, called an EchoCenter page, not just individual Echoes and additional materials. The
EchoCenter page offers:

® A convenient, intuitive dashboard that groups all materials (Echoes, Media Imports, and Personal Capture
recordings) together by date and lecture.
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® An organization that matches the syllabus and the mental model of students and Academic Staff. If your
license includes the Collaboration and Statistics Service and you implement EchoCenter publishing, you can
also offer:

Different pages for students and Instructors.

For students: Access to discussions and course notes (bookmarks).

For students and Instructors: Access to live webcasts (if offered by the section).

For instructors: Most student features plus access to course statistics, engagement analytics, and

Echo-specific heat maps.

See Moodle - EchoCenter Publishing for details.

Recommended Publishing Method - LTI-Based Publishing

You can use LTI-Based publishing if you have:

® Moodle, version 2.2 or higher, and
® EchoSystem 5.2 with Service Pack 2 or higher

We recommend that you use LTI-Based publishing instead of the traditional publishing methods for these reasons:

® | TI-Based publishing supports EchoCenter publishing, which is recommended instead of individual link
publishing.

® | Tlis a published standard. The information passed between the systems is secured and authorized, and
can ultimately provide for viewing analytics through the ESS.

® | TI-Based publishing is dynamic, but traditional publishing is static. Static publishing means that if you
change security settings or if you configure a publisher incorrectly, you must repost links to the learning
management system (LMS). In dynamic publishing, by contrast, any changes made to the courses or
sections are passed through automatically.

® LTI configuration on the ESS is simple. It requires only an LTI profile and an association between the ESS
section and the LMS course via the Course IDs.

See LTI-Based Publishing and Moodle LTI for details.

Moodle - EchoCenter Publishing
In this section:

Overview

Install the Moodle Plugin

Add a Trusted System (EchoSystem)
Configure the Administration Settings (Moodle)

[ )
[ ]
[ ]
[ ]
®* Map Moodle Courses to EchoSystem Sections (Moodle and EchoSystem)
[ ]
[ ]
[ ]
[ )

Add the EchoCenter Block to the Course (Moodle)

Collaboration Service Only - Review Permissions Assigned to Roles in Moodle
Test EchoCenter Publishing for a Section (Moodle and EchoSystem)
Troubleshooting

Overview

How EchoCenter Publishing Benefits Students and Academic Staff
EchoCenter publishing allows Academic Staff to create a link to the EchoCenter page in their Moodle course.

Students and Academic Staff will see the link in the Moodle course page, as shown in the figure below.
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Upcoming events =10
There are no upcoming events
Go to calendar...

New event...

Recent activity (=10

Activity since Thursday, 14 July
2011, 09:59 AM
Full report of recent activity...

Mothing new since your last
login

ech® 4

Go to Echo360 EchoCenter...

To open the EchoCenter, they click on the block. The EchoCenter page is displayed within the Moodle page layout,
as shown in the figure below.

Home ® My courses W Idap » Echo360 EchoCenter

Ldap only : Echo360 EchoCenter

!
Idap - BIET eche @
.
& Course Statistics View Trends By Echo v & Recent Activity <
Unique Viewers & Cumulative Views by Echo Unique Bl REPLY TO
Cumulative m e
hkjhkjh
25 - posi y sn.instructor on June 13. in BIET
(biet: p) Summer - lecture 2 - dencie
20 - added heatmaps

TOPIC
hkjhkjh

posted by dt.student on June 13. in BIET

10 - (biet- p) Summer - lecture 2 - dencie
added heatmaps
05 -
TOPIC
00 - Discussion 1
611 6111 612 612 614

@ Course Echoes (=) Available (_) Other

15 -

To open the EchoCenter in a new window, users click the Open in new window icon at the top right of their course
page.

Access is seamless. No further authentication is required.
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If you subscribe to the Collaboration and Statistics Service you can offer additional functionality, including different
EchoCenter pages for students and Academic Staff. Users will see the correct page for their role after the plugin is
installed. No further configuration is required, though you may want to review and adjust the permissions assignhed
to roles in Moodle.

Requirements

These instructions assume that:

® You have EchoSystem 5.0 or higher installed.
® You have Moodle versions 1.9.x through 2.4 installed. Later versions may work, but the latest tested version
is 2.4.
® You have PHP version 4.3.0 or later installed on the Moodle server.
® You have the following PHP modules installed on the Moodle server:
® Curl
® Hash
® Openssl
The server running the EchoSystem can contact the server running Moodle.
You are a Moodle Administrator.

Procedure

When you enable EchoCenter publishing, you are, essentially, setting up a link between Moodle and the ESS. To
establish this link you:

1. Set up atrusted system (following the OAuth standard) between Moodle and the ESS. You do this
establishing the trusted system in the ESS and giving Moodle the Consumer Secret and Consumer Key. This
trusted system allows the ESS to accept communication from Moodle.

2. Associate ESS sections and Moodle courses. You do this by establishing a Moodle Course Field that will
be compared to the ESS External System Id field.

Follow these phases:

1. Install the Moodle Plugin (Moodle).

Add a Trusted System (EchoSystem)

Configure the Administration Settings (Moodle).

Map Moodle Courses to EchoSystem Sections (Moodle and EchoSystem).

Add the EchoCenter Block to the Course (Moodle).

Collaboration Service Only - Review Permissions Assigned to Roles in Moodle. If you do not have Collaborati
on Service, skip this step.

7. Test EchoCenter Publishing for a Section (Moodle and EchoSystem).

ok wh

Moodle 2.0

The screen shots are from Moodle 2.0.

Install the Moodle Plugin

Use the following steps to install the Echo360 Moodle plugin to your Moodle installation.

1. Download the latest Moodle plugin from the Echo360 customer support portal.

2. Expand the zipped file.

3. Copy the blocks from the correct folder in the zip package to the blocks folder in your Moodle installation.
® Echosystem's Moodle plugin is only compatible with Moodle v2.0 or higher.
®* Moodle 2.x:
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® Unzip the moodle-54.zip file.
® Copy echo360_configuration to <moodle installation
dir>/moodle/blocks/echo360_configuration

® Copy echo360_echocenter to <moodle installation
dir>/moodle/blocks/echo360_echocenter
4. Install the new blocks.

a. Log into Moodle as an Administrator.
b. Navigate to Site administration > Notifications.

Echo360

Home ® Site administration ™ MNotifications

Navigation = ]

Home

My home
b Site pages
P My profile
b Courses

Admin bookmarks -0

bookmark this page

Settings -1
F My profile settings
¥ Site administratiny
Notifications
5. Notice the dialog boxes shown in the figures below. You will see these only once, right after you install the
plugin.
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You are logged i as Adkries User fLogout)

Plugins check

Plugins check

The folowing tables show the modules, biocks and fiters that have been detected in your cument Moodie installation; They indicate
which pluging are standard, and which ane not. All non-standard pluging should be checked and upgraded 1o their most recent versions
before continuing with this Moodie upgrade.

C Retoad

Upgrage

- . You are logged in as Admin Usar (Logout)
Upgrading to new version

block_echo360_configuration

Success

block_echo360_echocenter

Success

Continue

Add a Trusted System (EchoSystem)

©® Who can do this?
® System Administrator

Create a trusted system in EchoSystem so the Echo360 Moodle plugin can communicate with your EchoSystem
Server (ESS).

Be sure to record the Consumer Key and Consumer Secret. You will need both of these items when you configure
the administration settings in Moodle.

1. Log in to the ESS as an Administrator.
2. Navigate to System > Trusted Systems.
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Trusted Systems

System Name a Description

BCcp
EchoCenter

ew:| 20 j Systems per Page 4-1 of 1

[ Agd |

3. Click Add. The Add Trusted System page appears.
Add Trusted System

Trusted System Information

4. Complete the required fields:

® System Name. We recommend the name of the system being integrated, such as "Blackboard" or
"Moodle".
® Description. We recommend the URL of the system being integrated.
® Consumer Key. We recommend a simple string, such as your initials, for the Consumer Key.
5. Click Save to commit your edits and reveal your Consumer Secret.

Record the Consumer Key and Consumer Secret.

Make a note of the Consumer Key and copy the Consumer Secret value from the Trusted
Systems page into a text editor. Make sure you copy the equals signs (==) at the end of
the Consumer Secret. Do not copy the extra character of white space that follows the
equals signs (==).

6. Click Done.

Configure the Administration Settings (Moodle)

The Moodle plugin can be configured from within Moodle.

1. Log in to Moodle as an Administrator.
2. Navigate to the Echo360 configuration page by doing one of the following:
® Choose Echo360 Configuration from the navigation menu on the left (Site administration > Plugins
> Blocks), as shown in the figure below.
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Settings -l
b My profile settings

~ Site administration
[ Netifications
@ Registration
Advmc.e:l features
¥ Users
¥ Courses
¥ Grades
P Lecation
¥ Language
¥ Plugins
¥ Activity modules
¥ Blocks
Bl Manage blocks
Coursae list
2 Echo360
I:ﬂc::lnf'guralion

Online users

® Click on the Settings link in the Manage blocks page in the same table row as the Echo360
Configuration block, as shown in the figure below.

Echalbd
Fara B S alreniaion B Soges B Botas B G ae dass
havsgabar
Biocha
kv
, :‘;_‘“;‘__ By ralewet Sesoe  Baowtilne [eew Sefegs
[ ] FETISES w Lmata
L= - o
] K Ibrumdn
'] ¥ Lrntn
'] e Dt
1 - Mot
2 LTI E 3 Dt
L TN e Lhsw's
a anosazn » Uwta
L] I OOTANC » Dhrwta
] IS w Daasia  Sadingn
1 STHORS 40 - Theeet,
Caurdw S e L HETINSE w Ttasta
Edhaf sl Contl g ofiain L A a2 Dessda  Sallrigs
" Plgin Echali) Ecaismer " FALE & i

3. Notice that the Echo360 Configuration page appears as shown in the figure below.

Echo360 Configuration

C Details

Enter the connection details for the EchoSystem Server that this Moodle installation will communicate with. The Trusted System Consumer Key and Trusted System Consumer Secret can be
obtained from the Web ini ion Interface at "C ion — Trusted Systems”

) __CEChO‘SVS'em URL | https:/f Default: hitps://echosystem your.institution.edu:8443/ if you are using all HTTPS content security, hitpi/<same>:8080 if using HTTP content
black_ocha360_configuration_ echasys

" security

The full URL to your EchoSystem installation including the protoeol {htip or hiips) and port number.

Trusted System Consumer | moodie

Kes
500 confiueaton vusieh s Fhekeyantered for this extemal system into EchoSystem.

Default: Empty

Trusted System Con;umer tySwVnOfKInQroHVEQEShPIw+9i| Default: Empty
ecret
biack_echnt80_confauration_trusted_sys Thekey-generated by EchaSystem for this external system. The key will consist of a long series of randomised letters, numbers and symbols.

Moodle Course Mapping Details

Select the Moodle Course Field that will be entered in EchoSystem as the Section External ID

Moodle Course Field | Course short name  # | Default: Course short name
ck_echu380_configuration_moodle_exfemal d el

" Thisis the field in Moodle that will be passed to EchoSystem to associate a Moodle course with an EchoSystem section.

Save changes

4. Configure the plugin.
a. EchoSystem URL. Enter the content URL to your ESS.
i. Tofind it, log in to the ESS as a System Administrator and navigate to System > System
Settings.
ii. Find the Public Content Base URL field. The Public Content Base URL typically looks like this:
https://lyourhost:8443/ess.
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iii. Copy all of the URL except for the trailing ess.
iv. Make sure that the EchoSystem URL you enter looks like this: http://yourhost:8443/.
b. Trusted System Consumer Key. You entered this value when you created the trusted system. You
should have made a note of it. Enter the value.
c. Trusted System Consumer Secret. The EchoSystem generated this value when you created the
trusted system. You should have copied it into a text editor. Copy it from the text editor.

Best Practice: Do Not Copy the Trailing Space

Be sure not to copy the trailing space from the text editor into the ESS.

d. Moodle Course Field. This is the Moodle field that is used to map a Moodle course to an EchoSystem
section. You can enter any of several Moodle fields: Course Full Name, Course Short Name, Cours
e ID Number. In this example, we use the Course ID Number.

Map Moodle Courses to EchoSystem Sections (Moodle and EchoSystem)
Overview

When a student clicks on the EchoCenter block, the block must determine which section in EchoSystem to show to
the student. It does this by comparing the value in the field specified in the Moodle Course Field with the value in
the ESS's External System Id field.

Say, for example, you specified Course ID Number as the Moodle Course Field when configuring the
administration settings.

1. Moodle looks for the value in that field. Say that the value is Coursel.

2. Moodle passes this value to the ESS.

3. The ESS looks at the External System Id fields for each section.

4. When it finds a section that has Coursel in the External System Id field, it shows the student the
EchoCenter page for that section.

In this phase, you populate the External System Id field.
Populate the ESS External System Id Field for a Section

This procedure assumes that you specified Course ID Number as the Moodle Course Field when you configured
the administration settings.

This procedure shows how to populate the External System Id field for a single section. You must populate the Exte
rnal System Id field for each section.

Best Practice: Use .CSV Import for Sections

You can quickly populate the External System Id field for all sections by importing this field
(and, if you wish, many others) from a spreadsheet into ESS. For a general description of the
import feature, see Import and Export Objects. For further details, see Import Sections.

1. In Moodle, navigate to the Edit Course Settings page for the section (Home > Courses > EC-Demo > Edit
Course Settings). This example uses EC-Demo as the course.
2. Note the value of the Course ID Number field.
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Home » Courses ™ EC-DEMO M Edit course settings
Navigation =100
Home
o My home General
) Site pages
P My profile Category (3} | Miscellaneous '+
~ Gousea Course full name™ (3)  EchoCenter Shared Demo
¥ EC-DEMO .
b Participants Course short name™ (3}  EC-DEMO
P Reports Course D number C 1
R . @ | Course dp—

3. In ESS, navigate to the Section Details page.
a. Navigate to Schedule > Courses. The Courses page appears.
b. Click the course link. The Course Details page appears.
c. Click the section link. The Section Details page appears.

4. Click Edit.

5. In the EchoCenter group, enter the Course ID Number field value in the External System Id field. It is Cours
el in the example figure shown below.

EchoCenter

These seftings control the behawvior of the EchoCenter.

Disable at end of Term? : ]

Show podcast link? : g

Show EchoPlayer link? : IE]

Heading for scheduled captures (singular) : | Lecture
Heading for other uploaded content {singular) : | Supplemental
Extemal System Id : * Coursel

6. Click Save.

Add the EchoCenter Block to the Course (Moodle)

You can take either of two approaches to this phase:

® Alter the default layout for a course
® Train instructors to add the EchoCenter block

Alter the Default Layout for a Course

See the Moodle documentation for details on altering the default layout for a course.

A simple example would be to add a line to the config.php page for your Moodle installation:
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.....................................................................................................................................................................................

$CFG >def aul t bl ocks_topics =

‘participants, adm n: echo360 _echocent er, nessa
ges, onli ne_users';

This would change the default block layout for topics format courses to People and Administration on the left, and
Echo360 EchoCenter, Messages and online users on the right.

Train Academic Staff to Add the EchoCenter Block

You can train Academic Staff to follow this simple procedure or do the operation yourself.

1. In Moodle, make sure you are in Edit mode. You should see a "Turn editing off" button like that shown in the
following figure:

“ Turn editing off |

2. In the Add a block menu, choose the Echo360 EchoCenter block, as shown in the figure below.
Add. M
Activities |
Admin bookmarks |

Blog menu |

Blog tags |

Calendar |

Comments |

Community finder |

Course completion status |

Course/Site description |

Courses / |

Echo3g0 EchoCenter |

HTML

Logged in user w
Mentees

Messages

My private files

Online users

Feaople -
Cluiz results

Collaboration Service Only - Review Permissions Assigned to Roles in Moodle

If you do not have Collaboration Services, skip this step.

If you subscribe to the Collaboration and Statistics service, student and Instructors see different versions of the
EchoCenter page. They will continue to see the correct version of the EchoCenter page after you install the plugin
without any further configuration on your part. The plugin:

1. Adds two new permissions, View EchoCenter as EchoSystem Instructor and View EchoCenter as
Student

2. Adds these permissions appropriately to the Student, Teacher, Editing Teacher, and Manager (Admin in
Moodle 1.9) roles
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Users with these Moodle roles see the Instructor version:

® Editing Teacher
® Manager (Admin in Moodle 1.9)

Users with these Moodle roles see the student version:

Student

Teacher

Editing Teacher

Manager (Admin in Moodle 1.9)

You can see the EchoCenter permissions if you edit the roles.

® The student role shows that the Instructor permission is not set but the student capability is allowed, as
shown in the following figure:

Block: Echo360 Configuration

blockiecho3B0_configuration:viewasinsiructo

View EchoCenter as EchoSystem Instructor Not set A
Allow ;

View EchoCenter as Student

blockfecho360_configuration:viewasstudent

® The teacher role shows that both permissions are allowed, as shown in the following figure:

Block: Echo360 Configuration

View EchoCenter as EchoSystem Instructor Allow > A
blackiecho3B0_configuration:viewasinstructar

View EchoCenter as Student Allow
blackfecho3B0_configuration viewasstudent

You may wish to configure Moodle roles to add or remove these permissions.

Test EchoCenter Publishing for a Section (Moodle and EchoSystem)

1. In Moodle, navigate to a section that has EchoCenter enabled.
2. Look for the EchoCenter link.

3. Click on the link.

4. You should see the EchoCenter page.

5. If you do not, check Troubleshooting for common errors.

Troubleshooting

Most errors occur when entering data into the Echo360 Configuration page.

® EchoSystem URL is wrong. Make sure that the Echo Base URL has been copied correctly from the ESS
page (System > System Settings) to the Moodle plugin. Include the final slash but do not include the ess.
See Configure the Administration Settings (Moodle).

® Consumer Secret is wrong. Make sure you do not copy the trailing space when you paste the Consumer
Secret from the text editor to the Moodle plugin. See Configure the Administration Settings (Moodle)

® Values mismatch. The value in the External System Id in the ESS does not match the value specified in the
Moodle Course Field. See Map Moodle Courses to EchoSystem Sections (Moodle and EchoSystem).

You may also discuss this plugin on the Moodle contributed code forum.

Moodle - Individual Link Publishing
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In this section:

Overview

Install the Moodle Calendar Patch

Configure Moodle

Add the Moodle Publisher to the ESS

Add Moodle to Each Section

Example: San Francisco State University (SESU)

Overview

You can publish to Moodle, the open source learning management system. "Publishing" means that Echoes are
available to students via the Moodle calendar.

Enabling Moodle as an EchoSystem publisher consists of these phases:

1. Install a Moodle calendar patch provided by Echo360
2. Configure Moodle

3. Add the Moodle Publisher to the ESS

4. Add Moodle to each section

These instructions assume that:

You already have Moodle installed.

The server running the EchoSystem can contact the server running Moodle.

You are using Moodle versions 1.8.x through 1.9.x.

You are using the default Apache and Moodle paths. If your configuration does not use the default paths,
adapt the path names appropriately.

® |f you are running Windows, you already have GNU installed and can navigate to c:\\Program
Files\Gnuwin32\.

The patch file, named moodle-1.8.2-1.9.7.patch, is located in the Supporting_Components folder in your ESS
installation directory. This patch includes changes allowing publishing on Moodle version 1.9.7. You can install this
patch even if you installed another patch earlier. You do not need to uninstall the old patch.

Install the Moodle Calendar Patch

For Linux Operating Systems

These instructions assume that your Moodle installation is located in /var/www/html/moodle.

1. Navigate to the Supporting_Components folder in your ESS installation directory.

2. Locate the file labeled moodle-1.8.2-1.9.7.patch.

3. Copy it to your Moodle server program directory (typically C:\Program Files\Echo360\Server).
4. Stop the Apache service.

5. Execute these commands from the terminal prompt.

cd /var/ww/ ht m / noodl e
patch \-pl < echosystem noodl e_patch_1.8.2-1.9.7. patch

6. Look for output like that shown in Output After a Successful Patch Installation.
7. Restart the Apache service. The patch has been applied successfully.
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For Windows Operating Systems

arwbdPE

6.
7.

Navigate to the Supporting_Components folder in your ESS installation directory.

Locate the file labeled moodle-1.8.2-1.9.7.patch.

Copy it to your Moodle server program directory (typically C:\Program Files\Echo360\Server).
Stop the 1IS service.

Execute this command from the command prompt.

c:\Program Fi | es\ GhuW n32\ bi n\ pat ch. exe" \--binary \-pl <
\ [ pat hToPat chFi | e\]\ echosyst em npbodl e_patch_1.8.2-1.9. 7. patch

Look for output like that shown in Output After a Successful Patch Installation.
Restart the IIS service. The patch has been applied successfully.

Output After a Successful Patch Installation

After you install the moodle-1.8.2-1.9.7.patch, you see output like this:
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(Stripping trailing CRs from patch.) patching
file adm n/ met/adm nlib. php

(Stripping trailing CRs from patch.)
patching file cal endar/ met/cal endar. php
(Stripping trailing CRs from patch.)
patching file course/ met/course. php
(Stripping trailing CRs from patch.)
patching file I ang/en_utf8/ cal endar. php
(Stripping trailing CRs from patch.)
patching file | ang/en_utf8/ cal end met. php
(Stripping trailing CRs from patch.)
patching file | ang/en_utf8/ course met. php
(Stripping trailing CRs from patch.)
patching file met/ peer. php

(Stripping trailing CRs from patch.)
patching file met/renote client. php
(Stripping trailing CRs from patch.)
patching file met/xm rpc/server. php
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Configure Moodle

Moodle configuration consists of the following phases:

1. Enable Moodle authentication.

2. Enable network communication.
3. Generate a self-signed certificate.
4. Enable services.

Enable Moodle Authentication

1. Log in to the Moodle web interface.
2. Navigate to Users > Authentication > Manage Authentication.
3. Enable Moodle Network Authentication by clicking the eye icon, shown in the below figure.

Moodle Metwork authentication e + Settings

Enable Network Communication

1. Choose the new Moodle Network Authentication option that appears on the left-hand pane.
2. Set RPC negotiation timeout to 60. Auto add remote users is not used by the EchoSystem, so it can be
set to your preferred value. These options are shown in the figure below.

Users are authenticated according to the web of trust defined in
your Moodle Metwork settings.

FPC negotiation IEIZI The timeout in seconds for authentication over
timeout: the *MLEFC transport.

Auto add remote IYES vI YWWhen setto Yes, a local userrecord is
Lsers: auto-created when a remote user logs in for the
first time.

These host's users can roam in to your site:

w

Navigate to Courses > Enrollments and enable the Moodle Networking option, as shown in the figure below.

4. Click Save Changes.
LDAP r Edit
Moodle MNetworking = Edit

5. Navigate to Security > Site Policies and enable the Allow EMBED and OBJECT tags option, as shown in
the figure below.

Allow EMBED and OBJECT W Default: Ko
6. Navigate to Network > Settings. Set Networking to On and click Save as shown in the below figure.

Metworking: € Off
& On
oave changes

~

Navigate to Networking > XML-RPC hosts.
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10.

11.
12.

13.

14.

Page 234

Obwiously the last example is not a recommended configuration.

10.3.9.71/3z2

Enter the IP address (not the hostname) of the EchoSystem Server (ESS), using CIDR notation at the end of
the address (example: - /32), as shown in the above figure. Click Save.

Use the Test an address function at the bottom of the page to verify the ESS IP address is trusted.

Navigate to Networking > Peers.

Register all hosts (Hub mode)

You can choose to register all hosts that try to connect to you
automatically. This means that a record will appear in your hosts list for
any Moodle site that connects toyou and requests your public key.
You have the option below to configure services for "All Hosts' and by
enabling some services there, you are able to provide services to any
Moodle server indiscriminately.

r Feqgister all hosts (Hub moda)

Sawve changes |

Ensure that Register all hosts is not selected, as shown in the figure above.

In the Add a new host section at the bottom of the page, add the ESS as a Moodle Peer. Enter the URL to the
ESS, including the protocol and the port number (example: https://ess.echostate.edu:8443/).

Click Add host. The Review host details page appears. Ignore the error regarding the retrieval of the public
key. You will enter the public key soon.

Enter EchoSyst em(or any other name) in the Site field. The Hostname field should be populated with the
URL entered on the previous page, as shown in the figure below.
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Site: |E|::h|:|5ystem

Hostname:  |hitps:/4#10.3.8.71:8443

Fublic key:
Public key (3 -

YValid until.  Sunday, 24 hWay 2020, 0536 Ph
Last connecttime:  17:50:33 27/0%2010

IF address: 103971
IP address (3

sawve changes |

Generate a Self-Signed Certificate

Moodle requires a self-signed certificate for the ESS host, even though Moodle is not actually contacting the ESS.
These steps take place on the ESS itself.

1. Install OpenSSL for your operating system.
a. For Linux operating systems:
i. Open Terminal and run the following command:

openssl req -new -days 3650 -x509 -nodes -keyout /dev/null

b. For Windows operating systems:
i. Download and install OpenSSL for Windows. Navigate to this address: http://www.slproweb.co
m/products/Win320penSSL.html.
ii. Open the command prompt and navigate to C:\Program Files\OpenSSL-Win32\bin .
iii. Run the following command:

openssl req -new -days 3650 -x509 -nodes -keyout NUL

2. Enter information regarding the certificate request. Press Enter to accept the default values for all fields
except the Common Name (CN). This is the only required field.

3. When prompted for the Common Name, enter the URL to the ESS, including the protocol and the port
number (example: https://ess.echostate.edu:8443/).
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Sdev/null’

You are about to be ask enter information that will be incorporated
into your certifica
What you are about what is called a Distinguished Name or a DN.
e are gquite a few Ti s but you can leave so blank
me Tields there will be a default wvalue,
e field will be left blank.

Country Name | code} [AU]:
State or Province N {full name)

ity) []:
company) [Internet Widgits Pty Ltd]:
Organizational Unit Name (eg, section) []:

Common Name {eg, YOUR name) []:https: i 5 edu:B84437
Email Address []:

BEGIN CERTIFICATE
MITDMTCCApqoAWIBAQIIATIfVSEADCeXyMABGCSqGSIb3DOEBEQUAMGExCzAJBgNV
BAYTAKFVMRMWEQYDVQOIEwpTEZ1ILLVNOY XRIMSEWwHWYDVOOKExhIbnRLecmSLdCBX
aWRnaXRzIFBEOeSEMdGOxKDAMBgNYBAMTHZhEBdHEZz0i8vZXNzLmYjaG9zdGFRZS
ZHUGODOEM HRCNMT A j ASM] AzMDUIWhcNMj AwNjABM] AzMDULIW] BvMOs Y
VOQGEwIBVTETMBEGALUECBMKUZ29t Z51TdGFEZTERMBECALUECHMY SW5AZXIJuZX
V21kZ218cyBQdHkgTHREMS g¥DVQODEx9odHRwezovL2Vzey51Y 2hvc3RhdG
ZWR10jgBNDMvMIGTMADGCSqGSIb3DOEBAQUAALAGNADCELIQKEQQCeBOUGIPsT1CaU
wDZ2TswoSDM+XLln0iZlpekloDeiHAraaeddRyj928y4FpEFEThXSTCi0gF JKHmMy Sy
QJZCBf4wahFEtGNueSOTfDtm30RMys rFLFNcLVVzOmROyEqxbvhFRNAM3TSG+15q1
Vsecllg/ (bbYWEeTF uXy2EtjbOwIDAQABCAHUMIHRMBOGAILUDDgOWEBTiRzm7
JgDLXT+4 jwkbOuCpTdw CEBo0YDVROjBIGZMIGWQETiRzm7 gD LXT+4 jwkbOulp
TdveXKFzpHEwbzELMAKGAIUEBRMCOVUxEzARBgNVBAQTCLNVbWUTUIRhdGUxITAT
BgNVBAoTGELudGYybmVAIFdpZGdpdHMgUHRSIEx@ZDEoMCYGALUEAxMfaHRACHME

Le3MuZWNob3NEYXRLLMYEdTodNDQzLATJATFVSEADce XyMAWGALUdEWwDFMAME
ATBwWDOYIK hvcNAQEFBQADgYEAIXOVxXbjKACTIdzP2TT cPoipIl@r3NEQuz
SASKCspkYRRUV11pds+Qus LjrBIy/9LnimYkhttE KqjgCGR1IKUKIGN
k7+pWIhaQGe01lZ4XVIR] JgAp/P3AabXDDWmL2FoCmN7OVipj2jjZipM4+Dopdkid
abNKIbd=

4. After all information has been entered, a new self-signed certificate is generated. Copy and paste the entire
certificate into the Public Key field.
5. Click Save changes.

Enable Services

1. Notice that the ESS has returned you to the Review Host Details screen. Click the Services tab.
2. Select the Publish and Subscribe check boxes for both the Calendar Service and the Course Service, as
shown in the figure below.
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Calendar Service

Fublish this service to allows other systems to create events in your calendars.
Subscribe to this service to allow other systems to read events inyour calendars.

¥ Publish
V¥ Subscribe

Course Service

Fublish this service to allow other systems to publish course information to your server,
Subscribe to this service to allow other systems to read course information from your server.

¥ Publish
W Subscribe

3. Click Save changes.

You may need to log out and back into the Moodle web interface before these options
appear.

Add the Moodle Publisher to the ESS

1. Navigate from the Moodle web interface to the ESS.
2. Select Configuration > Publishers.

3. Click Add. The Add Publisher page appears, as shown in the figure below.
Add Publisher

Publisher Details

| Echo36o ~|

I Choose... j

e

| save [

Enter a name and description for the publisher.
Select the parent or child organization to which this publisher belongs.

6. From the Publisher Type list, select Moodle Learning System. The page expands to include a section on
Publisher Configuration that is specific to Moodle.

ok
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Add Publisher

Publisher Details

Mame : | sjg test

Description : test of moodle

Organization : | "Echo380577 3G v

Publisher Type I Moodle Learning System j

Lise by Default :

Publisher Configuration

Application URL : I Post Podcast : Iﬂ

Post Vodcast E'I Post EchoPlayer : E'I

If you want Moodle to be your default publisher, select the Use by Default box.

8. In the Application URL field, enter the URL of the Moodle Learning System server (example: https://ess.ech
ostate.edu/moodle).

9. By default you will post Podcast, Vodcast, and EchoPlayer versions of your Echo to Moodle. Post

EchoPlayer means that you will post a rich media version viewable in the EchoPlayer (student player).

Change these if necessary by clearing the check boxes.

10. Click Test Settings to verify that a connection can be established. If it cannot be established, you receive a
detailed error message.

11. Click Save.

~

Add Moodle to Each Section

After you enable Moodle as a publisher, specify it as the publisher for each section. This ensures that Echoes for
each section publish to Moodle.

1. In Moodle, find the course's Short name, as shown in the figure below.

Echo360 Demonstration Course

Echo360 » Echo-101 » Edit course settings

Edit course settings
General

Category (3 [ Miscellaneous ]

Full name® (3} | Echo360 Demonstration Course

Short name® (@) | Echo3e0

————— 7 Note the Short
Course ID number (3}  Echo360 -
name

Summary (3)

2. In the ESS, navigate to the Section Details page for the section.
3. Scroll to the bottom of the page.
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4. Click Add Publisher as shown in the figure below.

Courses > Course Details > Add New Section

Configure Publishers for Section Echo360 Demonstration Course (Echo360-001) 2010

Configured Publishers

Mame Publisher Type

There are no publishers to display here.

=3

5. On the Add Publisher page:
a. Select the publisher from the list.
b. In the Course ID field, enter the Moodle Short name.
c. Click save.

Courses = Course Details = Add Publisher

Add Publisher - Echo360 Demonstration Course (Echo360-001) 2010
General Info
=

Publisher Configuration

Course ID : | Echo360|

X

Example: San Francisco State University (SFSU)

SFSU created a custom publisher for Moodle using Echo360's Open Publisher SDK.

® The custom publisher is described on LectureCapture.com
® The plug-in is available on SourceForge

LTI-Based Publishing

In this section:

Overview

High-Level Procedure

Add LTI Profile to the ESS

Seamless Only vs Authentication Required
Add the ESS to the LMS as an External Tool

Configure ESS Sections to Publish to LMS Courses

Overview

EchoSystem LTI (Learning Tool Interoperability) allows you to integrate the EchoSystem with a learning
management system (LMS) such as Canvas, Moodle, or Blackboard. Basic LTI communication consists of a content
provider (EchoSystem) and a content consumer (the LMS).
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The list below shows LMSs supported by LTI-Based publishing. These integrations require EchoSystem 5.2 with Ser
vice Pack 2 or higher:

Blackboard, version 9.1 Service Pack 9 or higher
Moodle, version 2.2 or higher

Canvas

Desire2Learn (D2L), version 9.4 or higher

Sakai, version 2.9.1 or higher

If you are currently publishing to Moodle or Blackboard, we recommend that you change your ESS configuration to
use LTI instead of the traditional publishing methods. LTI offers these advantages:

® | TI-Based publishing supports EchoCenter publishing, which is recommended instead of individual link
publishing.

® |Tlis apublished standard. The information passed between the systems is secured and authorized, and
can ultimately provide for viewing analytics through the ESS.

® LTI-Based publishing is dynamic, but traditional publishing is static. Static publishing means that if you
change security settings or if you configure a publisher incorrectly, you must repost links to the learning
management system (LMS). In dynamic publishing, by contrast, any changes made to the courses or
sections are passed through automatically.

® LTI configuration on the ESS is simple. It requires only an LTI profile and an association between the ESS
section and the LMS course via the Course IDs.

© canvas LTI Profile Requires Additional Fields

If you are using Canvas as your LMS, see Canvas LTI for instructions. Configuring the Canvas
LTI profile requires additional steps not provided below.

High-Level Procedure

In order to pass information to the LMS, the EchoSystem Server (ESS) and the LMS must be configured to
communicate securely with each other. Configuring LTI integration with an LMS consists of the following phases:

1. Add the LTl into the ESS configuration.

2. Add the ESS as an External Tool in the LMS.

3. Identify or create courses in the LMS.

4. Add the Course IDs from the LMS into the section configuration on the ESS (External Course IDs).

Once configured, users can log into the LMS and seamlessly access each of their sections.

Best Practice: Use a Text Editor

Configuring the LTI connection between the ESS and an LMS involves copying several items
from the ESS to the LMS. These items must be exactly the same in both systems. To reduce
errors, we recommend using copy/paste to transfer the information:

1. Open Notepad or another editor.
2. Copy the item from the ESS interface.
3. Paste the item to the LMS.

Add LTI Profile to the ESS
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Configure HTTP/HTTPS System Settings First

Be sure you have configured your System Settings before adding the LTI profile to the ESS. In
particular, the Application Network Settings must remain static. If you change the HTTP/HTTPS
configuration in the Application Network Settings after creating the LTI profile, you will have to
delete and re-create the External Tool on the LMS. This is because changing the HTTP/HTTPS
settings also changes the ESS launch URL for the LTI tool.

Follow these steps to add the LTI profile to the ESS. Once the LTI profile exists, you will use the fields generated to
Add the ESS to the LMS as an External Tool.

1. On the ESS, navigate to Configuration > LTI
2. Click Add to open the Add LTI form, shown in the below figure.

Add - LTI Profile

CANVAS %

| save [NGHRGN

3. From the LMS Consumer drop-down list, shown below, select the LMS you are using.

Add - LTI Profile

SAKAI
MOODLE
ELACKBOARD
DESIREZLEARN
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4. Notice that when you select an LMS other than Canvas, the Add Profile page changes, removing several of
the fields, as shown in the figure below. See Canvas LTI for instructions on configuring a Canvas LTI profile.

Add - LTI Profile

| savo | Gancal |

The following table lists the Add LTI Profile fields and describes the information to be entered in each:

LTI Profile Field Description and Value to be Entered

Label Enter a name for this LTI profile. This identifies this
LTI configuration in the ESS interface.

LMS Consumer Select the LMS you are using from the drop-down
list. If you are using Canvas, see Canvas LTI for
configuration instructions.

Consumer Key Enter a term or short phrase with no spaces that
identifies this LTI and is easy to remember. You will
enter this Consumer Key into the LMS interface
when you Add the ESS to the LMS as an External
Tool. This must be different for each LTI profile
you create (if you create more than one).

5. Complete the fields using the information provided in the above table. The following figure shows a completed
Add Profile page.

DzL LTI

DESIREZLEARN  +

DZL-E360-LTI

| save | Gancel|

6. Click Save. The completed LTI profile appears, shown in the below figure, including the Consumer Key,
Shared Secret, and Launch URL fields, which you will use to configure the LTI Tool on the LMS.
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LTI Profile - Desire2Learn

The item has been added.

Label : Desire2Leamn

LMS Consumer : DESIRE2LEARN

Consumer Key : D2L-E360-LTI

Shared Secret : Hol/zFUG3vewRR5ziBMY ywWydK|z4Df8jjeltGtZDr1H7vjBpx OpKAuYdCzRfakK 3IHH7ZDieAo2LgabG5mXcul==
Launch URL : https://essB-white.qa.echo3B0.com:8443/ess/Itilv1/launch/DESIRE2LEARN/eb23745d-abf0-4854-99b6-b46925f90a2a

[ AddNew | Ecit_JiDonel]

7. From the completed LTI profile, copy the following items into Notepad or other text editor, for later pasting into
the proper fields when creating the ESS as an External Tool in the LMS.
® Consumer Key
® Shared Secret
® | aunch URL

© canvas LTI Profile Shows Additional Fields

The above list applies to all LTI profiles except Canvas. As stated above, creating
the Canvas LTI profile requires additional steps not provided here. The Canvas LTI
profile also shows additional fields not discussed here. Refer to Canvas LTI for
details.

8. When you have copied the appropriate information, click Done. The LTI screen appears, showing the new
LTI profile along with any others already created.

LTI
1-50of §
Profile Name LMS Consumer
Blackboard BLACKBOARD
22 DESIREZLEARN
echo
BLACKBOARD
Moodle MOODLE
View. | 20 | % Profiles per page 1-50f 5

When necessary, you can access LTI profile information by clicking the Profile Name in the LTI screen shown
above.

Seamless Only vs Authentication Required

If Seamless Only is used on a section, then students must be authorized via an LTI or Seamless link for the specific
section in the LMS in order to view content for that section.

If Authentication Required is used on a section, then any authenticated student can access the content for that
section.
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Add the ESS to the LMS as an External Tool

The ESS must be configured as an External Tool for the LMS. Basic LTI communication is configured by copying
the LTI profile fields from the ESS to the LMS.

While the API interaction between the systems is effectively the same, configuration instructions differ, depending on
the LMS you are using. Detailed instructions are available in the following pages:

Blackboard LTI
Moodle LTI
Sakai LTI
Desire2learn LTI
Canvas LTI

After the external tool is configured on the LMS, use the information below to configure sections on the ESS to
deliver the appropriate content to each LMS user.

Configure ESS Sections to Publish to LMS Courses

In order for the ESS to know what content belongs to the logged-in LMS user, each ESS section needs to be
associated with the corresponding LMS course. The External System ID field in the section page, shown in the
below figure, provides this association. For more information on creating and configuring sections, see Manage
Sections.

EchoCenter

These settings control the behavior of the EchoCenter.

(=]

O
]

=

/

WrldHst-2993

None Available %

Populate this field with the ID number for the corresponding Course or Section ID in the LMS. The table below
describes where, in each LMS, the ID can be found.

If you are using this LMS... The Course number to enter into the External ID
field is found here:

Blackboard Navigate to the Course page then select Customization
> Properties. Use the Course ID found on the
Properties page.

Moodle Navigate to the Course page, then select Edit Settings
. Select the value in the Course Short Name field the
Edit course settings page.

Sakai Navigate to My Workspace > Realms and use the
Provider IDs for the courses listed. Where there are
multiple sections for a course, you will see multiple
Provider IDs separated by a + (plus sign).
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Desire2Learn (D2L) Navigate to the Course page in D2L and use the
Course ID number located in the URL. In the sample
URL below, the External System ID to use would be

2040773.
https://riverland.ins. mscu. edu/d2l/ hone
/2040773

Canvas In the URL of the Section page in Canvas. Navigate to

the Course page and click on the section link. In the
sample URL below, the External System ID for the
section would be 1107705.

https://<institution
nanme>. i nstruct ure. conf cour ses/ 832164/ sec
tions/ 1107705

When a student logs into the LMS and navigates to each course, a link for the EchoCenter for the appropriate
section is automatically shown through the course page of the LMS interface.

Blackboard LTI

® Addthe ESS as an LTI Tool in Blackboard
® Adding the LTI Link to a Course

© Blackboard and EchoSystem Versions Required for LTI-Based Publishing

You can use LTI-Based publishing if you have:

® Blackboard, version 9.1, Service Pack 9 or higher, and
® EchoSystem 5.2 with Service Pack 2 or higher

Add the ESS as an LTI Tool in Blackboard

After you have created the Blackboard LTI profile on the EchoSystem Server (ESS) you must add the ESS as an
LTI tool in Blackboard. This allows Blackboard to securely communicate with the ESS.

The instructions below are provided as a guide for entering and enabling the proper settings in Blackboard using
Register Provider Domain. These steps must be performed by the LMS Administrator. Be sure you have created the
Blackboard LTI Profile on the ESS so you can copy the appropriate fields from that profile into the Blackboard LTI
tool configuration.

If you need further instructions or more detail on using Blackboard, refer to the Blackboard documentation.

1. On the Administrator Panel, under Building Blocks, click Building Blocks.

2. Click LTI Tool Providers.

3. Click Register Provider Domain.

4. Type the Provider Domain. This must be the fully qualified domain name of the ESS, such as ess. institu
tion. edu.

5. Select the Provider Domain Status - Approved or Excluded. Approved is the default setting. Selecting
Excluded prevents users from adding tool links to this provider.
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6. Select Set Globally and enter the following information from the LTI Tool configuration on the ESS:

®* Tool Provider Key - Copy the Consumer Key from the ESS.
® Tool Provider Secret - Copy the Shared Secret from the ESS.

7. Skip the Custom Parameters section. The ESS requires no custom parameters.

8. The Institution Policies section pulls preferences from the Global Properties and manages settings for the
ESS LTI tool. Note that the choices you make for the individual provider here will override the Global
Properties. Set the following policies:

® Send User Data - Send user data only over any connection.

® User Fields to Send - Role in Course, Name, Email Address

® Send Context Identifiers As - Batch UID

®* Show User Acknowledgement Message - Optional. Select whether a user acknowledgment
message appears when the user clicks a learning tool link, such as a notification that the user is
leaving Blackboard Learn for an external site. Yes turns the message on, and No turns it off. If you
select Yes, be sure to add Message Text.

9. Click Submit.

Adding the LTI Link to a Course

In order for students to access the EchoCenter for a course, a link to the EchoSystem LTI tool must be added to
each course.

There are two approaches you can take:

® Add an LTI tool link to a menu, allowing instructors to add them to courses (called "managing placements");
® Create a web link for the tool provider.

Both methods are outlined below. If you need further instructions, please see your Blackboard documentation.
The Instructor Must Be Properly Configured in the ESS to See the Instructor View

For instructors to be able to see the Instructor View of an EchoCenter page through the LMS, the
following must be true for that user on the ESS:

® The Instructor must be configured as an Academic Staff user in the ESS.

® The Instructor must be configured as an Instructor on the section.

® The Instructor's user name and email address in the LMS must match the user name and
email address in the ESS. For example an Instructor with the user name "instructor1" with
the email address "instructorl@echo.com" in the ESS must also be "instructorl" in the
LMS with the email address "instructorl@echo.com".

® The email address does not have to be valid (it can be a dummy address) but it does have
to be unique to the user.

An Instructor not configured in this way sees the Student View of the EchoCenter.

After adding the LTI link to courses, the final step will be to add the LMS ID for each course into the corresponding
section page on the ESS - documented at the bottom of this page.

Manage Placement for ESS LTI Tool Link

The newly created LTI provider appears on the LTI providers list. From here, you can manage the placement of the
tool in Blackboard. Creating a name and placing the tool in a menu is not required, but doing so makes it easy for
instructors (or students) to find and use, because the instructors adding the LTI tool to their courses do not have to
know the tool URL or secret key.
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If a tool provider has no placements, instructors can still use it in courses as described in Create a Web Link for ESS
LTI Toal.

To Manage Placement for an LTI tool link:

1.

7.

From the LTI Tool Providers page, right-click the ESS LTI tool you created above, and click Manage
Placements.
Click Create Placement.

In the Create Placement form that appears, enter the following:

® | abel: This is the name for the LTI tool that appears in the menu.
® Description: Descriptions appear only to students in their tools menu, not for instructors. This is used
only if the link type will be Student Tool, and provides a description to help students understand what
the tool is and what it does.
® Handle: Identifies the tool in the database, and must be unique.
For Type, select Student Tool or Content Type. These are described as follows:

® A Student Tool appears in the student Tools menu. The Description provided above helps them
understand what the tool is and what it does.

* A Content Type link requires you to select which content type to add, which determines what menu
tool appears in for the course. The Placement allows grading option allows you to add the grading
features such as due date and points possible to the tool.

. Add an icon for the tool by clicking Browse and uploading an image file 50 x 50 pixels. For your convenience,

we have attached an appropriately sized Echo icon to this page. Click the link then select Save As or Save
Page As from your browser's File menu to save the link for use. It should save as a *.png (portable network
graphic) file.

Type in the tool provider information. In most cases, this is the same information you added when you
created the tool, including Provider Secret and Provider Key, unless you are creating multiple placements for
the same registered provider.

Click Submit.

Create a Web Link for ESS LTI Tool

After the LTI tool has been added to the Blackboard system, a course administrator or instructor can add a link to
the EchoCenter LTI tool within the course. This LTI tool provides seamless authentication from Blackboard to the
EchoSystem. Use the steps below to create a new web link in your course.

To Create a Web Link for the LTI Tool:

1.

NooakwN

© ©

10.

Change Edit Mode to ON.

Access a content area, learning module, lesson plan, or folder for the link you are creating.
On the action bar, point to Build Content to open the drop-down list.

Select Web Link.

On the Create Web Link page, type a Name.

Enable the This link is to a Tool Provider checkbox.

If your school has already set up the Tool Provider (procedure above), type the web address for the Tool
Provider in the URL box.

There are no Custom Parameters required for the ESS LTI tool. You can skip these fields.
To enable grading, select Yes. This is optional.

Click Submit.

Adding Blackboard Course IDs to ESS Sections
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In order for the ESS to know what content to serve to the LMS, each section in ESS needs to be associated with the
LMS course to which it belongs. The External System ID field in the ESS section configuration page, shown in the
below figure, provides this association.

Populate this field with the Course ID number for the corresponding course in Blackboard. The Course ID can be
found on the Properties page for each course. In addition, you can export course IDs from Blackboard and use them
to create ESS sections via import.

This process can be done by the administrator for all courses and sections, or by the Instructor for specific sections.

EchoCenter

These settings control the behavior of the EchoCenter.

—

a
1

=

/

WrldHst-2993

None Available %

For more information on creating and configuring sections in the ESS, see Manage Terms, Courses, and Sections.

When a student clicks on the content link in Blackboard, the EchoCenter for the appropriate section is automatically
shown through the course page of the Blackboard interface.

Canvas LTI
In this section:

Qverview

Generate Canvas Access Token for ESS API Key
Add Canvas LTI to the ESS

Add the ESS to Canvas as an External Tool

Configure Sections to Publish to Canvas Courses

Overview

You can integrate the EchoSystem with Canvas, the cloud-based open source learning management system (LMS)
by taking advantage of the LTI (Learning Tool Interoperability) in Canvas.

You can use LTI-Based publishing if you have EchoSystem 5.2 with Service Pack 2 or higher.

Basic LTI communication consists of a content provider (which in this case is EchoSystem) and a content consumer
(which in this case is Canvas).

In order for the EchoSystem Server (ESS) to pass information to Canvas, both systems must be configured to
communicate securely with each other. In addition, each section in the ESS needs to be configured so that the ESS
knows what information to pass through to Canvas for each user.

Configuring the ESS and Canvas consists of the following phases:

Page 248



EchoSystem 5.5 Documentation

Generate an Access Token from Canvas to authenticate the ESS for passing content to the Canvas API
Add the Canvas LTI into the ESS configuration

Add the ESS as an External Tool to the Canvas configuration

Identify or create the courses in Canvas

Create and configure Sections in the ESS that correspond with the Canvas courses

Once configuration is complete, users are able to log into Canvas and seamlessly access each of their sections,
viewing the appropriate EchoCenter page and its associated content and course materials.

Best Practice: Use a Text Editor

Configuring the LTI connection between the ESS and an LMS involves copying several items
from the ESS to the LMS. These items must be exactly the same in both systems. To reduce
errors, we recommend using copy/paste to transfer the information:

1. Open Notepad or another editor.
2. Copy the item from the ESS interface.
3. Paste the item to the LMS.

Generate Canvas Access Token for ESS APl Key

Before you can configure the ESS to integrate with Canvas, you first need to generate an Access Token within
Canvas. This token is used to access enrollment information through the Canvas API.

Upon generation of the Access Token, you must copy the token and either paste it directly into the Canvas LTI
Profile in ESS, or paste it to an interim holding location, such as Notepad or other text editor. The Access Token mu
st be copied into the ESS exactly as it appears in Canvas, with no leading spaces or other characters.

© Use an Administrative Account to Generate the Access Token

Access tokens can be generated by any account in Canvas, however since the Access Token is
used to access enrollment information, you want to be logged in using an account that can
access all enrollment information for the courses that will be used with EchoSystem. You can use
a Canvas Administrator account or create a user account specifically for this integration. If you do
create a separate account, be sure the user has access to all of the appropriate course
enrollment information.

Please note that the steps listed here are provided as a guide and are to be performed by the Canvas Administrator.
If you need more detailed information, please refer to the Canvas documentation.

1. Log into Canvas as an Administrator or using an account specifically designed for this integration. See note

above.

Navigate to Settings.

At the bottom of the Settings page, click New Access Token.

Enter a Purpose for the token. This provides the reason or use for the token in the interface.

Enter an Expiration Date for the token, or leave the field blank if you do not want the token to expire.

Click Generate Token.

In the Access Token Details dialog box that appears, select and copy all of the characters in the Token field.

This token must be entered exactly as it appears into the API Key field of the Canvas LTI Profile in ESS. The

token shown will NOT be shown again. If you do not copy it now, you will have to regenerate an access token

to use for API authentication.

8. Paste the copied token either directly into the Canvas LTI Profile using the instructions in the next section,
or paste the token to Notepad or other text editor for later access.

No ok~ wN
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9. When finished, close the dialog box using the "x" in the top right corner.

If, for some reason, you lose the generated token or do not copy it correctly, you will have to regenerate the token
and use the new one in the Canvas LTI profile in ESS.

Add Canvas LTI to the ESS
Configure HTTP/HTTPS System Settings First

Be sure you have configured your System Settings prior to adding the Canvas LTI to the ESS. In
particular, the Application Network Settings must remain static. If you change the HTTP/HTTPS
configuration in the Application Network Settings after creating the Canvas LTI profile, you will
have to delete and re-create the LTI tool within Canvas. This is because changing the
HTTP/HTTPS settings also changes the ESS launch URL for the LTI tool.

Use the following steps to add the Canvas LTI to the ESS configuration. Once the Canvas LTl is added to ESS, you
will use the fields generated for the LTI profile to Add the ESS to Canvas as an External Tool.

1. On the ESS, go to Configuration > LTI
2. Click Add to open the Add LTI form, shown in the below figure.
Add - LTI Profile

CANVAS ¥

[
| Canoel

The following table lists the fields in the Add LTI Profile form and describes the information to be entered in
each:

LTI Profile Field Description and Value to be Entered

Label Enter a name for this LTI profile. This identifies this

LTI configuration in the ESS interface.
LMS Consumer Select Canvas as the LMS Consumer from the

drop-down list.
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Consumer Key Enter a term or short phrase with no spaces that
identifies this LTI and is easy to remember. This
Consumer Key will also be entered into the Canvas
interface when you Add the ESS to Canvas as an
External Tool.

API Key Enter the Access Token generated in Canvas from
the instructions above.

APl Host URL Enter the base URL of the Canvas server. For
example, https://<institution
name>. i nstructure.com

LTI Cartridge This field is populated by clicking the Generate butt
on. The resulting XML script provides the
instructions necessary for the ESS and Canvas to
process the information and content being passed
between the systems. The XML script can also be
used when you Add the ESS to Canvas as an
External Toal.

3. Complete the fields using the information provided in the above table.
4. Click Generate to populate the LTI Cartridge field with the appropriate XML script. When you are finished, the

Add LTI Profile form should appear similar to the following figure.
Add - LTI Profile

Canvas LTI

CANVAS &

ESS_Canvas

1-AWFB8BwAPzVOE4d|ChsXAtJNSdINDBBM 7 oHfZa45qrfY SYQCWOVCQINNjwn k.

https://echo3B0.instructure.com

<Twml version="1.0" encoding="UTF-8"7> "
<cartridge_basicli_link xmins="http:ferww.imsglobal orgixsd/imsltice_v1pd”
wmins bhti = "hitoewew imsglobal orgixsdimsabasicti vipd®

xmins :ticm ="http:lherww.imsglobalorg/ixsdimsiticm_v1pl”

i Hic p ="httpafeenw. imsglobal.orgxsdims tticp vi1pd®

xmins xsi = "hitpAewe. w3 .org/2001 XMLSchema-instance”

wsischemalocation = "hitpheenw imsglobalorgisdimsitice vipd
hitp:herwnw. imsglobal orgfsditiitiv 1 plvimsitice_vi1pl.xsd

httpeiterenw imsglobal orgxsdimsbasici_vipD ¥
hittp:/ifenwne . imsglobal orgfesditifttiv 1 pdfims basic ti vip0.xsd s
Generate

5. When finished, click Save. The completed Canvas LTI Profile appears, and includes Shared Secret and Con
figuration URL fields, in addition to the Consumer Key you entered, all highlighted in the below figure.

Page 251



EchoSystem 5.5 Documentation

LTI Profile - Canvas LTI

The item has been added

Label Canvas LTI

LMS Consumer CANVAS

Consumer Key : Canvas-E360-LTI

Shared Secret : KO0j+Txzpppt 0/QkOecaQ: ij CtFTENhHoQML igUdz490I P OY|7KqaDINyA==
Ci URL: https:; -white.qa.echo380.com:8443/ess/ltilv1/configuration/87218049-d722-44e6-821b-2943b5770c 25
Launch URL https:/iessB-white.qa.eche380.com:8443/ess/ltiiv1/launch/CANVAS/87218049-d722-44e5-821b-2943b5770c25
API Key 1~7prlibkw2khQcZHQS BhURNIMFkWFdXCs7movapC5E4Fo0D3bbJords 2nTiNGahdg

API Host URL https:/iecho360.instructure.com

LTI Cartridge <2xml version="1.0" encoding="UTF-8"?>

<cartridge_basiclti_link xmlns="http://www.imsglobal.org/xsd/imslticc_vip0"
xmins:blti = "http://www.imsglobal.org/xsd/imsbasiclti_vipd"
xmlns:lticm ="http://www.imsglobal.org/xsd/imsltiem v1p0"
xmlns:lticp ="http://www.imsglobal.org/xsd/imslticp v1p0"
xmlns:xsi = "http://www.w3.org/2001/XMLSchema-instance"
xsirschemalocation = "http://www.imsglobal.org/xsd/imslticc vlp0 http://www.imsglobal.org/xsd/lti/ltivlp0/imslticc v1p0.xsd
http://www.imsglobal.org/xsd/insbasiclti vip0 http://wew.imsglobal.org/xsd/1ti/1tivip0/insbasiclti vip0.xsd
http://www.insglobal.org/xsd/inslticm_v1p0 http://www.imsglobal.org/xsd/1ti/ltivip0/inslticm vipd.xsd
http://www. insglobal.org/xsd/inslticp_v1ip0 http://www.imsglobal.org/xsd/1ti/ltivip0/inslticp_vip0.xsd">
<blti:title>EchoCenter</blti:title>
<blti:description>EchoCenter provides all the lecture captures for this course.</blti:deseription>
<blti:launch_url>https://ess8-white.qa.echo360.com:8443/ess/1ti/v1/launch/CANVAS/87218049-d722-4485-821b-2943b5770c25</bLti: launch_url>
<blti:extensions platforms"canvas.instructure.com">
<lticm:property name="privacy level">public</lticm:property>
<lticm:options name="course navigation">
<lticm:property name="enabled">true</lticm:property>
<ltiom:property name="text">EchoCenter</lticm:property>
<ltiem:property name="default">enabled</lticm:property>
<lticm:property mame="visibility">members</lticm:property>
<ltiem:property name="url">https://ess8-white.ga.echo360.com:8443/ess/Lti/v1l/launch/CANVAS/87218049-d722-44e5-821b-2943b5770c25</ 1ticm: property>
</lticm:options></blti:extensions></cartridge_basiclti_link>

I |

6. From the LTI Profile screen, copy the necessary fields for use in creating the ESS as an External Tool in
Canvas. You can copy each of these directly from the ESS into Canvas, or you can use an interim holding
location, such as Notepad or other text editor, to paste each item for later use. The fields you need are:

® Consumer Key
® Shared Secret

® Configuration URL or LTI Cartridge

O Ln Cartridge only needed for Paste XML Configuration Type

The LTI Cartridge is only necessary if you are using Paste XML as the
Configuration Type for the External Tool in Canvas. If you are using URL as the
Configuration Type, use the Configuration URL provided in the profile details shown
above. There is no difference, from the ESS standpoint, which Configuration Type
you choose.

7. When you have copied the appropriate information, click Done. The LTI Configuration screen appears,
showing the new LTI along with any others that may have already been created.

LTI
1-6of 6
Profile Name LMS Consumer
Blackboard BLACKBOARD
Canvas LTI CANVAS
a2l DESIREZLEARN
echo
BLACKBOARD
Moodle MOODLE
View: | 20 ¥ Profies per page 1-6of 6

As indicated in the instructions, use the fields from the completed LTI Profile to configure the ESS as an External
Tool in Canvas. You can access this information any time by clicking on the Profile Name in the LTI screen shown
above.

Add the ESS to Canvas as an External Tool

Use the following steps to add the ESS as an External Tool in Canvas. The Consumer Key, Shared Secret, and C
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onfiguration Type fields are populated by copying the Consumer Key, Shared Secret, and either the LTI Cartridge
or Configuration URL fields respectively from the ESS LTI configuration.

© Addthe ESS as an External Tool at the Account Level

You can add the ESS as an External Tool at either the Account level or the Course level in
Canvas. However we strongly recommend adding it at the Account level. This allows the ESS
to deliver content to all courses configured between the ESS and Canvas.

Please note that the steps listed here are provided as a guide and are to be performed by the Canvas Administrator
or Course Owner for an individual course. If you need more detailed information, please refer to the Canvas
documentation.

1. Log in to Canvas as an Administrator.
2. Select the Top Level Account or a Sub Account under Managed Accounts.
3. Navigate to Settings > External Tools.
4. Click Add External Tool.
5. Enter a Name for the tool. This can be anything you want but should clearly identify this as the ESS from
which Canvas will be consuming EchoCenter content.
6. Enter a Consumer Key. This must be exactly the same as the Consumer Key in the Canvas LTI Profile on
the ESS.
7. Enter a Shared Secret. This must be exactly the same as the Shared Secret in the Canvas LTI Profile on
the ESS.
8. For Configuration Type, you have the following options:
® Select By URL. The dialog box changes, so that the only additional field to enter is the Configuration
URL. Paste the Configuration URL from the Canvas LTI Profile on the ESS. The URL must be
exactly the same, with no leading spaces or other characters.
® Select Paste XML. The dialog box changes, so that the only additional field to enter is Paste XML
Here. Paste the LTI Cartridge script generated from the Canvas LTI Profile on the ESS. The XML mu
st be exactly the same as it appears in the LTI Profile on the ESS.
9. When finished, click Save Tool Settings.

Communication between the systems is now established. The final tasks, described in the next section, are to create
or identify courses in Canvas, then associate those courses with the appropriate sections in EchoSystem. This final
configuration allows the ESS to deliver the appropriate content to each user through Canvas.

Configure Sections to Publish to Canvas Courses

Using the Canvas LTI as the content provider for EchoCenter is different that the normal "Publishing" performed by
other systems. For Canvas, instead of "pushing" the EchoCenter content out to a publisher, the Canvas LTI uses a
"pull" method, where the user logs into Canvas, which then makes a call to the ESS to "pull" the appropriate content
for the user into the Canvas interface.

In order for the ESS to know what content belongs to the logged in Canvas user, each course section in ESS needs
to be associated with the Canvas course to which it belongs. This association is done through the External System
ID field in the section page, shown in the below figure. For more information on creating and configuring sections,
see Manage Terms, Courses, and Sections.
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EchoCenter

These settings control the behawvior of the EchoCenter.

(]

E O O

/

WrldHst-2293

None Available %

Populate this field with the ID number for the corresponding Section in Canvas. This ID can be copied from the URL
of the section page when open in Canvas. Navigate to the course page and click on the section link. In the sample
URL below, the External System ID for the section would be 1107705.

https://<institution
nane>. i nstructure. conlf courses/ 832164/ secti on
s/ 1107705

When a user logs into Canvas, the EchoCenter for the appropriate section is made available through the section
page of the Canvas interface.

Desire2Learn LTI

In this section:

Overview

Add the ESS as an External Tool in D2L
Add D2L Course IDs to ESS Sections
Add LTI Link to Each Course

Overview

You can use LTI-Based publishing if you have:

® Desire2Learn version 9.4 or higher, and
® EchoSystem 5.2 with Service Pack 2 or higher

After you have created the Desire2Learn (D2L) LTI profile on the EchoSystem Server (ESS) you must configure D2L
to securely communicate with the ESS. The instructions below provide an overview of the steps required to
configure the D2L LTI tool.
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The Instructor Must Be Properly Configured in the ESS to See the Instructor View

For instructors to be able to see the Instructor View of an EchoCenter page through the LMS, the
following must be true for that user on the ESS:

® The Instructor must be configured as an Academic Staff user in the ESS.

® The Instructor must be configured as an Instructor on the section.

® The Instructor's user name and email address in the LMS must match the user name and
email address in the ESS. For example an Instructor with the user name "instructor1" with
the email address "instructorl@echo.com" in the ESS must also be "instructorl" in the
LMS with the email address "instructorl@echo.com"”.

® The email address does not have to be valid (it can be a dummy address) but it does have
to be unique to the user.

An Instructor not configured in this way sees the Student View of the EchoCenter.

Add the ESS as an External Tool in D2L

The instructions below are provided as a guide for entering and enabling the proper settings for communication with
the ESS, and must be performed by the LMS Administrator. Be sure you have created the D2L LTI Profile on the
ESS so you can copy the appropriate fields from that profile into the D2L LTI tool configuration. For additional
information, refer to the D2L documentation.

1. Log into D2L as an Administrator.
2. Navigate to Admin Tools > External Learning Tools.
3. Above the Learning Tools list, click New Link.
4. In the New Link dialog box, complete the following Properties fields:
a. Enter a Title for the tool that clearly identifies EchoSystem as the external tool you are configuring.
b. Copy the Launch URL from the LTI Profile in ESS to the URL field in the New Link dialog box.
c. Enter a Description for the tool if desired.
d. Enable the Visibility checkbox.
5. Complete the following Key/Secret fields/values:
a. Enable the Sign messages with key/secret checkbox.
b. Select the Link key/secret radio button.
c. Copy the Consumer Key from the LTI profile on the ESS into the Key field.
d. Copy the Shared Secret from the LTI profile on the ESS into the Secret field.
6. Under Security Settings, be sure that the following checkboxes are checked (others can be checked if
needed):
® Send User ID to tool provider
® Send Username to tool provider
® Send User email to tool provider
7. When finished, click Save.

Your next steps are:

® Add the D2L course IDs to the corresponding ESS sections, then
® Add a Quicklink to the ESS LTI tool to the course pages in D2L.

Add D2L Course IDs to ESS Sections

In order for the ESS to know what content belongs to the logged in user, each section in ESS needs to be
associated with the LMS course to which it belongs. The External System ID field in the section page, shown in the
below figure, provides this association.
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Populate this field with the ID number for the corresponding LMS ID for the Course in D2L. The Course ID can be
found by opening the Course page in D2L and looking at the URL for the course page. In the sample URL below,
the External System ID to use would be 2040773.

https://riverland.ins. mscu. edu/ d2l / home/ 204077
3

EchoCenter

These settings control the behavior of the EchoCenter.

(=]

O
]

=

/

WrldHst-2993

None Available 3%

For more information on creating and configuring sections, see Manage Terms, Courses, and Sections.

After completing these steps for each course, be sure to add a link to the ESS LTI tool to each course page in D2L
using the below instructions.

Add LTI Link to Each Course

Use the procedure below to add a link to the newly created ESS LTI tool to a course. As with the above instructions,
these are provided solely as a guide. For additional information, refer to the D2L documentation.

1. Log into D2L as an Administrator or an Instructor.
2. From the Materials menu, select Content.
3. From the Add Quicklink menu, select External Learning Tools.

© Menu Options May Vary by D2L Version

Depending on the version of D2L you are using, you may have an "Add Content" menu
instead of an "Add Quicklink" menu. In this case, select Add New Activity from the Add
Content menu, then select the ESS LTI tool created in the Add the ESS as an External
Tool in D2L section above.

Select the ESS LTI tool.

Click Insert.

Select the Module where the link should reside.
Enter a Title for the link that identifies it for users.
Click Save and Close.

© N A

When a student logs into D2L and clicks the link on the course, the EchoCenter for the appropriate section is
automatically shown through the D2L interface.

Moodle LTI
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In this section:

Overview

Add the ESS as an LTI Tool in Moodle
Adding the LTI Activity Link to a Course
Adding Moodle Course IDs to ESS Sections

Overview

You can use LTI-Based publishing if you have:

Moodle versions 2.2 or higher, and
EchoSystem 5.2 with Service Pack 2 or higher

After you have created the Moodle LTI profile on the EchoSystem Server (ESS) you must configure Moodle to
securely communicate with the ESS. The instructions below provide an overview of the steps required to configure
the Moodle LTI tool. If you require further instructions, refer to the Moodle documentation.

The Instructor Must Be Properly Configured in the ESS to See the Instructor View

For instructors to be able to see the Instructor View of an EchoCenter page through the LMS, the
following must be true for that user on the ESS:

® The Instructor must be configured as an Academic Staff user in the ESS.

® The Instructor must be configured as an Instructor on the section.

® The Instructor's user name and email address in the LMS must match the user name and
email address in the ESS. For example an Instructor with the user name "instructor1" with
the email address "instructorl@echo.com" in the ESS must also be "instructorl" in the
LMS with the email address "instructorl@echo.com".

® The email address does not have to be valid (it can be a dummy address) but it does have
to be unique to the user.

An Instructor not configured in this way sees the Student View of the EchoCenter.

Add the ESS as an LTI Tool in Moodle

The instructions below are provided as a guide for entering and enabling the proper settings in Moodle, and must be
performed by the LMS Administrator. Be sure you have created the Moodle LTI Profile on the ESS so you can copy
the appropriate fields from that profile into the Moodle LTI External Tool configuration.

arwdhPE
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Log into Moodle as an Administrator.
Navigate to Site administration > Plugins > Activity modules > LTI.
On the LTI External Tool Types page, click Add external tool configuration.
Enter a Tool Name that clearly identifies EchoSystem as the tool you are configuring.
Copy the following fields from the Moodle LTI Profile on the ESS into the corresponding fields on the Moodle
LTI Tool form:
® Launch URL > Tool Base URL
® Consumer Key > Consumer Key
® Shared Secret > Shared Secret

. Enable the Show tool type when creating tool instances checkbox. This is required for the Echo360 tool

to appear in the External tool type drop-down list, referenced in the instructions immediately below.
Click Save changes.
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Adding the LTI Activity Link to a Course

In order for students to access the EchoCenter for a course, an Activity link to the EchoSystem External Tool tool
must be added to each course. This can be done by the Administrator for all courses, or by the Instructor or a
non-managing Teacher for specific courses.

1. Navigate to the Course Page: Home > Course Name.

2. Click the Turn editing on button.

Click the +Add an activity or resource link located at the top of the screen. Do not click under a specific
week.

Select External Tool from the list on the left, then click Add.

Enter an Activity Name that clearly identifies the EchoCenter or Echo360 as the activity being added.

In the External tool type drop-down list, select the EchoSystem tool configured above.

DO NOT enter the Launch URL in this screen. That information is added in the external tool configuration
steps above, NOT in the course activity configuration.

8. Click Save and return to course. The course page should now show an activity link to EchoSystem.

w

No ok

The final step is to add the course ID for each course into the corresponding section page configuration on the ESS.

Adding Moodle Course IDs to ESS Sections

In order for the ESS to know what content belongs to the logged in user, each section in ESS needs to be
associated with the LMS course to which it belongs. The External System ID field in the section page, shown in the
below figure, provides this association.

Populate this field with the Course Short Name found on the course Settings page for the corresponding course in
Moodle.

Best Practice: Use Course IDs for Associating Moodle Courses with ESS Sections

Course IDs are not a required field in Moodle but are preferred for this purpose. Best Practice is
to:

® Create Course IDs for each Course in Moodle
®* Make sure there are no spaces in the Course ID value.

EchoCenter

These seftings control the behawvior of the EchoCenter.

™

O

® O

/

WrldHst-2993

None Available %

For more information on creating and configuring sections, see Manage Terms, Courses, and Sections.

When a student logs into the Moodle, the EchoCenter for the appropriate section is automatically shown through the
course page of the Moodle interface.
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Sakai LTI

In this section:

® Qverview
® Addthe ESS as an LTI Tool in Sakai
® Adding Sakai Course IDs to ESS Sections

Overview

You can use LTI-Based publishing if you have:

® Sakai version 2.9.1 or higher, and

EchoSystem 5.2 with Service Pack 2 or higher

After you have created the Sakai LTI profile on the EchoSystem Server (ESS) you must configure Sakai to securely
communicate with the ESS via LTI. The instructions below provide an overview of the steps required to properly
configure Sakai to be able to consume and display ESS content via LTI. If you require further instructions, refer to
the Sakai documentation.

The Instructor Must Be Properly Configured in the ESS to See the Instructor View

For instructors to be able to see the Instructor View of an EchoCenter page through the LMS, the
following must be true for that user on the ESS:

® The Instructor must be configured as an Academic Staff user in the ESS.

® The Instructor must be configured as an Instructor on the section.

® The Instructor's user name and email address in the LMS must match the user name and
email address in the ESS. For example an Instructor with the user name "instructor1" with
the email address "instructorl@echo.com" in the ESS must also be "instructorl" in the
LMS with the email address "instructorl@echo.com".

® The email address does not have to be valid (it can be a dummy address) but it does have
to be unique to the user.

An Instructor not configured in this way sees the Student View of the EchoCenter.

Add the ESS as an LTI Tool in Sakai

The instructions below are provided as a guide for entering and enabling the proper settings in Sakai, and must be
performed by the LMS Administrator. Be sure you have created the Sakai LTI Profile on the ESS so you can copy
the appropriate fields from that profile into the Sakai LTI External Tool configuration.

1.

o
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Log into Sakai as an Administrator.

2. Navigate to Site info > Edit Tools.
3.
4. Enter a Title for the new tool that identifies it as the EchoCenter and click Continue then click Finish to

Check the External Tool checkbox and click Continue.

confirm creation of the tool.

Click the new tool node that appears on the left, then click the Edit icon on the top right of the screen.

Copy the following fields from the Sakai LTI Profile on the ESS into the corresponding Required Information
fields on the Sakai IMS Basic Learning Tool Interoperability form;



EchoSystem 5.5 Documentation

® Launch URL > Remote Tool URL
® Consumer Key > Remote Tool Key
® Shared Secret > Remote Tool Secret
7. Under Releasing Roster Information, check BOTH boxes: Send Names to the External Tool and Send
Email Addresses to the External Tool. This allows the ESS to properly identify users and deliver the
appropriate section information.
8. When finished, click Update Options.

Adding Sakai Course IDs to ESS Sections

In order for the ESS to know what content belongs to the logged in user, each section in ESS needs to be
associated with the LMS course to which it belongs. The External System ID field in the section page, shown in the
below figure, provides this association.

Populate this field with the ID number for the corresponding course Provider ID from Sakai. The Provider ID can be
found by going to My Workspace > Realms. Page through until you see Provider IDs. Where there are multiple
sections for a course, you will see multiple Provider IDs listed, separated by a + (plus sign). For example
MATH111.SP13.001+MATH111.SP13.002. Each Provider ID corresponds to a section in the ESS and must be
entered into the External ID field for the section in ESS.

Be sure to copy only single Provider IDs and NOT multiple IDs with the plus signs into the External ID field.

EchoCenter

These settings control the behavior of the EchoCenter.

—

O
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WrldHst-2993

None Available %

For more information on creating and configuring sections, see Manage Terms, Courses, and Sections.

When a student logs into Sakai, the EchoCenter for the appropriate section is automatically shown through the
course page of the Sakai interface.

Email Publisher
In this section:

® Add the Email Publisher

Add the Email Publisher

Only Echoes with an Available status can be published to the Email Publisher. See Make an Echo Unavailable or
Available for details on making Echoes available.

Page 260



EchoSystem 5.5 Documentation

1. Log in as an Administrator.
2. Select Configuration > Publishers.

3. Click Add. The Add Publisher page appears as shown in the figure below.
Add Publisher
Publisher Details
Name : I
: =l .:I. l
nizatio | Echo36o ~|
Publisher Type : I Choose... j
Use by Default: O
4. Enter a name and description for the publisher.
5. Select the parent or child organization to which this publisher belongs.
6. From the Publisher Type list, select Email Publisher. The page expands to include a section on Publisher
Configuration that is specific to the Email Publisher, as shown in the figure below.
Publisher Configuration
SMTP Host | Port | 25
T._' '_;|'|':_;:_. g I -__‘\_ d o :._,.;::’._..._._\;,:J ? D
From Address : | Enable TLS ™
Post Podcast : E FPaost Viodcast E
Post EchoPlayer: &
SMTP Authentication
Require entication? : &
[=] ~j-: e :.:I'-C'-C-.'.'-_' I'l'|
7. If you want use Email as your default publisher, select the Use by Default check box.
8. In the SMTP Host box, enter the URL of your mail server.
9. In the Port box, enter the port on the mail server that emails from the EchoSystem should use.
10. In the To Address and From Address, enter the email address that emails from the EchoSystem should be
sent to and from.
11. Select the Send to Presenters? box to notify Academic Staff who are serving as Presenters by email that
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their Echo is ready to view. This allows Academic Staff to review an Echo before releasing it to the public.
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© Email notifications

When this option is selected, this email becomes the first in a series of two that Academic
Staff receive after publishing an Echo. This one, the first, notifies Academic Staff that the
Echo has completed processing. The second lets them know that the Echo is available for
students to view.

12. By default, the Enable TLS box is selected. Transport Layer Security (TLS) encrypts the emails.

13. By default you will post Podcast, Vodcast, and EchoPlayer versions of your Echo to the Email Publisher. Post
EchoPlayer means that you will post a rich media version viewable in the EchoPlayer (student player).
Change these if necessary by clearing the check boxes.

14. Click Test Settings. If the settings are not correct, a message appears detailing the problem. Correct any
necessary information.

15. If the SMTP host requires authentication, select the Requires Authentication box and then enter the
server's user name and password.

16. Click Save to save the new publisher.

Closed Captioning and Transcript Publisher
In this section:

® Qverview
® Coordinate With the Closed Captioning Provider
® Add the Closed Captioning and Transcript Publisher

Overview

If you use a closed captioning provider to add closed captions to Echoes, add the provider as your closed captioning
publisher. Echoes will be automatically published to that provider, which can then add the closed captions.

Setting up this functionality requires these two phases:

1. Coordinate With the Closed Captioning Provider
2. Add the Closed Captioning and Transcript Publisher

Coordinate With the Closed Captioning Provider

Your closed captioning provider must:

® Create a folder called ~/incoming within the SFTP account on their secure server
® Tell you the SFTP server address and SFTP account name
® Tell you the private key for the SFTP account

You will need the latter two items when adding the Closed Captioning and Transcript Publisher.

This structure allows the Closed Captioning and Transcript Publisher to publish the .mp3 and metadata files to this
location: https://<sftp server name>/<account name>/incoming.

Add the Closed Captioning and Transcript Publisher

1. Log in as an Administrator.
2. Select Configuration > Publishers.
3. Click Add. The Add Publisher page appears as shown in the figure below.
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Add Publisher

Publisher Details

Irganization : I Echo3ad j

Publisher Type : Ichuuse... j

Jee by [_ it 1

4. Enter a name and description for the publisher.

5. Select the parent or child organization to which this publisher belongs.

6. From the Publisher Type list, select Closed Captioning and Transcript. The page expands to include a
section on Publisher Configuration that is specific to Closed Captioning and Transcript, as shown in the figure
below.

Publisher Configuration

SFTP Server I Account Name : I

Private Ke)

Test Settings

7. If you want Closed Captioning and Transcript to be your default publisher, select the Use by Default box.
8. Inthe SFTP Server field, enter the URL to the Secure File Transfer Protocol (SFTP) server that you will use
to transfer files.
9. In the Account Name field, enter the name of the account used to access the SFTP server.
® Anincoming subfolder is required within the SFTP account
® The subfolder allows the Closed Captioning and Transcript publisher to transfer the .mp3 and
metadata files to the service provider
10. In the Private Key field, enter the private key for the account.
11. Click Test Settings to verify that a connection can be established. If it cannot be established, you receive a
detailed error message.
12. Click Save.

iTunes U

In this section:

® Qverview
® Add an iTunes U Publisher

® Troubleshooting: If Posting Fails

Overview

iTunes U is a course management system from Apple Computer, Inc. that you can integrate with EchoSystem
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Server (ESS). Once integrated, iTunes U becomes a publisher of your Echoes, which means that ESS automatically
uploads Standard Podcast (MP3 audio) and Vodcast (M4V) files to your iTunes U site. The audio files become

content that is visible in a defined tab in iTunes U.

ESS automatically uploads content to an existing iTunes U repository. It can also serve RSS feeds created in ESS
to iTunes U. The integration process described here does not describe how to design, configure, or administer

iTunes U sites. For this information, refer to the iTunes U Administrator's Guide.

© Disclaimer

to RSS.

Apple supports iTunes U only in North America. If you are outside North America, manually link

Before adding an iTunes U publisher, you must have the iTunes U account information that Apple provided to the
institution. You can get the account information from the iTunes U Administrator or System Administrator. Along with
the account, you must have access to the iTunes U site using iTunes.

Add an iTunes U Publisher

1. Log in as an Administrator.
2. Select Configuration > Publishers.

3. Click Add. The Add Publisher page appears as shown in the figure below.

Add Publisher

Publisher Details

Organization : I Echo360 j

Publisher Type : IChnﬂse...

Use by Default =]

4. Enter a name and description for the publisher.

o

Configuration that is specific to iTunes U.
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Select the parent or child organization to which this publisher belongs.
6. From the Publisher Type list, select iTunes U. The page expands to include a section on Publisher
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Add Publisher

Publisher Details

Publisher Type I iTunes U |

Publisher Configuration

Tunes U Site URL I redentials : I

El

7. If you want iTunes U to be your default publisher, select the Use by Default check box.

8. Enter your account information in the iTunes U Site URL, Shared Secret, and Credentials fields. This
information is required and you cannot publish without it. If you do not have it, consult your System
Administrator.

9. Enter your user name, e-mail address, display name, and User ID. You can publish to iTunes U without this
information but providing it customizes your iTunes U page.

10. If you want to publish a Podcast or Vodcast, check those boxes.

11. Test your settings by clicking Connect to iTunes U. If the settings are not correct, a message appears
detailing the problem. Correct any necessary information.
12. Click Save to save the new publisher.

Troubleshooting: If Posting Fails
When the ESS and iTunes U time servers are out of sync by more than 60 seconds, postings fail.

You will see publishing error messages in the ESS log that look like a configuration issue:

.....................................................................................................................................................................................

Publ i shi ngExcepti on whil e publishing
presentation
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[ 51d31848- 26e7- 4246- aal8- b43249884c04] to
LM i Tunes: An unknown error occurred while
trying to upload to i Tunes U. Pl ease check
the 'ess.log" file for nore details.

com echo360. ess. publ i sh. Publ i shi ngExcepti on:
An unknown error occurred while trying to
upload to i Tunes U Please check the
‘ess.log' file for nore details.

at

com echo360. ess. pl ugi ns. i tunesu. | t unesuUpl oa
der.val i dat eUpl oadUr | (I t unesuUpl oader.java: 1
49) ~[ na: na]

at

com echo360. ess. pl ugi ns. i tunesu. |t unesuUpl oa
der . upl oadMedi aTol t unes( |t unesuUpl oader . j ava
. 71) ~[ na: na]

at

com echo360. ess. pl ugi ns. i tunesu. i TunesuPubl |
shi ngPl ugi n. publ i sh(i TunesuPubl i shi ngPl ugi n.
j ava: 37) ~[na: na]

at

sun. refl ect. Nati veMet hodAccessor | npl . i nvokeO
(Native Method) ~[na:1.6.0 24]

at

sun. refl ect. Nati veMet hodAccessor | npl . i nvoke(
Nat i veMet hodAccessor | npl . j ava: 39)

~[ na: 1. 6. 0_24]

at

sun. refl ect. Del egati ngiMet hodAccessor | npl . inv
oke( Del egati ngMet hodAccessor | npl . j ava: 25)
~[na: 1. 6. 0_24]
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at

java.l ang. refl ect. Met hod. i nvoke( Met hod. j ava:
597) ~[na:1.6.0_24]

at

com echo360. ess. servi ce. i npl. PublisherServic
el npl $1. run( Publ i sher Ser vi cel npl . j ava: 227)

~[ ess-1ib-4.0.14- SNAPSHOT. j ar: 4. 0. 14- SNAPSHO
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T]
at java.l ang. Thread. run(Thread. j ava: 662)
~[na: 1.6.0 _24] Posting WII Fail

To avoid this error, ensure that the ESS machine is synchronized to a non-Windows NTP server such as the Echo
NTP server.

RSS Feeds

In this section:

® Qverview
® Create the Publisher Module
® |nstantiate the Publisher Module

Overview

You can configure an EchoSystem Server (ESS) so it creates an RSS feed automatically when an Echo is ready for
distribution.

Configuration consists of these phases:

1. Creating the publisher module. The publisher module, which is the main component, defines how the
publisher behaves when it is invoked. It appears at the system configuration level.

2. Instantiating the publisher module for each section. Operating components (“instances") determine which
Echoes invoke the publisher. They appear at the section and Echo levels. A section or Echo that makes use
of a publisher module instantiates it.

© System Settings determine the URL used for RSS feeds

The URL used for RSS Feeds is determined by the Application Network Settings configured in
the System Settings page, and whether you are using an internal or an external web server.
Briefly, the configurations work as follows:

® |f you are using an internal web server, and serving "mixed content" (HTTPS for
App/HTTP for Content, with or without reverse proxy), the Host Name and Port shown in
the Content Network Settings are used for RSS feeds.

® |f you are using an internal web server and using ALL HTTPS for serving content (with or
without reverse proxy), the Legacy Content Host Name and Port (HTTP) are used for RSS
feeds.

® If you are using an external web server, regardless of how you are serving the content, the
Host Name and HTTP port listed in the Active Echo Settings section of the System
Settings page are used for serving RSS feeds.

If you are having problems with RSS feeds, be sure to check the appropriate Host Name and
Port settings on the System Settings page (keeping in mind that RSS feeds require the use of an
HTTP port).

Create the Publisher Module
1. Log in as an Administrator.
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2. Navigate to Configuration > Publishers.

3. Click the Add button.
4. In the Publisher Details section, populate the fields as described in the following table.

5.

6.
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Field

Name

Description
Organization
Publisher Type

Use by Default

Description

Give the publisher a recognizable identifier
©® Remember This Name

You will need this name when
instantiating the publisher.

Optional
Select the organization from the drop-down list
Select RSS Feeds from the drop-down list

Check this box if you want all new sections created
to instantiate this publisher.

® This means that new sections are automatically
publicized via RSS feeds.

® You still have to instantiate the publisher for
existing sections

In the Enclosure Metadata section, choose the descriptive information that will appear with each entry in the

generated RSS feed.

In the Publisher Configuration section, populate the fields as described in the following table.

Field
Create Audio Podcast Feed

Create Enhanced Podcast Feed

Create Vodcast Feed

Language

Title Template

Description
Check to create an audio podcast feed

The Enhanced Podcast product was supported
through EchoSystem 3.0. Check this box if you will
be using this RSS feed to distribute Echoes made
with EschoSystem 3.0 or earlier.

Check to create a video podcast feed

Enter the language code for the represented
country's language. See the following Microsoft
MSDN library page for a list: http://msdn.microsoft.c
om/en-us/library/ms533052%28v=vs.85%29.aspx.

Name of the RSS feed. It appears as the feed
identifier in the Web browser or feed reader. The
built-in variables %€ our se , %section ,and % e
r m expand to the actual values for the course,
section, and term.


http://msdn.microsoft.com/en-us/library/ms533052%28v=vs.85%29.aspx
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Publish for all Sections in Course and Term

If disabled, the generated feed will contain only
Echoes from the section instantiating the module.

If enabled, the generated feed contains all Echoes
from the entire course of the section instantiating
the publisher (basically combining the feed for all
sections of the course). In this case, the %sect i on
variable in the title template does not function.

7. In the ITunes Group section, use the checkbox to select whether to Enable iTunes Tags for sections
published through this RSS feed. iTunes tags are items that appear in the iTunes RSS interface for the
broadcast section and are configured on the Edit Section page if this RSS Publisher is selected. See Instantia
te the Publisher Module immediately below for Instructions on adding iTunes tags.

8. Click Save.

Instantiate the Publisher Module

1. Log in as an Administrator.
2. Navigate to Schedule > Courses.

3. Click the name of a course containing a section to be published. The Course Details page appeatrs, listing the
course's sections at the bottom of the page as shown in the figure below.

4. Hover over the section you want to publish.

Section

CRS5104.5.001

http:10.3.14_175:8080/ess/portalsection'Scibd4ac-5132-408a-04 26-bbadlactbéie

adit delete

5. Click the edit button. The Edit Section page appears.
6. Near the bottom of the page, click Add Publisher in the Configured Publishers area.
7. In the box that appears, select the publisher module name you created earlier, as shown in the figure below.

Courses » Course Detailz > Add Publisher

General Info

Add Publisher - Course D: scap test (CR5104.5-
CRS104.5.001) echo.Spring 2011.1

| echo.Rss |

Publisher Configuration

es Subscription : E

Save

8. Select the Allow iTunes Subscription box if you want to allow iTunes users to receive the RSS feed from

within the iTunes application.
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@ iTunes U publishing is different.

Tunes U.

Allowing iTunes users to receive RSS feeds is different from publishing to iTunes U. See i

9. If the selected RSS Publisher has enabled iTunes tags, an iTunes Group section appears, shown in the
following figure. These fields are recommended but optional, and relate to how iTunesU presents information

on the section to users.

General Info

| RSSwith iTunes U Tags | 4

Publisher Configuration

Allow iTunes Subscription: &
iTunes Group
Enable iTunes Tags: Yes

Channel Author

Channel Category :

| save |§ Gancel

Channel Summary :

Channel Sub-Category :

The table below describes the field information requested, as indicated on Apple's iTunesU website for
Podcast and RSS feed specifications: http://www.apple.com/itunes/podcasts/specs.html#rss. All fields are

limited to 255 characters, except for Summary which is limited to 4000.

Field Name

Channel Author

Channel Summary

Channel Category
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Description/Use

Appears in the "Artist" column. Indicates the author
or organization responsible for the content, such as
the organization or academic department to whom
the section belongs.

Provides a description that appears separate
window when the "circled i" in the Description
column is clicked. It also appears on the iTunes
page for your podcast.

Appears in the "Category" column and for iTunes
Browse feature, allowing users to find the podcast.
There are two ways to browse podcast subject
categories on iTunes: Click Browse under Features
at the bottom of the iTunes Store window or select a
category from the Podcasts pop-up menu in the
navigation bar.

See http://www.apple.com/itunes/podcasts/specs.ht
ml#categories for a complete list of supported
Categories and Sub-Categories.



http://www.apple.com/itunes/podcasts/specs.html#rss
http://www.apple.com/itunes/podcasts/specs.html#categories
http://www.apple.com/itunes/podcasts/specs.html#categories
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Channel Sub-Category Functions like Channel Category but allows for
further narrowing of the subject matter or material
covered in the podcast.

See http://www.apple.com/itunes/podcasts/specs.ht
ml#categories for a complete list of supported
Categories and Sub-Categories.

10. Click Save.
11. Notice that the RSS Feed URLs appear at the top of the page.

Courses > Course Details > Edit Section

Edit Section - Intro to Linguistics (LING 101-MWF section) Spring 2013

RSS Feed URLs Podcast: hitps:fiess1-white.qa.echod60 com 844 3lesslfead id=5470d239-478d 4del-b54d-738ae5b8aDEtype=MPI
Enhanced Podcast (this feed is only applic: for Echoes created with version 3.0 or earlier): htips:/ess1-white.ga.echo360.com:8443/ess/eed?id=54700235-479d-4deB-0544-73
Vodcast: hips:ifess1-white.ga.echo360.com 8443 essileed?id=5470d239-479d-4des-b54d-738ae850baa0aty pe=MaV

12. On the Edit Section page, click Save again.

13. To immediately use the URLs produced by the publisher, click the title of any Echo, instantiating it from the
Echoes list in your ESS. The URLSs for the chosen products are listed at the top of the page. If you configured
other publishers (Moodle, Blackboard, and so on), these publishers advertise the presentation URLS in their
publications.

ANGEL Learning Management Suite
In this section:

® Qverview
® Modify ANGEL Settings
® Configure the ESS

Overview

The EchoSystem supports automatic publication of links to courses within the ANGEL Learning Management Suite
(ANGEL).

To create this functionality, you must:

1. Modify ANGEL settings
2. Configure the EchoSystem Server (ESS).

Modify ANGEL Settings

Some ANGEL settings must be modified. Others are optional, but recommended. Follow these steps.

1. Modify the required settings:
® Create or specify an ANGEL Admin User for the ESS. You will need the user name and password
when configuring the ESS ANGEL Publisher.
® |f you use the API_ACCESS Environment Variable on your ANGEL server, add the SECTI ON_SEARCH
and SECTI ON_| TEM CREATE items.
® Add the COURSE_ID for each ANGEL course you will be publishing to.
2. Modify the optional settings:
® Add the Admin user you just specified to the API_USER environment variable. This means the ANGEL
Admin user is restricted from interactive login. The user can only log in and use the API
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programmatically.

® The API_ACCESS Environment Variable can be used to limit the Admin user to just the two specific
API function calls required: SECTI ON_SEARCH and SECTI ON_| TEM CREATE.
® Enable the LOG_API_CALLS Environment Variable to log all of the API calls.

Configure the ESS

Configuring the ESS consists of these phases:

® Configuring the publisher.

® Configuring the schedules. The specific process you use varies, depending on whether you are applying the
publisher to existing Echoes, existing schedules, or new schedules.

Configure the Publisher

1. Loginthe ESS.
2. Navigate to Configuration > Publishers.

3. Click Add. The Add Publisher page appears, as shown in the figure below.

4. Enter a name and description.
5. Select a parent or child organization from the list.

6. From the Publisher Type list, select Angel Learning System. The page expands to show the configuration

settings for ANGEL Learning System.

Add Publisher

Publisher Details

Organization : j

Publisher Configuration

Angel APl Passwor

Save

URL I Rich Media Folder Name

Download Folder Mame : I Angel APl Usernan
|

Post Vodcast E Post Rich Mediz

=

7. If you want ANGEL to be your default publisher, select the Use by Default box.

8. Fill in the required fields and the optional field if desired:

® Name: The Publisher name. It will appear elsewhere in the application.

® Application URL: The URL for the ANGEL application.

® Rich Folder Name: The folder inside each ANGEL course where the rich media content links will be
posted. The publisher creates this folder if it does not exist in ANGEL.
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® Download Folder Name (optional): The folder inside each ANGEL course where the download links
(Podcast and Vodcast) will be posted if specified. If you do not specify a download folder name, links
are posted in the Rich Media Folder. The publisher will create this folder if it does not exist in ANGEL.
® Angel API Username: The user name of the ANGEL user, which has been granted ANGEL API
access.
® Angel APl Password: The password for the above user.
9. If you want to post a Vodcast, a Podcast, or rich media of your Echo to ANGEL, click the respective boxes.
10. Test the settings by clicking the Connect to Angel button. If the connection attempt is unsuccessful, verify
each of the settings.
11. Click Save.

Configure the Schedule

The ANGEL publisher can be applied to existing Echoes, existing schedules or new schedules.

For Existing Echoes (Presentations)

Navigate to the Echoes page

Hover over the Echo to publish.

Click the edit link.

Click the Add New button in the Presentation Publishing Settings section.

Select the ANGEL publisher created above.

Enter the unique Course ID for the course content you are publishing. This is the COURSE_ID you created
when you modified ANGEL settings.

7. Save the publisher and the Echo.

ok whPE

For Existing Schedules

Navigate to the schedule.

Click the Add New button in the Publisher section.

Select the ANGEL publisher created above.

Enter the unique Course ID for the course content you are publishing. This is the COURSE_ID you created
when you modified ANGEL settings.

5. Save the schedule.

N -

For New Schedules

If you selected the Use by Default option when configuring the publisher, follow these steps.

1. Click the ANGEL publisher name link in the schedule and add the Course ID when prompted.
2. Save the schedule.

If you wish to publish content from a certain schedule to multiple courses within ANGEL, add the same publisher to
the schedule and type in the Course ID for the additional course.

Echo360 Search Indexing

In this section:

® Add the Echo360 Search Indexing Publisher

Add the Echo360 Search Indexing Publisher

1. Log in as an Administrator.
2. Select Configuration > Publishers.
3. Click Add. The Add Publisher page appears as shown in the figure below.
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Add Publisher

Publisher Details

.
I

Organization : I Echo3ad j
Publisher Type : I Choose... j
Use by Default 8

Enter a name and description for the publisher.

Select the parent or child organization to which this publisher belongs.

From the Publisher Type list, select Echo360 Search Indexing.

If you want Echo360 Search Indexing to be your default publisher, select the Use by Default box.
8. Click Save.

3Play Media

In this section:

No oM

® Qverview
® Procedure

Overview
See the 3Play Media website for an overview of the integration:

http://www.3playmedia.com/services-features/tools/integrations/echo360/

Procedure

Adding the 3Play Media closed captioning publisher requires configuration of both the Echo360 ESS (EchoSystem
Server) and the 3Play Media account.

See the instructions on the 3Play Media website:

http://support.3playmedia.com/entries/21440817-echo360-link-your-echo360-account-to-your-3play-media-account

TWEN

In this section:

® TWEN Support Ends in 2013
® Qverview
® Add the TWEN Publisher
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TWEN Support Ends in 2013

Support for TWEN ends in January 2013, with release 5.2. It will be available (and visible in the user interface) for a
short time to allow customers to transition to another publisher. In a later release, TWEN will be removed from the

ESS code and user interface.

Overview

The West Education Network® (TWEN) is an online extension of the law school classroom at http://lawschool.westla
w.com, the virtual law school community. Using TWEN, you can create and manage courses online, access and
post course materials on document pages, create assignments that your students can receive and submit, organize
and participate in class forums and live discussions, administer online quizzes, exchange e-mails with other

professors and students, and more.

Add the TWEN Publisher

1. Log in as an Administrator.
2. Select Configuration > Publishers.

3. Click Add. The Add Publisher page appears as shown in the figure below.

Add Publisher

Publisher Details

rganization : I Echo3ad j
sher Type I Choose...

J5e 0 [- It ::

E

Enter a name and description for the publisher.

o
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Select the parent or child organization to which this publisher belongs.

From the Publisher Type list, select TWEN. The page expands to include a section on Publisher

Configuration that is specific to TWEN, as shown in the figure below.


http://lawschool.westlaw.com
http://lawschool.westlaw.com
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10.

11.

Add Publisher

Publisher Details

Publisher Type : | TweN hd
1

Use by Default =

Publisher Configuration

LIRL I http:/ /lawschool.westlaw.cc Password : I
Post Podcas v Post Vodcast T
Post Rich Media: ©

Save |

If you want TWEN to be your default publisher, select the Use by Default box.

Enter the URL for the TWEN Calendar Web Service. By default, this is http://lawschool.westlaw.com/servi
ces/calendar.asmx/EventCreatePasswordExpanded.

Enter your TWEN password. You can get this from your TWEN account manager.

By default you will post Podcast, Vodcast, and EchoPlayer versions of your Echo to TWEN. Change these if
necessary by clearing the check boxes.

Click Connect to TWEN to verify that a connection can be established. If it cannot be established, you
receive a detailed error message.

Live Webcasting

In this section:

® Qverview
® | ive Webcasting for Academic Staff
® | ive Webcasting for Students

Overview

Live webcasting supports blended distance learning, where the Instructor teaches some students in a traditional
classroom environment and other students are outside of the classroom, either all of the time or some of the time.
The remote students are each logged in to the presentation on their own computers, watching the rich multimedia
presentation as it occurs. Of course, the presentation can also be recorded and published in multiple formats so that

every student can view it later.

Live webcasting can also be used for special events (commencements, graduations, guest speakers), with
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participants both inside and outside of the university. Live webcasts (because of their moderate bandwidth
requirement) can be viewed by PC and Mac users with a broadband Internet connection. You can also establish an
agreement with a CDN (Content Delivery Network) provider to reach a large and geographically diverse audience.

Live webcasting can be used for classroom overflow situati
ons, where another classroom is set up to seat students
who cannot be accommodated in the main classroom. An
overflow classroom typically uses a large screen, which
requires high bandwidth and large resolutions. Live
webcasting is optimized for the individual student, who is
viewing on a laptop browser. This means that classroom
overflow webcasts may look coarse and grainy on the large
screen.

More information on setting up and administering live
webcasting can be found on the following pages:

® Specifications for Live Webcasting
® Configure and Enable Live Webcasting
® Live Webcasting FAQs for Admins

© Non-Jetty Web Servers and Live Chat

If you use an external Apache or 1IS web server and you will be using live webcasting with the

chat feature enabled, see External Web Server Configuration for Live Chat for a configuration
change that may be required.

Live Webcasting for Academic Staff

Live webcasting does not change the classroom experience much for an Instructor, but it does place two additional
demands on an Instructor or Teaching Assistant (TA):

® Monitoring at the beginning of the live webcast to ensure that remote students are seeing the webcast
properly. See Monitor the Webcast.

® Managing chat. During a live webcast, remote students can submit questions to the Instructor and
communicate with other students using the chat feature. See Manage Chat.

See Live Webcasting for Academic Staff for these sections
and further details.

Live Webcasting for Students

The student experience of watching a live webcast is nearly identical to viewing an Echo, except that students are
viewing the class in real-time. If chat is available for the webcast, remote students can participate in the classroom
discussion or ask questions. Their experience is similar to the experience of being present in the classroom.
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For more information, see Live Webcasting for Students.

Specifications for Live Webcasting

In this section:

® Bandwidth Requirements for Capture and Media Formats

® Hardware, Software, and Licensing Requirements

Bandwidth Requirements for Capture and Media Formats

Security

If a recording that is scheduled to be captured, is also scheduled for Live Streaming, the resulting
VOD capture file will be recorded at 480px high per the table below. In most cases, this results
in a 640x480 capture. This means that if you schedule a capture with live streaming enabled,
even if the VOD setting is set to 720p or 1080p, the resulting VOD capture file will be recorded at

480px high.

The SafeCapture HD is capable of doing single-encode per channel and chooses the Live profile
parameters to encode to. The SafeCapture HD does not encode at the VOD settings as, in the
event of a 720p or 1080p VOD, this would cause the live stream to be streamed at 720p or

1080p which requires extremely high bandwidth.

@ Note on VOD Capture that is also scheduled for Live Streaming (via SafeCapture HD)

The below table lists the specifications for live streams based on product selection. In the table and examples that
follow, kbps=kilobits per second; fps = frames per second; Mbps = megabits per second.

Stream
Content

Audio +
Display

Audio +
Video

Audio +
Display +
Video
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Audio

AAC,
128 kbps
stereo

AAC,
128 kbps
stereo

AAC,
128 kbps
stereo

Display

H.264, VBR
720 px high
15 fps

475 kbps

H.264, VBR
720 px high
15fps

475 kbps

Video

H.264, VBR
480 px high
15fps/12.5
fps

365 kbps

H.264, VBR
480 px high
15fps /
12.5fps
365 kbps

Second
Display

Stream to
Wowza

~605 kbps

~495 kbps

~970 kbps

Stream per
Viewer
from Wowza

~ 630 kbps

~515 kbps

~980 kbps
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Audio +
Display +
Display

AAC, H.264, VBR - H.264, VBR ~1080 kbps ~1100 kbps
128 kbps 720 px high 720 px high
stereo 15 fps 15 fps

475 kbps 475 kbps

To estimate bandwidth:

1. Calculate the total bandwidth from the SafeCapture HD to the Wowza Media Server (Wowza) by adding the

rate for each content type required. If your live event includes audio, video, and display, the bandwidth
consumed for this single transfer is 970kbps.

2. Estimate the total number of viewers, then calculate the total bandwidth for the output from the Wowza Media

Server to each viewer. The examples below provide calculation scenarios for estimating total bandwidth
requirements.

The number of concurrent connections also determines the CPU and RAM requirements. This article, from Wowza

Examples: Estimating Bandwidth Requirements

Example 1: A class has 30 students who will view the live webcast. The Presenter wants to
share a PowerPoint presentation (display), audio, and a camera feed showing a blackboard
(video).

® Total bandwidth from the SafeCapture HD to the Wowza Media Server: ~970 kbps (475
kbps for display graphics + 365 kbps for video + 128 kbps for audio).

® Total bandwidth from the Wowza Media Server to the students: 30 students x 980
kbps/student = 29,400 kbps (~29.5 Mbps).

® Total bandwidth usage from capture to students: 970 kbps + 29,400 kbps = 30,370 kbps
(~30.4 Mbps).

Example 2: Twenty students are viewing a webcast that includes audio and a document camera
(display).

¢ Bandwidth from SafeCapture HD to the Wowza Media Server: ~605 kbps (475 kbps for
display + 128 kbps for audio).

® Total bandwidth from the Wowza Media Server to the students: 20 students x 630 kbps =
12,600 kbps (~12.6 Mbps).

® Total bandwidth usage from capture to students: 605 kbps + 12,600 kbps = 13,205 kbps
(~13.25 Mbps).

Media Systems, advises on performance tuning: http://www.wowza.com/forums/content.php?5-general-tuning.

Adaptive streaming is not supported. A single bandwidth, which provides broad compatibility (including lower-speed

broadband network connections) is supported.

Hardware, Software, and Licensing Requirements

Live webcasting requires a classroom that has:

® The SafeCapture HD appliance installed in the venue.
® Alicense that allows live webcasting.
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® If you purchased the EchoSelect (EchoReady) site license, no further configuration is necessary. This

license includes live webcasting and, because it is a site license, all venues are enabled.

* If you purchased venue licenses for your devices, you must assign the licenses to each venue where

the capture appliances are installed.
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In addition to a live license, in order to use the chat and pre
sence features of live webcasting, you must have registered
your ESS with Echo360's Collaboration and Statistics
service. You can use live webcasting without this service,
but the chat and presence features will not be available.

© Non-Jetty Web Servers and Live Chat

If you use an external Apache or IIS web server and you will be using live webcasting with the
chat feature enabled, see External Web Server Configuration for Live Chat for a configuration
change that may be required.

You must have the Wowza Media Server v3.0 or higher. EchoSystem v5.4 requires the use of Wowza v3.5 or 3.6.
The Wowza Media Server must have the Wowza production license. The development or staging license does not
offer enough connections to support live webcasting.

For more information on configuring Wowza, see Configure the Flash Media Streaming Server.

Live Webcasting from an External Wowza Server

Echo360 has introduced support for iOS viewing of Live streams. If you are currently using an
external Wowza server to serve Live webcasts, this change in support requires an update to the
Wowza configuration. See Enabling iOS Live Streaming for information and instructions.

Other Flash media streaming servers, such as the Adobe Flash Media Streaming Server, cannot be used for live
webcasting. You can use Adobe FMS3 for your on-demand content if desired.

Security

The security settings of your section determine whether students must be authenticated to join a live webcast or if
you will allow unauthenticated users. The security settings you use will likely be determined by the purpose of the
webcast. For example, if you configure a regular class to provide a live webcast of the class sessions, you will
probably set the security for the section to only allow access by students and Academic Staff associated with the
section. If you are configuring a special event such as a live webcast, you may configure security for the section to
"Allow All" so that it can be viewed by anyone with access to the URL for the webcast.

© Authenticated and Unauthenticated Users

Authenticated users are those who log in to view a webcast and can be identified by the system.
Unauthenticated users are not required to log in and cannot be identified by the system.
Collaboration features such as chat and presence only appear for users who can log in to (and
therefore be identified by) the webcast.

Students join a live webcast one of three ways:

® By logging in to an LMS, and, from there, to the section's EchoCenter page. Students are authenticated, so
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chat and other applications are enabled.

® By logging in directly to the section's EchoCenter page. Students are authenticated, so chat and other
applications are enabled.

® By clicking on the live event URL from an email you send or from a website where it is posted. Students may
or may not be authenticated, depending on the section security settings.

You can allow both authenticated and non-authenticated students in an event if you configure a section to "Allow All"
users, but encourage a workflow where some students join through authenticated methods (such as using seamless
login from a LMS) and others access the live webcast directly. Only the authenticated students will have access to
webcasting tools such as chat or presence, but all students will be able to view the live webcast.

Chat entries are processed with the webcast and attached to the Echo. This means that anyone viewing the Echo
can also review the chat.

© Why Are Only Some Students Authenticated?

As noted above, you can configure section security settings to "Allow All" so that users are not
required to log in to view the live webcast, but encourage users to join through an LMS which
provides seamless login. In this case, some students are authenticated but others are not.

Even if you don't use this configuration, you may find that some users are authenticated while
others are not.

This occurs because of authentication carryover. If a student has recently logged into another
section's EchoCenter or LMS page, the login may persist in the browser session. When the
student accesses the live webcast URL, the login is passed through. This authenticated student
can use the chat feature and see the presence list, showing what other students are logged into
the webcast. Students who are not authenticated in this way will not see the chat or presence
features.

Configure and Enable Live Webcasting
In this section:

® Qverview

® Prepare the Infrastructure

® Enable Live Webcasting

® Administer the Live Webcast

Overview

The administrative tasks for live webcasting involves a variety of configuration and setup items, and consists of
these phases:

Prepare the infrastructure.
Train Academic Staff to use live webcasting.

Enable live webcasting for the section or special event.
Notify students of the live webcast.

Monitor the live webcast, if necessary.

Control the live webcast as needed.

oukrw N

Prepare the Infrastructure
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The architecture for live events consists of:

® A source: The EchoSystem SafeCapture HD
* Areflector: The Wowza Media Server (Wowza) to stream live Flash media content
® A sink: One or more EchoPlayers that allow students to view the content

Preparing the infrastructure consists of these phases:

1. Enable licensing.

2. Registering the ESS with Echo360's Collaboration and Statistics Service (only required if using chat and
presence features of live webcasting).

3. Configure the Wowza Media Server, including configuring the system streaming settings for the ESS.

4. Optional - Distribute live webcasts with a CDN.

If you are currently using an Internal configuration of Wowza, and the combined load of live webcasts and
on-demand recordings exceeds the capacity of the media server, you will want to convert to an External
configuration of Wowza. Furthermore, the use of Wowza v4 with EchoSystem requires you to use an External
configuration.

See Configure the Flash Media Streaming Server and Configure an External Wowza Media Server for media server
configuration information as needed.

Enable Licensing

1. Update the ESS to use the EchoSelect license. This license includes live webcasting as an option.
2. Do one of the following:
a. If you have a site license, continue with configuration. See Configure the Wowza Media Server
b. If you have venue licenses, assign the licenses to venues (typically classrooms) that will have live
webcasting.

© cChat and Presence requires the Collaboration and Statistics Service

The chat and presence features for live webcasting are only available if you have the
Collaboration and Statistics service registered for your system. See Collaboration and Statistics
Service for more information.

Configure the Wowza Media Server

© Live Webcasting Requires the Wowza Media Server

If you are using live webcasting, the Flash media streaming server for your live content must be
Wowza Media Server v3.0 or higher. EchoSystem 5.4 requires the use of Wowza v3.5, v3.6 or
v4. See Configure the Flash Media Streaming Server for more information.

1. Make sure the Wowza Media Server has a production license. Each viewer receiving the live webcast
requires at least four connections to the Wowza Media Server and may need as many as seven.
Development or staging licenses do not have enough connections to support a typical class.

2. Estimate your anticipated media server requirements for both live webcasts and on-demand recordings. See
Deployment Planning and Bandwidth Requirements for Capture and Media Formats.

3. Install and configure your Wowza Media Server. See Configure the Flash Media Streaming Server and Config
ure an External Wowza Media Server for external configuration instructions.
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4. Reconfigure the firewall ports for the Wowza Media Server.
5. Review, and if necessary, edit the Streaming Settings.

Accessing the Knowledge Base
You will need a customer portal login to access the Knowledge Base. Contact Technical Support
if you need a login.

Optional - Distribute Live Webcasts with a CDN

Echo360 does not provide a CDN integration, but you can integrate your Wowza Media Server with certain CDNs,
as described in this article: http://www.wowza.com/partners.html. Please also see the push publishing article on the
Wowza Support forum. The RMTP solution described requires some custom configuration on the Wowza server.

© chat and Presence are not available on CDN networks

The chat and presence features for live webcasting are not available when using a CDN network
to deliver content, and will produce inconsistent results when deploying Wowza servers for
redundancy.

Enable Live Webcasting

Enabling live webcasting consists of the following phases:

1. Determine which sections might have live webcasting, and verify those sections occur in rooms containing a
SafeCapture HD device.

2. Configure product group defaults and security settings for the section.

3. Configure a schedule for the section. The section must be scheduled in a room containing a SafeCapture HD
device.

4. Review the Person and Section roles for the section. Make sure you have a Teaching Assistant assigned to
the section.

5. Notify the students/participants as necessary.

The sections below explain how live webcasting configuration differs from on-demand capture configuration.

Configure Product Group and Security Settings for the Section

If a section will typically use live webcasting as a normal part of its schedule, or there is a Special Events section
dedicated to live webcasts of specific events, assign a live-enabled product group to those sections as the default.
You can always select a different product group when scheduling the section if necessary.

Default Product Group selections include different bandwidth options, including low bandwidth streaming for mobile
connections. Users can view live webcasts on mobile iOS devices, however, depending on which product group is
selected for the webcast, a WiFi connection may be required for the event to stream smoothly.

If there are no existing live-enabled product groups that suit the needs of the section, you can configure a custom
product group. See Manage Product Groups for details on product groups.

Security defaults for a section determine whether students need to log in to view the Echoes or live webcasts for a
section, or if the section outputs, including any live webcasts, are available to anyone with access to the proper
URL.

The portion of the Edit Section page that contains these settings is shown in the figure below.
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Product Groups

These settings control the default product groups created for each capture. Change these setfings on a section’s or schedule's page to override the global defaults.

{CUSTOM] Live Only - Audio-Video-Display -

Security Settings

These settings control the security.

Echo Viewers =

1. Use the Product Group drop-down list to select a live-enabled product group. The selected product group is
passed through to each schedule you generate for this section, however you can select a different product
group for each schedule if appropriate.

2. Use the Security Module drop-down list to identify how users access captures for this section (either live
webcasts or Echoes).

® |f you select Allow All, users are not required to log in to view any live webcasts or Echoes published
for this section. This also means that the chat and presence capabilities for live webcast are also
disabled, because these features require users to be identified (via their logins).

® Selecting a different Security Module will require authentication (student login) in order to access the
live webcasts or Echoes, and also allows use of the chat feature for live webcasts if you have the Colla
boration and Statistics Service configured for your system.

Security Settings Apply to All Instances of the Section

Unlike the Product Group default, the Security Settings default applies to all instances of the
section and cannot be changed for individual section schedules. Keep this in mind if you are
configuring a section devoted to live webcasts of special events. You may need to configure
different sections depending on whether the event webcasts are open to all users, or if some
events will require student login.

For more information on adding and configuring sections, see Manage Sections.

Configure a Schedule for a Live Webcast Section
All live webcasts must be scheduled. You can schedule a live webcast as late as 15 minutes before its start time.

Use the following steps for every section or event that needs live webcasting. The steps below assume you have
already created a live-enabled product group as well as the section you must now schedule. See Manage Product
Groups and Add a Section for more detailed information on those tasks.

1. Navigate to the Schedules page (Schedule > Schedules).
2. You can create a new schedule for the section OR edit an existing schedule to do live webcasting:
® Select the section you want to schedule with live webcasting using the Term, Course and Section
drop-down lists. Click Add New.
® Find the section you want to edit to include live webcasting from the Schedules list. Hover your mouse
over the section and click the edit button that appears.
3. Select or if necessary change the room where the section occurs. The room selected MUST have a
SafeCapture HD capture appliance. Live can only occur in venues that have a SafeCapture HD.
4. Configure or review the Date and Time, Exclusions, Presenters, and Echo Defaults settings.
5. Review or edit the Product Groups selection for the section.
® |f you choose a product group for which live is required, the Stream Live field is checked, but grayed
(dimmed) because there is no need to configure it.
® |f you choose a product group for which live is optional, the Stream Live field can be enabled or
disabled as shown in the below figure. Enabling this check box generates a live webcast URL and
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allows students to view the section in real time.

Product Groups

These settings control the default product groups created for each capture. Change these seftings on a section’s or schedule's page to override the global defaults.

w

Product Group : A live optional config. Audio Only (Podcast). Balanced between file size & quality j tream Live : E

6. Review the Echo Defaults section of the Schedule Details page. Be sure that the Echoes Initially
Unavailable checkbox is NOT checked, as shown in the below figure. Uncheck the box if necessary.

Echo Defaults

This setting controls the default presentation state. Presentations can either be made Available or Unavailable by default. Change these
seltings on a section’s or scheduwle's page to override the global defaults.

O fp—

Click Save.

Review the schedule settings. Be sure the Stream Live setting under Product Groups reads Yes.

Click Activate to activate the schedule.

10. When the Schedule Details page refreshes after activation, notice, in the Course/Description section of the
page, there is a Next Live Event Link entry followed by a URL, shown in the figure below. If appropriate, you
can disseminate this link via email or by posting it on a website, to allow students to join the webcast. The
EchoCenter page for the section also provides access to the webcast. For more information on providing
access to the scheduled live webcast, see Notify Students.

© o N

Course / Description

Course : SJG course with live event (SJG101-5JG section with live event) Fall 2011

Title: : SJG course with live event (SJG101-5JG section with live event) Fall 2011
Description : {
Mext Live Event Link : httoVlivedemoc.echo3e0.com:B080/esslecho/presentation/e0982 34 b-3ab ¥ -4 7 35-aBf6-80bBETbde 152

Administer the Live Webcast

As an Administrator, you can monitor and control the live webcast as it is happening. The Instructor may also
monitor and control the webcast through the instructor interface for the live webcast.

Monitor the Live Webcast

You may want to monitor the SafeCapture HD inputs prior to the start of the live webcast, and monitor at least the
initial few minutes of the presentation to make sure all of the sources are being webcast correctly. There are two
ways to monitor a live webcast:

¢ Use the Monitor tab in the ESS interface.
® Use the Monitor tab in the SafeCapture HD appliance's user interface.

To monitor the webcast through the ESS interface:

1. Inthe ESS, navigate to Monitor > Summary.
2. The Capturing tab is active by default. If there is a current live webcast being captured, it is listed on the
Capturing tab along with a Monitor link in the Streaming column, as shown in the below figure.
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Echoes | Downloads Schedule WAGLIGLE  Reports || Configuration | System

Summary Captures Processing Tasks Personal Capture Alerts Notifiers Alert Settings Support Help
Summary
System Alerts Capture Stations Processors System Status
1 inlasthour 4 registered 1 registered 7 active license(s) [expiration in 1 year, 11 months]
2 1to4 hours ago 0 outofcontact 0 outofcontact 2 storage volume(s) with disk space OK
7 41012 hours ago 3 assigned to a room 0 jobsin queue 0 storage volume(s) with disk space LOW
0 12to 24 hours ago 26 jobs completed today 0 jobsin process 0 storage volume(s) with disk space CRITICAL
0 1to5daysago 25 jobs completed today
Recent Captures
Filter By : Organization % Organization : | choose.. s Keyword Search : m
Scheduled: 1 Capturing: 1 Processing: 1 Completed: 25 1-1of 1

Time ~ Course Room Capture Status Source [legend] Streaming Processing Status Progress Elapsed Publishing Alerts

9:30 AM - 8:35 AM ASLPL-Aptus section  echo.building-SCHD [d¢ Capturing I i N/A NiA nia [i}

3. Click the Monitor link. This opens the EchoCenter page for the live webcast section in a new tab.
4. Click to join the live webcast in progress. The student view of the webcast appears, allowing you to see the
output being viewed by students.

© WMonitor Link Shows Student View

The Monitor link described above only shows the student view of a live webcast. While an
Instructor may be in the habit of logging into the ESS to monitor a classroom capture, accessing
a live webcast in this manner will not provide the Presenter view of the webcast, which contains
additional capture control features. Instructors should log into their EchoCenter pages and
access live webcasts from there, to monitor and control live webcasts.

To monitor the webcast through the SafeCapture HD appliance interface:

Below is an abbreviated procedure for this task. See Log In to the EchoSystem SafeCapture HD for more detailed
instructions.

1. In the ESS, navigate to Configuration > Devices.
2. Look for the SafeCapture HD device in the room where the live webcast is taking place. If necessary, use the
Search drop-down lists to filter which devices are shown.
Click the MAC address for the device. The Device Details screen opens.
In the Device Details screen, click the Local IP Address. A new browser tab opens, connecting to the device.
5. When prompted, enter your Administrator user name and password. The interface to the device appears, with
the Capture tab active by default.
6. Click the Monitor tab to activate it. One of two monitoring tasks will be available:
® |f the webcast has not yet started, click Start Monitoring to review the inputs being received for the
webcast. This is the feed the students will see once the webcast begins.
* If the webcast has begun, the Monitoring tab shows the inputs being broadcast. This is the feed that
students are seeing. The figure below shows the Monitor tab of a SafeCapture HD device. Notice that
the figure shows both a Video and a Display feed.

how
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ech®

Captures Monitor Status Diagnostics Logs Help

Dulles: HQ, Medium Conference Room

Input Monitoring

EchoSystem Version 5.0.28578 Device Time: 2092-03-05 09:52:37

7. When finished, click Stop Monitoring. If the webcast has begun, simply close the browser.

Capture Control of the Live Webcast

Live webcasts can be controlled much the same way that Ad Hoc recordings are controlled. This includes the ability
to pause, resume, extend, and stop a live webcast. In fact, you use the same interface features. If you have
integrated the capture appliance with an AMX or Crestron system, there are no changes to enable capture control
functionality through the capture device API.

In the same way that pausing an Ad Hoc recording suspends the capture of a classroom's activities, pausing a live
webcast suspends the broadcast of the event or class until the webcast is resumed.

Pausing Suspends the Webcast

When a live webcast is paused, any actions or instructions in the venue during the pause are not
broadcast and are not captured. Classroom students see what occurs. Remote students see a
"pause" symbol on the screen and do not see what occurs. The Echo does not show what
occurs.

Typically the Instructor or Teaching Assistant (TA) for a section controls the live webcast. However, as an
Administrator, you may want to manipulate a live event if you are:

® Testing the configuration to be sure everything is set up correctly, or
Managing a special event, such as a guest speaker, and want to control the event broadcast as it occurs

There are two ways to access the capture control features of a live webcast:

® Using the administrative access to the capture appliance
® Using the instructor interface of the live webcast screen

To use the administrative access method:

1. Navigate to Configuration > Devices.
2. Look for the SafeCapture HD device in the room where the live webcast is taking place. If necessary, use the
Search drop-down lists to filter which devices are shown.
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Click the MAC address for the device. The Device Details screen opens.

In the Device Details screen, click the Local IP Address. A new browser tab opens, connecting to the device.
5. When prompted, enter your Administrator user name and password. The interface to the device appears, with
the Capture tab active by default, shown in the figure below.

»

Logout

ech®

Captures Monitor Status Diagnostics Logs Help

Dulles: HQ, Medium Conference Room

Capturing: EchoCenter Scrum

Presenter: Live, Agile Team

Start Time: 2012-03-12 at 10:30:00
Duration: 14 minutes

Status: Recording...

Capture Time Remaining: 1:29

Stop Capture Extend Capture

EchoSystem Version 5.0.28578 Device Time: 2012-03-12 10:42:20

6. Use the Stop Capture, Pause Capture, and Extend Capture buttons as follows to manipulate the live
webcast:

® Stop Capture - Ends the live webcast. Note that you cannot restart a webcast; you must create a new
one if you stop the webcast by mistake.

® Pause Capture - Temporarily suspends the capture or broadcast of events in the venue. Useful for
short breaks in the event or for time taken to set up a classroom activity that may not need to be
captured or broadcast. Once paused, the button changes to Resume Capture.

® Extend Capture - Allows you to add time to the scheduled event, if necessary. Note that you cannot
extend the time of a webcast past the start time of the next scheduled capture for the device.

Live Webcasting FAQs for Admins

In this section:

What do | need for Live Webcasting?

Are there limitations on where students can view Live Webcasts?
Are there browser limitations for Live Webcasting?

Can Live Webcasts be viewed on a Mobile device?

Can students participate in Live Webcasts?

Can | use Live Webcasting for special events?

What kind of network usage can | expect for each Live Webcast?
How does webcasting impact my Wowza server?

Can | have Echo360 host my Live Webcasting?

What do | need for Live Webcasting?

In order to enable live webcasting, you need to have the following:

® EchoSystem 5.1 or above

Page 289



EchoSystem 5.5 Documentation

® Aroom or venue where an EchoSystem SafeCapture HD is installed and licensed
* Wowza Media Server v3.5 or higher as the Flash media streaming server for live content. EchoSystem 5.5
requires Wowza v3.5, 3.6 or 4.0.

Along with those items, you need to be sure the you have completed the proper configuration steps associated with
live webcasting.

Are there limitations on where students can view Live Webcasts?

Regardless of their location, individuals can view these live events from a personal computer (PC) or Mac with a
broadband Internet connection of at least 515 kbps (kilobits per second) for audio and video streaming. Streaming
audio with dual display, or audio with video and display requires 980-1100 kbps for a quality viewing experience.

Are there browser limitations for Live Webcasting?

The user just needs a PC or Mac, Internet connectivity and a modern browser with Flash. Firefox, Internet Explorer,
Chrome, and Safari are all supported.

Can Live Webcasts be viewed on a Mobile device?

Echo’s live webcasting feature is designed primarily for multimedia streaming to a PC or Mac via a broadband
network connection. However Echo360 supports the viewing of Live webcasts on iOS devices running iOS 5 and
above. There are additional steps you may need to perform on the Wowza media server to allow for live streaming
to iOS devices.

Keep in mind, however, that mobile viewing is subject to the following limitations:

* Viewers will only see the Primary Display (e.g., what is featured on a computer screen during the
presentation) OR the Video for the event. They will not see both.
® Viewers may require a broadband (wifi) connection for the event to stream smoothly.

Can students participate in Live Webcasts?

If students are required to log in to the live webcasts (as controlled by the configuration of the Section), and you
have registered your ESS with Echo360's Collaboration and Statistics service, the live webcast will have a chat
feature that allows students to participate via text-based chat. If the chat feature is not available or you would prefer
voice communication, an Instructor or Presenter can initiate an optional audio bridge (not provided by Echo360).
Using an audio bridge can significantly augment Echo’s live webcasting, but note that there is a small but
perceptible delay between the audio bridge and the webcast audio and video feeds. Because of this delay, if using
an audio bridge, the audio feed from the webcast should be muted to avoid confusion.

Can | use Live Webcasting for special events?

While Echo360’s live webcasting is designed for remote student access to a lecture, it can also be used to
broadcast a special event (e.g., a guest speaker) to a broader audience both inside and outside of your institution.

It is important to note this capability is not a broadcast quality distribution platform -- it webcasts a unique stream or
combination of streams for each active viewer. Therefore, bandwidth limitations between the institution’s streaming
server, the public Internet, and “the last mile” to the viewer can cause performance issues. The bandwidth for
various product combinations is provided below. It is important to confirm that your institution has the necessary
network configuration to support anticipated load for streaming special events, especially if it is being broadcast to a
large and geographically diverse audience.
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What kind of network usage can | expect for each Live Webcast?

The below table lists the specifications for live streams based on product selection. In the table and examples that
follow, kbps=kilobits per second; fps = frames per second; Mbps = megabits per second.

Both live webcasts and on-demand recordings share these specifications:

Stream Audio Display Video Second Stream to Stream per
Content Display Wowza Viewer
from Wowza
Audio + AAC, H.264, VBR - - ~605 kbps ~ 630 kbps
Display 128 kbps 720 px high
stereo 15 fps
475 kbps
Audio + AAC, - H.264, VBR - ~495 kbps ~515 kbps
Video 128 kbps 480 px high
stereo 15fps/ 125
fps
365 kbps
Audio + AAC, H.264, VBR H.264, VBR - ~970 kbps ~980 kbps
Display + 128 kbps 720 px high 480 px high
Video stereo 15 fps 15fps /12.5
475 kbps fps
365 kbps
Audio + AAC, H.264, VBR - H.264, VBR ~1080 kbps ~1100 kbps
Display + 128 kbps 720 px high 720 px high
Display stereo 15 fps 15 fps
475 kbps 475 kbps

The following example provides real-world calculations for bandwidth usage:

Twenty students are viewing a webcast that includes audio and a presentation display from the classroom's

computer.

® Bandwidth from SafeCapture HD to the Wowza Media Server: ~605 kbps (475 kbps for display + 128 kbps for

audio)

¢ Bandwidth from the Wowza Media Server to the students: 20 students x 630 kbps = 12,600 kbps (~12.60

Mbps)

® Total Bandwidth Required for stream end-to-end: 605 kbps + 12,600 kbps = 13,205 (~13.25 Mbps)

How does webcasting impact my Wowza server?

It is important to recognize that a live webcast uses streaming server resources differently than an on-demand
recording, and so benefits from different improvements to the server hardware.

The items for each type of content delivery are in listed below in order of most important to least important:

On-Demand content

Page 291

Live Webcasting content



EchoSystem 5.5 Documentation

1. Disk Size/Storage 1. Network

2. Ram 2. CPU

3. Network 3. Ram

4. CPU 4. Disk Size/Storage

Can | have Echo360 host my Live Webcasting?

Yes, but only in and for North American customers. However, there are important considerations when a customer
has Echo360 host their EchoSystem and uses live webcasting.

First, live streaming will increase network traffic and volume—which are costs born by the university. Just like
streaming recorded content, streaming live content drives usage-based streaming fees.

The fees for both live and on-demand streaming are based on output bundles. There is no premium pricing for live
over on-demand streaming—»both are based on the volume out. If a customer is likely to use live streaming
infrequently, then the incremental costs will be small relative to the standard on-demand streaming costs. If the use
case for live streaming is to support a large distance learning program, then Echo360 must work with the customer
to better estimate the costs under this use case.

Manage the EchoCenter

In this section:

What is EchoCenter?

Deploy the EchoCenter

Best Practice - Deploy the Collaboration Service Version
Instructor and Student EchoCenter Pages

Overview on Views and EchoCenter Analytics

Standard EchoCenter Pages

Train Academic Staff to Use EchoCenter Pages

What is EchoCenter?

EchoCenter is a convenient, intuitive dashboard for both students and Instructors. On this single page, users find:

® All course materials for a section (Echoes, media imports, and Personal Capture recordings), grouped
together by date and lecture. This organization matches the syllabus and the mental model of students and
Instructors

® For students: Access to discussions and course notes (bookmarks).

® For students and Instructors: Access to live webcasts (if offered by the section).

® For Instructors: All student features plus access to student usage data ("teaching aids"), engagement
analytics, and Echo-specific heat maps.

Deploying the EchoCenter helps Instructors get the most out the university's investment in the Echo360 blended
learning solution. Although you might still want to publish individual links of Echoes and supplemental materials (and
this method, "individual link publishing" is still supported), the EchoCenter page is automatically created for each
section and offers a better experience.

EchoSystem also provides the ability to embed the EchoPlayer for individual echoes into external websites or an
LMS page, allowing users to view the echo with the full EchoPlayer functionality.
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See Deploy the EchoCenter below for details on how to implement the EchoCenter.

See Train Academic Staff to Use EchoCenter Pages below for suggestions on how to help Academic Staff get the
most value from this feature.

© If You Use RSS Feeds

If you use RSS feeds with integrations, consider using an EchoCenter page instead. It provides a
much better interface for students and instructors. You should still use RSS feeds for podcasting
and iTunes U.

Deploy the EchoCenter

This procedure shows how to deploy the Collaboration Service version of the EchoCenter, which we recommend.
See Best Practice - Deploy the Collaboration Service Version for details of the advantages offered by this version.

Follow these steps:

1. Required: Ensure that you are subscribed to the Collaboration Service.
2. Required: Configure the appropriate authorization method.
* LDAP Authentication (if you are not integrating with BlackBoard or Moodle). Be sure to configure
LDAP, ensuring that students and Instructors are correctly identified. If you do not, Instructors see the
standard EchoCenter page and do not see valuable teaching aids. See Enable LDAP Authentication.

® Seamless login (if you are integrating with BlackBoard or Moodle). For Blackboard, see Blackboard
Learning Management System Enterprise (7.3-9.1). For Moodle, see Moodle - EchoCenter Publishing.
3. Required: If you use BlackBoard or Moodle, you can publish EchoCenter pages directly to your learning
management system (LMS). The EchoCenter page appears on the Blackboard or Moodle page for the
section. See:
® Blackboard Learning Management System Enterprise 9.1 - EchoCenter Publishing

® Moodle - EchoCenter Publishing
4. Optional: If you publish to a different LMS and want seamless integration between it and the EchoCenter,
contact Echo360 Client Services for information.
5. Required: Configure EchoCenter settings in the parent or child organization. You may want to configure
other settings as well. See Configure the EchoCenter and Other Settings in the Parent or Child Organization .
6. Optional: Customize the user experience via ESS configurations. You can, for example, add your school's
logo to the EchoCenter pages. See Enable EchoCenter Pages in the ESS.

7. Optional: If you use an LMS other than BlackBoard or Moodle, you can embed the EchoCenter page URLs
in that system. See Enable EchoCenter Pages in a Learning Management System.

Best Practice - Deploy the Collaboration Service Version

Although you can deploy either the standard or Collaboration Service versions of EchoCenter pages, we
recommend that you deploy the Collaboration Service version, which has optimized views for both Instructors and
students. In addition, if you are integrating a Lecture Tools system with EchoSystem, you must use collaboration
services and set up user authentication for EchoCenter access.

The Instructor view helps Instructors teach better by offering several teaching aids:

® Instructors can initiate discussions on key topics or participate in student discussions
® Course statistics show viewing trends by week and by Echo.
® Viewing statistics for a specific Echo show the number of viewers and unique viewers.
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® Engagement statistics show the number and depth of discussions.
® Heat maps give Instructors insight into student reaction to a specific lecture.
® Student usage reports show student engagement in the course.
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The student view helps students learn better by supporting discussions and bookmarks.

® Discussions offer an interactive way for students to engage with their Instructors, with each other, and with
the material.

®* Bookmarks in the EchoPlayer tag key moments in the lecture, a timesaver when students review an Echo
when preparing for an examination. In the EchoCenter, a student can scan the list of Course Bookmarks to
get a quick summary of those key moments.

The unauthenticated view has none of these helpful features, as shown below:
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Instructor and Student EchoCenter Pages
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When you deploy the Collaboration Service version of EchoCenter and a user's credentials are authenticated, there
are two different views of the EchoCenter page:

The Instructor view is visible to Instructors, Administrators, and Teaching Assistants
The student view is visible to students, Student Presenters, and Guest Presenters

The Instructor View

The Instructor view looks like the figure shown below:

& ol @

The Instructor view offers most of the functionality of the student view, lacking only the course notes (bookmarks)
pane. The Instructor can also see several teaching aids:

1.
2.

4.

5.

Course statistics show viewing trends by week and by Echo.

Viewing statistics for a specific Echo show the number of viewers and unique viewers. This helps an
Instructor gauge student interest in a particular Echo.

Engagement statistics show the number and depth of discussions. This gives an Instructor additional insight
into reaction to a particular Echo.

A heat map of a specific Echo shows specific topics within the lecture where there is a significant discussion,
class-wide disagreement, or confusion.

Student engagement reports give detailed statistics on each student's participation.

See EchoCenter for Academic Staff for details on the Instructor view.

The Student View

Students do not see the teaching aids in the Instructor view. The student view of a Collaboration Service page looks
like the figure shown below:
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From this page students can:

1. See a notice of the next recording or join a live webcast if one is scheduled. The join button appears shortly
before the scheduled webcast time. See Live Webcasting for Students.

2. See course notes (bookmarks) they have added to Echoes. Clicking on the course note (bookmark) opens
the Echo at the relevant scene.

3. View recent discussions and join the discussion. Clicking on the discussion link opens the Echo at the
relevant scene.

© Wwhy Aren't There Links to the Most Recent Echo Here?

The Recent Activity section lists the most recent discussions that occurred in any Echo for
this section. If the most recent Echo did not elicit any discussion, no discussion link is
listed. Discussions sometimes occur as students review the Echo. As students submit
discussions topics, they are listed in this pane.

N

. View the list of available Echoes and supplemental materials (media imports or Personal Capture
recordings) or other Echoes.

Launch Echoes.

. Select tab.

Download the podcast or vodcast for the Echo.

. See the description of the Echo entered by the Instructor (see Train Instructors to Customize Descriptions
for Specific Echoes).

©~N o

See EchoCenter for Students for details on the student view.

Overview on Views and EchoCenter Analytics

A view is defined as any continuous viewing for a given user and a given presentation with a 10 minute timeout. This
means that if the user comes back into the presentation within 10 minutes of the last time they viewed that
presentation HEMS will log that as a single view.

Usage data (heatmap data) is sent once every few minutes to the server as the player is running. If the session does

not exist HEMS registers the new session and logs the view. These view numbers are now used for all calculations
returned from HEMS for view stats.
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HEMS divides the presentations up into segments for analytic reasons and keeps track of how many times users
cross segment boundaries. To get the average completion, HEMS returns to EchoCenter the total number of
segments viewed divided by the number of cumulative views of the presentation. EchoCenter then uses that number
to calculate the % viewed, based off the total number of segments for the presentation.

The accuracy of this is highly dependent on the length of the presentation. The EchoPlayer does not send data up to
HEMS on every segment viewed. It accumulates them and sends data on timed intervals just like google analytics
does. The timed interval is dependent on the length of the presentation. For presentations less than 50 minutes it
only sends data once every 1.5 minutes, with segments at 15 second intervals. So lets say, the presentation is only
2 minutes long and the user views the 2 minutes and then closes the browser. In this case, only the first set of stat
data would be sent by the EchoPlayer and therefore, even though the user watched the entire presentation, the
second chunk of data was never sent and EchoCenter will only see about 50% of the presentation as viewed.

Standard EchoCenter Pages

When a user's credentials are not authenticated, the user sees the standard version of the EchoCenter page, as
shown in the figure below:

ech@ Demo Course - Introduction to EchoCenter & eché @

@ Course Echoes

Available - Most Recent - 4 Echoes

I ﬁ Algebra And Trig | Algebra And Trig | plavgll

September 05 5:00 PM

Water Contrel and Management (i}
May 21 11:59 AM

Information
= @B Medical Grand Rounds
i
B8] November 05 10:14 AM

=m Web Communications
August 05 9:00 AM

DATE September 05 5:00 PM
ol PRESENTERS Carl Marrelli
l TYPE Lecture
DURATION 00:03:55

DOWNLOADS Audio File
Videa File

DESGRIPTION
(MA 15300-MA 153, FALL 2012)

The standard EchoCenter page lacks useful features for both students and Instructors:

® Students do not see discussions or course notes (bookmarks)
® Instructors do not see discussions, course statistics, viewing statistics, engagement statistics, or heat maps

Best Practice: Deploy the Collaboration Service Version

The Collaboration Service version has optimized views for both Instructors and students. See De
ploy the EchoCenter.

Train Academic Staff to Use EchoCenter Pages

You will need to show Academic Staff how to:

® Access their EchoCenter pages. Academic Staff receive EchoCenter links in different ways, depending on
your configuration. You can:
® Integrate the EchoCenter to Blackboard or Moodle. See Blackboard Learning Management System
Enterprise 9.1 - EchoCenter Publishing or Moodle - EchoCenter Publishing .
® |nclude the link in the email announcing that media is ready to view.
® Show Academic Staff how to navigate to the EchoCenter page from the ESS user interface. Clicking
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on an Echo opens the Echo Details page, where the EchoCenter link is shown.
® Understand the information on an EchoCenter page.
® Academic Staff members can click on an embedded help button. They will see the instructions shown
on the EchoCenter for Academic Staff page.
® You can also post the EchoCenter for Academic Staff page in an easily accessible location and urge
Academic Staff to review it.
® You can give a brief "guided tour" of a typical EchoCenter page.
® Customize descriptions for specific Echoes. Academic Staff have had this ability for some time. Now
students see the description on their EchoCenter pages, offering an opportunity to orient students as they
view an Echo. See Improve Learning - Add Descriptions for Each Echo.

Enable EchoCenter Pages in a Learning Management System
In this section:

® Qverview
® Copy-Paste URLs and Embed Codes
® The Mass Export Method

Overview

If you use a learning management system (LMS) that supports EchoCenter publishing, such as Blackboard or Moodl
e, use that method to enable EchoCenter pages.

© EchoCenter Publishing Required with BlackBoard

You cannot use the copy-paste method described in this section to embed EchoCenter codes to
a BlackBoard page. You can use this method with Moodle, though we recommend using EchoC
enter publishing instead.

If you use an LMS other than BlackBoard or Moodle, you can still add EchoCenter page URLs on your LMS course
page using either of two methods:

® The copy-paste method
® The mass export method

In addition to enabling EchoCenter pages into an LMS, admins or instructors can also embed the EchoPlayer for an
echo onto an LMS page or other external site. See Embedding the EchoPlayer for additional information.

Copy-Paste URLs and Embed Codes

You can copy-paste:

® Just the URL
® The URL with embedded code that formats it for a course page

Do this once per section per academic term.

1. Navigate to the section details page.
a. Navigate to Schedule > Courses.
b. Click on the course link.
c. Click on the section link. The section details page appears, shown in the figure below.
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Courses > Course Details > Section Details

Section Details — SJG course (SJG101-Spring 2011) echo.May 2011

EchoCenter Page \ URL: http:lfec2-50-17-98-228 compute-1 amazonaws.com:8080/ess/portal/sectiion/Section %201
Embed Code:  <iframe width="100%" height="100%" frameborder="0" src="http

2. Do one of the following:

® Copy just the URL
® Copy all of the text in the Embed Code field

3. Paste either the URL or the Embed Code field contents into your LMS page for the section.

The Mass Export Method

You can use this method to export the URLS, but not the embed code.

See Example - Post EchoCenter Page URLS to an LMS.

Enable EchoCenter Pages in the ESS

In this section:

Overview

Configure the EchoCenter and Other Settings in the Parent or Child Organization
Configure Settings in Each Section

Train Instructors to Customize Descriptions for Specific Echoes

Overview

Enabling EchoCenter pages consists of one required phase and two optional phases.

1.

Required: Configure the EchoCenter in the parent or child organization. This is done by the System
Administrator, the parent organization Administrator, or a child organization Administrator. See EchoCenter.
® |f you configure the parent organization, settings are inherited by child organizations and sections

® |f you configure a child organization, settings are inherited by sections

. Optional: Customize some aspects of the EchoCenter page by configuring settings in each section. This can

be done by an Administrator or a Scheduler. You can customize all sections or just some. You can do these
customizations when you add the section.
Optional: Train Instructors to customize the descriptions for individual Echoes.

Configure the EchoCenter and Other Settings in the Parent or Child Organization

1.
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Display the Organization Details page for either the parent or child organization.

a. Navigate to Configuration > Organizations.

b. Select the organization.
Configure EchoCenter settings. These settings control many aspects of the appearance of the EchoCenter
page.

. Implement either standard or Collaboration Service EchoCenter pages by configuring the Security Module s

etting in the Security Settings group, as shown in the figure below.
a. To implement standard EchoCenter pages, select Allow All.
b. To implement Collaboration Service EchoCenter pages, select either LDAP or seamless login. See Se
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curity.
Security Settings

These seftings control the security.

Security Module : Echo360 LDAP hd|

4. Optionally, add a logo. The logo that appears on the EchoCenter page is specified in the Player Logo Image

setting in the Branding group.
5. Click Save to close the Organization Details page.
6. After you complete this configuration, EchoCenter pages will appear automatically for each section.
® You, the System or Organization Administrator, will see the URL for each EchoCenter page on the

Section Details page, as shown in the following figure:
Section

MEF 5001 (FVR)

http:fec2-50-16-76-204.compute- 1. amazonaws.com:B080Vess/portal'section/™NSP_S5001.1

® These URLs are different from the URLs for individual Echoes, which appear on the Echo Details
pages.
Echoes > Echo Details

Show Echo — NS Physics (NSP101-NSP S001) ns.term

rrent Status : Available URL: nttp:fiec2-50-16-76-204 compute-1 .amazonaws com:B080/ess/echa/presentation/ 1FB4836-10d4-417a-e1 c- 293536487 e4b

7. Deploy the URLSs to students and faculty using any of these methods:

® |f you use Blackboard Learn as a publisher and have enabled EchoCenter publishing, URLs appear on
the Blackboard pages.

® |f you use Moodle and a publisher and have enabled EchoCenter publishing, URLs appear on the
Moodle pages.

® |f you use another publisher, you can enable EchoCenter pages by manually copy pasting or
embedding URLSs on the EchoCenter pages.

® If you send notifications via e-mail, continue to use that method. The EchoCenter page links are
included in the emails.

Configure Settings in Each Section

You can customize all sections or just some. This customization can be done when you add the section.

1. Display the Section Details page for the section.
a. Navigate to Schedule > Courses.
b. Click on the course name to display the Course Details page.
c. Click on the section name to display the Section Details page.

2. Except for the External System Id fields, all of the EchoCenter settings shown for the section are inherited
from the organization. Customize them for the section as necessary. See EchoCenter settings for the
organization for details on each setting.

3. The External System Id fields (the last two EchoCenter settings) are not inherited from the organization.

They appear only here, on the section page. You may want to customize these fields. See External System
IDs.

4. Click Done to close the Section Details page.
5. Enter a description for the Echoes. The text will appear underneath each Echo posted to the EchoCenter
page.
a. Navigate to Schedule > Schedules and edit the schedule for the section.
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b. In the Course/Description area, enter a description, as shown in the figure below.

Schedules > Edit Schedule

Edit Schedule - sjg course test (SJG101-SJG section)
Echo Term 1

Course [ Description

Course : sjg course test (SJG101-5JG section) Echo Term 1
Title : I sjg course test (5)JGL01-5)C section) Echo Term 1
Description : Enter a description here. Text will apoear undemeath each Echo on the

course list page.

c. Click Save to close the Schedule page.
d. After the next scheduled capture occurs, check the description for the Echo. It should reflect the
changes you made.

Train Instructors to Customize Descriptions for Specific Echoes

You may have added a description for the section in the section's schedule. This description appears in the
Information tab for each Echo posted to the EchoCenter page. However, when the same description appears for
each Echo, students cannot easily find a specific Echo.

Best Practice: Customize Echo Descriptions

Show Instructors that it is quick and easy to customize the description for a specific Echo. The
Instructor can reinforce a key concept from the lecture while helping a student to find and replay
a specific Echo.

Instructions on customizing descriptions for each Echo are included in the documentation for Academic Staff. You
can point Instructors to these instructions or demonstrate the procedure. See Improve Learning - Add Descriptions
for Each Echo.

Enable Engagement Analytics

® Qverview
® Enable Section Security
® Put Students Names in the ESS Internal Database

Overview

Engagement analytics are data on student activities. These include detailed data on student viewing of Echoes and
participation in discussions. Engagement analytics are typically conveyed to Academic Staff via student usage
reports, accessed via the EchoCenter page for a section (see Student Usage Reports - Are Students Engaged? for
details). Engagement analytics can also be exported and included in a broader analysis.
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Enabling engagement analytics requires this configuration:

Secured section. The section must be secured in some way. The individual student accessing the section
must be identified so his activity can be compiled in a report. See Enable Section Security below for details
on security methods you can use.

Student names. Student names must be in a database so the ESS can identify an individual student when
he logs in. If you are using a security method that includes a name database (LDAP, CAS, Shibboleth, an
LMS with seamless login), student names are already in an accessible database and you do not have to
create one. If you are not using such a security method, you will have to enrich the ESS internal database
with student names. See Put Students Names in a Database below.

When this configuration is in place, engagement analytics can be collected because the following process takes

place:

1.
2.

The student logs in to an Echo for the first time.

The ESS gathers identification data (the student's first name, last name, and email address) from a database.
This can be a learning management system (LMS), LDAP, or the internal ESS database.

The ESS marks the student as an Active Student.

The ESS compiles engagement analytics for the student, using the identification data gathered from the
source system.

. The ESS formats these engagement analytics into student usage reports on the EchoCenter page for the

section. See Student Usage Reports - Are Students Engaged?

Enable Section Security

You can enable security for the section in a variety of ways. See Security Settings for a general discussion of
security settings. The section security setting is usually inherited from the organization security setting.

Implement CAS or Shibboleth with the Authentication Required security module. You do not need to explicitly
put student names in a database because student names are gathered from the CAS or Shibboleth
databases. See CAS and Shibboleth Authentication .

Implement an LDAP security module. Student names are gathered from the LDAP database. See LDAP
Authentication.

Implement seamless login with your learning management system (LMS) and implement the Authentication
Required security module. Student names are gathered from the LMS. See Blackboard Learning
Management System Enterprise 7.3-9.1 - Individual Link Publishing.

Import all users and passwords into the internal ESS database and implement the Authentication Required
security module. You will have to put student names in the internal ESS database. See Put Students Names
in a Database.

Be aware of these special cases and side effects:

CAS as source system. The ESS collects only the student username from CAS. This means that
engagement analytics show the username, not the student's actual name. If you want to show the actual
name, you can export the user list for the section as a .csv file, enrich it with the actual name data, then
re-import it. See Import and Export Objects for a general discussion of this technique. See Import Users for
specifics on user names.

A disengaged student is not listed on student usage report. If the student never logs in to view an Echo,
the student name is not gathered and does not appear on the student usage report.

In some cases, an engaged student is not listed on the student usage report. If a student downloads
Echoes rather than streaming them from the ESS, engagement analytics are not collected. See Students
Who Download Echoes Have Skewed Data. You may need to explain this case to Academic Staff.

Put Students Names in the ESS Internal Database
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If you are using a security method that includes a name database, you can skip this step. If you do not, or if you
have problems with the name database, you can import students manually. You can use any of these methods to do
this:

® Import students using a .csv file
® Manually add individual students

See Manage Student Users for details.

Manage Product Groups

In this section:

Overview

About Default Product Groups

Assign a Product Group to a Section or Schedule
Add a Custom Product Group

View Product Group Details

Edit a Product Group

Copy a Product Group

Filter the List of Product Groups

Delete a Product Group

Overview

Product groups simplify scheduling because they are ready-made "bundles" of products and output qualities.
Product groups simplify the scheduling process because they allow a Scheduler to choose a ready-made product
group instead of specifying individual products. You can make the process even easier for the Scheduler by giving a
product group a "friendly name" that suggests its function:

® "Use for math classes"
® "Use for special events in Everest Hall"
® "Use for med school procedure demonstrations"

You may have up to three different types of product groups:

® Default product groups. After you install or upgrade to EchoSystem 4.0 or higher, you will see the default
product groups.

® System-generated product groups. If you upgrade to EchoSystem 4.0 or higher from an earlier release,
you may have additional product groups. These have the term "Upgraded product group" in their names.
During the upgrade process, the EchoSystem Server (ESS) analyzes your existing schedules and prepares
additional product groups that support the products you have requested most often.

® Custom product groups. You, as the System Administrator or Organization Administrator, may decide to
create custom product groups.

A product group owned by the parent organization is automatically shared with all child organizations. A product
group owned by a child organization cannot be shared with other child organizations.

About Default Product Groups

Default product groups are included with a new or upgraded installation.

® The Product Groups page, shown in the below figure, identifies capture appliances and applications
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supported by a particular product group.

® The Live column indicates whether a product group supports live webcasting. A Y indicates that the product
group always supports live webcasting. An O indicates that live webcasting is optionally provisioned for the
product group. See Add a Custom Product Group for details.

® The descriptions discuss products supported, bandwidth, quality, and typical use cases.

Babelirivrs Coptare  Captuee A s PLAP Lt Lhew Dbt gt
O Apglance  Saftwsrs Imzeet

Assign a Product Group to a Section or Schedule

When you add or edit a section or schedule, you assign a product group. When you do this:

® Review the product group details.
® Understand that the product groups available for selection are determined by what device is in the venue. For
example:
® If the venue has an EchoSystem Capture Appliance, you will not be able to select a product group with
"highest quality video" because this is not supported by the device.
* |f you are configuring a section for live webcasting, the room must contain an
EchoSystem SafeCapture HD device. If it does not, you cannot select either a "live only" product
group, nor can you enable the Stream Live check box.

The product group you select determines the output
generated by the capture, which in turn is determined by
the available input devices. Select a product group that is
compatible with both the input capabilities of the venue and
the output desired for the section or schedule.

Add a Custom Product Group
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Keeping custom product groups to a minimum makes it easier to manage your EchoSystem. Before creating a
custom product group, review the existing product groups to see if one is sufficient. Consider:

The content (audio, video, display) you want to capture
The quality (high, medium, low) you want to capture
The products you want to support

The devices that support those products

If you determine that a custom product group is needed, you can add a new group or copy and edit an existing
group.

1. Navigate to Configuration > Product Groups. The Product Groups page appears.
2. Click Add. The Add New Product Group page appears.
3. Complete the Product Group Information section.
a. Enter a name for the new product group. You might want to specify a "friendly name" ("Use for math
classes") that will help a Scheduler choose the product group for particular sections or schedules.
b. Optionally, enter a description. You might want to include details that will help a Scheduler choose the
product group for particular sections or schedules ("Use for classes in Room 767").
c. Select the parent or child organization to which this product group belongs.
d. Review the Estimated Storage information.
4. In the Product Details section, select the Podcast, Vodcast, and EchoPlayer options from the drop-down lists.
a. Select the quality for each output option.
b. Review the suggested use cases and storage/bandwidth estimates for the output option and quality
you selected. For on-demand profiles, the numbers are storage estimates. For live profiles, the
numbers are estimates of bandwidth consumption.

EchoBasic (Single Display) | Extreme | Suggested use: Display of high motion video in HD
mév-audic-vga: 128Bkbps; 44100Hz; stereo; wBA4lpx; 384kbps; 30.0ps;
=230 MB/hr maximum

—. fiv-audio: 128kbps; 44100Hz; stereo; ~58 MB/hr maximum
swi-chunked-video: w:1280px; 3333kbps; 30.04ps; ~1,500 MBihr maximum

Mobile Capable ~l Suggested use: Distance learning with off campus viewers

# Optionally provisioned

* sdp-audio-video: 32kbps; 22050Hz; maono; h:480px; 238kbps; 30.0fps

Best Practice: Compare These Estimates to Your Own Experience

The storage/bandwidth estimates shown are derived from a test environment. We
recommend that you compare these estimates with your own experience. See the
discussion on bandwidth requirements for details on estimating bandwidth for live
webcasting.

5. If you want to enable live webcasting for this product group, do the following:
a. In the Format section, select a live format option from the drop-down list. "Live Display and Video" is
selected in the example below.
i. Select the quality for the live webcasting option. "Mobile Capable" is selected in the example
below.
ii. Review the suggested use cases for the output option and quality.
b. In the Device And Use Case Compatibility section, select the SafeCapture HD device by checking the
box. Other devices can also be checked, however live webcasting is only supported using
a SafeCapture HD device.

The example below shows the sections of the Edit Product Group page that contain these settings.
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Product Details

N

Live Display and Video % Mobile Capable
™ Optionally provisioned

Device And Use Case Compatibility

Format Quality
Podcast Audio = Medium (Previously Quality) %
Screen Podcast + Medium (Previously Quality) %
EchoPlayer Display and Video & Low (Previously Quality) +

a
o

Outputs

Suggested use: Group Discussions (Balance between size & quality)
mp3-audio: B4kbps; 44 100Hz; mono; ~29 MB/hr maximum

Suggested use: Detailed Powerpoint on Smart phones (Balance between size & quality)
mév-audio-vga: 32kbos; 22050Hz; mona; w:E40px; 250kbps; 10.0fps; —127 MB/hr maximum

Suggested use: Simple Powerpoint & instructor Talking Head (Optimized for file size)
fh-audio-video: 32kbps; 22050Hz; mono; w:320px; 180kbps; half frame-rate; ~05 MB/hr maximum
mdv-audio-vga: 32kbps; 32000Hz; mono; w:B40px; 250kbps; 4.0fps; ~127 MB/hr maximum
fiv-audio: 32kbps; 22060Hz; mona; ~14 MB/hr maximum
swi-chunked-videa: w:1024px; 1111kbps; 4.0fps; ~500 MB/hr maximum

Suggested use: Distance leaming with off campus viewers
sdp-audio-videoa: 32kbps; 220650Hz; mono; h:4B0px; 385kbps; half frame-rate
sdp-video: h:720px; 385kbps; 15.0fps

Allow this product group te werk with the following devices:

™ SafeCapture HD [ Classroom Capture

/ 7] Capture Appliance "1 Personal Capture

Disabled/greyed items indicate the selected Products will not work for the use case or with the capiure device.

Allow this preduct group te be used in the following cases:

™ Ad hec Capture

Media Import

| save | Gancsl

6. If you enabled live webcasting, check or uncheck the Optionally provisioned check box, shown in the figure

below. This allows you to control live webcasting for an individual section that uses this product group.
® |f this box is checked, you can enable or disable live webcasting when you configure the section

schedule.
® |f this box is not checked, all schedules that use this product group will automatically generate a live
webcast.
Live Video =l Mobile Capable | Suggested use: Distance learning with off campus viewers
E Optionally D[D\l"iSiOI'IEd k sdp-audic-video: 32kbps; 22060Hz: mono; h:480px; 238kbps; full frame-rate

7. If you have not already, complete the Device And Use Case Compatibility section.

8. Click Save.

View Product Group Details

1. Navigate to Configuration > Product Groups.

2. Select a product group by clicking it. The Product Group Details page appears as shown in the figure below.

Product Groups = Product Group Details

Product Group Information

Product Group Details — Audio Only (Podcast). Balanced between file size & quality

Product Details

Name : Audio Only (Podcast). Balanced between file size & quality

Description : This product group is designed for audio podcast creation for external media uploads
Organization : echo3sl

Estimated Storage (excluding original media): =~30 MB/hr maximum

Podcast Audio [Medium (Previously Quality)]

Device And Use Case Compatibility

Suggested use: Group Discussions (Balance between size & quality)
mp3-audia: 64kbps; 44100Hz; mena; ~30 MB/he maximum;

This product group is created to work with the following devices:

v SafeCapture HD v/ Capture Software

' Capture Appliance ' Personal Capture

This product group is created to be used in the following cases:

v Ad hoc Capture

v External Media Ingest

Edit a Product Group
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You can edit any field except Organization.

1. Navigate to Configuration > Product Groups.

2. Hover over the product group that you want to edit and click edit. The Edit Product Group page appears as
shown in the figure below.

Product Groups > Edit Product Group
Edit Product Group — Example of a live optional config. Audio Only (Podcast). Balanced between file size & quality

Product Group Information

Hame Exampie of 2 live optional config. Audio Only (Podcast). Balanced between file size & guality

Shdwt ol SOUOAR SOVIGUIEIGA

T proQucT Group i esgrid 107 Sudid POCRT! Creaton 10! Mede Impon upleacs
This sampie- product group will be cdited

Organization Institution
Estimated Storage (excluding original media =30 MB/Mhr maxirmumm
Product Details
Format Quality Qutputs
Podeast Audio = Medium (Previcusly Quality) =|  Suggested use: Group Discussions (Balance between size & quality)
mpiaudc Biitpe, 44100H: momo, - 20 MBhe manmum
Select Vodcast product... =] None available =]
Select EchoPlayer product... =] wonc available -]
Live Video = Mighile Capabile = Suggested use: Distance learning with off campus viewers
& Optionally provisi sdiz-puso-vdeo: Tabps. T2060HE. mone; R 480D TIEkDEe. ul Fmme-rale
Device And Use Case Compatibility
Disablecigreyed ifems incicate e selected Products will nof work for (he LSe CAse oF wilh the Capie device.
Allow this product group 1o work with the following devices: Allow this product group to be used in the following cases:
™ SafeCapture HD ™ Capture Software ¥ Ad hoc Capture
# Capture Appliance @ Personal Capture # Media Import

3. Edit the product group fields. You can edit any field except Organization. In this example, we edit the product

group to create a low bandwidth version. Notice that the storage/bandwidth estimates have changed as
shown in the figure below.

Product Groups > Edit Product Group
Edit Product Group - Example of a live optional config. Audio Only (Podcast). Balanced between file size & quality

Product Group Information

Example of a live opeional config. Audie Only [Podcastl. Low Bandwidth

Sharach vl optinndl confiGListion
This product group ks designed for sedio podcal creation for Meda Impost uplcads
This samgsde product grous nis bean oced 10 Supe0n low tandwdh

e

Instibution

icrage (axciud inal media =10 MBMr maximum

Product Daotalls
Format Quality / Outputs
Pedeast Audia = Lerw (Previcusly Bandwidthl  »|  Sugpested use: instrucior Only (Optimized for size)
moSacde: Aubos; FHEMH: mona. =14 MBM manmun

Select Vockast product.., =) Kone sailable =]

Sl ECRoPlipes prtdull =] None svailable =]

Live Video | Mobile Capabie = Sugoestsd use: Diatance leaming with off campus viewers

™ Optionally provisioned B viien: FPdpe; TIECHE: maores; hoER0pe TBkbpe. Iull framp-rale

Dervice And Use Case Compatibility

Dizablsciprayed itams indicats the seiacimd Prockers will o wark for i ae c85e or with i caplun devics.

Mliorw this product group 1o wark with the following devices: Allow this product group 1o be used in the following cases:
# SafeCaphurs HD # Caphure Software # Ad hoo Capture
® Capture Appliance ¥ Personal Caplure & Media kmport

Page 307



EchoSystem 5.5 Documentation

4. Click Save. The Product Group Details page appears.
5. Click Done to return to the Product Groups page. You can also begin to add, copy, or edit a product group by
clicking the relevant button at the bottom of the page.

Copy a Product Group

You might want to create a custom product group by copying an existing product group and editing a few fields.

Navigate to Configuration > Product Groups.

Hover over the product group you want to edit and click copy. The Add New Product Group page appears.
Edit the product group's name, description, or products.

Click Save. The Product Group Details page appears.

Click Done to return to the Product Groups page. You can also begin to add, copy, or edit a product group by
clicking the relevant button at the bottom of the page.

arLODdRE

Filter the List of Product Groups

1. Navigate to Configuration > Product Groups.
2. At the top of the page, select the organization whose product groups you want included in the filtered list.

Product Groups

Search

Organization : | "Eihosen d

3. Click Search. Only those product groups matching the filter you selected appear. The example shown in the
figure below shows product groups belonging to the Echo360 organization.

Product Groups
Seansh
Ogsiston: | oot o o |
12m
Nama = SafeCapture Capture  Captars  AdMoc  PCAP o Description
WO Applance  Saftwar
Ao Only [Podcast). Balanced between fie size & quality - » ¥ . . ¥ This product group bs designed for sudio podcast creation for extemal media
wpbmda
5 5 Thin produst group i designed for sl bandwidth cotions. Il ereatm matile
Déspiay Cnly (Podcast/VodcasiEchoPiayer). Balanced betwnen fio sizo & quality - - ¥ - - and Eche: Player formats for dsplay orly capture. | supports both the
SateCaptue HD and 18! ganseaton spoisnce as well us ol sofware capturn
davicss
Dispiny Only [PodcastVoseastEchoPlayer). Optimized for etk PowerPont presentations - v v This product group Is designesd for high speed bandwieh opsons. & crestes
motider and Echo Player formats at high qualty for display only captuns.
Dispimy Condy (PodcastVodoastEchoPiayer). Optimizsd for high motion This produst grovp s designed for i bandwidth options. It createss mokile
¥ ¥ and Echo Player formats for exdemal media uploads of digiined dislay
capiunes.
Displaryivides (PodcastVodcasyEchoPlayer). Balanced betwaen fie size & quality This product grouw & designed for low basdwicth and low quality caphure
¥ ¥ ¥ ¥ Feeds. It crastes mobie and Echo Payer formata including display and wideo
capiure. I supports both e SaleCasture HD and 1st generation spplance.
Disglryivideo (PodcastiViadcastEchoPiayer), Oplimized for quakitylull mobion vides This product group is designed for a8 bandwidth optiona. It createss moie
¥ ¥ ¥ and Echo Player formats af good quality for blended dizplay and video

capune,

Tres prociuct growp i desgned for hgh speed bandwiah opor & crasms

Dual Display (PodcastVodcastEchoPiayer). Balanced betwoen fo sizo § qualty b and Eche Playor forma 32 goos quaiy for dust degiary capturms:
Typécal wse cases arm for clissmom with dual progsctor Systems whens bwo
Cisplay SOUCHE NS 10 e CEXUB] Smulanecusly.

Tres product grovp s desgned for hgh spped bandwicth opson. & ooatms
Dual Display (PodcastVodcastEchcPlayer). Optimized for file sine & Bandwid mabile and Eche Player lnmats at good quaiiy for dual dispiary capiures.

v o Typécal use cases oo for CASSIHOM with JuBl pOJSCor SEStaMS whene bwo
Siaptay Soureie R 1 b CRolutd Emutanecusly.
echa Dispiaynty
¥ ¥ Audia Podoast; Screen Podoast; ne Rich Medi
Seminars_sig_low_bandwidth . » - L harmrtth et foe pesdenats ery Ling ot simranuacs. that are mesty

ealk, o vides er display,

This product groug ks designed for ol bandwidth options: It creains masde
¥ ¥ ¥ and Echo Player formais for wideo anly capiwe. |t supposts beh the
SuteCapiurn HD and 18! ganersion sppines.

Vides Only (PodoastiVodoastiEchoPlayer]. Balanced bebwoen fie size & qualiy

Thie product group is designed for high speed bandwidth opfions. | crestes

Viebtss, Dy [PesieastivoseastEcraPuyer]. Diptiritnd for Sresietnr captur qualty (SD) " mtile and Echo Player fomats ot excellent qualty for HO wideo., Typcsl use
canas ar for CRaliboind Caphess or High DefiniiorDtaled Procedural
damcnaatons.

ighe Dty [Poceaatvodeast EchoPayer] Optimized tor Cresertnnproceduses caplre cunlity (HO Tris product group i designed for sl bandwidih cotiona. i ensates mosde

¥ ¥ ‘anel Ectd Praryer Formats e extermaal madi upiancs of SGIEDed video

capures.

4. To see the unfiltered list, click Clear.
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Delete a Product Group

You can delete any product group.

1. Navigate to Configuration > Product Groups.
2. Hover over the product group you want to delete and click delete. A confirmation message appears.
3. Click Yes. The Product Groups page appears with a delete confirmation message at the top.

Manage the Branding Files Repository

In this section:

® Qverview
® Upload a Branding File
® Edit a Branding File

Overview

The EchoSystem Server (ESS) allows institutions to brand (with logos, art, and messaging) the EchoPlayer that
students use to review and interact with content. Please take a moment to upload your branding assets to this
repository. Only assets within this repository can be used to customize the EchoPlayer. Once uploaded, you can
choose which assets to use as branding elements by customizing the branding settings.

Upload a Branding File

1. Verify that the file you want to use is a supported size and format. Refer to the following table for supported
sizes and formats. You cannot scale an image in the ESS. Use a graphics design program such as Adobe
PhotoShop to design and scale the image.

File Supported Sizes and Formats

Player Banner Background Image Use .png or .jpg files. The image must be 2 pixels
wide by 62 pixels high.

This image is layered below the logo image, the

metadata text, and the title. Choose an image and
color that will contrast well with these elements.

Player Logo Image Use .png or .jpg files. The image must be 2-250
pixels wide and no more than 62 pixels high.

We recommend padding the image with 10 pixels of
transparency on both sides.

This image is layered above the background image.
You may need to adjust the logo or background

image.

Animated .gif files are not supported.
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Intro and Outro clips Use a standard .mov or .mp4 file that is 5-60
seconds long. The file must contain both audio and
video tracks.

The image size must be 640x480 pixels.

Please note that Outro clips are only added to the
Podcast/Vodcast download files; they do not appear
in the EchoPlayer.

Watermark The watermark appears in the lower right corner of
both the video pane and the display (VGA) pane.

You can use any .png files except 16 bit channel
.png files and grayscale alpha channel .png files.
The watermark should be 1024x256 pixels or
smaller.

The image is scaled so the width is 10 percent the
width of the pane. The height is scaled to the width,
preserving the aspect ratio.

If you are using Adobe PhotoShop, we recommend
saving in PNG-24 format, checking the
Transparency option, and checking the "convert to
sRGB" option.

EchoCenter Logo Image Use .png or .jpg files. The image must be 10-192
pixels wide by 10-32 pixels high.

We recommend padding the image with 10 pixels of
transparency on both sides.

Animated .gif files are not supported.

Navigate to Schedule > Branding.
Click Add. The Add Branding File page appears as shown in the figure below.
Enter a name.
Select the parent organization or child organization from the list.
Click the radio button for the branding file type. Note the technical requirements for that type below the row of
radio buttons.
Click the File field, then click the Upload File button.
Browse to the file location on your computer and click Open.
9. Notice that the file begins to upload. While it is uploading, the Upload File field shows you how much has
uploaded.
10. If the file uploads successfully, you see a new field, Verify Media File, and a series of checks.

ook whN

© N
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Branding > Add New Branding File

Add Branding File

Branding File
Name : I Echo logo for EC page
Organization : | echo360 |
O Logo image (O Banner background image O Watermark image O Introfoutro video @ EchoCenter Logo image
Requirements : For the EchoCenter Logo Image, use .png or .jpg files. The image must be 10-192 pixels wide by 10-32 pixels high.
File : File uploaded (0.0074 MB).
Verty eas Fle Uploaded file is the correct type : @

Uploaded file has valid dimensions : @

11. Click Save.
Edit a Branding File

Overview

You can navigate to the branding files list, hover the cursor over a particular file, and click the edit button, as shown
in the screenshot below:

Echoes Downloads Schedule Monitor Reports Configuration 8

Schedules Courses Terms Branding

Branding Files

Title « Organization

E@E} dalete

Edit the branding file

SJG branding file
Institution

However, the "edit" button does not allow you to make changes to the appearance of the branding file. You can use
the edit button to:

® Edit the name of the file. You might do this when the file has a somewhat generic name ("logo™) and you are
about to add another logo file. You might want to rename "logo" to "logo for arts and sciences" then add
another file called "logo for med school".

® Replace the current file with a different file. You might do this when the logo has changed and another group
has supplied you with the new logo file.

To change the branding file itself, open the file in an appropriate media editor (this will differ depending on the file
type), make changes, and re-upload the changed file.

Procedure

1. Navigate to Schedule > Branding.
2. Hover over the file to be edited.
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3. Click edit.
4. In the Verify Certificate dialog box, click Trust.
5. In the applet is requesting dialog box, click Allow.
6. On the Edit Branding File page, do one or both of the following:
a. Edit the name field.
b. Click the Upload a file... button, then follow the same procedure described in Upload a Branding File.
7. Click Save.

8. If you edited the file name, you will see the new name on the Branding File Details page. If you uploaded a
new file, you may notice that the file size is different.

Branding > Branding File Details

Branding File — SJG branding file with new name

Branding File r

Name : SJG branding file with new name

Manage Rooms

In this section:

Overview

Add Rooms

Room Configuration Options

License Rooms

Assign Capture Appliance to the Room
Assign Classroom Capture to the Room
Retire a Room

Delete a Room

Reinstate a Room

Overview

Rooms are a critical concept for the EchoSystem Server (ESS) and are configured by navigating to Configuration >
Rooms.

Rooms are associated with Buildings and Campuses in a logical hierarchy. Within Rooms are Devices which are
scheduled for capture or used for Ad Hoc captures. The Room must also be licensed for the capture method or
device contained in the room.

Rooms, Buildings, and Campuses are all created through the Add Room functionality. The following table provides
descriptions of these terms and how they apply.

Concept Applies To Description
Campus(es) Buildings Campus defines the physical
Rooms campus on which buildings and

classrooms exist. They are the top
tier in room structure.

Page 312



EchoSystem 5.5 Documentation

Building(s) Rooms Buildings define the physical
building in which the classrooms
exist. They are the second tier in
the room structure.

Rooms Capture Appliances Rooms are the physical classroom
Classroom Capture or lab in which lectures are
occurring and are captured. Rooms
are scheduled for capture.

Device Room Assignment Capture Appliances EchoSystem devices are assigned
Classroom Capture to rooms for scheduling.

Room or Venue License Venues/Rooms with capture Specific venues that are licensed

Assignment appliances for capture, typically classrooms,
Venues/Rooms with Classroom auditoriums, or other lecture
Capture locations.

Room Settings Rooms with capture appliances The settings for a room.

Rooms with Classroom Capture

You can filter the Rooms list by Campus, Building, or Keyword to quickly find a specific room. You can also add
new rooms, import or export rooms (via a CSV file), or retire rooms.

Add Rooms

Rooms are the physical locations in which capture is occurring. They are defined within a structure of campuses and
buildings. Capture devices are assigned to rooms and rooms are scheduled for capture.

1. Inthe ESS interface, navigate to Configuration > Rooms.
2. Click the Add button. The Add New Room screen opens as shown in the below figure.
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3.

© N O

9.
10.
11.

You may sometimes want to add many rooms all at once or to change properties of many rooms. You can do this
efficiently by using the export and import feature with a spreadsheet program such as Excel. See Import and Export

Add New Room

Location

Campus : | echo.caEpus 4 Add>>  FEdit>>
Building : [ echo.building ' ¢ Add>> Edit>>

Room Details

Name : |

EchoSystem Identifier:  6760ec61-10ba-473c-a567-afe6914be3d6

Alternate Identifier

Organization : | Choose... :

Device Web User Interface

These seftings control the capture device's Local Web Ul parameters, and also the authentication into the capture device's REST
API. Change these setlings on a room'’s page fo override the global defaults.
admin )

Admin User Name / Password : instructor

FEERasEEE sssssssns

If necessary, add a campus.
a. Click the Add link next to the campus list to open the Add New Campus dialog.
b. Add the name of your campus.

c. If appropriate, enter an Alternate Identifier for the campus. See Room Configuration Options for details

on this field.

d. Select a Time Zone from the list. This is the time zone where the campus is.

e. Click Save. If you have capture rooms across multiple campuses, you will create each of these

campuses using the same steps when you create the rooms.
Select the appropriate campus.
If necessary, add a building using the same steps as adding a campus above.
Select the appropriate building.
Complete the Room Details section. See Room Configuration Options for details.

Review the fields and if necessary edit the Device Web User Interface fields. These are inherited from the
device defaults. See Room Configuration Options for details. See Manage Device Defaults for information on

setting these defaults.

Click Save.

On the Room screen, the new entry is visible as a line item in the Rooms list.
Repeat this operation for each room, campus, and building as needed.

Objects.
Room Configuration Options

Room Location

The following figure shows the Room Location configuration settings. Below the figure is a table that describes the

settings available.
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Add New Room

Location

Campus . ' echn.caEpus ¥ Add=> Edit =>

Building : ( echn.bu:ilding Add =»  Edit ==
Setting Description Inherited From...
Campus The campus in which the capture N/A

room resides

Building The building in which the capture N/A

Room Details

room resides

The following figure shows the Room Details configuration settings. Below the figure is a table that describes the

settings available.

Room Details

Mame : |

Alternate Identifier :

EchoSystem Identifier:  6760ecE1-10ba-473c-a567-afe6914be3d6

Organization : [ choose... v
Setting Description
Name The name of the room or lecture hall where the capture

EchoSystem Identifier

Page 315

appliance is installed, or its identifying number.

The globally unique identifier (GUID) used by the
EchoSystem Server (ESS) to identify the object. The
ESS automatically assigns this ID to each object in the
system. You may use this identifier when making API
or other system calls. See APl Documentation for
further explanation.
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The globally unique identifier (GUID) used by an
external system, such as an LMS or LDAP, to identify
the object. Entering an Alternate ID is optional, but
allows you to use the external system's GUID (not the
EchoSystem Identifier) when making API or other
system calls.

Alternate Identifier

The Alternate Identifier must be unique for each ESS
object type. See APl Documentation for further
explanation.

The organization that owns the room. If you are the
System Administrator or Administrator of the parent
organization, you will see all rooms. If you are

the Administrator of a child organization, you will see
only the rooms owned by your organization.

Organization

License Rooms

Classrooms, auditoriums, lecture halls or other venues can be licensed individually or as a group. See Manage
Licenses for more information on licensing, and License Rooms for instructions on assigning individual licenses to
rooms or venues.

Alternately, EchoSystem allows you to assign a license for a capture method for a room at the same time you assign
the capture appliance or classroom capture installation to the room. The instructions in the following sections show
you how to assign capture methods to a room, including a step for assigning a license if necessary.

Assign Capture Appliance to the Room

1. Loginto the ESS.

2. Navigate to Configuration > Devices.

3. Mouse over the line item of the capture appliance to be assigned to the room.
4. Click Edit from the hover menu. The Edit Device screen opens.

Current Room Assignment

Echo State University

i
hd

Atlantic Blwd.

i
hd

Room 600

s
v

5. Select the campus, building and room from the Current Room Assignment section.

6. If necessary, select a license from the License drop-down list. This assigns a product license to that room for
the selected device. The figure below shows an SCHD device assigned to a room with an appropriate
license.

Current Room Assignment

Room ! 3CHD 11 ¥ SCHD 12 % SCHD13 &

This room utilizes the following licensing: Product License, 1D 2013-04-22-001877, Product(s): 2 channel PRO

Navira Canfialiratinm
Device Configuration : [custom) 5

7. Click Save. The device summary appears.
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8. Click Done. The Device Details screen shows the capture appliance and room assignment.

9.

Repeat this operation for each capture appliance and associated room.

The capture appliance is now enabled and assigned a licensed room location. Your EchoSystem is now installed
and ready to capture lectures. See EchoSystem Capture in the Classroom for additional information and links to
related documentation.

© If You Are Assigning the EchoSystem SafeCapture HD

The SafeCapture HD does not record high definition content that is protected by HDCP
(High-bandwidth Digital Content Protection). If other devices in the room use HDCP, the
SafeCapture HD does not record their content.

Assign Classroom Capture to the Room

1.

7.
8.
9.

Log in to the ESS.

2. Navigate to Configuration > Devices.

3. Mouse over the line item of the device to be assigned a room.

4,

5. Select the campus, building and room from the Current Room Assignment section.

Click Edit from the hover menu. The Edit Device screen opens.

Current Room Assignment

Echo State University = Atlantic Blvd. = Room 700 ¥

. If necessary, select a license from the License drop-down list. This assigns a product license to that room for

the selected device. The figure below shows a Classroom Capture device assigned to a room with an
appropriate license.

Current Room Assignment

ROOm : CourtCampus 5 CourtBuilding = Andy's CC | ¥

This reom utilizes the following licensing: Product License Classroom Capture, |D 2014-01-08-001844, Product(s):
Podeast, Enhanced Podeast, Vedcast, Rich Media (A/V, A/D, AVID)

Click Save. The device summary appears.
Click Done. The Device Details screen shows the capture appliance and room assignment.
Repeat this operation for each Classroom Capture device and associated room.

The Classroom Capture software is now enabled and assigned a licensed room location. Your EchoSystem is now
installed and ready to capture lectures. See EchoSystem Capture in the Classroom for additional information and
links to related documentation.

Retire a Room

You can retire a room that is not currently active. You cannot retire a room that is still associated with a course, a
section, or a schedule. Those rooms are considered active and cannot be retired.

To retire rooms, you must have the role of Administrator of either the parent or child organization or System
Administrator of the parent organization.

After you retire a room, you cannot associate the room with a course, a section, or a schedule. Retiring a room does
not delete the room permanently. You can reinstate a retired room later.
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1. Navigate to Configuration > Rooms.
2. To retire a single room, hover your mouse over the room's hame and click retire, as shown in the figure
below.

BJG Test Room

- edit ratire Institution

3. To retire multiple rooms at once:
a. Check the rooms you want to retire, either individually or using the Select links at the bottom of the
page, highlighted in the below figure.
b. Scroll to the bottom of the page. Select Retire selected from the drop-down box, also shown in the

below figure.
tus. Appli

EI Sl Appance echodsi / Aptus echo.Campus aptus.Building US/Eastern

echo.Appliance -
E] echo36l echo.Campus echo.Building US/Eastern

Patio
@I echo36l West Coast Seal Beach US/Eastern
Select: All 12 (of 12) Displayed Above, All 12 in Filter, None Action v Choose 1-12 of 12

Retire selected View: | 20 5 Rooms per Page

 Add_ | Import

4. In either case, a confirmation message appears. Click Yes to confirm the retirement of the room(s).

The selected room(s) move to the Retired tab.

Delete a Room

Deleting a room removes that room permanently from the ESS. To delete rooms, you must have the role of
Administrator of either the parent or child organization or System Administrator of the parent organization. You
cannot delete rooms that are associated with an ongoing course, section or schedule. To delete those rooms, you
must remove the association between the room and the course, section, or schedule first.

You must retire a room before you can delete it.

Navigate to Configuration > Rooms.
If necessary, retire the room or rooms.
Select the Retired tab, as shown in the figure below.
To delete a single room, hover your mouse over the room's name and click delete.
To delete multiple rooms at once:
a. Check the rooms you want to delete, either individually or using the Select links at the bottom of the
page, highlighted in the below figure.
b. Scroll to the bottom of the page. Select Delete permanently from the drop-down box, also shown in
the below figure.

abrwbdpRE

Active: 11 Retired: 1 1=10of 1
Mame Organization Campus « Building Time Zone Current Device
Patio echo3B West Coast Seal Beach US/Eastern
Select: All 1 (of 1) Displayed Above, All 1 in Filter, None Action v Choose...
View! Reinstate selected 1-1 of 1
Export Delete permanently

6. In either case, a confirmation message appears. Click Yes to confirm the deletion of the room(s).

Reinstate a Room
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Navigate to Configuration > Rooms.
Select the Retired tab, as shown in the figure below.
To reinstate a single room, hover your mouse over the room's hame and click reinstate.
To delete multiple rooms at once:
a. Check the rooms you want to reinstate, either individually or using the Select links at the bottom of the
page, highlighted in the below figure.
b. Scroll to the bottom of the page. Select Reinstate selected from the drop-down box, also shown in the
below figure.

roODdPE

Active: 11 Retired: 1 1.1 of 1

Mame Organization Campus « Building Time Zone Current Device

Patio echod6l West Coast Seal Beach US/Eastern

Select: All 1 (of 1) Displayed Above, All 1 in Filter, None Action ¥ Choose
Reinstate selected 1-1ef 1
Delete permanently

Wiew!

The rooms are reinstated and appear on the Active tab.

Manage Users

In this section:

Overview

System Roles

Organization Roles

Section Roles

If You Have Delegated Administration
Export and Import Users

Overview

As the Administrator, you will want to add users and, in most cases, assign them to organizations and roles. These
users (Administrators, License Managers, Schedulers, A/V/V Technicians, and Academic Staff) are Active Staff.
They can log in to the ESS (EchoSystem Server).

You may also want to add users who are Active Students. Active Student users:

® Are not assigned an organization and role. When you add a user but do not assign an organization or role,
the user is, by default, an Active Student.

® Cannot log in to the ESS.

® Have their activities logged and included in engagement analytics.

The figure below shows how Active Staff and Active Students are organized into different tabs on the Users list page
(Configuration > Users).

Active Staff: 57 Active Student: 5 Retired: 0
Name a Email Address Syst
Anup pujari
anup@gmail.com Echo!

Any Administrator (System Administrator, parent organization Administrator, or child organization Administrator) can
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add users.

EchoSystem comes configured with several user roles, each with a unique set of rights, as described below.

Role names are part of the EchoSystem Server Ul, and so can be localized.

For information on monitoring and managing Personal Capture users, see Administer Personal Capture.

System Roles

The System level roles described in the table below can only be associated with the parent organization.

Role

License Manager

System Admin

Organization Roles

Description

This role can view licensing assignments within the
EchoSystem. When combined with the Admin role, the
user can assign licenses to rooms, and Personal
Capture licenses to Academic Staff.

The License Manager role can only be assigned at the
root or parent Organization level. This is why it is
considered a "System Role" and not an "Organization
Role." The License Manager role allows the user to
view all assigned licenses across the entire
organization, including sub-organizations.

If the user is also assigned the Admin role for an
organization (either parent or child), the user can then
assign or revoke licenses for that organization.

The System Admin (System Administrator) can perform
all ESS actions, in the parent or any child organization.

The Active Staff roles described in the table below are associated with either a parent or child organization. When
the role is associated with the parent organization, the user can perform allowed actions for the parent organization
or any child organization. When the role is associated with a child organization, the user can affect only objects

owned by the child organization.

Role
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Academic Staff

Admin

Page 321

This role identifies the user as a member of the
Academic Staff for the selected organization. This role
assignment allows the user to:

® Be assigned to a section and given a role within that
section, such as Instructor.

® Be licensed to use Personal Capture.

® |oginto the ESS to review and edit Echoes for an
assigned section.

® Log in to the EchoCenter for an assigned section and
review student usage or prepare Lecture Tools
materials.

Academic Staff can only be assigned to sections
belonging to their organization or sub-organization.

You can assign this role at the parent organization level
if the user is not associated with a specific child
organization and needs to be assigned a section role.

The parent organization Admin (Administrator) can do
everything except system configuration (the System
Settings page). More specifically, the Administrator
can:

® Create and manage child organizations

® Manage and create objects (courses, rooms) in child
organizations

® Manage all user accounts and roles except the
System Administrator

® Perform all monitoring tasks for both parent and child
organizations

® Manage the details of a course or section (edit a
course or course details; edit a section or section
details)

These configuration choices apply to the entire
institution and where applicable are inherited by the
child organizations.

The child organization Administrator can:

Set defaults for the child organization

Create objects owned by the child organization
Access shared objects from the parent organization
Perform all monitoring tasks for the child organization
Manage the details of a course or section (edit a
course or course details; edit a section or section
details)

When combined with the License Manager role, a user
can assign and revoke Room licenses and Personal
Capture licenses for the organization to which their
Admin privileges apply.
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A/V Technician The A/V Technician can:

® Register devices and assign devices (Configuration
> Devices) to rooms

® Configure properties set at the device level (Configu
ration > Device Configuration) or room level (Confi
guration > Rooms)

* View (but not edit) Echoes in all available formats
(Podcast, Vodcast, EchoPlayer)

® View the Monitor tab

® View capture details and logs

Scheduler The Scheduler can perform all schedule-related tasks
for the parent organization or any child organization.
More specifically, the Scheduler can:

® Create terms, courses, and sections

® View the Monitor Summary and Processing Tasks
tabs, seeing information for both the parent and child
organizations

® Schedule captures for the parent organization or any
child organization

® Manage the details of a course or section (edit a
course or course details; edit a section or section
details)

Section Roles

If you assign the Academic Staff role to a user, you will also apply one of the following section roles to the user when
you add a section.

Guest Presenter
Instructor

Student Presenter
Teaching Assistant

These particular roles, described in the below table, are assigned on the section level to allow flexibility. For
example, a particular individual might be a Guest Presenter for a section in the business school, but an Instructor for
a different section in the math department.

Role Description

Guest Presenter The Guest Presenter gives a single (or a few) lectures
to a particular section. These lectures are usually
captured via the Ad Hoc interface. The Guest
Presenter:

® Can view Echoes for which he or she was the
Presenter

® Can participate in discussions in the EchoPlayer

® Cannot edit, reprocess or change the state of an
Echo
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Instructor

Student Presenter

Teaching Assistant (TA)

If You Have Delegated Administration

The Instructor is the course owner. The Instructor:

® Can edit, reprocess, change state and permanently
delete Echoes

® |s listed in metadata as the person who presented
the materials in the ESS and EchoPlayer data

® Can import external media and Personal Capture
presentations for their sections

® (Can see viewing statistics in the EchoCenter and can
see hot spots in the EchoPlayer

® Can participate in and moderate discussions (delete
posts and replies) in the EchoPlayer

This role is primarily for students who prepare Personal
Capture presentations as class assignments. The
Student Presenter can do these tasks for his section:

® Prepare presentations in the Personal Capture
application, then log in to the ESS to publish them

® |oginto the Ad Hoc interface and prepare captures

® |ogintothe ESS and view only all Echoes

A Student Presenter:

® Cannot import external media

® Cannot edit any presentations, even presentations
he himself published

® Does not appear in schedules

® Must be granted access if LDAP Authentication or
trusted system security is applied to the section

The Teaching Assistant (TA) has rights similar to an
Instructor's but:

® Cannot permanently delete an Echo.

® Is not listed as the Presenter. To allow this person to
be listed as the Presenter for certain Echoes, assign
the Guest Presenter role.

This table below provides some common scenarios and answers some frequently asked questions about managing

users in an organization with delegated administration.

Scenario

We manage all schedules centrally at my institution but
| want user roles and other objects to be managed by
department. What should | do?
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Solution

Give users who manage schedules the Scheduler role
at the parent organization. This allows them to
schedule courses and rooms for all child organizations.
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We have a designated administrator for each Give these users two roles for their respective
organization in our hierarchy. We want that person to organizations: the organization Administrator role and
manage everything for those organizations. What the License Manager role. In the Administrator role,
should we do? they can then create objects and users and assign

more granular roles accordingly. With the License
Manager role, they can assign licenses from the license
page. Child organization Administrators can do this
because licenses are automatically shared, even
though they are owned by the parent organization.

Export and Import Users

You may sometimes want to add many users all at once or to change properties of many users. You can do this
efficiently by using the export and import features with a spreadsheet program such as Excel.

® For general information on the export and import function, see Import and Export Objects.
® For details on the exact format required to export and import users, see Import Users.

Add a User

In this section:

® Qverview
® Procedure
Overview

This procedure explains how to add a single user through the user interface. You can also add many users all at
once (or change their attributes) using the import/export method.

© If the User is an Instructor

You may be adding a user as an Academic Staff Member, whom you will assign to specific
sections later.

Procedure

1. Navigate to Configuration > Users.
2. Click Add. The Add New User screen appears, as shown in the figure below.
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Add New User

User Details

First Mame :
Last Mame :
Display Name :

Email Address :

Block Alerts? :

am

Local Time Zone : | (-05:00) US/Eastern

EchoSystem Identifier:  32f85941-792d-4ebe-a51a-e3cBcBe7id09

Alternate Identifier :

Organization Roles

Confirm Password :

Academic Staff Upload Settings

Organization Role
Choose... = Choose... = Add ==
User Account
User MName :
Password :

Passwords can be left blank for users other than "System Admin” when using LDAP authentication.

Change these settings on a presenter's page to override the global defaults.

May Upload External Media : @

These settings control the upload of media files via the External Media tab in the EchoSystem Server and via Echo360 Personal Capture.

| save [§Cancell]

May Configure Products : @

3. Complete the form by filling in the fields with the necessary information. The table below describes each
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field.

Field
First Name & Last Name

Display Name

Email Address

Block Alerts?

Local Time Zone

Description
The First and Last Names for the user.

Enter the name that should appear in the system,
such as on Echoes or in Discussion logs for the
user. Can be different than the name entered
elsewhere on the form. For example, the user's
name might be Larry Uffelman but his Display
Name should appear as Dr. L. Uffelman.

Email address for the user. This field is required.

Use the checkbox to determine if the user should
receive monitor alerts to the email address
provided. Check the box to block alerts.

Select the local time zone from the drop-down list.
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EchoSystem Identifier

Alternate ldentifier

Organization & Role

User Name

Password & Confirm Password

The globally unique identifier (GUID) used by the
EchoSystem Server (ESS) to identify the object.
The ESS automatically assigns this ID to each
object in the system. You may use this identifier
when making API or other system calls. See API
Documentation for further explanation.

The globally unique identifier (GUID) used by an
external system, such as an LMS or LDAP, to
identify the object. Entering an Alternate ID is
optional, but allows you to use the external system's
GUID (not the EchoSystem Identifier) when making
API or other system calls.

The Alternate Identifier must be unigue for each
ESS object type. See APl Documentation for further
explanation.

If you are creating a Student User, skip these fields.
Students are identified by the system as "users
without a defined role or organization".

For all other users you must complete this section.
Assign Organization and Role as follows:

a. Select the Organization to which this user
belongs.

b. Select a Role for the user. Your options are

shown in the below figure.

Then click Add.

d. Repeat these actions to assign the user to a
different role in the same organization, or to a
role in a different organization.

o

Organization Roles

Organization Role

ar

Choose... « Choose...
Admin
Academic Staff
User Account Scheduler
License Manager
AV Technician
Systern Admin

Enter the account User Name for this user. This is
what the user will enter when logging into the
system and must uniquely identify the user.

Enter a password and confirm the password for the
Username provided. This is NOT required for users
other than System Administrators if you are using
LDAP for authentication. System Administrators
MUST have a username and password even if
using LDAP authentication.



EchoSystem 5.5 Documentation

May Upload External Media Check this box to allow this user to upload external
media to the system such as media files to support
a class or a Personal Capture recording. NOTE:
Personal Capture still requires a license to upload
recordings, in addition to having this option checked
for the user.

May Configure Products Check this box to allow this user to configure
uploaded media, such as editing echoes or other
media files uploaded to the system.

4. When finished, click Save.

Verify that the user was added properly by checking the different tabs in the Users page on the ESS, shown in the
below figure.

® |f you created a non-Student user, the new user is listed in the Active Stalff tab.
® |f you created an Active Student user, the new user is listed in the Active Students tab.

Active Staff: 13 Active Student: 1 Retired: 0
Name Email Address System Role(s)
dmi
Bys admin sysadminf@sn.com echo3B0-->System Admin
hruthi
shruthi shruthi@sn.com echo360-->Academic Staff
orgstudent sn echo360 / shruthi-->Academic Staff, echo380--

sn.student@sn.com >Academnic Staff

hiedul
OrgactiscLiar s sn.scheduleri@sn.com echo380 / shruthi-->Scheduler

instruct . 1 N
orginstructor sn sn.instructor@sn com ﬁrcmsﬁi?na:csg:gu =pcademic Staff, echo360

View User Details

In this section:

® Qverview
® Personal Capture Licenses
® Active Schedules

Overview

To view or edit user details, navigate to Configuration > Users, then click the name of the user from the User list.
Click Edit located at the bottom of the page to make changes.

When you view user details, you see all the settings (User Details, Organization Roles, User Account, Academic
Staff Upload Settings) you configured when you added the user, plus some additional settings, as shown and
described below.
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Personal Capture Licenses

Name Products Available Expiration Time

Podcast Audio, Enhanced Podcast Audio,

. R Screen Podcast, EchoPlayer Display,
| ~ ProductLicense - SITE, ID EchoPlayer Display and Video, 0 6/2/12 8:00 PM (in 6 months, 0 days)
2011-09-09-001926 X
EchoPlayer Video,

EchoPlayer Dual Display

Active Schedules

Title Presenter Room Status Capturing Device
Introduction to Linguistics , ;

N Dulles: 11912 - 5/anz2 b8-ac-6f-38-60-12
(ENG205-001) (ENG205-Special ~ Gagne, Bronwyn Tadesse building, Tadesse Room  Wed 8:00 PM - 6:50 PM (since 11/17/11 5:33 PM)

Projects) Spring 2012

Personal Capture Licenses

Personal Capture Licenses lists the Personal Capture license associated with the user.

® If your institution purchased a site license, Presenters are automatically granted a Personal Capture license,

as shown above.

® |f your institution purchased individual Personal Capture licenses, you can glance at this user details page to
see if a user has a license assigned and how many licenses are available. To assign or deassign a license,
follow these steps and refer to the screenshot below:

1. Click the Edit button at the bottom of the page to edit the user
2. Check or uncheck the box next to the user name
3. Save the user record

Personal Capture Licenses

Name Products Available
Product License - PCAP, 1D 2011-02-10-001826, Productis): Podcast Audio, Enhanced Podcast Audio, Screen Podcast,

@ Podeast, Enhanced Podcast, Viodeast, Rich Media Audio, Rich EchoBasic (Single Display), 8
Media Video EchoEnhanced (dual channel, Videc and Display)

Active Schedules

Active Schedules lists active schedules associated with the user. You cannot edit this setting.

Retire and Reinstate a User

In this section:

® Qverview
® Retire a User
® Procedure - Reinstate a User

Overview

Retiring a user temporarily removes the user's privileges but does not delete the user permanently. You can reinstat
e aretired user.

You can retire a staff member who is associated with an active section or schedule. If there are scheduled captures
associated with the user, these captures will be assigned to the Default Presenter. See What is the Default
Presenter?

You cannot retire yourself as a user when you are logged in with that user account.
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You cannot retire a System Administrator; you must first remove the System Admin role.

To retire or reinstate a user, you must be:

® An Administrator (assigned the Admin role) for the user's organization, or
® System Administrator of the parent organization.

© Retiring System Administrators with No Other Role

As stated above, you must remove the System Admin role from a user before you can retire
them. After you remove the System Admin role and click Save, the User Details screen appears,
including a Retire button at the bottom. If you do not retire the user at this point, and the user has
no other roles assigned, the user will appear in the Active Student tab. Students are defined by
the system as any user without an assigned organization and role.

Retire a User

1. Navigate to Configuration > Users.

2. If you can easily do so, use the Search options to find only the users you want to retire.

3. Check the users you want to retire, either individually or using the Select links at the bottom of the page,
highlighted in the below figure.

4. Scroll to the bottom of the page. Select Retire selected from the drop-down box, also shown in the below

figure.
Laura Test n echo360 / Imi-->Academic Staff, echo360-- 7/3(13 10115
o lingle@echo380.com >Academic Staff; echo360-->System Admin PM
lenin madhu . . echo360 / Aptus-->Admin; echo360-- 7313111
lg lenin@aptus.in >License Manager PM
mohan kumar
@I mohan@gmail.com echo360 / Aptus-->Scheduler
Iy k
@] naveen kumar naveen{@yahoo.com echo360 / Aptus--=Academic Staff
Nithya Admil
@] ya Acmin 1nr.admin@echo.com echo360-->Admin
Select: All 20 (of 65) Displayed Above, All 65 in Filter, None Action: v Choose... 1-20 of 65 [ 3]
Retire selected View: | 20 | 3 Users per Page
m m m Assign PCAP Presenter License
Revoke All PCAP Presenter Licenses

5. Confirm that you want to retire the user(s).

6. Notice that a confirmation message appears. If the user being retired is associated with future captures, these

future captures will be assigned to the Default Presenter. See What Is the Default Presenter?
7. Click Yes to confirm the retirement of the user(s). The selected users move to the Retired tab.

What Is the Default Presenter?

The Default Presenter is a particular type of user, created for a specific case: if you retire an Academic Staff
member who is the only Instructor assigned to a section and/or the only Presenter associated with a scheduled

capture, the system automatically assigns the "Default Presenter” user to the section and future captures. This is

because this information is required for sections and schedules.

® You do not have to create a Default Presenter. The ESS creates this user account automatically.
® The Default Presenter cannot be retired or deleted.

® The assignment of Default Presenter occurs automatically when the sole instructor or presenter is retired.

The screenshot below shows the Default Presenter as the Instructor for a section.
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People and Section Roles

Person

Default Presenter

Section Role

Instructor

Replace Default Presenters with Academic Staff

When a new Instructor is assigned to the section, you should update the section and associated
schedules with the newly assigned staff member, removing the Default Presenter from those

configurations.

To easily find Default Presenter assignments to replace, you can:

* Perform a Search on the Courses list page:

a. Navigate to Schedule > Courses.

b. Enter "Default Presenter" or select the Default Presenter from the Person drop-down list.

c. Click Search.
® Sort the Schedules list page:

a. Navigate to Schedule > Schedules.

b. Click the Presenter column to sort the list by Presenter, OR

c. Enter "default" into the Keyword Search box and click Search. This is shown in the below figure.

Search

Fiter By : | Date | From: 0 T

All: 34 Available: 11 Unavailable: 13

Title
Intro to Linguistics (LING 101-MWF section) 2013
LING 101-UrsuMWF section
section-echo.Summer 2011.1.2013.06.11.07.35.56.AM
ASLPL-section

section-echo.Summer 2011.1.2013.06.11.02.55.48 AM
ASLPL-section

3 Keyword Search:

Archived: 10

default

Presenter

Default Presenter

Default Presenter

Default Presenter

Term

2013

echo.Summer 2011.1

echo.Summer 2011.1

Start Ti

611213
81213

611213

Either method allows you to review the current Default Presenter assignments, and change them to assign active
Academic Staff as necessary.

Procedure - Reinstate a User
1. Navigate to Configuration > Users.
2. Click the Retired tab to show retired users.
3. To reinstate only one user, hover your mouse over that user's name and click reinstate.

4. To reinstate multiple users:
a. Check the users you want to reinstate, either individually or using the Select links at the bottom of the

page, highlighted in the below figure.
b. Scroll to the bottom of the page. Select Reinstate selected from the Actions drop-down list, also

shown in the below figure.

Active Staff: 18 Active Student: 0 Retired: 1 1-1 of 1
Name o Email Address System Role(s) Assigned Licensedlast Log In
orgassistant sn echo360 / shruthi--=Academic Staff,

sn.assistant@sn.com echo360-->Academic Staff

1-1 of 1
Users per Page

Select: All 1 (of 1) Displayed Above, All 1 in Filter, None

| Add_J) Export J Import |

5. The selected users move to the Active tab.

Ly v Choose...
Reinstate selected
Delete permanently

View: | 20 | %
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If appropriate, you should update any section and associated schedules configurations, to replace any Default
Presenter assignments with the reinstated Academic Staff member.

Delete a User
In this section:

® Qverview
® Delete Active Staff
® Delete Students

Overview
Deleting a user removes that user permanently from the ESS.

To delete users, you must be:

® An Administrator (assigned the Admin role) for the user's organization, or
® System Administrator of the parent organization

You must retire a user before you can delete it.

Delete Active Staff

When you delete an Active Staff member, the following occurs:

® No log in. The staff member can no longer log into the EchoSystem.

® Existing Echoes and Past Schedules. For Academic Staff associated with sections, the name of the staff
member remains with the Echoes and completed schedules in which the user was a Presenter. This name
appears in the EchoCenter and EchoPlayer.

To delete active staff members:

1. Navigate to Configuration > Users.

If necessary, Retire the user(s).

Select the Retired tab.

To delete individual users, hover your mouse over that user's name and click delete, as shown in the figure
below.

~ownN

User, CKK
— reinstate  delete

5. To delete multiple users:
a. Check the users you want to delete, either individually or using the Select links at the bottom of the
page, highlighted in the below figure.
b. Scroll to the bottom of the page. Select Delete permanently from the Actions drop-down list, also
shown in the below figure.
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6.

Active Staff: 18 Active Student: 0 Retired: 1 1-1 of 1
Name o Email Address System Role(s) Assigned Licensedlast Log In

orgassistant sn . echo3B0 / shruthi-->Academic Staff,
sn.assistant@sn.com echo360--=Academic Staff

Select: All 1 (of 1) Displayed Above, All 1 in Filter, None Actior' 1.1 of 1

Reinstate selected Wiew: | 20 | §  Users per Page

In either case, a confirmation message appears. Click Yes to confirm the deletion of the user(s).

Delete Students

Student accounts are usually deleted programmatically, by using the APIl. However you can use the above
instructions to delete students manually.

As with deleting any type of user through the ESS interface, student users must be retired before they can be
deleted.

Manage Student Users

In this section:

Overview

Automatic Student Import from LMS or LDAP
Manual Bulk Student Import via CSV File
Add Individual Student Users Manually

Overview

When you add students to the EchoSystem Server (ESS), student activities (viewing Echoes and participating in

discussions) can be tracked. These engagement analytics give valuable insight into student learning and help
Academic Staff teach more effectively. Engagement analytics are typically presented in student usage reports,
though they can also be downloaded and made part of a broader analysis. See Student Usage Reports - Are
Students Engaged? for details.

Students added to the system are listed in the Active Students tab of the Users page of the ESS, shown in the below

figure.

Page 332




EchoSystem 5.5 Documentation

Users
Search
Keyword Search : m
Active Staff: 60 Active Student: 20 Retired: 1 1-20 of 20
Name Email Address System Role(s) Last Log In

active stu
(=] stu@u.in

Andrew Analore
(=] ! ! aanalore(@echo3s0.com

Bernard Koloski

]

bkoloski@echo360.com

Bronwyn Gagne

(]

bgagne@echo360.com 2/511310:28 AM

Denice ThornStudent

]

dthornstudent@gmail.com

Douglas Thomas

0

dthomas@echo360.com

Dwayne Mumma
=] v dmummaGecho3s.com

Earl Stolzfus

m

estoltzfus @echo360.com

Erica Hanselman

]

ehanselman@echo380.com

FirstName2 Lastname2

m

test223@test.com

Lawrence Uffelman

(]

luffelman@eche3s0.com

Matthew Gallow

0O

mgallow@echo360.com

Students can be added as Active Students in three ways:

® Automatically imported from the Learning Management System (LMS) or LDAP, through which students log
in to access Echoes

® Imported in bulk via a CSV file upload to the ESS

® Manually added individually through the Users page in the ESS

More information about each of these methods is provided in the sections that follow.

Automatic Student Import from LMS or LDAP

As each student logs into the system, either through an LMS or through LDAP, the student information is captured
by the ESS and the student is added as an Active Student user. Only the basic information required for student
identification is added to the system. Student users have no assigned role within the ESS.

For each student automatically imported from another system, only the following fields are populated:

® First Name
® |ast Name
® Username
® Email Address

This information can be edited or added to whenever appropriate.

Manual Bulk Student Import via CSV File
The ESS interface allows you to import any type of user in bulk via a properly formatted CSV file.

You can use this method to import users as Active Students. The process remains the same as for any import,
except that the Organization and Role fields must be left blank. This tells the ESS that the imported user does not
have a defined "user role" within the system (such as Instructor or Administrator) and must be tracked as an Active
Student for reporting purposes.

See Import and Export Objects as well as Import Users for specific instructions on generating a proper CSV file and
performing the import.
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Add Individual Student Users Manually

As with all user types, the ESS interface allows you to manually add Active Students to the system one at a time.
See Add a User for detailed instructions.

When creating a Student user, leave the Organization and Role selections blank. The ESS identifies any user
without an organization or role as a Student. This indicates that the user does not have a defined "user role" within
the system (such as Instructor or Administrator) but must be tracked as an Active Student for reporting purposes.

Manage Terms, Courses, and Sections

In this section:

® Terminology

® Qverview

® Training Echo

® Deleting Objects from the System

Terminology

Echo360 recognizes that different countries use different names for some of the concepts discussed on this page.
For simplicity, this page uses chiefly U.S. terminology.

You can change some terms shown in the ESS interface by changing the language preference in your browser to
British English (en-gb). See Show the ESS in British English for details.

Overview

Terms, courses, and sections are created and managed in the EchoSystem Server (ESS) Ul, Schedule tab.
Courses and sections provide the structure in which to enable various EchoSystem features and therefore are
foundational to using EchoSystem.

Details on creating, configuring, and deleting these items are found on the following pages:
® Manage Terms

® Manage Courses
® Manage Sections

Training Echo

This link below opens a training Echo, which walks you through the basics of course and section management:

Course and Section Management

Deleting Objects from the System
Prior to EchoSystem 5.3, in order to delete an object from the system, you had to delete the associated objects first.

For example, to delete a course, you first had to delete all of the sections associated with the course. Now the
deletion process takes care of that for you, deleting the associated items along with the selected object.
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This section is designed to let you know what actually goes on when you delete an object from the EchoSystem.

Most of the deletion process happens in the background. The full process of object deletion works like this:

®* The item you deleted and all of its associated objects are removed from the interface.
® The item and its associated objects are marked for deletion in the system.
® Background cleanup jobs pass through and delete all items marked for deletion.

The reason this is important to know is because the background jobs don't delete items in the same order in which
they are removed from the interface. These background deletion jobs have a hierarchy of their own that allows for
the efficient and complete removal of objects from the system. This means that depending on what kind of item you
just deleted and the number of associated objects also being deleted, the full removal process could take from
several hours to several days. Be patient.

If you want to confirm complete deletion, wait a day or two and then run an Audit Report (Reports > Audit Report).
Click Export to export the data to a CSV file. Opening the resulting CSV file in a spreadsheet program like Excel
allows you to sort and search the report information to determine if all of the appropriate objects were deleted.

If, after seven days, the Audit Report does not show one or more of the deleted items, contact Customer Support.

Best Practice: Defragment the Database After Large-Scale Deletions

High-volume data manipulation, including large scale deletions, may result in a high level of
database fragmentation (non-continuous and/or non-full data pages), particularly where large
numbers of media files were altered or removed.

While fragmentation does not cause the database to operate incorrectly, it can result in
sub-optimal performance. To mitigate this issue, after a large number of objects are deleted from
the system, we recommend that you defragment your database, then re-index the ESS.

Depending on your database type and configuration, defragmentation may occur as an
automated background or self-repair job, or may need to be explicitly triggered. Please consult
your database documentation for details. For additional information on database
defragmentation, refer to the following links:

Microsoft SQL.: https://www.simple-talk.com/sqgl/database-administration/defragmenting-indexes-i
n-sql-server-2005-and-2008/

MySQL: http://blog.softlayer.com/2011/mysql-slow-check-for-fragmentation/

After the database defragmentation is finished, go ahead and re-index the ESS. The easiest way
to do this is to:

1. Navigate to System > System Indexes.
2. Click the Re-index All on Next ESS Restart button.
3. Restart the ESS service.

Manage Terms
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In this section:

® Qverview

® \What Are Exclusion Dates?
® Add aTerm

® Delete a Term

Overview

Terms define a date range associated with an academic term, semester, trimester, etc. In any given term there may
be multiple offerings of the same course, so the EchoSystem assigns sections to a term. For example, an
Introduction to Economics (ECON101) course has three offerings during the Fall term. Each of these offerings is
defined as a section (001, 002 and 003).

Term dates are primarily used when scheduling recurring captures for a section. Although academic term dates are
likely to be specifically defined, you can capture lectures outside the defined date range.

What Are Exclusion Dates?

Most academic terms include dates when classes do not meet or exam days when no lecture is presented. We
recommend that you specify these days as exclusion dates.

The dates entered as Excluded Dates for the term are passed through to any schedules created for the term.
Schedulers can edit the inherited exclusion dates on the schedule if necessary. Scheduled captures will not occur
on exclusion dates.

Exclusions, e.g. mid-term break / holidays

Fcluded betes 6/1/13 - 6/2/13 remove
6/27/13 - 6/28/13 remove

from 3 to 3 Add>>

Add a Term

1. Navigate to Schedule > Terms. The Terms page appears.
2. Click Add. The Add New Term page appears, as shown in the figure below.

Add New Term

Term Information

MName : I

EchoSystem Identifier :

Alternate |dentifier :

d3923cfb-8bb6-4665-b3dc-298c5db6de 85

Organization : I Choose... |
Start Date : s
End Date : D

Exclusions, e.g. mid-term break and/or mid-term holidays

Excluded Dates :

Dto

from

3 Add>>

3. Complete the page.
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Field
Name

EchoSystem Identifier

Alternate ldentifier

Organization

Start Date
End Date

Exclusion Dates

4. Click Save.
5. Verify that the term appears on the term list page:

Input
Enter the term name.

The globally unique identifier (GUID) used by the
EchoSystem Server (ESS) to identify the object.
The ESS automatically assigns this ID to each
object in the system. You may use this identifier
when making API or other system calls. See API|
Documentation for further explanation.

The globally unique identifier (GUID) used by an
external system, such as an LMS or LDAP, to
identify the object. Entering an Alternate ID is
optional, but allows you to use the external system's
GUID (not the EchoSystem Identifier) when making
API or other system calls.

The Alternate Identifier must be unique for each
ESS object type. See APl Documentation for further
explanation.

Select the parent organization or child organization
from the list.

Enter or select the first day of the term.
Enter or select the last day of the term.

See What Are Exclusion Dates? for details.

Enter or select the first exclusion date range then
click Add>>.

Enter additional exclusion date ranges.

Name Organization

SJG spring term

Duration: 4 weeks gt | EChO360

Start Date ~ End Date Excluded Dates

53113 6/28/13 61113 - 6/2/13, 6/27/13 - 6/28113

6. After you add a term, you may want to add courses. See Manage Courses.

Edit at Any Time

clicking the edit button.

You can edit a term at any time by hovering your mouse over the term on the Terms page and

Delete a Term

When you delete a term, the following objects are also deleted:

® All sections associated with the term
® All schedules associated with the term
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® All Echoes associated with the sections

The following objects are not deleted, as they are related to objects outside of the term and/or may be reused:

® Courses associated with the term
® Users associated with the term
® Security modules associated with the term

For technical details on what happens when you delete a Term, see Deleting Objects from the System.

@ Deleting Sections is Permanent.

Once you confirm to delete the term, the term and its associated items are permanently deleted
from the system. You cannot recover deleted terms, sections, schedules, or Echoes.

Procedure

1. Navigate to Schedule > Terms. The Terms page appears.
2. Click the term you want to delete.

Mame

SJG spri@term

Duration’ waak=

Term Details
= E— T —

3. Scroll to the bottom of the page and click Delete.
4. Check the box to confirm that you want to delete the term and associated objects.

] Are you sure you want to delete Term
. "SJG spring term™?

This will permanently delate the term and its:
+ 1 Seclions
+ () Echoes
= 1 Schedules

! | understand these materials will be permanenthy
deleted, and this action is not reversible

Yes, Delete

5. Click Yes, Delete.

6. Notice the following:
® A message at the top of the page confirms that the item has been deleted.
® The term and associated are also removed.

For technical details on what happens when you delete a Term and how to confirm complete deletion, see Deleting
Objects from the System.

Manage Courses
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In this section:

®* Qverview
® Add a Course
® Delete a Course

Overview

The EchoSystem defines a course as an academic subject being taught and captured over a period of time, such as
a term, and then taught and captured again during a different period of time or term. Courses defined in the
EchoSystem are effectively a container for sections , while sections (called "modules” in Great Britain) are the
actual offerings of the course during a particular term.

For example, a course name might be "Introduction to Economics” with an identifier of "ECON2101", with three
sections configured as ECON101-001, ECON101-002, and ECON101-003.

Echo360 understands that the word "course" has different meanings at different institutions. We recognize that the
meaning given to "course" may not suit every institution, particularly those outside the United States. The
explanation given here is designed to show how a "Course" works within the EchoSystem hierarchy.

Add a Course

1. Navigate to Schedule > Courses.
2. Click Add. The Add New Course page appears as shown in the figure below.

Add New Course

Course Details

choSystem Identifier:  Gcalb3ec-bcd6-443b-bdB1-c36d7005d83d

o

3. Enter the details as follows:

® Name - The Name for the course that will appear in the ESS as well as in the EchoCenter.

® I|dentifier - An abbreviated identifier for the course, such as ECON101 or ENG330. This also appears
in the ESS and the EchoCenter.

® Organization - Select the organization to which this course belongs.

® EchoSystem Identifier - The globally unique identifier (GUID) used by the EchoSystem Server (ESS)
to identify the object. The ESS automatically assigns this ID to each object in the system. You may use
this identifier when making API or other system calls. See APl Documentation for further explanation.

® Alternate Identifier - The globally unique identifier (GUID) used by a learning management system
(LMS) or LDAP or other external system to identify the object. Entering an Alternate ID is optional, but
allows you to use the external system's GUID (not the EchoSystem Identifier) when making API or
other system calls. See API Documentation for further explanation.
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© A Course and a Section Can Have The Same Alternate ID

The Alternate Identifier must be unique for each ESS object type but you can use
the same ID for different types. For example, you can have a course with an
Alternate ID of ECON101 and a Section with an Alternate ID of ECON101. This is
useful if the external system recognizes courses and sections as the same object
type whereas ESS does not.

4. Click Save.

Edit at Any Time

You can edit a course at any time by hovering your mouse over the course on the Courses page
and clicking the edit link.

You may sometimes want to add many courses all at once or to change properties of many courses. You can do this
efficiently by using the Import Courses feature, using a spreadsheet program such as Excel to generate a CSV file
for import.

Delete a Course

When you delete a course, the following objects are also deleted:

® All schedules associated with the course.

® All sections associated with the course. Both current sections (sections that occur during the current term)
and past sections (sections associated with a previous term) are deleted.

® All Echoes associated with the course.

Users associated with the course are not deleted. For technical details on what happens when you delete a Course,
see Deleting Objects from the System.

@ Deleting Sections is Permanent.

Once you confirm to delete the course, the course and its associated objects are permanently d
eleted from the system. You cannot recover deleted courses, sections, schedules, or Echoes.

Procedure

1. Navigate to Schedule > Courses. The Courses page appears.
2. Click the course you want to delete.

Intro to Li istics
niro to _iﬁist cs (LING 101)  edit

3. Scroll to the middle of the page and click Delete.
4. Check the box to confirm that you want to delete the course and associated objects.
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Are you sure you want to delete Course
. Intro to Linguistics (LING 101)7

This will permanently delete the course including:
* () Echoes
= 1 Sections
* 1 Schedules

| understand these materials will be permanently
deleted, and this action is not reversible

Yos, Delata

5. Click Yes, Delete.

6. Notice the following:
®* A message at the top of the page confirms that the item has been deleted.
® The course and its associated objects are removed.

For technical details on what happens when you delete a Course and how to confirm complete deletion, see Deletin
g Objects from the System.

Manage Sections

In this section:

Overview

Add a Section

Section Configuration Options
Delete a Section

Overview

Sections (called "modules"” in Great Britain) define the offering of a course and are associated with a term. Sections
may also be called "offerings” or "courses". Sections are the items scheduled for capture. You need at least one
section per course and can have as many sections as you need for that course. Each section is associated with a
term. Using our "Introduction to Economics" course example, Introduction to Economics (ECON101) is the course
name. This course has three sections during the Fall 2009 term and four sections during the Spring 2010 term. Each
section is created within the course and assigned to the appropriate term. Captures are then based on a section.

© if You Want to Display "Module" not "Section"

You can change some terms shown in the ESS interface by changing the language preference in
your browser to British English (en-gb). See Show the ESS in British English for details.

Add a Section

1. Navigate to Schedule > Courses. The Courses page appears.

Click a course link. The Course Details page appears.

In the Sections area of the page, click the Add button. The Add New Section page appears.
Configure the new section by reviewing the configuration details below.

To add or configure default publishers for the course's section, click the Add Publishers button.
Click Save.

o0k wN
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Edit at Any Time

and clicking the edit link.

You can edit a section at any time by hovering your mouse over the section on the Section page

You may sometimes want to add many sections all at once or to change properties of many sections. You can do
this efficiently by using the import and export capabilities with a spreadsheet program such as Excel.

Section Configuration Options

You can configure sections to enable automation and streamline the user interface. Most section defaults are
inherited from the organization. Some of these default settings can be changed in the section configuration. See Org

anization Settings for information on configuring the organizational defaults.

The sections that follow provide details on each of the Section Configuration options available.

Section Information

The figure below shows the Section Information configuration options. Below the figure is a table that describes the

settings available.

Add New Section

Section Information

Ak

Term: ' 2013

MName : |
EchoSystem Identifier:  2d0ae32e-28c0-4dd6-b7f8-d3eb6Bb562a6

Alternate Identifier :

Setting Description

Term Identifies the associated academic
term for the section.

Name Defines the name of the section.

EchoSystem Identifier The globally unique identifier
(GUID) used by the EchoSystem
Server (ESS) to identify the object.
The ESS automatically assigns this
ID to each object in the system. You
may use this identifier when making
API or other system calls. See API
Documentation for further
explanation.
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Alternate Identifier The globally unique identifier
(GUID) used by an external system
(such as an LMS or LDAP) to
identify the object. Entering an
Alternate ID is optional, but allows
you to use the external system's
GUID (not the EchoSystem
Identifier) when making API or other
system calls. See API
Documentation for further
explanation.

© Acourseanda
Section Can
Have The Same
Alternate ID

The Alternate
Identifier must
be unique for
each ESS object
type but you can
use the same ID
for different
types. For
example, you
can have a
course with an
Alternate ID of
ECON101 and a
Section with an
Alternate ID of
ECON101. This
is useful if the
external system
recognizes
courses and
sections as the
same object
type whereas
ESS does not.

People and Section Roles

The figure below shows the People and Section Roles configuration options. You must assign at least one person to
the section.

To assign a person to a section, select the Person then a Section Role from the drop-down lists, then click Add.

When you create a schedule for the section, you can select a subset of the roles configured here for that particular
schedule, if appropriate.
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People and Section Roles

Parson Section Rola
Debbie Allen Instructor

R student Teaching Assistant
[ Choose...

Remove
Remove

Add >

Ak

The table below describes the settings available.

Setting

Person

Section Role
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Description

Lists all users with the Academic Staff role for the
organization. You must add users to the organization
first as Academic Staff before you can assign that user
a section role. The person you select here can publish
recordings to this section from Personal Capture (if lice
nsed for Personal Capture) and select this section for
Ad Hoc captures.

Lists all section roles for persons assigned to this
section. Options are Instructor, Student Presenter,
Teaching Assistant, and Guest Presenter.

Best Practice: Assign the
Teaching Assistant Role if the
Section Has Live Webcasting
Enabled

If the section may webcast live, it is
good practice to assign a Teaching
Assistant to the section. Some
Instructors will manage chat
themselves, but others prefer to
assign this duty to a Teaching
Assistant.
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© A word about "Default Presenters"

In some cases you will see the Default Presenter assigned to a section or schedule. This occurs
when the only person assigned to the section has been deleted from the system. Every section
MUST have a person assigned, and to fill the void, the ESS automatically assigns the Default
Presenter. The Default Presenter is then also passed through to scheduled captures for the
section.

People and Section Roles

Person Section Role

Default Presenter Instructor

The Default Presenter is not a real person; it is a system generated user and cannot be deleted.
Once you assign a new person to the section (to replace the deleted user), you can remove the
Default Presenter from the section, and edit any upcoming Schedules to use the assigned
person and not Default Presenter.

To see which schedules have Default Presenters assigned, navigate to Schedule > Schedules
and then:

® Filter the list and sort by Academic Staff.
® Specify "Default Presenter” in the Keyword Search text box.

Changing only a few schedules can be done individually. See Manage Schedules with Default
Presenter as Instructor. However if a large number of schedules must be changed, you may want
to use the Import Schedules feature.

Media Settings

Media Settings

These seftings conirol the automated deletion of raw media files and media file copyright insertion. Change these seitings on a
section’s page to override the global defaults.

s to Keep Originals | 120
Setting Definition Inheritance
Delete Original Media? See Media Settings for the Parent Organization > Child
organization. Organization > Section
Days to Keep Originals See Media Settings for the Parent Organization > Child
organization. Organization > Section

Echo Deletion Settings

The figure below shows the Echo Deletion Settings options. Below the figure is a table that describes the settings
available.
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Echo Deletion Settings

These settings conirol the automated deletion of echoes. Change these seltings on a section’s page to override the global defaults.

Automatically delete Echoes? : @

Days to Keep Echoes : | 120
Setting Definition Inheritance
Automatically Delete Echoes? See Media Settings for the Parent Organization > Child
organization. Organization > Section
Days to Keep Echoes See Media Settings for the Parent Organization > Child
organization. Organization > Section

Echo Defaults

The figure below shows the Echo Defaults configuration options. Below the figure is a table that describes the
settings available.

Echo Defaults

This setting controls the default presentation state. Presentations can either be made Available or Unavailable by default. Change
these settings on a section’s or schedule’s page to override the global defauits.

Echoes Initially Unavailable? :

Setting Definition Inherited From ...
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Echoes Initially Unavailable? See Echo Defaults settings for the Parent Organization > Child
organization. Organization

Live Streaming
Unavailable if
Checked

If you are
configuring this
section for Live
Webcasting, this
box must be
unchecked. If
only certain
schedules for
this section are
to be live
webcasts, you
can uncheck this
box for those
particular
schedules. See
the Echo
Defaults section
of Create a New
Schedule for
more
information.

Branding

All branding settings are inherited from the organization. See Branding settings for the organization for descriptions
of the settings.

Enforcing copyright acknowledgment prevents Echo playback from embedded EchoPlayers. If
you or your users plan to embed EchoPlayers for this section, the Enforce Copyright
Acknowledgement box must be unchecked.
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Branding

These seftings control the optional colors, images and copyright text used to brand the Echo player for your institution. There are also
seftings to add a short video clip at the beginning and end of media files. Change these seftings on a section’s page to override the
global defaults.

Copyright Text :

Enforce Copyright Acknowledgement :

Player Metadata Font Color : | #999339 Player Title Font Color: | #ffffif
Player Banner Background Image : Choose... H Player Logo Image MNone Available %
Player Logo Hover Text Player Logo Click URL :
Intro Clip : None Available Qutro Clip : None Available %
Watermark Image : Choose... B

EchoCenter

All EchoCenter defaults for the section are inherited from the Organization, except for External System IDs, which
are specific to each section.

The figure below shows the EchoCenter configuration options. Below the figure is a table that describes the settings
available. Additional details are available in the EchoCenter section of the Organization Settings page.

EchoCenter

These seftings control the behavior of the EchoCenter.
Disable atend of Term? :
Enable Audio File downloads : Enable Video File downloads :

Enable EchoPlayer downloads :

External System Id : External System Id :
External System Id : External System Id :
External System Id : External System Id :
EchoCenter Logo Image : Echo360 EC &
Setting Definition Inherited From
Disable at end of Term? If checked, the EchoCenter page for Parent Organization > Child
the course will be disabled when Organization

the term ends.

Enable Audio File downloads If checked, the EchoCenter page Parent Organization > Child
provides an Audio file (Podcast) Organization
download link. It appears on the
Info tab for an Echo. This allows
users to download the audio
recording of the Echo for offline
listening.
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Enable Video File downloads If checked, the EchoCenter page Parent Organization > Child
provides an Audio file (Vodcast) Organization
download link. It appears on the
Info tab for an Echo. This allows
users to download the video of the
Echo recording for offline viewing.

Enable EchoPlayer downloads If checked, the EchoCenter page Parent Organization > Child
provides an EchoPlayer download Organization
link. It appears on the Info tab for an
Echo. This allows users to
download the full EchoPlayer media
experience along with the content of
the Echo. This is useful for
instances where available internet
speeds for students are not fast
enough to allow streamed viewing
over the internet.

External System Id fields are noti  N/A
External System Id nherited from the organization.

They appear only here, on the

section page.

If you have a learning management
system (LMS), populate this field
with the LMS ID for the course or
section.

If you are using LTI-Based
Publishing, population of this field is
required in order for the ESS to
provide the appropriate content to
the LMS user. See Configure ESS
Sections to Publish to LMS Courses
for a table that describes where in
the LMS to find the course or
section ID to enter into this field.

Multiple External System Id fields
are available in the event you need
more than one. For example you
may have multiple sections in the
LMS that link to a single ESS
section. Or you may use more than
one LMS that needs to connect to a
single ESS section.
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EchoCenter Logo Image Allows you to select an image that Parent Organization > Child
will appear on EchoCenter pages. Organization
You must first add the image to the
branding repository. See Manage
the Branding Files Repository.

EchoPlayer

All EchoPlayer settings are inherited from the organization. See EchoPlayer settings for the organization for details
about the settings.

EchoPlayer

These seftings control which applications are available in the EchoPlayer.
Discussions : o Feedback : o~

Sharing : ET

Product Groups

The Product Groups setting lets you set a default product group for the section, overriding the organization (global)
defaults. You might want to do this when:

® You know that a certain section will always use a specific product group as a normal part of its schedule.
® You have configured a special events section to use for live webcasts of specific events. In this case, you can
configure those sections to use a live-capable product group by default.

Select a product group that is likely to be used for most if not all schedules for the section.

Product Groups

These settings control the default product groups created for each capture. Change these seftings on a section's or schedule's page to
override the global defaults.

Product Group : Display Only (Podcast/Vodcast/EchoPlayer). Balanced between file size & quality

a

The Product Groups default setting is inherited from the organization. See Product Groups settings for the
organization for details about these inheritances.

Security Settings

The Security Settings area of the Edit Section page shown in the figure below, allows you to select a security
module for the section. This determines how (or if) students will be authenticated. The options in the list are

determined by what Security Modules you have configured. The Security Setting configured for the Organization app
ears as the default.

If you do not require authentication, students can view Echoes or live webcasts easily, but chat and other collaborati
on capabilities are disabled.
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Security Settings

These seftings control the security.

Security Module : Allow All

4k

Allow All does not authenticate users for access, and therefore implements the Standard version of the
EchoCenter, without collaboration capaibilities or statistics information.

Authentication Required uses either the ESS user information or an external Trusted System such as CAS or
Shibboleth to authenticate users. You can also configure the LMS (like Blackboard or Moodle) as as trusted system
to authenticate users. This configuration requires users to access EchoCenter through the LMS.

LDAP allows you to use an external LDAP system for user authentication. See LDAP Authentication for more
information.

@ LTI-Based Publishing Requires Authentication

If you are using LTl-Based Publishing, you MUST use either LDAP or Authentication Required as
the security module for sections to be presented through an LTI integrated system.

Seamless Only requires the use of an LMS (such as Blackboard or Moodle) or other third party system to pass
through user credentials and allow user access.

® With Seamless Only, users can only access Echoes through the third party system and only if the appropriate

building blocks or plug-ins have been installed. Echo360 provide downloads for supported systems via the Cu
stomer Portal.

If you select an LDAP security module, additional fields appear, as shown in the below figure. The section inherits
the default Tree 1 settings from the LDAP security module.

Security Settings

These settings control the security.

Security Module : echo360-Idap

Ak

Security Settings — Tree 1

This is the primary LDAP tree that will be evaluated.

Group Aftribute Value : Base Group DN : I ou=echo360, dc=univ

Search Group Subtree : @j Extra User Attribute Name :

Required Extra User Aftribute Value :

Support

The Support settings are inherited from the organization. See Support settings for the organization for details about
the settings.
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Support

Heip information can optionally be provided. Ifthis information is entered, it will be provided to users in the Echo player when
presentations are viewed. Change these seftings on a section’s page o override the global defaults.

Support URL Text : Support Phone :

Support URL :

Upload Settings

The Upload Settings allow you to configure and enforce file size quotas for each section. The quota applies to
instructor-uploaded files like external media files and Personal Capture recordings. Section upload quotas let you
limit the amount of total storage that can be used for these files.

Be advised that quota size includes the total of the processed AND completed media files (the /content AND the
[flash folder on the file system), not just uploaded files. Take this into consideration when calculating quota
allotments per section.

All upload settings are inherited from the organization. See Upload Settings for the organization for additional details
about the settings.

Upload Settings

These settings control the upload of media files via the External Media tab in the EchoSystem Server and wia Echo360 Personal
Capture. Change these seitings on a section’s page o override the global defaults.

Enforce section upload quotas : Section upload quota (MB) : 20,480

Configure Publishers

The bottom of the Section page contains an Add Publisher button, that allows you to assign one or more publishers
for the section.

After you add a publisher to a section in the ESS, you must still add the publisher's name for the course to each
section. This means that you must:

1. Find the publisher's name for the section. Each publisher has a different protocol and format for a section
name.

2. Add the publisher's name to the ESS.

For more information on this process, see:

® Add Blackboard to Each Section
* Add Blackboard CE/Vista to Each Section
®* Add Moodle to Each Section

After you add a publisher to a section, the publisher is listed, as shown in the following figure.

Configured Publishers

Mame Publisher Type Configuration Complete?
CMS ID: testBlackboard 8 Blackboard Learning System Enterprise (8-9)
Moodle Moodle Learning System

| Add Publisher |
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The table below describes the Configured Publishers settings.

Setting

Name

Publisher Type

Configuration Complete?

Add Publisher

Delete a Section

Definition

This column displays the name and configuration
information for the publisher.

This column displays the publisher type for the selected
publisher.

This column displays the status of the configuration. It
reads "Yes" if the section specific information for the
publisher is entered and "No" if this information is not
yet entered. Hover over the publisher and click the edit
link to set the section specific information for the
publisher.

This button opens the Add Publisher page.

When you delete a section, the following objects are also deleted, because they exist specifically for the section:

® All schedules associated with the section
® All Echoes associated with the section

The following objects are not deleted, as they exist independently of the section:

® Courses associated with the section
® Users associated with the section
® Security modules associated with the section

For technical details on what happens when you delete a Section, see Deleting Objects from the System.

@ Deleting Sections is Permanent.

Echoes.

Once you confirm to delete the section, the section and its associated schedules and Echoes are
permanently deleted from the system. You cannot recover deleted sections, schedules or

Procedure

1. Navigate to Schedule > Courses. The Courses page appears.

2. Click the course with the section you want to delete.
3. Click the name of the section you want to delete.

Section

MW sﬁcn
https:iies vhite.ga.echo3G0.com: 44 Wess/portal/
Section Details

4. Scroll to the bottom of the page and click Delete.
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6.
7.

Check the box to confirm that you want to delete the section and associated objects.

[

Are you sure you want to delete Section
. Intro to Linguistics (LING 101-MWF
section) summer 20137

This will permanently delete the section including:
# [ Echoaes
= 1 Schedules

If this section has any future scheduled captures or in
progress live captures they will also be deleted

# | understand these materials will be permanently
deleted, and this action is not reversible

Yos, Dolobe

Click Yes, Delete.

Notice the following:
* A message at the top of the page confirms that the item has been deleted.
® The section its associated objects are removed.

For technical details on what happens when you delete a Term and how to confirm complete deletion, see Deleting
Objects from the System.

Manage Ad Hoc Captures

In this section:

® Qverview
® Ad Hoc Captures with "Curtains"
® Deleting Ad Hoc Captures

Overview

Ad hoc captures are not scheduled through the EchoSystem Server user interface (ESS Ul) but rather started and
controlled through the ad hoc web interface, accessed through the capture device or the Classroom Capture system
tray dialog box. There are two options for ad hoc capture:
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Automated Ad Hoc Capture. In this case, the Academic Staff member logs in to the capture device using an
ESS user account. The Academic Staff member can choose from a list of assigned sections to start the
capture. This method completely automates the rest of the workflow after capture by applying the settings
defined for the section. For example, if the section is set to create Podcast, Vodcast, and EchoPlayer
products, and to publish to Blackboard, the automated ad hoc capture assumes those settings.

Basic Ad Hoc Capture. Basic ad hoc captures are similar to automated ad hoc captures but are missing
several key details of the capture. This requires manual processing (to supply the missing details) within the
ESS Ul after the capture is complete. This option is available to Academic Staff members if they do not have
a section assigned or if they choose to capture instruction not related to a specific section. Basic ad hoc
captures can also be run as the generic user. The generic user is a shared log in to the capture device. After
you run a basic ad hoc capture, you may want to associate the capture with a section. This means that
students in the section can see the ad hoc capture on the section page in an LMS or on the EchoCenter page
for the section.
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Academic Staff can create ad hoc captures through:

®* The Ad Hoc Web Interface, using the URL of the capture device;
® The Classroom Capture interface (if installed in the classroom);
® Using the Device Monitor (if installed in the classroom).

You may want to receive alerts about new ad hoc captures being available for processing, if you do not already
receive such alerts. See View and Set Alerts.

When they are no longer needed, ad hoc captures can be deleted.

See the pages in this section for further instructions:

Server Configuration for Ad Hoc Capture
Run an Automated Ad Hoc Capture

Run a Basic Ad Hoc Capture

Recover an Ad Hoc Capture

Ad Hoc Captures with "Curtains"

In rare situations, ad hoc captures result in Echoes with black bands on either side of the display area ("curtains").
This may occur if:

® You are using the EchoSystem SafeCapture HD
® |t is set to capture with the widescreen aspect ratio

See When Using the Widescreen Aspect Ratio on the Display Input.

Deleting Ad Hoc Captures

If a capture is no longer needed, you can delete it.

1. Navigate to Echoes > Ad Hoc Captures.
2. Sort and/or Filter the list to find the captures you want to delete.
3. Do one of the following:
® To delete a single capture, hover over the capture and click delete.

[ Testadhoocapira /28013 2:24 PM 10 minutes 00-13-85-05-b7-7F

process delete

® To delete multiple Ad Hoc Captures:
a. Check the captures you want to delete.
b. Scroll to the bottom of the page. Select Delete permanently from the Actions drop-down list.

adhoc capture test 3
@] " 627113 12:08 PM 3 minutes 00-1c-08-00-02-2d
Test Capti
o esthapture 6/24/13 3:10 PM 2 minutes 00-13-05-05-bf-4c
Test Capture for countdown
@] v 672413 2:50 PM 3 minutes 00-13-95-05-bf-4c
Select: All 5 (of 5) Displayed Above, All5 in Fiter, None Actior‘ 1-50f 5
Delete permanently View: | 20 | % Captures Per Page
Recover an ad hoc capture >>

4. Confirm that you want to delete the item(s).
5. Notice the confirmation message at the top of the page.
6. Refresh the page. Notice that:

® The Ad Hoc Capture is deleted from the list.

® The number of items listed for the tab is smaller.
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Server Configuration for Ad Hoc Capture

In this section:

®* Qverview
® Automated Ad Hoc Capture
® Basic Ad Hoc Capture

Over

All ve

view

nues (rooms) must have a capture device, such as a capture appliance or Classroom Capture that is properly

licensed in order to perform ad hoc captures. See License Venues.

Auto

mated Ad Hoc Capture

The automated ad hoc capture workflow is driven by the association of Academic Staff members to sections. This
association is done in the ESS UI. These steps assume you have created sections and Academic Staff.

The Academic Staff member must have a section assignment to run automated ad hoc captures. There are also
several other settings applied to sections to drive the ESS processing and publishing automation. This section is
specific to Academic Staff member and section assignment. For details on the other settings, see Manage Sections.

1.

2
3.
4

In the ESS UlI, navigate to Configuration > Schedule.

. Click the Course containing the section to assign.

Edit the desired Section.

. Inthe People and Section Roles portion of the page, shown in the below figure, use the Person and Sectio

n Role drop-down lists to assign an Academic Staff member to the section, along with their role. Section Role
choices include:

® Instructor

® Student Presenter

® Teaching Assistant
® Guest Presenter

People and Section Roles

Person
Grodsky_instructor, Susan

Tillery, David

Media Settings

These settings control the automated deletion of |

Section Reole
Instructor Remove

Instructor Remove

+ Choose... Add >>
Instructor [
Student Presenter
Teaching Assistant

Guest P t N ) ) )
UesLEYeSeNer e copyright insertion. Change these settings on a section's

5. Click Add, located to the right of your selections.

6. When finished, save the changes.

Basic Ad Hoc Capture

To run a basic ad hoc capture, use the generic user name and password to log in to the capture device via the ESS

Ul. The generic user is a shared log in to the capture device.

To specify the authentication settings for all capture devices:
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1. Navigate to System > Device Defaults.

Click Edit.

3. In the Local Web User Interface section, set the Generic User Name/Password. You can now use this
information to log in to any capture device in any venue.

n

You can override this user name and password for a capture device in a single room as follows.

1. Navigate to Configuration > Rooms.

Click the edit button in the row corresponding with the room you want to edit. The Edit Room page appears.

3. In the Local Web User Interface section for the capture device type(s) you have licensed, edit the Generic
User Name/Password.

n

Run an Automated Ad Hoc Capture
In this section:

® Qverview
® Procedure

Overview

Automated Ad Hoc Captures can be run either from an EchoSystem capture appliance or from a podium PC with
Classroom Capture software installed. The instructions below apply to running an automated ad hoc capture from an
EchoSystem capture appliance. See Start an Ad Hoc Capture for instructions on creating an ad hoc capture from
the Classroom Capture system tray dialog.

When you run an automated ad hoc capture, you associate the capture with a section before you begin. This means
that when the capture is processed, it will be listed with all other Echoes for the section (in an LMS or on an
EchoCenter page) and students will be notified of it in the usual ways.

The capture device must be online with the ESS for automated ad hoc captures to function.

© Wwho can do this?

The user must be assigned to the section and must be one of these Academic Staff roles:

® |nstructor
® Teaching Assistant
® Student Presenter

Procedure

1. Browse to the Ad Hoc Web Interface URL for the device. The URL protocol and port are defined by the
device configuration. See About Devices for details. In most cases the URL is based on IP address as in this
example:

https://192.168. 77. 110: 8443

2. Log in with the user name and password for the Academic Staff user, as shown in the figure below.
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User Name: |jsmith

Password: |ssssssss

w

Click Ad Hoc Capture on the capture page.

Enter a title and duration for the capture.

5. Select the appropriate section to capture. The capture source options (audio, video, display) are automatically
selected based on the product settings for the section. For example, if you set the section to create vodcast,
then audio and display are captured. If you set the section to create EchoPlayer, then audio, video, and
display are captured.

6. Click Start Ad Hoc Capture. The capture stops automatically when the capture duration is complete. The

ESS processes the capture according to the settings for the section.

E

Run a Basic Ad Hoc Capture
In this section:

® Qverview
® Capture an Ad Hoc Recording
® Associate the Recording with a Section

Overview

Basic Ad Hoc Captures can be run either from an EchoSystem capture appliance or from a podium PC with
Classroom Capture software installed. The instructions below apply to running a basic ad hoc capture from an
EchoSystem capture appliance device. See Start an Ad Hoc Capture for instructions on creating an ad hoc capture
from the Classroom Capture system tray dialog box.

When you run a basic ad hoc capture, you do not associate the capture with a section. This means that you must
associate the capture with a specific section manually. See Associate the Recording with a Section.

Capture an Ad Hoc Recording

1. Browse to the Ad Hoc Web Interface URL for the device. The URL protocol and port are defined by the
device configuration. See About Devices for details. In most cases the URL is based on the IP address. For
example:

https://192.168. 77.110: 8443

2. Log in with the generic user, as shown in the figure below. For example: Instructor.

User Name: | instructor

Password: sssssses|

Click Ad Hoc Capture on the capture page.

Enter a description and duration for the capture.

Select the appropriate capture source option. For example: display-audio-video

Click Start Ad Hoc Capture. The capture stops automatically when the capture is complete and has been
uploaded to the ESS.

ISR
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Associate the Recording with a Section

When you associate a recording with a section, students in the section can see the ad hoc capture on the section
page in an LMS or on the EchoCenter page for the section. You will also see it in the Echoes > Echoes list.

You may need to consult with an Instructor or Teaching Assistant to determine the correct section.

Log in to the ESS.

Navigate to Echoes > Ad Hoc Captures.
Hover over the recording.

Click process.

rpowdP

Search

Filter By : | Date ~| From : F To: 3] Keyword Search :

Title Date -

adhoc test
= process  delete

121412 4:16 PM

Select: All, None Actions: Choose... j

5. Complete the fields in the Process Ad Hoc Capture page. Notice that you can change the title of the recording
to make it more intuitive for students.

Process Ad Hoc Capture
Manual Capture Description
Title : I Adhoc discussion of great vowel shift
Course/Section
Section :
Term: | 2012 - 2013 | Course: | LING101 x| Section : | sig course section 7|
| Cancel |
6. Click Next.

7. Review the details on the Process Ad Hoc Capture page. You may want to add a Presenter, for example.

Process Ad Hoc Capture

Manual Capture Description

Title Adhoc discussion of great vowel shift

CourselSection

Section Intro to Linguistics (LING 101-sjg course section) 2012 - 2013

Start Date

Start Date/Time 1214112 4:16 PM Duration 3 minutes
Room

Room Echo 380

Echo 360 , Nithyas Device

Presenters

Presenter : . :
® Add>> Grodsky_instructor, Susan (sjgrodsky@yahoo.com) remove
Saarch using partialfirst name, last nama andfor smail addrss

Echo Defaults

This setting controls the default presentation state. Presentations can either be made Available or Unavailable by defauit. Change these settings on & section's or schedule's page to override the giobal defauls.
Echoes Initially Unavallable? :

Product Groups

These settings control the default product groups created for each capture. Change these seftings on a section's or schedule's page fo override the global defaults.

Product Group Display Only (Podcast fVodcast/EchoPlayer). Balanced between file size & quality  ~|

[ e [

8. Click Process.
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9. Notice the message confirming that the recording has been submitted for processing. In time, the recording
will appear:
® Inthe Echoes > Echoes list
® On the course page of an LMS (if an LMS is used)
® On the EchoCenter page for the section

Recover an Ad Hoc Capture
In this section:

Overview

When to Use This Procedure
Before You Begin

Procedure

Overview

This procedure shows how to recover an ad hoc recording that was captured successfully by a capture appliance,
but was later lost, damaged, or inadequately processed.

© Ad Hoc Captures Only

This process can only be used with ad hoc captures. You can use the EchoSystem Server (ESS)
recover and reprocess methods for scheduled recordings.

You might need to recover an ad hoc recording when one of the scenarios listed below occurs.

® You receive errors in the capture and the recover and reprocess methods are not successful

® You accidentally deleted the capture presentation media files (the files created by the media processor that
are streamed to viewers)

® You accidentally deleted or do not have the raw media (h264 and aac) files created by the capture appliance

® The disks (perhaps a RAID array) that store existing presentations crash

When to Use This Procedure

This procedure on this page shows you how to log in to the capture appliance and use a simple interface to
re-upload a capture from the appliance to the ESS.

If this procedure does not work, you can try the more cumbersome process described in this Knowledge Base
article: Perform an ad hoc recovery. This process uses the Recover an ad hoc capture link on the Echoes > Ad
Hoc Captures page.
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Ad Hoc Captures

Search

Filter By : | Date ~| A

Title

Select All, Nona f,ic

Recover an ad hoc capture >>

You can use this process to reprocess media files for any capture except a Personal Capture recording.

Accessing the Knowledge Base
You will need a customer portal login to access the Knowledge Base. Contact Technical Support
if you need a login.

Before You Begin

Before using this process, try to recover the capture via the Monitor tab.

1. Navigate to Monitor > Captures.
2. Hover over the capture.
3. Look for the recover option

If you do not see it, continue with this procedure.

Procedure

1. Log in to the capture appliance as an advanced user (example: https://10.3.10.123:8443/advanced).
® Detailed instructions for the EchoSystem Capture Appliance (also called the first generation capture
appliance or 1G capture appliance)
® Detailed instructions for the EchoSystem SafeCapture HD (also called the SafeCapture HD, second
generation capture appliance, or 2G capture appliance)
2. Select the Diagnostics tab.
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_m Ch— . -L'm
ec Echo 360 : Echo 360 , Nithyas Device

| Captures 1 Monitor 1 Status J Diagnostics Logs 1 Help

Diagnostic Tools

Request System Info

| View Current Tasks File 3| [ Get Systern Info
Perform System Action
| Ping IP 3| [ Perform Action

Data Recovery

| Reupload Saved Content 3| [ Recover

Saved User Authentication Data

[ Clear User Cache |

m

3. Click Recover.
4. Select the recordings you want to recover and click Reupload.

ech®

" Reupload Content ]

JE——

Reupload Content to ESS

# adhoc test 9:16:33 PM - 9:19:30 PM
adhoc test — AdHoc Capture December 14, 2012
AdHoe Capture

] Testadhoc 12/14 8:27:08 PM - 8:32:04 PM
Test adhac 12/14 — AdHoc Capture December 14, 2012
AdHoc Capture

(] Dog Grooming (DOG101-3000 (Idap)) 2012 1:00:00 PM - 1:20:00 PM

Dog Grooming (DOG101-3000 (kap)) 2012 — Dog Grooming DEEEIEET L L

{DOG101-3000 (idap)) 2012
denice thomton abc

[ section-echo.Summer 2011.1.2012.12.05.01.40.28.AM 21001005:'\"'- ﬁiﬂiﬂgﬂi'g
saction-echo . Summer 2011.1.2012.12.05.01.40.28 AM — aptus course CEITIET S,
{ASLPL-section) echo.Summer 2011.1
Uday Rajaput pavan kumar

[ Computers (CS-ldap) 2012 ?:3n:nnD:M- z:n‘:ug;g
Computers (CS-dap) 2012 — Computers (CS-kdap) 2012 CEmIer S
orginstructor sn

M

5. Notice a message from the server confirming a successful upload. This means that the capture has been
recovered from the capture appliance. What happens next depends on the previous state of the capture.

® |f the capture was an automated capture, it will be associated with the proper section. See Run an
Automated Ad Hoc Capture.

® |f the capture was a basic ad hoc capture and had not been assigned to a section, itis in ad hoc
recovery tab (Echoes > Ad Hoc Captures). From there, you will have to associate it with the proper
section manually. See Run a Basic Ad Hoc Capture.

® |f the capture was a basic ad hoc capture and had been assigned to a section, it will be associated
with that section.
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© if You See a Signature Mismatch Error

In rare cases, the re-upload process fails with a signature mismatch error. This
occurs if you have recently done a clean install of the ESS and manually reattached
the capture appliances. You may be able to recover ad hoc captures using the
more cumbersome process described in this Knowledge Base article: Perform an

ad hoc recovery.

Manage the EchoPlayer

Administration of the EchoPlayer involves making sure users are seeing what they need to see in the EchoPlayer
and enabling licensed features such as discussions or live chat. Pages in this section of the documentation include:

® EchoPlayer Configurations
* Embedding the EchoPlayer
® Variable Speed Playback in the EchoPlayer

EchoPlayer Configurations

In this section:

® Qverview
® Details

Overview

Students, Instructors, and Teaching Assistants (called "users" collectively) may see different versions of the
EchoPlayer, depending on a number of factors. These include:

® What they are viewing:
® Echoes have a particular set of features.
® Live webcasts don't have some features that appear in Echoes (such as the Forward, Back, and Stop
buttons) but have others that don't appear in Echoes (such as the presence and chat applications).
® Theirrole:
® All users see the same EchoPlayer when viewing Echoes.
® Students and Instructors/Teaching Assistants see different interfaces when viewing live webcasts.
® Subscription status. Users will see certain applications if you are subscribed to the Collaboration and
Statistics Service .
® Section configuration. You can enable or disable the Discussions, Feedback, and Share applications for a
section.
® Logged in status. Some applications appear only if the user is logged in.
® Closed captioning or search indexing applied. The Scenes button may or may not appear.
®* Closed captioning. Some Echoes have closed captioning applied and others do not.

Details

The table below shows which features are available for each configuration.
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Feature

Scenes

Search

Bookmarks

Discussions

Info

Help

Feedback

Share

Closed Captioning
pane
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2
o
Q
D}

Appears in
Echoes?

®, Search

E1 Bookmarks

"~ Discussions

9 Help

~ /|  Feedback

», Share

Appears in live
webcasts?

No

No

No

No

Yes

Yes

Yes

Yes

Welcome to those who have never seen me before.

Appears if:

Always appears.

Closed captioning or

search indexing has
been applied.

® You subscribe to
the Collaboration
and Statistics
Service.

® The useris
logged in.

® You subscribe
to the Collaboratio
n and Statistics
Service.

® |tis enabled for
the section. See E
choPlayer.

® The useris
logged in.

Always appears.

Always appears.

It is enabled for the
section. See EchoPlI

ayer.

It is enabled for the
section. See EchoPlI

ayer.

Closed captioning
has been applied.
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Presence o Yes ® You subscribe
= Presence to the Collaboratio

n and Statistics
Service.

® The useris
logged in.

Chat pane % 9:02:41 A- Grodsky_Instructor: Good Mo T ir\g everyone
A- BronwynG: Good morning.

.student: Good moming Dr. Grodsky

BronwynG: This Is Bronwyn and I'll be acting as TA this morning. | will be monitoring chat. Please also let me know If you %ava arilems whin iCS
the webcast feed or sound.

sg.student: Good moming. Sorry| am late

® The useris
logged in.

Monitoring _ Yes The user is logged
"' Monitoring in as Academic
Staff.

Capture Control Yes The user is logged

L& Capture Control in as Academic
Staff.

Embedding the EchoPlayer

In this section:

® Embedding the EchoPlayer
® Authentication and the Embedded EchoPlayer
® Features of the Embedded EchoPlayer

Embedding the EchoPlayer

In addition to the embeddable EchoCenter link that has been available for some time, EchoSystem now provides an
embeddable EchoPlayer link, allowing users to embed the EchoPlayer for a specific Echo into an LMS, or
instructor's webpage, or other external location.

The Embed Code is enabled for Sections through the Sharing checkbox in the EchoPlayer configuration for the
section, shown in the below figure.

EchoPlayer

These seitings control which applications are available in the EchoPlayer.
Discussions : EI Feedback : @I

Sharing : )

The embedded EchoPlayer does not work on mobile, but mobile users will be provided a link to launch the full
EchoPlayer.

The embeddabile link, called Embed Code is available as follows:

Page 365



EchoSystem 5.5 Documentation

® On the Info tab for the Echo in the EchoCenter

(1]

Information

i DATE December 26 10:30 AM
PRESENTERS dan zhang
TYPE Lecture
| DURATION 00:09:59
DOWNLOADS Disabled

DESCRIPTION

This Echo has no description

EMBED CODE /
<iframe width="560" height="315" src="https://ess5-

white.ga.echo360.com:B443/ess/echo/presentation/42d75151- 1 e02-4fc6-b521-ae0155618e387
embed=true" frameborder="0" allowfullscreen></iframe=

® By clicking the Share button in the EchoPlayer

Applications

Let your friends know what you're doing for class.

HTML Embed Code:

<iframe width="560" haight="315" src="https./lass12-
white.ga.echodgl. com:B44 3ess/echo/presentation/364 139
B6-c209-4b0b-836a-5674bb08381d PTembed=trua”
frameborder="0" allowfullscreen></iframa=>

The embeddable EchoPlayer link functions exactly as a YouTube embeddable link, only instead of the YouTube
URL for a video, it contains the ESS URL for the specific Echo. Copying and pasting the Embed Code into an
external location displays the selected Echo within the EchoPlayer on the webpage, providing the full EchoPlayer
experience for the user.

Copyright Check Prevents Embedded EchoPlayer Playback

If you enforce copyright acknowledgement for Echoes, you cannot also use embedded
EchoPlayers for Echo playback. This setting prevents Echoes from being played through
embedded EchoPlayers. Copyright Acknowledgement is set in the Branding section of the Organ
ization settings or Section settings forms (sections inherit the organization settings but can be
changed on a per-section basis).
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Authentication and the Embedded EchoPlayer

If the section requires user credentials in order to view Echoes, a login screen appears in the EchoPlayer frame for
the embedded player. If Seamless authentication is configured, users who are already authenticated through the
LMS will not have to re-enter their credentials.

If you are gathering usage statistics on student views, know that viewers who are authenticated through the
embedded EchoPlayer are captured by EchoSystem's usage statistics gathering mechanism. You will still get that
information even though users do not have to access the full EchoCenter.

Features of the Embedded EchoPlayer

The embedded EchoPlayer looks and functions very similarly to the full EchoPlayer, but without having to launch the
EchoPlayer in its own browser window or tab. The below figure shows an embedded EchoPlayer in a web page,
along with identifying some of the capabilities. These items are described in more detail below the figure.

DEC 29, 2013 1:38:00 PM - EBANKER
Active Leaming &

~ ilantic
The Post: Lecture € Tassromm: How Will
l\!’llldruh I-lallr'.'l "

ot B o Hrnded Inssmussg s #Foeen.
aid that thin wun ~corainky ameng
]

-

ey pasmcular msaneng for mas fol

4l 1l I ru0 o) 01:06:16/ 02:14:35

The arrows in the above figure identify the following items in the embedded EchoPlayer:

® Clicking the section title or launch arrow in the header opens the EchoCenter for the section to which the

Echo belongs.

® Clicking the Echo logo on the right side of the header will launch the full EchoPlayer in a new tab (just like
launching the EchoPlayer from EchoCenter, with full functionality).

® The standard playback controls appear at the bottom of the embedded EchoPlayer, allowing for play/pause,
skip to next scene, skip to previous scene, variable speed playback (VSP), audio level, and "seek" with the

playhead.

The embedded EchoPlayer also allows for the use of the following keyboard shortcuts:

P: Play/Pause (toggle)
F: View in Fullscreen
N: Skip to Next Scene

U: Volume Up
D: Volume Down

B: Go back to Previous Scene

The Embedded EchoPlayer has the following limitations:

® Audio Only presentations will not be displayed.
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® |ive streaming webcasts cannot be viewed in an embedded EchoPlayer.
® For Echoes with two visual capture inputs (Audio/Display/Video, Audio/Display/Display, or
Audio/Video/Video), only one of the two visual items will appear, as follows:
® For A/D/V, users will see the Display input.
® For A/D/D, users will see the Primary Display input.
® For A/VIV, users will see the Primary Video input.

Variable Speed Playback in the EchoPlayer

® Qverview
® | imitations

Overview

Variable speed playback (VSP) allows a viewer to slow down or speed up the rate at which an Echo plays. Viewers

can slow playback down to half-speed (0.5) or speed it up to twice the normal rate (2.0) by adjusting the slider
control, as shown below.

a4 nmw s f

Limitations

VSP is available only with certain browsers and with certain capture options.

® VSP is supported by newer browsers that adhere to the HTML5 standard. See Browsers.

® VSP is supported only for Audio/Display (A/D) and Audio/Display/Display (A/D/D) inputs. Video input is not
supported.

®* When a viewer varies the playback, both the audio and the display (or both displays) speed up or slow down.
If the Echo includes a video input, the video pane turns black when playback speed varies from the normal
speed, as shown below. The video re-appears and resynchronizes when the playback speed returns to
normal.

Video displays only when the playback

rate is 1.0
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Notify Students

In this section:

® Qverview
® Procedure

Overview

After an event of any kind (scheduled, ad hoc, or live) has been captured and processed, you, the System
Administrator, must arrange for students to be notified of the new recording. You can do this via email, EchoCenter
publishing, or publishing to an LMS. This is still true if the event is a special event such as a graduation or speech,
and the people to be notified are alumni or other interested parties, not just students.

You do this in different ways, as shown in the procedure below.

Best Practice: Create an EchoCenter Page

Both Echoes and live webcasts are automatically posted to an EchoCenter page. If you use
email publishing or a publisher that does not support an EchoCenter integration, you will have to
take extra steps (explained in the procedure below) to notify students of live webcasts.

To avoid those extra steps, create an EchoCenter page for any special event that includes a live
webcast or any section that might include a live webcast.

Procedure

If you use... Then
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Email Publishing If the recording is a regularly scheduled Echo,
students automatically receive an email with a link to it.

If the recording is a special event Echo, you have two
options. Both assume that you have created a section
for the special event.

® Find the recording on the Echo Details page (Echoe
s > Echoes). Copy the URL into an email you send.

Echoes > Echo Details

Show Echo - Aptus section-aptus term.2012.02.08.8.06.15.AM

Current Status Available URL: nupetece-50-1 .-’-144-63.:3'\1%-1 Aamazona

EchoCenter Page : URL: nitp:fec2-50-17-144-63 compute-1.amazonay View Echo pe

®* Add the Email Publisher to the section. In this case,
you will have to create an email alias or distribution
list because you can only specify one recipient per
publisher.

If the recording is a live webcast, notify students via
an email you send:

1. Navigate to the schedule for the event (Schedule >
Schedules).

2. Click on the link for the schedule.

3. In the Course/Description settings group, copy the
link from the Next Live Event Link field and send it
to students or post it to a website, as appropriate.

Course / Description
Course : SJG course with live event (S
Title : SJG course with live event (S
Description :
Next Live Event Link hitolivedemoc.echa3s0. com:BOB0 e
The EchoCenter The link (whether for an Echo or a live webcast)

appears on the student's EchoCenter page. See Mana
ge the EchoCenter.

A learning management system (LMS) that has an The link (whether for an Echo or live webcast) appears
EchoCenter integration on the EchoCenter page within the LMS.

® See Publishing for a list of all publishers.

® Only some publishers support an EchoCenter
integration.

¢ |f you publish to an LMS that does not have an
EchoCenter integration, but would like to offer that
seamless integration, contact Echo360 Client
Services for information.
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An LMS that does not have an EchoCenter integration

Manage Echoes

If the recording is an Echo, the link appears on the
LMS page for the course.

If the recording is a live webcast, copy-paste the
EchoCenter page URL to the LMS page for the course.
See Enable EchoCenter Pages in a Learning
Management System . You could also paste the live

event URL instead of the EchoCenter URL.

In this section:

Add Closed Captioning to Echoes
Reprocess an Echo

Add a Publisher to an Echo
Delete an Echo for Administrators

See also:

® Edit Echoes for Academic Staff
® Manage Echoes for Academic Staff

Add Closed Captioning to Echoes

In this section:

® Qverview
® Procedure

Overview

Deaf and hard-of-hearing students are often faced with an impossible choice during a lecture: Should they watch an
interpreter sign or take notes? Lecture capture with closed captioning allows these students to watch the interpreter
sign during the lecture then watch the closed captioned Echo later while they create their own set of notes.

Echo360 has implemented closed captioning standards for its EchoPlayer in line with broadcast television
standards. The following is the procedure for adding closed captioning to your recordings.

Procedure

1. Navigate to Echoes > Echoes.
2. Hover over the Echo to be captioned.

3. Click closed caption to download the mp3 audio file from the lecture. Clicking on this button does not

download the Echo.

Title

Cloged Captioning Examgple 1
] cc-axamples-2010 FY

view play mpd ploy miv odil  downboac

delete

4. Provide the audio file to the captioner.
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Best Practice: Have the Captioner Subscribe to the Podcast Feed

If you want all recordings for a course to have closed captions, suggest that the captioner
subscribe to the Podcast feed. The captioner will receive the mp3 audio files
automatically. You will be able to skip this step.

5. Once you have received the closed caption file from the captioner, navigate to the Echo and click Edit.

6. Click Add Resources.

Add Resources

7. Select the closed caption file and/or transcript file if one has been provided.

Presentation Resources

Clesed Captioning | [ Choose File | 7 example-cc.xml

Transcript File :Chame Fule_' no file selected

8. Click Add Resources.

Add Resources

9. Click Save.

10. Open the Echo in the EchoPlayer.
a. Notice that the CC button appears in the button bar.

b. Notice that the closed captions appear in a separate pane that can be closed, resized, or moved
around the EchoPlayer window. You can adjust the font size of the closed captions by clicking the plus
and minus buttons.

you said, two buildings, let me see. | have the feeling that

Reprocess an Echo
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In this section:

®* Qverview
® Procedure
® Troubleshooting - If the Reprocess Fails

Overview

Some changes to an Echo are not automatically applied. These include:

® Adding an intro/outro clip
® Adding a watermark

You must force the Echo to be reprocessed.

Please note that Outro clips are only added to the Podcast/Vodcast download files; they will not appear in the
EchoPlayer.

Procedure

1. Navigate to Echoes > Echoes.
2. Click the name of the Echo.

Echoes Monitor = Schedule = Conflguration Reports = Test

Echoes Ad Hoc Captures External Media

Echoes (Available)

Search
Filter By :  Date | From : M To:
Click on the
All: 8 Available: 9 Echo to be Archived: 0
Title reprocessed
Sanity (sanity-3.0) fall. 2010

=
- sanity-3.0

3. On the Edit Details page, scroll to the bottom. Click Reprocess Media, as shown in the figure below.

Presentation Media Edits
Mo. Title = Updated Tin
1 Original Click the 10127410 11
Reprocess Media _
2 Manual Reprocess button 10/28/10 1:
EditMedia || Reprocess Media
Notice that a new line has been added to the Presentation Media Edits section of the page, as shown in the
figure below.
Presentation Media Edits
No. Title Updated By Updated Time The file has Status.
1 Original System 10627/10 11:42 AM been Obsolete
2 Manual Reprocess User, Default 10/28/10 1:13 PM submitted Current
3 Manual Reprocass User, Default 10/28/10 2:55 PM Ne ) E";:;:::;m

4. You can wait for this line to be updated or you can monitor the processing. To monitor the processing:
a. Navigate to Monitor > Summary.
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b. Click the Completed tab. If your Echo is not their, click the Processing tab, as shown in the figure
below.
Echoes Monitor Schedule Configuration Reports Test

Summary Captures Processing Tasks Personal Capture Alerts MNotifiers Alert Settings Support
Summary
System Alerts Capture Stations Processors
0 in last hour 1 registered 1 registered
2 1to 4 hours ago 0 out of contact 0 out of contact
0 4to 12 hours ago 1 assigned to a room 0 jobsin queue
0 12 to 24 hours ago 1 jobs completed today 2 jobsin process
1 1to 5 days ago 7 jobs completed today

Recent Captures

Click on the
Processing tab

Filter By : | Course ~| Course :  Choose.. | yword Search :

Scheduled: 0 Capturing: 0 Processing: 1 Completed: 10

Time - Course Room Capture Status Source Processing Status

There are no captures currently in progress.

| Eosmemvaozoioi0zo |
c. In either the Completed or Processing tab, you see:

® The word "Succeeded" in the Processing Status column

® A green, completed filled progress bar with the text "100%," as shown in the figure below.

I Succeeded 100% 0:11:22

Troubleshooting - If the Reprocess Fails
On rare occasions, you receive an error message when you attempt to reprocess an Echo.

This may be caused by an over-full .tmp directory. Your System Administrator can correct this by changing the
temporary storage location. See Best Practice - Establish a Temporary Storage Location.

Add a Publisher to an Echo

® Qverview
® Procedure

Overview

Most of the time, you configure a publisher for a section and each Echo is automatically published. However, if this
process fails you can add a publisher to a specific Echo.

Page 374



EchoSystem 5.5 Documentation

Best Practice: Investigate

This process ensures that the individual Echo is published. After you process this particular
Echo, investigate to discover why Echoes are not publishing automatically. See Publishing and
the individual pages for each publisher.

Procedure

Follow these steps. This procedure assumes you have already configured at least one publisher.

1. Navigate to Echoes > Echoes.
2. Edit the Echo.
a. Hover over the Echo of interest.
b. Click edit.
3. On the edit Echo page, scroll to the bottom and click Add Publisher.

paspuierer |

4. On the Add Publisher page, select the publisher. If necessary, add the publisher configuration.

Add Publisher > Add Publisher

Add Publisher - aptus course (ASLPL-Aptus section) aptus term

General Info

I echo.rss j

Publisher Configuration

Allow iTunes Subscription : ™

5. Click Save.
6. Notice that the publisher appears in the Configured Presentation Publishers section of the edit Echoes page.

Configured Presentation Publishers

Name Publisher Type Configuration Complete?

echo.rss edit delete
Allow iTunes Subscription: true

RSS Feeds

Delete an Echo for Administrators

In this section:

® Qverview
® Procedure

Overview
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When you delete an Echo, you delete it permanently. It cannot be retrieved after being deleted. Before deleting an
Echo, consider these alternatives:

®* Make the Echo unavailable. If you want to keep the Echo but do not want students to view it, you can make
the Echo unavailable. When you make an Echo unavailable, students can still see it listed on their
EchoCenter pages but cannot view it. You can make the Echo available when you want students to view it.
See Make an Echo Available or Unavailable for Viewing.

® Archive the Echo. You can also move Echoes to an archive location. Students do not see archived Echoes
on their EchoCenter pages. See Archive or Unarchive an Echo.

© Deleting a Lot of Echoes?

If you are performing a large-scale deletion of Echoes, or other users have repeatedly deleted
presentations and other media from the system, refer to Deleting Objects from the System. This
section provides technical information regarding how deletions work as well as a Best Practice tip
for defragmenting and re-indexing your database.

Procedure

1. Navigate to Echoes > Echoes.
2. Select one of the tabs (All, Available, Unavailable, Archived). Note the number of items listed (Example: Avail
able: 78).
3. If you can easily do so, use the Search options to list only the Echoes you want to delete.
4. Do one of the following:
® To delete a single Echo, hover over the Echo and click delete.

5.JG copy of this Echo to demo deleting an echo. Security (sec101-ldap) summer 2013 .
LING 101-MWF section view play mp2 play mdv edit download closed capfion copy dele& Larn,
LMI First Course (Imi_fc-test1) summer 2013 Delete Echo

® To delete multiple Echoes:
a. Check the Echoes you want to delete, either individually or using the Select links at the bottom
of the page, highlighted in the below figure.
b. Scroll to the bottom of the page. Select Delete permanently from the Actions drop-down list,
also shown in the below figure

CapturcBs
[ Spuss orginstructor sn Summer 2013 743113 5:00 AM Available
sec101-ldap
CaptureB?
[ =P e orginstructor sn Summer 2013 743113 4:50 AM Available
sec101-ldap
CaptureBs
o niy orginstructor sn Summer 2013 74313 4:40 AM Available
sec101-ldap
CaptureBS
o P e orginstructor sn Summer 2013 743113 4:30 AM Available
sec101-ldap
CaptureBa
o =puss orginstructor sn Summer 2013 743113 4:20 AM Available
sec101-ldap
Select: All 20 (of 46) Displayed Above, All 46 in Fiter, None Action v Choaose. 1-20 of 46 L3
Make unavailable View: | 20 %  Echoes per Page
Archive selected
EchoSystem v. 5.3.2013-5 Delete permanently B | Logout
e——

5. Confirm that you want to delete the item(s).
6. Notice the confirmation message at the top of the page.
7. Refresh the page. Notice that:

® The Echo is deleted from the list

® The number of items listed for the tab is smaller
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